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Getting Started with Unifier General 
Administration Guide 

Within our documentation, some content might be specific for cloud deployments while other 
content is relevant for on-premises deployments. Any content that applies to only one of these 
deployments is labeled accordingly. 

Access to Unifier functionality is granted through permissions. The ability to utilize a specific 
function in Unifier depends on permissions settings (accessed in Admin mode). 

The Unifier General Administration Guide explains how to use the general options that are 
available in the administration mode of operation.  

The Primavera Unifier has two modes of operation: 

 Admin (Administration) mode

Company administrators work in Admin mode to set up, for example, company, program, 
and project or shell properties, user permissions, templates for major Unifier features, data 
structures, and configure and set up business process (BP) workflows. 

 User mode

Users spend most of their time in the User mode. The User mode allows users perform the 
day-to-day activities, collaborate through business processes and Mailbox, maintain, for 
example, the Cost Manager, Schedule Manager, and Document Manager, and run reports. 

The Unifier User Guide explains how to use the options that are available in the user mode of 
operation. 

You can switch between modes using the mode icons ( ). 

Note: This option is not available in Home page because Home page 
does not support the Admin mode. 
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Security Considerations in Unifier 

For any company that deals with sensitive data, keeping it secure is crucial to success. While 
hosting Unifier data on the Oracle Cloud provides security measures, it cannot do everything. 
For example, it cannot prevent phishing attempts or other attacks that exploit gaps in its users' 
security awareness. That is why it is important for everyone who works with Oracle Primavera 
Unifier, whether hosted on-premises or on the Oracle Cloud, to understand what they can do to 
keep data secure.  

Who this information is for 

This guide (the Unifier Administration Guide) and the Unifier Integration Interface Guide contain 
comprehensive information on administrative features, including those related to security. 

This chapter is for anyone who uses, manages, or is just interested in Unifier. If you are a 
security expert or administrator, this is a good place to start. It should help you see the big 
security picture and understand the most important guidelines related to security in Unifier. 

For further information on configuring your on-premises Unifier environment securely, refer to 
the Unifier Security Guide for On-Premises. 

Some Security Basics 

We use the term administrator to refer to anyone who is responsible for managing a company's 
data and who can access that data. For our purposes, administrators includes a wide variety of 
IT professionals, from those who define roles in the Primavera Unifier application to those who 
manage company servers. 

An end user is anyone who uses Primavera Unifier to do their job. This includes project 
managers, subcontractors, general contractors, and everyone else who logs into Primavera 
Unifier from an office or jobsite to get their work done. 

Administrators

 Set up Single Sign-On (SSO) and enable multi-factor authentication to minimize the number 
of passwords that users have to remember and to consolidate risk. 

 Educate users on how they can avoid unwittingly helping hackers. One of the best ways 
application administrators and security advocates can help users is by helping them to 
prevent security breaches. 

 Use a VPN to encrypt data being sent over the internet. 

 Stay up-to-date about security trends and best practices.   

End users

 Follow security guidelines created by their companies and the administrators of any network 
applications they use. 

 Use strong passwords. The more random-looking the better, and avoid reusing passwords. 
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 Learn to recognize phishing. Phishing is when someone disguises an email or some other 
transmission as a legitimate message in an attempt to get a user to reveal sensitive 
information. For example, a hacker may send you an email disguised to look like an email 
from your employer requesting login information. These attacks are becoming more 
sophisticated, but you can still protect yourself by making sure any emails you receive or 
websites you visit are legitimate before using them to share sensitive information. 

In This Section 

Authentication: How Users Sign On ......................................................................... 16 
Authorization: What Users Can Access ................................................................... 16 
Endpoint Security .................................................................................................... 17 
Confidentiality for Primavera Unifier ......................................................................... 18 
Integration with Other Applications .......................................................................... 18 
Security for Developers - API Security ..................................................................... 18 
Establishing Security Contacts ................................................................................ 18 

Authentication: How Users Sign On 

Authentication refers to the way users sign on. If Primavera Unifier is configured to use Oracle 
Identity Cloud Service (IDCS), administrators can—and should—implement Single Sign-On 
(SSO). SSO reduces the number of passwords users have to remember. It can also be used to 
enable multi-factor login, which is when users are asked to provide some verification in addition 
to their passwords, like a code that they receive via text or email. 

If your Unifier Cloud environment is provisioned in Oracle Cloud Infrastructure (OCI), it comes 
with IDCS. Otherwise, you can configure some authentication settings on the Application 
Settings page. 

Note: Unifier does not support integration with IDCS for Unifier 
On-Premises customers.  

To learn how to change the authentication settings, refer to the "Authentication Options for 
Primavera Unifier" section of the Unifier Security Guide for On-Premises. 

Authorization: What Users Can Access 

Authorization refers to what users can access. Authorization to use the Unifier application is 
based on permissions. You also have super-user, the Administrator. Grant authorization 
carefully to all appropriate Primavera Unifier users. 

Administrators: There are different types, or levels, of Administrators in Unifier, their 
responsibility vary from (but not limited to) end-to-end administration of the Unifier to 
administration the company functions. See Administrators in Unifier (on page 21). 
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Permissions: Unifier offers a flexible yet powerful permission-based security system, as 
opposed to role-based security. Role-based security by definition limits the user to a fixed set of 
functions or tasks. With permission-based security, access to all modules, functions and tasks in 
Unifier is controlled by granting each user any combination of permissions. These permissions 
consist of the ability to access specific Unifier tasks, and to perform specific actions within those 
tasks, such as create, modify, and view. See Permission-Based Security in Unifier and 
Managing permissions and access control. See Permission-Based Security in Unifier (on 
page 23) and Managing Permissions and Access Control. 

Groups: Security groups make it easier for administrators to assign permission sets to multiple 
users at the same time. User groups can be used to group users who will be using the same 
functionality in Primavera Unifier and assigned the same Permissions. Anytime a new person 
comes onto the project or shell, administrator can assign them to the appropriate groups and 
their permissions will be set automatically. See User Administration. 

For more information on user authorization, refer to the Unifier Security Guide for On-Premises. 

Endpoint Security 

From laptops to cellphones, organizations have to keep track of data on more devices than ever, 
and more devices means more risk. It is important to implement Enterprise Mobility Management 
(EMM) tools and policies. 

Inherent Risks and Practical Policies 

No automated security system or protocol can make a system fully secure if those with 
legitimate access exploit it for illegitimate purposes or if a device falls into the wrong hands. Here 
are some general "common sense" guidelines you should follow when it comes to endpoint 
security: 

Use good mobile device management (MDM) software. 

MDM systems can help your organization secure the devices where its sensitive data might 
end up. 

Grant security permission conservatively. 

Do not give everyone permission to everything just to avoid perceived complexity. 
Remember, one breach can be many times more costly and time consuming than setting 
and following standard security protocols. 

Organize permission sets and credentials so they can be edited quickly. 

Keep user groups and their permissions organized and easy to manage. Use descriptive 
names for permission sets, and organize them logically to make it easier for you or anyone 
else to manage them quickly and confidently. 

Keep up with organizational changes. 

If a user no longer needs access to a part of the app, for whatever reason, update that user's 
permissions accordingly. 

Use timeout settings. 
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Administrators can limit how long mobile apps and APIs remain connected to the server after 
a user signs in. For more information: 

See Unifier Mobile Application (on page 305). 

Refer to the Unifier Security Guide for On-Premises. 

Confidentiality for Primavera Unifier 

Confidentiality ensures that only the authorized users see the stored and transmitted 
information. In addition to the documentation included with other applications and hardware 
components, follow the Primavera Unifier-specific guidance below. 

 For data in transit, use SSL/TLS to protect network connections among modules. If you use 
SSO authentication, ensure that you use LDAPS to connect to the directory server. 

 For data at rest, refer to the documentation included with the database server for instructions 
on securing the database. 

See Managing Personal Information in Unifier (on page 287). 

Integration with Other Applications 

The ability to connect and exchange information with other apps is powerful, but it also presents 
some potential security issues that administrators must manage. It is important to understand 
which data flows between applications to ensure compliance with policies and regulations 
related to security and privacy. 

For more information on integration, refer to the Unifier Integration Interface Guide. 

Security for Developers - API Security 

With APIs, developers can use some of the data and functionality of Primavera Unifier outside of 
the limitations—and relative safety—of the Primavera Unifier environment. This opens many 
possibilities. But as with any situation where data can move in potentially unpredictable ways, it 
presents risk. For more information on integration, refer to the Unifier Integration Interface 
Guide. 

Establishing Security Contacts 

While the apps used by your organization may have some security features of their own, most 
security issues ultimately come down to the people who use them. When your company 
establishes its security procedures, it's important to also establish in-house security experts to 
whom other members can turn when they have security questions. Security points of contact 
should be continuously learning about security trends and how they can educate users to keep 
their data and network secure. Security contacts should also routinely update and maintain 
protocols that suit the security needs of their organizations. 
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Companies in Unifier 

The following is a list, and description of, company types in Unifier: 

 Owner Company (also referred to as the Sponsor Company) 

 Partner Company 

 Member Company 

The following explains each company type in detail. 

Owner Company (Sponsor Company) 

The entity that engages in business and has the complete control (or ownership) of the Unifier 
application with all its rights and privileges. An Owner Company (Sponsor Company), 
commissions projects or shells. Projects and shells are created in Unifier under the Owner 
Company, as projects and shells. 

Note: Projects and shells are a collaboration space allowing users to 
collaborate and coordinate efforts during the execution of a project. 

A Sponsor Company may have one, many, or no partners. 

Partner Company 

A Partner Company is a consultant, a contractor, or a vendor company which is associated with 
a Sponsor Company. A Partner Company may work with the Sponsor Company on all, or only 
some, of the Sponsor Company projects or shells.  

Member Company 

When a Partner Company participates in a project or shell, the Partner Company becomes a 
Member Company in that project or shell, and the Partner Company users that are added to the 
project or shell become the Member Company users.  

Note: Project and shell access is limited to Unifier users (including 
Sponsor Company users or Member Company users) who are chosen 
for the project or shell and permissions are configurable for each 
company. 

Unifier allows adding Partner Company/ Member Company to enable project users to 
collaborate on (and coordinate) the execution of a project.  

To access the User Administration node, go to Company Workspace > Admin mode > User 
Administration. The following explains each sub-node in details. 
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Administrators in Unifier 

Note: The following information is based on the default settings and 
typical use of Unifier. 

There are different types, or levels, of Administrators in Unifier and they include: 

 Site Administrator (also referred to as the System Administrator) 

 Company Administrator 

 Project Administrator or Shell Administrator (Project/Shell Administrator) 

The following explains each administrator type in detail. 

Site Administrator (also referred to as the System Administrator) 

A Site Administrator is responsible for the end-to-end administration of the Unifier. 

Note: For cloud customers, the Oracle Primavera Technical Team 
performs the Site Administrator function. For on-premises customers, the 
customer performs the Site Administrator function.  

The Site Administrator's tasks include: 

 Loading modules. 

 Loading certain system reports. 

 Managing the License Manager. 

 Performing basic system administration tasks, including unlocking locked user accounts. 

 Performing Company Administrator and Project/Shell Administrator functions, if requested. 

 Changing the Authentication Key.  

Company Administrator 

Generally, a Company Administrators administers the Owner Company (Sponsor Company) 
functions. The Company Administrator can perform user tasks, also. 

Note: Except where noted, the Company Administrator cannot perform 
tasks designated for the Site Administrator. 

Depending on the permission a Company Administrator typically performs the following tasks: 

 Creating multiple partner companies in the Owner Company. 

 Creating users for each partner companies in the Owner Company. 

 Modifying the company properties, including Company Workspace 

 Managing company details such as contact information. 

 Managing company-level users, groups, and granting permissions. 

 Managing Partner Company (or Member Company) status. 

 Managing Partner Company (or Member Company) users. 

 Creating cross-project or cross-Shell reports. 
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 Creating, and maintaining, Data Definitions (DDs) and Data Elements (DEs). 

 Activating a Business Process schema. 

 Defining record numbering scheme. 

 Defining the company exchange rate and currencies. 

 Creating programs, projects, and shells. 

 Managing project organization (categories) and shell organization (types). 

 Setting up templates. 

 Setting up and managing data structure. 

 Configuring the User mode Navigator (the setup of the left-hand Navigator in User mode: 
Company Workspace > Admin mode > Configuration > User Mode Navigator). 

In Unifier, you can have multiple company administrators. 

The Company Administrator group, which can contain multiple company administrators, is 
automatically created when the Owner Company (Sponsor Company) is created in Unifier, by 
the Site Administrator. 

This Company Administrator group has preset permissions. These permissions can be changed 
as needed. 

Examples 

 If new business processes are added. 

 If new modules are added. 

 If the Company Administrator assists in administration of other modules such as projects 
or shells.  

Project Administrator or Shell Administrator (Project/Shell Administrator) 

Project/Shell Administrators manage project-level or shell-level administration tasks, and may 
also administer programs for projects. A project or shell administrator will add existing Unifier 
users to projects and/or project/shell groups, restrict access within specific projects, set up the 
project or shell cost/funding/Schedule of Value (SOV)/schedule sheets, and set up business 
processes. Project or Shell Administrators typically: 

 Administer projects or shells they are a member of 

 Add Project or Shell Users, create Groups and grant Permissions 

 Create and modify the Cost Sheet 

 Create Business Process Setups and define workflows 

 May also manage programs as a Program Administrator (for projects only) 

To access company administration functions see Company Landing Page (Admin) (on page 
25). 
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Permission-Based Security in Unifier 

Unifier offers a flexible yet powerful permission-based security system, as opposed to role-based 
security. Role-based security by definition limits the user to a fixed set of functions or tasks. With 
permission-based security, access to all modules, functions and tasks in Unifier is controlled by 
granting each user any combination of permissions. These permissions consist of the ability to 
access specific Unifier tasks, and to perform specific actions within those tasks, such as create, 
modify, and view. 

For ease of use, permissions can be set for both individuals and for groups of users. You can 
even copy permissions from one user to another, and then make modifications. 

A user may belong to any (or all) of the administration groups and perform functions as a 
company, program, or project or shell administrator. Company Administrators generally have 
program and project or shell permissions, and may or may not work within the specific projects 
or shells. You may want a project, shell, or program administrator to have the ability to perform 
some company administrator functions, such as creating a project or shell. Creating different 
types of user permission templates will help you to more easily grant access to different staff 
members, whether they are administrative staff, engineers or architects, managers, vendors or 
subcontractors, IT personnel, etc. 

Use default permissions as a guideline, but your users’ actual permission settings will depend on 
your organizations needs. 
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Company Landing Page (Admin) 

When you (a user or an administrator) sign in to Unifier, the system is in the user mode, by 
default. 

You can switch between modes using the mode icon ( ). 

Note: This option is not available in the Home page  because Home 
page does not support the Admin mode. 

To access your company landing page (Admin):  

1) Click your company tab (Company Workspace) to open it. 

2) Switch to Admin mode. 

3) From the left-hand Navigator, on the very top, click your company name (for 

example: ). 

The company landing page has the following elements: 
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Left-hand Navigator Right-hand Pane 

 Company name 

 Announcements 

 License Manager 

 Consent Notice 

 Partner Companies 

 uDesigner 

 Data Structure Setup 

 Access Control 

 User Administration 

 Gateway 

 Configuration 

 Standards & Libraries 

 Company Workspace 

 Templates 

 Programs 

 Company Sponsored 
Projects (Standard) 

 Company Sponsored 
Shells 

 Analytics 

 Custom Dashboard 

 Background Jobs 

 Event Notifications  

 System Reports 

 Configuration Package 
Management 

On the top: 

 Tab name: Company Workspace 

 Menu options (File, Edit, View, and Help) 

 Toolbar options (New, Open, and Find) 

Below the top, on the left, company general 
information: 

 Company name 

 Description 

 Administrator (click on the link to view contact 
details for the company administrator contact.) 

 Home Page URL (links to the company web site, 
which opens in another browser window. This 
optional link is defined by the Company 
Administrator.) 

 Help URL (links to an internal source of supporting 
information, such as a company intranet site. This 
optional link is defined by the Company 
Administrator.) 

Below the top, on the right: 

 Company Addresses: the right side of the window 
displays a list of all addresses that have been 
entered in the system for the company, such as the 
main office, billing and shipping address, etc. 

 Partner Companies: any consultants, contractors or 
vendors that are associated with projects or shells 
that the Sponsor Company commissions. 

On the right-hand pane, on top, click the Open toolbar option to open the Edit Company
window. See Access Company Details (on page 61) for information about the tabs in the Edit 
Company window. 
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Program Landing Page (Admin) 

To access your program landing page (Admin):  

1) Click your program tab to open it. 

2) Switch to Admin mode. 

3) From the left-hand Navigator, on the very top, click your program name (for example: 

). 

The program landing page has the following elements: 

 Left-hand pane (Navigator) which contains the following nodes (modules): 

 Program name 

 Summary 

 Other nodes (such as Cost Manager, Schedule Manager, etc.) 

 Reports 

 Right-hand pane which contains: 

 On the top: 

 Tab name 

 Menu options (File, Edit, View, and Help) 

 Toolbar options (New, Open, and Find) 

 Below the top, on the left, program general information: 

 Program name 

 Program Number 

 Location 

 Email Address 

 Description 

 Below the top, on the right: 

 Links 
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Shell Landing Page (Admin) 

Once you create a shell, it is available for use. To access your shell landing page:  

1) Click the shell tab to open it. 

2) Switch to Admin mode. 

3) From the left-hand Navigator, click your shell name (for example: ) on top. 

The top section of the landing page contains the Shell Dashboard. 

By default, the shell dashboard contains the following blocks: 

 Tasks

 Notifications

 Mail

 Image

 Details

 Links

The bottom section of the shell landing page displays a log of all sub-shells that have been 
created under the currently selected shell. For example, if you select the sub-shell South Bay, 
and then the further sub-shell Mathilda Northwest, this landing page displays. 

By default, the following two tabs are displayed. 

 Summary

 Workspaces

You can change the layout of the tabs, in My Dashboard or other custom dashboard. 

Example 

Block Length: 2 units 

Block Height: 2 units 

The following explains the various informational blocks in the Summary tab:  

 Tasks

This block lists the total tasks belonging to the shell. When you click on Tasks you go to the 
Task log directly. You will be able to add this block in all tabs (in all dashboards) by using the 
data-source "Items Requiring Attention" in the Standard block. Also, you can remove the 
block from My Dashboard. 

 Notifications

This block lists the total notifications belonging to the shell. When you click on Notifications 
you go to the Notifications log directly. You will be able to add this block in all tabs (in all 
dashboards) by using the data-source "Items Requiring Attention" in the Standard block. 
Also, you can remove the block from My Dashboard. 

 Mails
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This block lists the total mails belonging to the shell. When you click on Mails you go to the 
Inbox log directly. You will be able to add this block in all tabs (in all dashboards) by using 
the data-source "Items Requiring Attention" in the Standard block. Also, you can remove the 
block from My Dashboard. 

 Project Image

This block displays an image, if available; otherwise, the block will be blank. 

 Details

This block is displayed with either custom fields or default fields based on the configuration of 
the details block that is designed in uDesigner, shell manager. In the latest version of Unifier, 
the shell home landing page displays the custom fields; otherwise, the shell home landing 
page displays the default fields, only. 

You can edit the details block using the pen icon or through Edit dashboard option. This 
capability applies to block information, or to the fields that must be displayed in the block. 

 Links

If links have been added to the shell details, then those links are displayed in this block. 

 Sub-shell log

This block displays the sub-shells of parent shell, based on the view that you have selected. 
You can hide Workspaces in other dashboards.  

The user-created dashboards support all of the existing functionalities, except the sub-shell 
log. 

You cannot delete Workspaces tab in any Dashboard. 

You cannot hide the Workspaces tab in My Dashboard. As a result, you cannot deselect the 
Show checkbox for Workspaces. 

14. User will be able to hide Workspaces Tab in all user-defined Dashboards and will be able 
to un-check the 'Show' checkbox for Workspaces. 

Important Information

The Tasks, Notification, and Mails can be added or removed. Individual tiles cannot be 
added/removed. 

The block will get displayed back, post removal, by navigating to Add Block > Standard and 
selecting Data Type as "Items Requiring Your Attention." When you save the Standard Block, 
the block will be added automatically to the dashboard. 

The following explains the various informational blocks in the Workspaces tab: 

The Workspaces tab is available when geo-code server details are configured in Unifier, only. 

 If there are no geo-location present in the sub-shells, Unifier displays a map without location 
markers. 

 If there is a geo-location present in the sub-shells, Unifier displays a map with location 
markers. 

When you hover over the location markers on the map, you can see the details for the location 
marker based on available information. 

When you right-click on the location marker, you can open the shell (for that location) in a new 
tab, in Unifier. 
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The My Dashboard sub-menu (the three dots) enables you to: 

 Access additional dashboards for the shell, if available. 

 Edit Dashboard 

To open the editing mode of the current dashboard. 

 Details 

To view the shell details, as overlay. The details include: Shell Name, Shell Number, and the 
following tabs: 

 General 

 Currency 

 Options 

 Links 

 Calendar 

 Integration 

 Audit Log 

To open the audit log, as overlay. 

The Workspaces tab has the following toolbar options: 

 View 

For example, Buildings, Cities, Shells, Projects, Regions. 

 Actions 

 Get Activity Sheet Data 

All Shells 

Selected Shells 

Filtered Shells 

History 

 Send Activity Sheet Data 

All Shells 

Selected Shells 

Filtered Shells 

History 

 Search 

 Find on page 

 Expand All Groups 

The columns the Workspaces tab sub-shell log are not hard-coded. The fields defined in Shell 
Detail form (in uDesigner) are added as columns in the Sub-shell log. 

 Name 

 Shell Number 

 Shell Name 

 Description 

 Status 
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 Administrator 

 Location 

 User-Defined Text 

The right-hand pane displays the map that shows the regions. 
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Project Landing Page (Admin) 

To access your project landing page (Admin):  

1) Click your project tab to open it. 

2) Switch to Admin mode. 

3) From the left-hand Navigator, on the very top, click your project name (for example: 
) 

The project landing page has the following elements: 

 Left-hand pane (Navigator) which contains the following nodes (modules): 

 Project name 

 Member Companies 

 Access Control 

 User Administration 

 Setup 

 Rules 

 Right-hand pane which contains: 

 On the top: 

 Tab name: Company Workspace 

 Menu options (File, Edit, View, and Help) 

 Toolbar options (New, Open, and Find) 

 Below the top, on the left, project general information: 

 Project name 

 Description 

 Number 

 Address 

 City 

 State 

 Country 

 Phone 

 Fax 

 Email Address 

 Below the top, on the right: 

 Progress 

 Links 
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Queries 

You will be using queries to extract data from the database for reports and data pickers, and to 
set up auto-creation with creator elements.  

A query is a data mining tool—a method for retrieving information from a database. A query 
filters the information returned from the database according to restrictions or conditions you 
specify. The Unifier queries can: 

 Filter or narrow the data being retrieved for use in reports and manager sheets 

 Set up conditions or triggers to make something happen automatically in Unifier 

 Filter or narrow the data being retrieved for use in a data picker element 

In This Section 

How Queries Work .................................................................................................. 35 
Using Formulas or Conditions in Queries................................................................. 36 
Assignee Filter Query Condition .............................................................................. 40 
Query Based Data Element (QBDE) ........................................................................ 41 
Defining the Format of the Currency for QBDE ........................................................ 43 

How Queries Work 

The way queries work in Unifier is as follows: 

 You mine down to the information you want by choosing an element (field) in the database 
on which to base the query. 

 You test the data against conditions and values you specify. 

A condition is a state or restriction the value in the data element (field) must meet. A 
condition of the value might be that it must be equal to a certain number (maybe 10) or that it 
must contain a certain string of letters (such as "due date of"). 
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 When (or if) the data meets the condition you specify, Unifier retrieves if from the database 
for use in a report, manager sheet, auto-creation, data picker, etc. 

Using Formulas or Conditions in Queries 

For queries, you can evaluate the data before retrieving it from the database to determine 
whether or not to include the value in the report, manager sheet, or data picker, or to spawn an 
auto-creation. To evaluate the data, you can use a formula or a condition. 

In formulas, multiple fields can be calculated to arrive at a certain value that the data must meet 
before it will be used. The value can be one that you enter, or a value from another field. 

You can include formulas in conditions. 

In the Condition field, select the condition the value in the field must meet.  

The following explains the formulas you can use in a query. 
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Field Value Comparison 

The formula for field value comparison produces data that meets a field value (string or numeric) 
from the form of a business process or a shell in a hierarchy, or a constant. Used to populate a 
data picker. 

Date Plus or Minus 

The formula for date adds or subtracts a value to or from a date. 
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Date Difference 

The formula for date difference subtracts one date from another to give you the number of days 
between the dates. 

Compare Date Fields 

You can also compare date fields as part of a query. 



Queries

39

Dynamic Date Value 

You can compare a date field value with a date field from the form of a business process or a 
shell in a hierarchy, a specific date, or today’s date, and also add or subtract days to the result. 
Used to populate a data picker. 
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Between Dates 

You can compare a date field value to see if it falls between two dates. Used to populate a data 
picker. 

Assignee Filter Query Condition 

When you are setting up a business process, you can filter the condition for the assignee 
according to: 

 Contains 

 Does not contain 

 Exists in 

 Does not exist in 

 Equals 

 Does not equal 

 is empty 

 is not empty 

The following is an example of query evaluation. The workflow setup follows these policies for 
selecting users. 

Assignee Query Field (Role as defined in the User Attribute Form) 

A Approver 
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Assignee Query Field (Role as defined in the User Attribute Form) 

B Reviewer 

C Controller-Approver 

D Controller 

E Reviewer-Submitter 

F Submitter 

G Approver 

The following shows examples with condition/operator: 

Condition/Operator Business Process Form (Field value)

Example of the data source used. 

Filtered List of 
Assignees 

exists in Controller-Approver A, C, D, G 

Reviewer B 

does not exist in Controller A, B, C, E, F, G 

Note: If the workflow setup has any of the new operators, the list of 
assignees that the user sees at runtime honors the stated query 
parameters. 

The following shows examples with value, condition/operator, and result:  

Value 1 Condition/Operator Value 2 Result 

ABC exists in ABC, BCD, CDE True 

XYZ exists in ABC, BCD, CDE False 

ABC does not exist in ABC, BCD, CDE False 

XYZ does not exist in ABC, BCD, CDE True 

ABC, BCD, CDE contains ABC True 

ABC, BCD, CDE contains XYZ False 

ABC, BCD, CDE does not contain ABC False 

ABC, BCD, CDE does not contain XYZ True 

Query Based Data Element (QBDE) 

In Unifier, a Query Based Data Element (QBDE) enables you to view data from the Upper Form 
or Detail form of a Business Process. QBDE also enables you to view data from: 
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 Other Business Processes 

 Sheets 

 Cash Flow 

The QBDEs are based on the “SYS Numeric Query Based” Data Definition (DD), and the query 
for these QBDEs is set in the Business Process Configuration setup. See the "Configure a 
Query for a Query Based Data Element on a BP" for additional details. 

In addition to the Web interface (Unifier Application in the browser), the system evaluates QBDE 
in the following areas: 

 CSV import for record creation 

 CSV import for Line Item creation 

 Web Service methods for record creation along with Line items 

 Web Service methods for Line Item creation 

 Web Service methods for record updates 

 Bulk Edit 

 Bulk Update 

 Creating BP records using BP Template 

Evaluating Query Setups of Data Picker Data Elements 

Unifier supports many types of Data Picker DEs. The Administrator can set up Query conditions 
on these Data Picker DEs to filter the results. When a Data Picker DE is launched in the Web 
interface (Unifier Application in the browser), the system runs the query and displays the records 
based on the queries defined in uDesigner. The system evaluates the data picker query 
conditions in the following areas, as well: 

 CSV import for record creation 

 CSV import for Line Item creation 

 Web Service methods for record creation along with Line items 

 Web Service methods for Line Item creation 

 Web Service methods for record updates 

The following is a list of the supported Data Pickers: 

 BP Data Picker 

 Shell Data Picker 

 User Data Picker 

 CM Data Picker 

 Role Data Picker 

See the "Importing Configuration Packages" section for more information about importing data. 

Creating a Record from the Query Based Tab   

When creating a record from the Query Based tab of another BP (that auto-populates data to the 
record being created), the Data Element (DE) of type “SYS Numeric Query Based” Data 
Definition (any DE of this type) is not updated, unless the user manually changes the trigger 
element. 



Queries

43

Defining the Format of the Currency for QBDE 

You can use the QBDE to get the count of records. As a result, you can format the DEs that are 
query-based to hide the currency symbol. That is to say, you have the option to hide the 
currency symbol, at the data element level. As a result, when viewing the value in a query-based 
DE, Unifier displays the correct format so that the number makes meaningful sense.   

Example 

A Budget Change BP may have the 'Count of Change orders' QBDE (defined as a DE of 
SYS Numeric Query type) associated with the BP. On the same BP, there may be another 
QBDE 'Sum of All Change Orders' which needs the formatting of a Currency DE. You can 
choose whether or not to display the currency symbol for these DEs at runtime.  

In the Admin mode, you define the Data Element (DE) that is query-based, add it to the BP 
form, and set up the query. In the User mode, you can see the results in the run-time (for 
example, displaying or not displaying the currency symbol). 

The Data Element properties tab of SYS Numeric Query Based Data definition contains a 
checkbox option for hiding currency symbol in Cost type BP. By default, this option will be 
unchecked.  

Note: When the same DE is placed in non-Cost BPs, this option will be 
ignored since these BPs do not display currency symbol for data 
definition with Input type of Currency Amount at runtime. 

Go to: Company Workspace (Admin mode) > Data Structure Setup > Data Elements to find 
the DEs that are query-based. 

Click Find and enter "qbde" in the Search for field box to find the DEs. 

When you open a query-based DE (Modify Data Element window), you have the option to 
select, or deselect, the Hide Currency Symbol in Cost type Business Process option. 

Depending on your selection, Unifier displays, or hides, the currency symbol for the query-based 
DE. 

Configuration Package

The format set in the Data element must be included in the bundle. 
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Dashboards in Unifier 

In Unifier, the following types of dashboards are available. 

My Dashboard (end user-defined dashboard): By default, all shells have a dashboard that the 
end user can configure if they have configure permissions. The dashboard is the user’s personal 
dashboard, with their personally configured view of shell data. My Dashboard can be configured 
by end users in User Mode using the Edit Dashboard window, but is often configured for each 
user by the Administrator. Users can select this type of dashboard to view from the View 
Dashboard drop-down list on each shell. This dashboard is recommended if the user wants a 
personalized dashboard to view data that they specifically need to see regarding the shell. 

Shell dashboards: These dashboards allow users to view information specific to the shell for 
which the dashboard was created. This differs from My Dashboard in that it is a shell view of the 
shell for all users to use. My Dashboard is a personalized view for a specific user, therefore 
displaying only the information that the user wants to see. The shell instance dashboard is a 
general view of specific shell data, and is not specific to any one user view of data. 
Administrators can create multiple shell instance dashboards per shell instance. Users can 
select this type of dashboard to view from the View Dashboard drop-down list on each shell. 
These dashboards are maintained at the shell level and are available to any user to view (but 
not edit) provided the user has permissions. 

Custom Dashboard. This is a dashboard someone created externally using a dashboard 
creation software that generates SWF (Small Web Format) files. An Administrator can upload a 
SWF file into the Custom Dashboard for use within Unifier. Users cannot modify these 
dashboards. You can use this dashboard as your default dashboard. 
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Self-Service Portal 

The Self-Service Portal enables users to sign in and work with specifically-enabled business 
processes. For example, Oracle Primavera customers use Unifier for corrective work order 
management. These work requests are usually generated from project participants who do not 
use Unifier. These participants can use the Self-Service Portal, which allows request submittals 
through a web-based tool. Users can use the Self-Service Portal to submit requests and to view 
the status of these requests, and to collaborate on submitted requests. 

In uDesigner, you can enable certain business processes to be accessed through the 
Self-Service Portal. The business processes that you can enable to be accessed through the 
Self-Service Portal must have the following characteristics: 

 Simple 

 Company level 

 Non-workflow 

 Multi-record 

The actions users can take through the Self-Service Portal are: 

 Create a business process 

 Modify a business process 

 Add or remove business process attachments 

 Add General Comments to a business process 

Before you begin, design the Landing Page in terms of the text and graphics that you want it to 
contain. Then:  

Step 1: Set Landing Page permission. 

Step 2: Configure and activate the Landing Page. 

Step 3: Specify users that receive portal-specific notifications. See Setting Up a Non-Workflow 
Business Process for details. 

Setting Up a Self-Service Portal Landing Page 

Note: You must have Configure permission to be able to configure a 
Portal Landing page. 

To set Landing Page permissions: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Access Control in the left Navigator. 

3) On the right pane, select Administration Mode Access > Configuration > All > Landing 
Page. 

4) Set the permission as needed: Configure: Administrators can configure Self-Service Portal 
Landing Pages. 
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Configuring and Activating a Portal Landing page 

If you have the Configure permission for the Self-Service Portal Landing Page, you can use an 
HTML editor to set up a Landing Page. After you configure and activate the Portal Landing 
Page, users signing in to the Self-Service Portal will see this landing page. You can configure 
one Landing Page, and activate this page for use. 

Note: If no Landing Page is configured, a user sign in to the Self-Service 
Portal will see the Unifier Announcement page. 

To configure and activate a Portal Landing page: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Configuration > Landing Page in the left Navigator. 

3) Click New. 

4) Enter the Setup Name of the Landing Page, and an optional Description of the page. The 
default initial status of the page is Inactive. You can change this status after you complete 
the page. 

5) Click the Layout tab. 

6) Use the HTML editor to add text, and perform other editing functions. 

7) Click the Insert Image button (second button from the right in the toolbar) to insert an image 
into your Landing Page. Browse for the image, and click OK, and Close after the upload is 
complete. 

8) Click OK. 

To activate a Portal Landing page: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Configuration > Landing Page in the left Navigator. 

3) Select the Landing Page in the log. 

4) Choose Status > Active. You can inactivate the Landing Page by choosing Status > 
Inactive. When a Landing Page is inactive, the user who signs in the Self-Service Portal 
sees the Unifier Announcement page. If no active Landing Page is set up, the portal user 
sees a default Landing Page. 
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Access Control and AutoVue Stamps 

The following permissions are available:  

 Create 

The user will be able to perform all the operations on a stamp (Import, Download, Create, 
Delete, and Edit) along with changing the Stamp data elements selection. 

 Modify or Delete 

The user will not be able to create or import stamps into Unifier, but the user will be able to 
perform the rest of the operations on the stamp.  

 View 

The user will not be able to edit or delete stamps, but the user will be able to open and 
download the stamp. 
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Managing Public Searches 

A public search is any set of criteria a user has specified to search a log for specific records and 
has saved for future use as a search. Users can specify search criteria, give the criteria a name, 
and save it. The search then becomes available on their Tasks and business process log pages 
under the Filtered By button. In addition, users can make searches available to other users by 
making them public. Administrators with "Manage Public Searches" permissions can delete, 
change status, and transfer ownership of public searches created by any user. 

In This Section 
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Setting Public Search Permissions 

To set public search permissions: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Access Control in the left Navigator. 

3) On the right pane, select Administration Mode Access > Data Structure Setup > Public 
Searches to open the Module Permission Settings window. 

4) Set the permissions as needed: 

 To modify the Manage Public Searches permission for an existing user/group, click to 
select the user/group, click Modify, and under Permission Settings click to select 
Manage Public Searches option. 

 To permit a user/group to have access to public search, click Add to open the 
Permission/Access Control window. Click Add Users/Groups and follow the prompts 
to add the new user/group. When finished, under Permission Settings, click to select 
Manage Public Searches option. 

Managing Public Searches 

The Company Administrator can delete, change status, and transfer ownership of public 
searches. 

To delete public searches 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Data Structure Setup > Public Searches in the left Navigator to open the Public 
Searches log. This log lists only searches that have the status of "public." 

3) Click to select a public search from the log. 

4) Click Delete. The search is deleted from all Filtered by lists on Tasks logs and business 
process logs, and is no longer available to any users to use for searches. 
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To change the status of a public search 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Data Structure Setup > Public Searches in the left Navigator. The Public Searches 
log opens. 

3) Click to select a public search from the log. 

4) Choose or Status > Private. 

Note: When you change the status of a public search to private, it no 
longer appears on the Public Searches log. 

To transfer the ownership of a public search 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Data Structure Setup > Public Searches in the left Navigator. The Public Searches 
log opens. 

3) Click to select a public search from the log. 

4) Click Transfer Ownership. 

5) Select a user to whom you want to transfer ownership and click OK.
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Adding & Managing Partner Companies 

A sponsor company may work with one or many partner companies (for example, 
subcontractors, vendors, etc.) to work on projects, shells, or company level activities. Company 
Administrators can manage partner companies and users. The Site administrator will first add 
the potential partner company to the list of available companies, from which you can select the 
companies to activate. Partner company users can be granted access to specific company level 
and project-level or shell-level features. 

Note: Contact your Site Administrator to add a company to the list of 
available companies. 

To access partner companies 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click the Partner Companies node in the left Navigator. The Partner Companies log opens. 
The log will display any current partner companies. 

In This Section 
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Add a partner company 

Adding a partner company to the list allows you to work with partner company users within 
Unifier. 

To add a partner company 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Partner Companies in the left Navigator. The Partner Companies log opens. 

3) Click the Add button. The Add Partner Companies window opens, listing available potential 
partner companies. (This list is maintained by the Site Administrator.) 

4) To search for a particular company, click the Find button. The Find box opens at the top of 
the window. Click the Search By drop down and choose Company Name or Contact Name. 
Enter the search criteria in the Search for field and click the Search button. 

5) Select one or more companies from the list and click the Add button. 

6) When the confirmation window opens, click Yes. The company is added to the log. Users 
from the company are now available to be added to company, project, or shell functions. 
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Remove a partner company 

If you no longer want users in a partner company to participate in your company, project, or shell 
Unifier areas, you can remove the company from the list. If you remove a partner company: 

 The partner company users that have been added as users either under your company 
(Partner Users node) or in any projects or shells will be inactivated automatically. 

 If the partner company being removed has previously been added to a project or shell as a 
project or shell "member company," the company will remain in the Member Company log for 
the project or shell, but users will be inactivated. 

 These inactivated users cannot be reactivated unless the partner company is added back to 
Partner Companies node. 

To remove a partner company 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Partner Companies in the left Navigator. The Partner Companies log opens. 

3) Select a partner company from the list and click Remove. 

4) At the confirmation window, click Yes. 

View partner company profile 

Partner company details are managed by the company administrator for the company, or the 
Site Administrator. You can view the details. 

To view the company profile of a partner company 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Partner Companies in the left Navigator. The Partner Companies log opens. 

3) Select a partner company from the list and click Open (or double-click). The Company 
Profile window opens. The information in this window is read-only, and is maintained by the 
partner company’s administrator. 

4) Click the General tab to view general information, or the Address tab to view address and 
other contact information for the company. 
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Manage Support and e-Learning contact 
information (Contact tab) 

In the Contact tab of the Edit Company window, you can provide your users with an email 
address and/or phone number of your internal support staff. This information will be displayed in 
error messages users may encounter if their accounts become locked, on the Support window 
Contact tab, and at the bottom of email notifications. The information included for email 
notification can contain a hyperlink to your local support. For information about translating Email 
Notifications, see the Internationalization (Email Notifications) section. 

In addition, if your company is part of the eLearning suite of interactive tutorials, you can provide 
access information to your users in this tab. This space can also be used for any location (such 
as an internal website) where you have provided Unifier training materials. 

To manage user support contact information 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the right pane, click the Open button. The Edit Company window opens. 

3) Open the Edit Company window and click the Contact tab. 

4) Under Support Contact Info and eLearning Access, you can add or modify the contact 
information as needed. See the following table for details. 

5) Click Apply to save changes, or OK to save and exit the Edit Company window. 

To complete this section: Enter this information: 

Support Contact Info 

Email: Email address for company internal support. 

Phone: Phone number for company internal support. 

Instructions: Information that appears in the Support window 
Contact tab, as well as the Email and Phone from above. 
This provides information to your users on how the use the 
support information. 

Email Notifications: Information that appears at the bottom of 
email notifications. This field supports simple html formatting, 
and can include a hyperlink. For example: 

<p>For YourCompany support, contact <a 
href="mailto:support@yourcompany.com">support@your
company.com</a> or 1-800-555-1212. </p> 

which will display in the bottom of record email 
notifications as: 

For YourCompany support, contact 
support@yourcompany or 1-800-555-1212. 

eLearning Access 
URL: Enter the URL for eLearning access. It is best to 
include the entire address 
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Label: This is the label for the URL above. The label can 
display the actual URL, or you can a different label. This will 
appear as a hyperlink to users. 

Contact email: Enter an email address that you would like 
users to use if they need to contact someone. Enter a valid 
email format, e.g., elearn@yourcompany.com. 

Instructions: You can enter instructions or other information 
such as a contact phone number. This field does not support 
html formatting. 
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Manage Company Password Policy (Security tab) 

Sponsor company administrators can specify password security policies in the Security tab of 
the Edit Company window. By default, the minimum password requirement is set at one (1) 
character, meaning that the user is required to create a password with a minimum of one 
character. If a value is not entered in a field, the option is ignored. 

Notes: 

 These settings apply to Sponsor/Owner company users only. They 
will not apply to Partner Company users, where the default settings 
apply. 

 If your company is using Oracle Identity Management (OIM) to 
provision your company users, the password policy specified on this 
tab will not be used. OIM has its own password policy which will 
supersede the policy on this Security tab. 

To manage user password criteria 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the right pane, click the Open button. The Edit Company window opens. 

3) Open the Edit Company window and click the Security tab. 

4) Select the password criteria that you want to configure, then enter the value in the text box. 
See the following table for details on each option. 

5) Click Apply to save changes, or OK to save and exit the Edit Company window. 

Select this option: To specify: 

Minimum overall character(s) 
Minimum number of characters that a 
password must contain; default is one (1) 
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Maximum overall character(s) 
Maximum number of characters that a 
password must contain 

Minimum numeric character(s) 
Password must contain a minimum amount 
of numbers 

Minimum alphabetic character(s) 
Password must contain a minimum amount 
of letters 

Minimum special character(s) 
Special characters are 
[{~!@#$%^&*()-_=+;:'",<.>/?]} 

Password cannot be same as user 
name 

Users cannot use their user name as their 
password 

Password cannot be same as first or last 
name 

Users cannot use their name as their 
password 

Password cannot be same as last 
A newly changed password must be different 
from previously used ones (indicated the 
number here) 

Password expiration 
If password expires, users will be prompted 
to change it when attempting to log on  

Inform user before expiration 
Upon signing in, users are warned that their 
passwords are about to expire and given the 
option of changing it 

Maximum login attempts 
If user does not successfully log on after this 
number of attempts, the account will become 
locked 

Suspend inactive user after Sets the number of days of inactivity before a 
user’s account is locked 

Password recovery secret questions 
required 

If selected, users will be prompted to set up 
security questions for password reset upon 
first login. Existing users will be prompted to 
set up security questions upon the next login. 

Note: This option is available for Owner, 
Partner, and Hosting companies. When 
selected, it makes it mandatory for users to 
set up the password recovery secret 
questions. This is applicable to all users in 
the respective companies including 
Company Administrators and site 
Administrator. 
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Manage Company Addresses (Address tab) 

At a minimum, a Headquarters address must be entered in the Edit Company window. The 
Headquarters address will be the default company address. The default address displays on the 
Company Home page and is used to generate an online company location map. You can add up 
to six additional company addresses. 

To manage company addresses 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the right pane, click Open. The Edit Company window opens. 

3) Click the Address tab.  

4) Complete all fields marked as mandatory (red asterisk *). To enter additional addresses, 
click Address Type and choose another address to enter. See the table below for details. 

5) Click Apply to save changes, or OK to save and close the Edit Company window. 

In this field: Do this: 

Address Type 

Click the field and select from the drop-down list. At a 
minimum, an address for Headquarters is required, 
which is used as the default company address in 
Unifier. You can enter up to seven company 
addresses (for example, billing). 

Attention 
Click the Select button and select a user from the 
picker. 

Address and phone fields 

These are text fields. No validation will be performed 
on these fields. All fields with a red asterisk are 
required. Select the Country/Region from the 
drop-down list. 
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Access Company Details (Edit Company 
Window) 

Company detail information is managed in the Edit Company window. To access the Edit 
Company window: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the right pane, from the toolbar, click Open. The Edit Company window opens. The Edit 
Company window has the following tabs: 

 General: In this tab, you can manage several company features. See the table below for 
details. The fields with red asterisks are required. 

 Address: You can enter up to seven company addresses. There must be at one address 
entered for the company headquarters. 

 Security: In this tab, you can set up file security policy and password/login policy that 
your users must follow after they signed in to Unifier. 

Note: If your company is using Oracle Identity Management (OIM) to 
provision your company users, the password policy specified on this tab 
will not be used. OIM has its own password policy which will supersede 
the policy on this tab. 

 Contact: Maintains support contact and e-Learning access information for your users. 
The information entered here appears in the Support window (Contact tab). To access 
the Support window, click Help, from the upper right-corner of the Unifier window, and 
select Contact Support from the menu. 

 E-Signatures: In this tab you can manage the default e-signature type, DocuSign setup, 
and AdobeSign setup to use these digital E-signature solutions within Unifier documents.  

 Outgoing E-mails: In this tab 

The following explains each tab in details. 

In This Section 
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Edit Company (General Tab) 

To complete the General tab: 
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In this field: Do this: 

Name 
Enter a company name, up to 64 characters. It can include 
alphanumeric characters, spaces and punctuation. 

Short Name 

Enter a one-word short name, up to 60 characters. The Short Name
is a unique, one-word abbreviated form of your company name, and 
is used throughout Unifier in place of the company name. (For 
example, uDesigner-created business processes and on logs that 
identify partner companies.) 

Description 
Enter a company description. This is displayed on the Administration 
Mode home page. This can be especially useful for identifying 
partner companies, such as subcontractors or vendors. 

Contact Name 

Click Select, then select a user from the User/Group picker. This 
name is displayed on the Company Home Page in Administration 
and User Modes. The list is generated from the list of active users in 
the Company Users log. 

DUNS 
Enter the nine-digit Dunn & Bradstreet business identification 
number. 

Home Page 
URL 

Enter the URL of your company’s web site, displayed on the 
Company Home Page as a hyperlink. 

Help URL 

Enter an additional URL that to point to internal documentation 
regarding company policies or practices, an intranet site, or other 
internal information that you choose. This is displayed on the 
Company Home Page as a hyperlink. 

Status 
(read-only) 

Company status is controlled by the Site Administrator. 

Image 
Similar to the Image field in the Shell properties, this field allows you 
to include a picture that represents the company.  
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In this field: Do this: 

Authentication 
Key  

or 

Re-Enter 
Authentication 
Key 

Note: This field 
is available for 
the Site 
Administrator, 
only, and the 
Site 
Administrator is 
the only person 
who can change 
the value.  

The Authentication Key provides a means of gaining access to the 
company that you are signing in to. This key was set up at the time 
the company was configured.  

For Unifier Cloud customers, the Cloud Administrators will need to 
enter a unique key to manage the cloud administration services. The 
current key is stored in an encrypted format and can be changed as 
needed. 

If a key has already been assigned to the company, it will not be 
displayed in the field; the field will appear blank. 

Re-enter the key in the following field to confirm it. 

This field is not available on the General tab, for the company 
administrator. The company administrator must access the 
Integration Users sub-node to access the authentication key. Read 
"Additional information about the Authentication Key" below for more 
details. 

Bid Access URL

Used with Request for Bid (RFB) feature. This is the URL that will be 
used by bidders to access bids (system-assigned). 

When a bidder is invited to bid for the first time, the system sends 
two emails simultaneously: 

 Invitation email, which contains the Bid Access URL. 

 Credential email, which contains the username and 
system-generated password. 

Note: Oracle recommends that the bidders change the password at 
the very first log in. 

Bid 
Management 
Account 

Enter the account name of the user who will be managing the bids 
that your company receives. 

This is the account that will contain the bidder’s preferences you 
specify when you create the bid management account. See the 
instructions under "Set Up a Bid Management Account in Primavera 
Unifier" in the Primavera Unifier Administration Help. 

Owner 

Selecting this option allows a company to sponsor projects or shells, 
and is controlled by the Site Administrator. The checkbox will not be 
selected if the company is a partner company that is not authorized 
to sponsor projects or shells. 

Enable Custom 
Dashboards 

Selecting this option allows the creation of custom dashboards that 
provide an accurate and dynamic view of company and project 
performance indicators. 
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In this field: Do this: 

Maximum Limit 
for UDR records

The company administrator will be able to set the maximum number 
of records to be retrieved for the company. By default the maximum 
number will be set to 1 million. The company administrator will have 
multiple options to choose from and the set the maximum limit.  

Display element 
for Project/Shell 

By default, the "Name" option is selected. Based on the setting in this 
field, the labels change in the following areas:  

Top navigation tabs 

Breadcrumbs 

The first (top) left menu node (Home node) for the Shell/Project 

Bookmarks: Add new bookmark (editable label of bookmark) 

If the user selects the "Name" option to display the Shell name, the 
default string will appear as "{Shell Name} - {Location}" when adding 
a new bookmark. 

If the user selects the "Number" option to display the Shell number, 
the default string will appear as "{Shell Number} - {Location}" when 
adding a new bookmark. 

The tool-tips will be seen in format: {Shell Number} - {Shell Name} 

Hide Tabs in 
Company 
Dashboard 

When checked:  

 No tabs will be displayed on the company dashboard and only 
the company workspace information is displayed. 

 The Summary and other tabs created will be hidden and only the 
General tab will be visible. There will be no General tab heading, 
since there is only one (1) tab on the dashboard. The user will 
only see the General tab along with the logged in user's 
information. 

 The Edit Dashboard option will be hidden. 

By default, this option will be unchecked. So all users will be able to 
view and modify the Summary tab of the dashboard, and the Edit 
Dashboard option is enabled. 

Source for 
Activity Sheet 
data 

Users who have the edit permissions to company properties should 
be able to modify or add the P6 and Oracle Primavera Cloud URLs. 

This block enables you to provide a link to a source (for Activity 
Sheet) application, P6 or Oracle Primavera Cloud:  

 P6 URL (format: https://site_url/p6/...) 

 Primavera Cloud URL (format: https://site_url/web/...)

By default, the URL fields will be empty with a place holder text to 
show the format. There will be no link shown in a project activity 
sheet when a user does not enter any URL in company properties. 
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Changing the Authentication Key 

For integration users, the company administrator can access the authentication key value by 
way of the Integration Users sub-node (Company Workspace > Admin mode > User 
Administration node > Integration Users).  

For users who are using Unifier 19.x:

You (the company administrator) need to create a new integration user in order to change 
the authentication key. 

You need to use the following format to create the integration user: 

User Name - $${shortname} 

Password - {Desired authentication Key} 

If you have upgraded to Unifier 19.7, Unifier will not create $${shortname} integration, by 
default. In such case, Oracle recommends that you use new token-based REST APIs, 
instead of legacy SOAP and old REST APIs. 

If you have not upgraded to Unifier 19.7, but you have upgraded to Unifier 19.6, Unifier 
creates $${companyshortname} automatically, by way of the migration process, with the 
password that is the same as the original authentication code.  

To access the authentication value: 

1. In the Integration Users log click on a customer row to open the Update User page. 

2. In the Update User page, scroll to see the Security block. 

3. In the Security block, the value in the User Name field shows the company name (for 
example: $$company short name). 

4. In the Security block, the value in the Password field shows the existing authentication 
key. 

Note: The Site Administration can change the authentication key, also. 

For users who are upgrading to Unifier 19.x:

As a part of upgrading process, Unifier will automatically create an integration user by: 

Using the company short name as the integration user. 

Using the existing authentication key as the password. 

That is to state: 

User Name - $${shortname} 

First Name - $${shortname} 

Last Name - $${shortname} 

Time Zone - Company timezone as seen in the Background Jobs 

Language - Company language as seen in the Internationalization node 

If a company does not have an authentication key, then the integration user will not be 
created. 

If a customer already has an integration user $${shortname}, then Unifier will leave it 
unchanged. 

The legacy SOAP and old REST APIs do not access the integration permissions. 
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For this created integration user, all legacy permissions will be checked. 

Edit Company (Address Tab) 

Enter the company address information in the fields. 

Edit Company (Contact Tab) 

The Contact tab has the following blocks: 

 Support Contact Info

Enter values in each field. 

 eLearning Access

Enter values in each field. 

Edit Company (E-Signatures Tab) 

The E-Signatures tab contains the following field and blocks:  

 Default E-Signature Type

 DocuSign

 AdobeSign

The following provides details: 

Default 
E-Signatur
e Type

(Mandatory field) To select the default technology that provides electronic 
signature solution for the company. 
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DocuSign This block contains the following fields and options:  

 Url

The API URL which the customer or Oracle attains after acquiring the 
license. 

 Account Id

The ID for the DocuSign account 

 Client ID

To enter the user identification needed to log into AdobeSign. 

 Client Secret

This field is needed to set up integration between Unifier and 
DocuSign. 

 Token

This field is needed to set up integration between Unifier and 
DocuSign. 

 Status

Inactive by default. When you click Active, Unifier tests the connection. 
If the connection is successful, then you will be able to lock the status 
as Active. If the connection is not successful, then you will be 
receiving pertinent messages, and the status will remain as Inactive. If 
you successfully change the Status as Active and then change any of 
the fields, the Status changes to Inactive, and you must select Active 
to run the test connection. 

 Generate Token

 Test Connection

To establish a connection between Unifier and DocuSign:  

1. Click Generate Token. Unifier inspects the integrator key and the 
client secret and directs the end-user to DocuSign URL to enable 
them to log in to their Demo or Production DocuSign account. 

2. Once the end-user logs in to their DocuSign account, the token will 
be generated automatically in the Token field. 

3. Click Test Connection to ensure that the connection has been 
made successfully. This option is available after you successfully 
entered in, and selected values for, all the fields. If the testing the 
connection fails, then Unifier displays the error message: Integrator 
key / Client Secret / Token combination is not correct. 

4. Follow the prompts to complete the work. 

1)  

1.

2.

3.

2)
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AdobeSig
n

This block contains the following fields and options: 

 Url

The API URL which the customer or Oracle attains after acquiring the 
license. 

 Client ID

To enter the user identification needed to log into AdobeSign. 

 Client Secret

This field is needed to set up integration between Unifier and 
AdobeSign. 

 Token

This field is needed to set up integration between Unifier and 
AdobeSign. 

 Status

Inactive by default. When you click Active, Unifier tests the connection. 
If the connection is successful, then you will be able to lock the status 
as Active. If the connection is not successful, then you will be 
receiving pertinent messages, and the status will remain as Inactive. If 
you successfully change the Status as Active and then change any of 
the fields, the Status changes to Inactive, and you must select Active 
to run the test connection. 

 Generate Token

 Test Connection

To establish a connection between Unifier and AdobeSign: 

1) Click Generate Token. The token will be generated automatically in 
the Token field. 

2) Click Test Connection to ensure that the connection has been made 
successfully. This option is available after you successfully entered in, 
and selected values for, all the fields. 

3) Follow the prompts. 

OK Click when you are finished. 

Cancel Click to exit the tab. 

Edit Company (Outgoing E-mails Tab) 

The Outgoing E-mails tab enables you to set the maximum file size for each of your outgoing 
emails, in megabyte (MB), by entering a numeric value in the Maximum Size for Each 
Outgoing E-mail field. 
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To set the maximum file size for each of your outgoing emails to your system default 
specification, either click the Set to System Default option or enter zero (0) in the Maximum 
Size for Each Outgoing E-mail field. 

If the size of your email (from Unifier) is larger than the limit set for the recipient's server, then 
Unifier truncates all of the attachments in the email body to reduce the email size. Unifier also 
appends a custom-defined text in the email body informing the recipient that the email 
attachments have been deleted, and informs the recipient to can login to sign in to Unifier in 
order to view the email.  
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Background Jobs 

Unifier uses system jobs to perform various:  

 Operations (such auto creation) 

 Scheduled jobs (such as UDR runs) 

 Record creations (from WF templates) 

 Analytics data pushes (to staging table) 

The node called "Background Jobs" (Company Workspace > Admin mode > Background 
Jobs) enables certain users and groups (Company Administrators) access the jobs data and 
can choose to set the time zone for the recurring jobs. 

The visibility of, and access to, the Background Jobs node is controlled by permissions set in 
the Access Control node. The following shows how to determine access by way of the Access 
Control node. 

Go to Company Workspace > Admin mode > Access Control > Administration Mode 
Access > Background Jobs to set the permissions. The permission settings contain the 
"Modify" and "View" options, and permissions can be assigned to both Users and Groups. 
Users/Groups with View permission are able to view the log without having the ability to edit the 
time zone. Users/Groups with Modify permission are able to view the log content and edit the 
time zone. 

The Background Jobs node log page has the following toolbar options: 

 Reload ( ): Enables the user to reload the contents of the page. When the action is 
complete, the list may vary from before reload. 

 Find on Page ( ): Enables the user to conduct a quick find (on the contents of the page) 
for any of the log columns. 

 On the far right-corner of the log page, the field labeled "Time Zone for Recurring Job:" is 
displayed. By default, this field shows the "(Default) <Time Zone Name>". The Edit icon 

( ), next to the field, is displayed if the user has Modify permission, only. 

The system uses the set time zone to calculate the next start time for time-based jobs. 

The Background Jobs node log page content: 

 High Priority Jobs: Example - Auto Creation job 

 Background Jobs

The lower-end of the page displays the total count of the jobs and log pagination number. 

The Background Jobs node log page has the following columns: 

 Name: The name of the job. Examples - system:collect action emails, alert:Hourly Trigger 
etc. 

 Status: The possible values are: Running and Waiting.  

Refer to the Unifier Reference Guide for the default time zones and the possible values. 



Unifier General Administration Guide

72

 Next Start Time: The time that the scheduler runs the job. The value seen here will be per 
User Preferences. Example: If the User preference is set, then the format of the next run will 
be according to this time. 

 Type: The possible values are: Simple and Recurring. Simple is a type of job that was done 
once, at a specific time. Recurring is a type of job that is done based on a calendar 
schedule. 

 Priority: The job priority. Only high priority jobs will have this column populated with the 
value of "High." The values for other jobs will be blank. 

 Workspace

Displays the name or number of the shell for the job (listed under the Name column).  

 Time Zone

Displays the time zone for the job. 

All current jobs (scheduled UDR, scheduled refresh of the attach flow, BP record creation using 
templates) across the shells are run based on the time zone that you set up in the company 
Background Jobs module (company-level time zone).  

In cases where the project time zone is different from the company time zone (for example 
facilities based on a certain geographical location), you can go to the shell details (Details > 
Options tab) and from the Time Zone for Background Jobs drop-down list select the desired 
time zone for all the shell. After saving your changes, all the jobs within the shell will use your 
selected time zone. 
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Event Notifications 

The Event Notifications log displays events that happen within the Workflow, or Non-workflow, 
BPs according to the conditions defined by the designer, in uDesigner.   

Note: Unifier runs automatic purge every day in order to delete the 
notification records that are older that one month. 

By design, the event notifications are generated for all active (Active) BPs (within the project or 
shell). 

If you do not want to generate event notifications for certain WF BPs (within the project or shell), 
then Oracle recommends that you use a new WF that does not have the notification setup. 

Note: If it has been set up in uDesigner, you cannot avoid generating 
even notifications for Non-WF BPs. Unifier generates notifications for all 
of the records that meet the setup conditions. 

If any BP record moves to the step which is set up to generate event notifications by way of web 
service or CSV, then the event notifications is generated and recorded in the events log, also. 
This applies to WF and Non-WF BPs. 

Event Notifications toolbar options: 

View Similar to the View option in BP log (Logs node), Standard View, it enables to 
use one of the following system-defined default views: 

 All Notifications

This is the default view in this log and available to all users. 

By default, all rows in this log (sorted by event date and in descending 
order) are visible to the users. 

 Group by Object Name

This means grouping the rows in the grid by the "Object Name" parameter.

As in the BP log view, the user has the ability to Create New View, 
Manage Views. 

Any view created by any user who has permissions to this log will be 
available to all other users who have permissions to this log. Similarly, any 
view edited or deleted by one user will be edited or deleted for all other 
users using this log. 
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Edit 
View

Similar to the Edit View option in BP log (Logs node), Standard View, it 
enables you to edit the: 

 Columns tab: To remove, add, or reorder any column in the view that uses 
this tab. 

 Filters tab: To create filters using any columns in the grid of this log. 

 Group By or Sort By: To group or sort any columns within the grid of this 
log. 

Refres
h

Similar to the Refresh option in BP log (Logs node). 

Print Similar to the Print option in BP log (Logs node). 

Search Similar to the Search option in BP log (Logs node). 

Find 
on 
Page

Similar to the Find on Page option in BP log (Logs node). 

Event Notifications grid (Workflow BPs): 

For the Workflow BPs, the grid displays a record of all of the workflow actions that are taken 
within the BP records, and which are set with the Generate event notification option as 
checked, in uDesigner. 

A Workflow BP step completion policy does not impact the creation of the notification row. 
Regardless of the completion policy, if an action (which is setup to generate an event 
notification) is taken in the Workflow BP record, then the notification row is inserted in the log.  

If there are multiple assignees on a step, then the final action on the Workflow BP record, which 
moves the record to the next step, determines what will be included as an event notification row 
in the grid, not each action taken by an assignee. 

If a task is reassigned and the new assignee takes an action that moves the record to the next 
step, and the record is configured to generate a notification, then Unifier inserts an event 
notification row in the grid, also. 

Unifier populates the grid columns within the newly inserted notification row with the values of 
the Workflow BP records. 

Event Notifications grid (Non-workflow BPs): 

For the Non-workflow BPs, the grid displays all workflow actions that are set with the Event 
Notification status (BP status) as "Yes", in uDesigner. When the Non-workflow BP record 
reaches a status, as set in uDesigner, then Unifier inserts a notification row in the grid. 
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Note: If a user clicks Edit on a Non-workflow BP record and proceeds to 
click Finish Edits without making any changes, but the status change is 
set to generate notifications per the design in uDesigner, then Unifier 
inserts a notification row in the grid, also. 

Unifier populates the grid columns with the values of the newly inserted notification row from the 
values of the Non-workflow BP records. 

Event Notifications grid columns: 

Colum
n Name

Description Appli
es to 
WF 
BPs 

Appli
es to 
Non-
WF 
BPs 

Shell 
Numbe
r 

Populates with the project or shell number where the event was 
triggered. 

Yes Yes 

Shell 
Name 

Populates with the name of the project or shell where the event 
was triggered 

Yes Yes 

Object 
Type 

Populated as, "Business Process." Yes Yes 

Object 
Sub-Ty
pe 

When the Object Type = Business Process, then the Object 
Sub-Type is populated as Workflow or Non-workflow, based on 
the type of the BP. 

No Yes 

Object 
Name 

Populated with the name of the Business Process in which the 
event was triggered 

Yes Yes 

Record 
Numbe
r 

Populated with the "record_no" value of the BP record that 
triggered the event. 

Yes Yes 

Event 
Date 

Populates with the date and time, when the event was 
triggered. The content of this column is in descending order, 
which is the default sort format.  

Yes Yes 

WF 
Step 
From 

Populates when the event notification is for a WF BP. This 
column is populated with the name of the starting step of the 
record that have triggered the notification generation. 

No Yes 

WF 
Step 
To 

Populates when the event notification is for a Non-WF BP. This 
column is populated with the name of the final step of the 
record that have triggered the notification generation. 

No Yes 
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WF 
Action 
Name 

Populates with the WF action name that was taken for the BP 
record that triggered the notification. 

Note: The same BP could go through several events which 
trigger the notification generation. Each such event inserts a 
corresponding row in this log. 

No Yes 

Old 
Status 

The original status of the BP record (before the event got 
triggered). 

Yes Yes 

New 
Status 

The final status of the BP record which satisfies the event 
trigger condition. 

Yes Yes 

To set the Event Notifications node permissions: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Access Control in the left Navigator. 

3) On the right pane, select Administration Mode Access > Event Notifications to open the 
Permission Settings for Event Notifications window. 

4) Set the View permission to users and groups as needed. 

Users or groups with the View permission have the ability to: 

a) See the Event Notifications node in the left Navigator. 

b) Take actions using available options in the log toolbar. 

c) View all notifications records within the log. 
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uDesigner Overview 

uDesigner is a functional module of Unifier and is enabled automatically when Unifier is installed.  

The uDesigner module is used to create: 

 Business Process (BP) 

 Managers (Asset - Cost - Document - Planning - Portfolio - Resource - Schedule - Space - 
Shell) 

 Configurable Modules 

 Attribute Forms (Users, Shells, Document Manager, Cost) 

Collapse by Default Option in Block Properties 

In the Block Properties window of both a BP form and a manager attribute form, there is a new 
checkbox called Collapse by Default. If the checkbox is checked, the block is collapsed by 
default. If the checkbox is unchecked, the block is expanded by default. 

With the Collapse by Default option, you can avoid scrolling through irrelevant information. 

Under the Collapse by Default checkbox, the following note is displayed: “The block will be 
collapsed in User Mode, only if the block has a label and the Show Border and Show Label 
options are checked. This option is applicable only for Standard View of forms.” 

Collapse by Default is applicable to the following forms: Action form, View form, Detail form, 
and various attribute forms. 

Additional uDesigner Options  

You can use the uDesigner module to: 

 Create a design in the Development environment. 

 Configure, setup, and test your designs in both the Development environment and Test 
environment.  

After this point you can import your designs to the Production environment by way of 
Configuration Package.  

Oracle recommends that you: 

 Create your Configuration Package in the Development environment and import your 
Configuration Package to the Test environment for additional testing. 

 Import your Configuration Package from the Development environment onto the 
Production environment for use. 

You can select the Unifier environment in the Unifier Configurator. 

 The Unifier Development environment is a Unifier server deployed by selecting the server 
type as "Development" in the the Unifier Configurator. 

 The Unifier Test environment is a Unifier server deployed by selecting the server type as 
"Test" in the the Unifier Configurator. 
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 The Unifier Production environment is a Unifier server deployed by selecting the server type 
as "Production" in the the Unifier Configurator. 

The Development/Test environment is an environment that replicates the Unifier Production
environment. 

An object (for example a BP) can be deployed multiple times in the Development environment, 
only. 

Note: In Development environment, all uDesigner functionalities are 
available, but in the Test/Production environment the uDesigner 
functionalities are not available. 

In the Test environment, you can:  

Import an unpublished Configuration Package. 

In the Test environment, you cannot: 

Publish your Configuration Package. You can only publish your Configuration Package from 
the Development environment. 

The Test server is equipped with usable uDesigner and Data Structure Setup nodes so users 
can create or modify BP designs and include them in configuration packages and export them to 
another Test or Development server. 

When deploying your designs using Design Bundles, it is important to note the version numbers: 

 A deployed version indicates that the design has been tested in the Development/Test 
environment. 

 A published version indicates that the design has been imported, or the design has been 
imported into the Production environment for the first time. 
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Custom Dashboards 

Custom dashboards present data in a graphical format. Using data mined from data views and 
data cubes, you can create custom dashboards that provide an accurate and dynamic view of 
company and project performance indicators. You can have multiple custom dashboards in 
Unifier. 

Note: Before you begin creating a company or shell custom dashboard, 
ensure your company has enabled custom dashboards. Consult with 
your site administrator for details. 

In This Section 

Creating Company or Shell Custom Dashboards ..................................................... 79 
Granting Custom Dashboard Permissions ............................................................... 79 
Configuring a Shell Dashboard ................................................................................ 83 
Modifying a custom dashboard ................................................................................ 85 

Creating Company or Shell Custom Dashboards 

You cannot create Company or Shell SWF-based (small web format) custom dashboards. 

Note: Existing custom dashboards can be modified. 

The SWF file should be configured to point to a data cube in Unifier. You can only use 
Company Data Cubes with Company Dashboards and Shell Data Cubes with Shell 
Dashboards (See the "Data Cubes" topic). 

When you create the SWF file, be sure to include a URL that includes the custom dashboard 
name. This will ensure there is a link between the SWF file and the custom dashboard’s data 
cubes, and that the custom dashboard data will refresh when the data changes. 

Users can print the custom dashboard if the print capability is resident in the imported SWF file 
used to display the dashboard. 

Granting Custom Dashboard Permissions 

Ensure you have permission to create company and shell dashboards. These two types of 
dashboards use the same Module Permission Settings for Company Dashboard and Shell 
Dashboard. 

 To grant Custom Dashboard permissions 

1) Navigate to the Company Workspace tab and switch to Administration Mode. 



Unifier General Administration Guide

80

2) In the left Navigator, select the Access Control node. The Access Control log opens and 
lists all available functions in Unifier. 

3) Select Administration Mode Access > Custom Dashboard in the Access Control log. The 
Permission Settings for: Workspace window opens. 

4) Click the Add button. Another Permission Settings for: Workspace window opens. 

In the Select Users/Groups pane: 

a. Click the Add Users/Groups button. The User/Group Picker window opens. 

b. Select users and/or groups and click the Add button. The user or group name appears in 
the Selected Users/Group pane. 

c. Click the OK button. 

In the Permission Settings: pane, located in the bottom section of the window, select the 
desired permissions. The permissions cascade, in other words, if you have a permission, you 
have all the permissions below that selection. 

 Create: Users can create a Custom Dashboard; they can use the custom dashboard 
toolbar buttons New, Open, Delete, Find, Permissions, Download XML, Refresh 
Cache. 

 Modify: Users can modify Custom Dashboard properties and edit the dashboard; they 
can use the custom dashboard toolbar buttons Open, Delete, Find, Permissions, 
Download XML, Refresh Cache. 

 Modify Permissions: Users can assign permissions but cannot edit properties unless 
they have the Modify permission. They can use the custom dashboard toolbar buttons 
Open, Find, Permissions, and Download XML. 

 View: Users can view existing custom dashboards. They can use the custom dashboard 
toolbar buttons Open, Find, and Download XML. 

5) Click the OK button. 

Configuring a Company Custom Dashboard 

Configuring a Company Dashboard entails modifying the dashboard properties and assigning 
permission for users. 

The Company Dashboard properties include: 

 A General tab, where you can name the dashboard and upload the SWF file 

 A Query tab, where you can add multiple queries, select the data cube, and define grouping, 
summary, output, and reporting options 

 A Cache tab, where you can enable the XML caching option (instead of using real-time data) 

Modify the General Properties of a Company Dashboard 

You cannot define the general properties of Company Dashboard. 
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Note: Existing custom dashboards can be modified. 

To modify the General properties of a Company dashboard, do the following: 

1) Navigate to the Company Workspace tab and switch to Administration Mode. 

2) Select the Custom Dashboard node. The Custom Dashboard log window opens. 

3) In the General tab complete the fields as shown in the table below. 

In this field: Do this: 

Name Enter a name for the dashboard. 

Title Enter a title. The title appears in the list of available custom 
dashboards that a user can view. 

Description Enter a description 

SWF File Browse for the SWF (Small Web Format) file to use with the 
dashboard. 

Type Unifier displays the dashboard type as a read-only field. 

Next, select data sources in the Query tab, as described in the following procedure. 

Define queries for Company Dashboard data cubes 

 To define queries for data cubes 

1) Click the Query tab. 

2) Click Add. The Query window opens. Complete the fields in the Query window as described 
in the table below. 

In this field: Do this: 

Name Enter the name of the query. 

Data Cube Choose a data cube to use as a data source for the custom 
dashboard. 

 For a company-level custom dashboard, the data cube 
must be defined as Company Data Cube. 

 For a shell-level custom dashboard, the data cube must be 
defined as Shell Data Cube. 

Source Grouped By Choose a column from Data Cube definition by which to group 
data. This drop-down list lists those data elements that are 
marked Group By in Data Cube definition. Changing the value 
under this drop-down should always reset values under Report 
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On and Summary Type. 

Output Type Choose the output type, which determines the output after 
grouping data based on Source Grouped By column. Following 
are the options 

 Record Count 

 Summary Value 

Report On Choose a column defined in the data cube from among those 
designated as Summary. 

Summary Type This drop-down shows a list of possible summary types. Values 
shown under this drop-down are based on the type of Report 
On data element: 

 For Numeric type of data element: Summary, Min, Max, 
Average 

 For Date type of data element: Min/Max 

Next, specify cache details in the Cache tab, as described in the following procedure. 

Specify cache details 

This tab is only available on a company-level dashboard. You must enable the cache before 
data can be cached. Enabling the cache allows you to schedule the refresh of dashboard data at 
a preset frequency. With every successful run, the XML data file associated with the dashboard 
is refreshed. 

Note: The Enable Cache option controls the Refresh Cache ability on 
the log. If Cache is not Enabled, Refresh Cache will not work. 

The XML data is created only during a scheduled run or when the refresh cache option is 
selected. If Enable Cache is disabled, the XML is deleted. Until the scheduler refreshes the 
cache, or a manual refresh of the cache is not done, XML is not created. If Cache is not enabled 
in the custom dashboard properties, the dashboard query will result in real-time XML data. 

 To enable the cache and specify refresh and recurrence 

Click the Cache tab. Complete the cache fields as described in the table below. 

In this field: Do this: 

Enable Cache Mark this check box if you want to use the caching function. 
This selection enables the other options on the form. 
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Cache Refresh 
Frequency 

Select cache refresh frequency. 

 Daily. 

 Weekly, end of day. Select which day of the week you want 
the cache to refresh. 

 Monthly. Select which day of the month for the cache to 
refresh. 

 Yearly. 

Range of Recurrence  Start on. Select a date to begin the refreshing the cache. 
This is a required field. 

 No end date. 

 End by. Select a date to end refreshing the cache. 

Grant Company Dashboard View permission 

 To grant Company Dashboard View permission 

1) Navigate to the Company Workspace tab and switch to Administration Mode. 

2) Select the Custom Dashboard node. The Custom Dashboard log window opens. 

Note: Although the log lists both Company and Shell custom 
dashboards, you cannot grant Shell custom dashboard View permission 
in this log. Shell custom dashboard view permission is set at the 
individual shell level; that is, if you have access to a shell you will see its 
dashboard. 

3) Select a Company dashboard from the log and click the Permission button. The Edit 
Permission window opens. 

4) Click the Add button. The User/Group Picker window opens. 

5) Select the users and or groups to add and click the Add button. The selected users or 
groups populate the Selected User/Groups pane. 

6) Click the OK button to close the User/Group Picker. 

7) In the User/group Name pane select the user or group and in the Permissions pane select 
View. 

8) Click the User/Group Picker button to save the selection. 

Configuring a Shell Dashboard 

Configuring a Shell Dashboard entails modifying the dashboard properties, which include: 

 A General tab, where you can name the dashboard and upload the SWF file 
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 A Query tab, where you can add multiple queries, select the data cube, and define grouping, 
summary, output, and reporting options 

Caching is not available for the shell dashboard. 

If you are a member of a shell, you can see its dashboard. 

Modify the General Properties of a Shell Custom Dashboard 

You cannot define the general properties of Shell Dashboard. 

Note: Existing custom dashboards can be modified. 

To modify the General properties of a Shell custom dashboard, do the following: 

1) Navigate to the Company Workspace tab and switch to Administration Mode. 

2) Navigate to the Company Workspace tab and switch to Administration Mode. 

3) Select the Custom Dashboard node. The Custom Dashboard log window opens. 

4) In the General tab complete the fields as shown in the table below. 

In this field: Do this: 

Name Enter a name for the dashboard. 

Title Enter a title. The title appears in the list of available custom 
dashboards that a user can view. 

Description Enter a description 

SWF File Browse for the SWF (Small Web Format) file to use with the 
dashboard. 

Type Unifier displays the dashboard type as a read-only field. 

Next, select data sources in the Query tab. 

Define queries for shell dashboard data cubes 

 To define queries for shell dashboard data cubes 

1) Click the Query tab. 

2) Click Add. The Query window opens. Complete the fields on the Query tab. 

In this field: Do this: 

Name Enter the name of the query. 
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Data Cube Choose a data cube to use as a data source for the custom 
dashboard. 

 For a company-level custom dashboard, the data cube 
must be defined as Company Data Cube. 

 For a shell-level custom dashboard, the data cube must be 
defined as Shell Data Cube. 

Show Data From Determine the level from which the data cube should pull 
information. 

 Current Shell Only 

 Subshells Only 

 Current Shells and sub-shells 

Source Grouped By Choose a column from Data Cube definition by which to group 
data. This drop-down list lists those data elements that are 
marked Group By in Data Cube definition. Changing the value 
under this drop-down should always reset values under Report 
On and Summary Type. 

Output Type Choose the output type, which determines the output after 
grouping data based on Source Grouped By column. Following 
are the options 

 Record Count 

 Summary Value 

Report On Choose a column defined in the data cube from among those 
designated as Summary. 

Summary Type This drop-down shows a list of possible summary types. Values 
shown under this drop-down are based on the type of Report 
On data element: 

 For Numeric type of data element: Summary, Min, Max, 
Average 

 For Date type of data element: Min/Max 

Modifying a custom dashboard 

With the exception of refreshing a company dashboard cache, modification procedures pertain 
to both Company and Shell dashboards. 

 To modify a custom dashboard 

1) Navigate to the Company Workspace tab and switch to Administration Mode. 

2) Select the Custom Dashboard node. The Custom Dashboard log window opens. 
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3) Select a company dashboard. 

4) Click the Open button. 

5) Modify the dashboard as needed and click OK. 

See these dashboard modification topics: 

 Delete a custom dashboard 

 Find a custom dashboard 

 Download XML Company or Shell dashboard data 

 Refresh the Company Dashboard cache 

Delete a custom dashboard 

Only users with Create/Modify permissions can delete a custom dashboard.  

The Delete procedure pertains to both Company and Shell Dashboards. 

 To delete a custom dashboard 

1) Navigate to the Company Workspace tab and switch to Administration Mode. 

2) Select the Custom Dashboard node. The Custom Dashboard log window opens. 

3) Select a company dashboard. 

4) Click the Delete button. 

5) You will receive a confirmation message. Click OK. 

Find a custom dashboard 

This procedure is germane to both Company and Shell Dashboards. 

 To find a custom dashboard 

1) Navigate to the Company Workspace tab and switch to Administration Mode. 

2) Select the Custom Dashboard node. The Custom Dashboard log window opens. 

3) Click the Find button. 

4) You can search for custom dashboards using Name or Type. 

5) Enter the search criteria and click Search (or press Enter). 

Primavera Unifier displays all the dashboards that met the search criteria you entered. 

Download XML data associated with a custom dashboard 

You can download the data associated with the custom Company or Shell Dashboard. 
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Note: For Company Dashboard, if you enabled the cache when you 
defined the dashboard properties, then Unifier will download the last 
stored XML data. 

 To download XML data associated with a custom dashboard 

1) Navigate to the Company Workspace tab and switch to Administration Mode. 

2) Select the Custom Dashboard node. The Custom Dashboard log window opens. 

3) Select a company dashboard. 

4) Click the Download XML button. 

5) Save the XML file. 

Refresh the Company Dashboard cache 

 To refresh the company dashboard cache 

The Refresh Cache option is available only for Company Dashboards that have the cache 
enabled. If you attempt to refresh the cache and the cache is not enabled, you will receive the 
message: Cannot refresh the cache. Cache is currently disabled on this dashboard.

1) Navigate to the Company Workspace tab and switch to Administration Mode. 

2) Select the Custom Dashboard node. The Custom Dashboard log window opens. 

3) Select a company dashboard. 

4) Click the Refresh Cache button that is located on the tool bar. 





89

Program Administration 

The following section describes how to create and manage programs.  

In This Section 

Creating and Managing Programs ........................................................................... 89 
Creating a Project .................................................................................................... 89 
Creating a Program ................................................................................................. 93 
Defining Program Properties ................................................................................... 93 
Program User Administration................................................................................... 96 

Creating and Managing Programs 

Programs are a way to group like projects or CBS shells together (or projects and shells in 
combination). Programs allow consolidation of financial, schedule and status data across 
projects or shells. They are created at the company level in Admin mode. An administrator 
typically grants permissions to other project or shell team members who will modify an existing 
program and generate specific project or shell data. For example, a project or shell team 
member may modify a program to produce high-level forecasting data or to generate program 
reports based on a project's cost, schedule, and status data. 

Although the Company Administrator creates the program, rights are typically granted to project 
or shell members who will then modify the existing program and generate specific project or 
shell data. 

For example, a project or shell team member may modify a program to produce high-level 
forecasting data or to generate program reports based on the project cost, schedule and status 
data for one project or shell or across several projects or shells. 

Creating a Project 

The follow discusses creating a project by copying from a project template, by copying from 
another existing project, or creating manually. 

Grant permission to administer projects or project templates 

In order for a Project Administrator to be able to create and setup a Project, the administrator 
must have the permission setting to "Administer All" (or "Administer Project Category") at the 
Company Sponsored Projects, Project Properties level. 

To grant permissions to Project Administrator User or Group 

1) Go to the Company Workspace tab and switch to Admin mode. 
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2) In the left Navigator, click User Administration > Company Users or Partner Users (to 
grant permissions to individual users) or Groups (to grant permission to a project 
administration group). 

3) Scroll to Company Sponsored Projects (Standard) and select. 

4) Select the user or group and click Open. Click the Permissions tab. 

5) Select Administer All (for non-categorized projects), and/or Administer Project Category. 

Create a project by copying a template or project 

You can create projects using the project templates you created. You can also create projects 
by copying from existing projects. 

You can verify the project properties, make changes as necessary, update status, or activate as 
necessary. 

Tip: Because you can only have one cost sheet per project (and once a Cost Sheet is created 
for a project, it cannot be deleted or replaced), you might consider creating a Cost Template in 
the Templates log and copy into the project separately. 

Note: As Project Administrator, you can receive email notification of the 
successful creation of a shell instance, for shells that are created 
manually, through Web Services or a CSV file upload, or through 
auto-creation. This notification can be set up in email notifications in 
uDesigner. Also, you can set your User Preferences to control whether 
you receive these notifications. 

To create a project from a project template or existing project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects in the left Navigator. 

3) If your company is using project categories, click a project category in which to create the 
new project. If you don't wish to categorize the project, or if no categories have been setup, 
click All. Note that not all administrators will have access to all project categories. 

4) From the File menu, click New > Copy From. The Project Cloning window opens. 

5) Click the Copy From drop-down list and choose Project to copy an existing project, or 
Template to copy a project template. 

6) Select a project or template from the list and click OK. To search for a specific project or 
template on the list, click the Filter By field and select Name or Number. In the Filter For
field, enter all or part of the name or number to search for and click Search. 

7) In the Select Modules pane, select the modules to include in the new project. Users and 
Groups are selected by default and copied along with the project properties. 
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Note: If the Schedule Sheet option is selected, the curves relating to the 
schedule sheet will be copied to the new project. If the Schedule Sheet 
is NOT selected, the curves relating to the schedule sheet will be 
created but the name of the schedule sheet selected on the properties 
window will be empty. 

8) Click OK. The Project window opens, displaying the project properties. 

Most properties are copied from the original template with the following exceptions: 

 Project Number: On the General tab, enter a Project Number 

 Project Currency: On the Standards tab, specify the Project Currency 

 Project Image: On the Standards tab, specify the Project Image (optional) 

9) When the window is complete, click OK. 

10) Click Yes to confirm and create the new project. 

Create a new project manually 

To manually create a new project: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects in the left Navigator. 

3) Click a project category in which to create the new project. If you don't wish to categorize the 
project, or if no categories have been setup, click All. Note that not all administrators will 
have access to all project categories. 

4) Click the New button. The Project window opens. 

5) Complete the information on each of the tabs. 

The tabs contain the same fields as the template window. 

Some notes on the tabs: 

 General tab: Note Project Status: you may set the project status to Active to make it 
available to users immediately, or leave it as Inactive until you have completed setting up 
the new project. This will prevent users from signing in to their company and attempting 
to access the project before it is ready. 

 Location tab: Be sure to enter the complete Project Address and any other project 
related addresses. 

 Progress tab: Enter the project schedule start date, planned completion date, status and 
project phase. 

You can manage a project's progress on a continuing basis by reviewing the project 
properties you define here.  For instance, at any time you can enter a revised completion 
date, enter the percent complete for a design and/or construction project, monitor the 
project status, or change the project phase to ensure information contained in the 
Document Manager is current and available to the project team at the right time. 

The information that you enter here is also viewable from the Progress pane of the 
Project landing page. This means a project administrator can quickly view the current 
status of a project and make modifications as necessary.  

6) Click OK to save your changes and exit the Project window. 
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Add Cost Sheet 

The option "Enable P6 sources" is not available in a Cost Sheet created in a Standard Project or 
Standard Project Template. 

The cost sheet that has the option "Enable P6 sources" selected is not included when you want 
to create a new Cost Sheet by copying a cost sheet. 

The template that has the option "Enable P6 sources" selected is not included when you want to 
create a new Cost Sheet using: New > Cost Sheet > Copy from Template. 

Manage Projects 

You can verify the Project properties, make changes as necessary, update status, or activate as 
necessary. It is recommended that you keep the company progress information up to date to 
reflect the ongoing status and progress of the project. 

You can also modify project information in a Project Template and then update one or more 
existing projects by "pushing" the information from the template to the projects (see Updating 
Projects (on page 115)). 

To open a project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects in the left Navigator. Select a project name from the 
project log and click Open. The Project home page opens. 

To edit an existing project 

1) Open the project's home page and switch to Admin mode. 

2) Click the Open button. The Project window opens. 

3) Modify the project information as necessary on the tabs. You can modify any of the project 
properties any time during the project duration, except for the project currency. Once a 
project is set up, the project currency is locked. 

4) Click OK to save your changes and exit the Project window. 

Note: The tabs contain the same fields as the Template window. 

Activate or deactivate a project 

To activate/deactivate a project 

1) Open the Project Home Page and switch to Admin mode. 

2) Click the Open button. The Project window opens. 

3) In the General tab, set the status to Active, Inactive, or On-hold. 

 On-hold: The initial project status. On-Hold projects are listed on the projects log, but you 
cannot work with them. 

 Active: Active, in-progress project. All project actions in User and Administration Mode 
are available. 
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 Inactive: Inactivate projects to suspend project usage. Inactive projects are visible from 
the Administration Mode under Sponsored Project log only, but not visible under the 
Projects node (i.e., only Sponsor Company can access the project), or in User Mode logs 
and selections. Only System and Project Administrators (users with Modify Status rights) 
can reactivate the project. 

Note: "Late" tasks in an inactive project may still show up in users’ task 
logs. Though they can access the task, no transactions can be 
performed in the inactive project. 

Creating a Program 

To create a new Program: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Programs in the left Navigator. 

3) Click New on the button bar. The Program window opens. 

4) Complete the tabs. This defines the program properties: 

 General: Define general properties 

 Shell/Projects: Add projects and shell to the program 

 Progress: Track progress of the program 

 Links: Add your own web page links, which appear on the Program home page 

See the following section for details. 

5) Click Apply to save changes, or OK to save and exit the window. 

Defining Program Properties 

You can define program properties when you first create a program, or open an existing 
program. 

Define Program General Properties (General tab) 

To access program properties: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Programs in the left Navigator. 

3) Select a program from the log and click Open. The program properties landing page opens. 

4) Click Open to open the Program window. 

5) Use the information in the following table to complete the General tab. 

In this field: Do this: 

Program Number Enter a number for the program. 

Setup Date 
This field is populated with the program creation 
date. 
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Program Name Enter a name for the program. 

Description 
(Optional) Enter a description of the program or 
projects or shells within it. 

Administrator 
Click Select and select an administrator from the list. 
Each program must have an administrator. 

Image 
(Optional) You can click Browse and select an 
image file. This image will appear on the Program 
Home Page. 

Program Category 
If a program category data definition has been setup, 
you can select it here. 

Status Select a status. 

Add or Remove Projects or Shells From a Program (Projects tab) 

You can add any Active or On Hold project to a program. Inactive projects are not eligible. 

To add a Projects/Shellsto a program 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Programs in the left Navigator. 

3) Select a program from the log and click Open. The program properties landing page opens. 

4) Click Open to open the Program window. 

5) Click the Projects/Shells tab. 

6) Click New. 

7) Select one or more projects or shells and click the Add Project/Shell button. To select 
multiple projects or shells, hold down the Ctrl or Shift key while selecting. 

8) In the Program window, click Apply to save, or OK to save and exit. 

To remove a Projects/Shells: 

On the Projects/Shells tab, select the project or shell and click Remove. 

Set Up Program Progress Tracking (Progress tab) 

You can enter a start date and planned completion dates for a program by manually entering the 
dates, or by linking the program to the project or shell schedule sheet. To use the Schedule 
Manager options, a schedule sheet must be defined in your project or shell. As changes are 
made in the Schedule Manager, they will automatically change the progress indicator in the 
Progress tab. 

Progress indicators linked to the schedule are: 

 Start Date 

 Planned Completion 
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 Revised Completion 

To track the progress of a program manually: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Programs in the left Navigator. 

3) Select a program from the log and click Open. The program properties landing page opens. 

4) Click Open to open the Proram window. 

5) Click the Progress tab. 

6) Complete the fields. See the following table for details. 

7) Click Apply to save the changes, or OK to save and exit. 

In this 
field: 

Do this: 

Start Date 

Choose one of the options: 

Manual: Manually enter the project or shell start date by clicking the 
calendar icon. 

From Schedule Manager: Click the selection list and choose a data column 
from the list (for example, Program Start Date). The Program Schedule 
Sheet must be created and setup before selections become available. 

Planned 
Completio
n 

Choose one of the options: 

Manual: Manually enter the project or shell start date by clicking the 
calendar icon. 

From Schedule Manager: Click the selection list and choose a data column 
from the list (for example, Program Due Date). The Program Schedule 
Sheet must be created and setup before selections become available. 

Revised 
Completio
n 

Choose one of the options: 

Manual: Manually enter the project or shell start date by clicking the 
calendar icon. 

From Schedule Manager: Click the selection list and choose a data column 
from the list The Program Schedule Sheet must be created and setup 
before selections become available. 

Notes 
Program notes can be anything that the Administrator feels is relevant to 
share with other Project or Shell Administrators. This note is not displayed 
on the Summary or Home Page. 

Add Links to Other Program-Related Web Pages (Links tab) 

Links are displayed on the Program home page. 
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To add a link 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Programs in the left Navigator. 

3) Select a program from the log and click Open. The program properties landing page opens. 

4) Click Open to open the Proram window. 

5) Click the Links tab. 

6) Enter a name for the link and the link's URL. 

7) To add more links, click the Add Row button and repeat step 5. 

8) When you are finished, click OK. 

Program User Administration 

The User Administration node appears below the new program name in the Navigator once it 
is created and activated. As projects or shells are added to programs, the users and groups are 
not automatically added to the program. By default, the Program Administrator chosen during 
the program setup is added as a program user. The Program Administrator group is 
automatically added as a default group, and the program administrator is added to the group by 
default. You can add additional users and groups to the Program and set permission levels. 

Add Users or Groups to a Program 

To add users or groups to a program via the Company Workspace: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click the User Administration node for your program in the left Navigator. 

3) Click Users to add users, or Groups to add groups to the program. 

Note: If a User Attribute form has been imported, the program user log 
will reflect the design of any designed Partner Log included in that form. 
See Importing User Attribute Form for details. 

4) Click New on the button bar. The standard User/Group Picker window opens. 

5) Select a Company from the List Names from: list box and Users or Groups from the Show 
By: list box. 

6) Select the users/groups to include in the Program and click Add. You can also create a new 
group by highlighting the Groups node and selecting File > New or the New button. 

7) When you are done adding users and groups, click OK to return to the Users or Groups log. 

Grant Program Permissions (Access Control) 

Granting program permissions entails granting users access to the modules in the program, 
such as the Schedule Manager or cost sheets. 

To grant user/group permissions to the program 

1) Go to the Company Workspace tab and switch to Admin mode. 
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2) Click Access Control in the left Navigator. 

3) On the right pane, select User Mode Access > Programs > [module]. The Permission 
Settings window opens. 

4) Click the Add button. The User/Group Picker opens. 

5) In the picker, specify a user or group and select the Permission Settings. 

6) Click OK, then click OK in the Permission Settings window.  
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Project Administration 

The following topics describe tasks related to Project Administration. 

In This Section 

Creating and Managing Projects ............................................................................. 99 
Updating Projects .................................................................................................. 115 
Managing Member Companies .............................................................................. 129 
Managing Project Users and Groups ..................................................................... 131 
Setting Up Automatic Status Update ..................................................................... 134 
Setting Up Gates ................................................................................................... 135 
Create an automatic project status update setup ................................................... 141 
Choose the order of non-active statuses (Settings tab) ......................................... 142 
Define status change query and trigger conditions (Settings tab) .......................... 142 
Define project status update schedule (Schedule tab) ........................................... 143 
Activate or deactivate an auto-update status setup ............................................... 144 
Set permissions for automatic update of project status .......................................... 144 

Creating and Managing Projects 

Projects can be created from scratch one at a time, or can be created by copying a project 
template. It is recommended that you create one or more project templates first, then create new 
projects based on them. Advantages to using a template include ease of individual project setup, 
consistency between projects, and the ability to update project information easily (for example, if 
you add a new user, introduce a new business process, or edit a cost sheet column) by allowing 
you to make an addition or modification directly to the template and then "push" it to existing 
projects. 

Note: You can migrate standard projects to CBS shells. See Migrating 
standard projects to CBS shells (on page 270). 

How to create and setup a project 

Be sure you have the proper permission setting to administer projects. If your company has 
chosen to "organize projects" (that is, create projects under different project categories), be sure 
these categories have been set up. Categories can also include asset classes. 

Step 1: Create a Project Template. Most major functionality that is available in a project can be 
set up in a project template. You can set up as few or as many individual features as you like 
within a template. 

Step 2: Create a new Project. This can be done manually, or by copying a project template. 

Step 3: Set up permissions. Grant permissions to access and work with the new project to 
project team members. Refer to the Unifier Reference Guide for project permission settings. 
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Step 4: Setup up gates. This is an optional step. The gates feature allows you set up 
acceptance criteria to use to track and control project phases. 

Step 5: Manage projects. This includes updating projects to "push" updated information, set 
ups, etc., to existing projects. The projects do not need to have been created originally from the 
template. 

The following sections discuss creating and managing projects and project templates. 

Creating a Project Template 

Project and project template categories are maintained by the company administrator. Asset 
classes are added as project category nodes when they are created. One category ("All") is 
listed by default. You can create project templates under the All category, or other project 
categories or asset classes as needed. These categories do not appear to users in User Mode; 
they are a way to organize projects or link asset classes to projects. 

Access project templates 

To access project templates 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) in the left Navigator. 

3) Expand the Projects (Standard) node. Like projects, project templates can be grouped by 
categories or by asset classes. 

4) Click one of the category or asset nodes. The Project Templates log opens. The log lists any 
project templates that have been created under the category. 

Create a project template 

The following procedure describes how to create a project template. The procedure is similar to 
creating a new project. 

To create a new project template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects in the left Navigator. 

3) Expand the Projects (Standard) area to display the categories. The default is All. The 
project category that you define here will determine the category to which subsequent 
projects will be assigned. The project category cannot be changed. 

Use caution when defining a template in a project category. You cannot "re-categorize" a 
project or project template once it is created and saved. 

4) Click one of the category or asset nodes. The Project Templates log opens. The log lists any 
project templates that have been created under the category. 

5) Click the New button. The Template window opens. The Template window is equivalent to 
the Project window; the same properties and tabs are filled out for a project template as for a 
new project. 
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6) Complete the Template window. This window will be used for the project Properties when 
creating projects: 

 General tab: Define properties. See Define general project properties (General tab)
(on page 104). 

 Location tab: Define the project location. See Define project location (Location tab)
(on page 106) and Add a project image (Standards tab) (on page 108). 

 Standards tab: See Add project currencies (Standards tab) (on page 107). 

 Progress tab: See Set up project progress tracking (Progress tab) (on page 110). 

 Links tab: See Add links to other project-related web pages (Links tab) (on page 
112). 

 Custom tab: See Select a project custom attribute (Custom tab) (on page 112). 

These tabs are the same for both project templates and projects. 

7) Click Apply to save changes as you enter information, and OK when you are ready to save 
information and exit the Template window. 

Create a project template by copying a template or project 

You can create a Project Template by copying from an existing Project template or an existing 
Project. 

Note: You can choose to copy any existing Custom Calendars from the 
template or from an existing project. 

To create a project template by copying an existing project or project template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Project (Standard) in the left Navigator, then select a project category. 
The default is All. Use caution when defining a project category. You cannot "re-categorize" 
a project or project template once it is created and saved. 

3) From the File menu, choose New >Copy From. The Template Project Cloning window 
opens. 

4) From the Copy From drop-down list, select one of the following: 

 Template: The log displays the list of existing project templates 

 Project: The log displays the list of available company-sponsored projects 

5) Select a listed template or project name. 

6) In the Select Modules pane, select the modules to include in the new template. 

7) Click OK. The Template window opens, displaying the project template properties. 

Most properties are copied from the original project or template into the Template properties 
window, with the following exceptions: 

 Project Number: On the General tab, enter a Project Number 

 Project Currency: On the Standards tab, specify the Project Currency 

 Project Image: On the Standards tab, specify the Project Image (optional) 

8) Click OK. Click Yes to confirm. 
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Note: Use caution when selecting which modules to copy. When you 
create a project template by copying from an existing project or template, 
you will be copying existing setups already created in the selected 
modules. (For example, if you select Cost Sheet, you will copy not only 
the project cost sheet, but any existing work packages and worksheets 
as well; since cost sheets and work packages cannot be deleted once 
created, you will not be able to delete these from the new template.) 

Set up modules in the project template 

Setting up modules is optional. For example, you can configure a Cost Sheet in your project 
template. When you create a new project using this template, you will have the option of copying 
this Cost Sheet into the new project. 

Project Templates have the same fields as a new Project. 

Note: Some fields are not filled in or not copied over when you copy 
from a template because they are not relevant until a project is created, 
like Project Start Date and Project Image. 

Member Companies

You can select project member companies from your company’s list of partner companies. See 
Managing Member Companies (on page 129). 

Access Control

Enables setting up default permission settings for users and groups. See Grant project user 
permissions through Project Access Control (on page 134). 

Users and Groups

As with projects, you must add at least one user to the project template before you can activate 
it. Users and groups added to a project template are always copied by default from the template 
to the project created from it. See Managing Project Users and Groups (on page 131). 

If your groups are going to be similar across all of your projects, you can define them once in the 
template rather than creating them in each project. It is not recommended that you put Users 
into the Project Template unless you know that those users will be on every project. The one 
exception is that a Project Administrator is required to be named in the template. Users cannot 
be deleted once they are in the Template, although Users can be deactivated. 

Projects Templates can include the following modules: 

Business Process Setup

Business Process setups created in the template can be copied over to projects. 

Rules

You can define project level cost or funding rules. 

Project Information

You can define the business process that will be used in the Project Information: General node. 
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Gates Setup

You can include a gates setup in your project template. See Setting Up Gates (on page 135). 

Cost Manager

You can define any or all of the following in a template: 

 Cost Sheet (includes Worksheets and Work Packages) 

You can create a cost sheet for the project template. This is similar to creating a cost sheet 
for a project. And like projects, you can also include worksheets and work packages. 

 Funding Sheets

You can create a project fund sheet, and commitment funding sheet structure. 

 Schedule of values (SOV) (Structures for General Spends, Payment Applications, and/or 
Summary Payment Applications) 

 For General Spends SOV, the SOV structure is copied from an SOV template in the 
Templates log. 

 For Payment Applications SOV and Summary Payment Applications SOV, the structure 
is copied from the line item grid structure of the Payment Application Business Process. 
This means that you must first complete the Business Process (BP) setup for the 
Payment Application BP before you can create the structure. 

 Cash Flow Curves

You can create Cash Flow Curves. 

Note: Since only one Cost Sheet, Funding Sheet, SOV structure (of 
each type) and commitment funding structure can exist in a project, 
make these choices carefully. Once you create these items in the project 
template, you can modify them, but will not be able to delete or replace 
them. 

Document Manager, Project Documents

You can create a folder structure for the document manager that can be used across projects. 
These can be created from Folder Structure Templates, or folders can be added manually. 
Unlike Folder Structure Templates, you can also assign users (if they are in the project template) 
folder-level permissions, and can import folders and folder properties. 

Resource Manager

You can create the setup and resource sheets in the template. 

Schedule Sheet

A Schedule Template will be used to create the Schedule Sheet. Like the Cost Sheet, once this 
is created, it cannot be deleted. 

User-defined Reports: You can create one or more user-defined report templates, which will be 
used for project user-defined reports. You can import user-defined reports into project templates 
from project templates in other companies and Unifier environments. See Importing 
User-Defined Reports into Project or Shell Templates. 
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To set up modules in the project template 

1) Open the project template. 

2) Click a module and add the applicable information. This information can be carried over to 
new projects created from the template. 

Manage Project Templates 

Once the Project Template properties have been defined, you can setup any or all of the 
available modules. These will be copied to projects that have been setup using the template. 

Note: You do not have to setup modules here. If you do not setup a 
module in the Project Template, the modules will not be setup in the 
projects. You can setup the projects manually after project creation, or 
by using individual templates, for example, cost sheet templates. 

You have the option to edit project properties and modules and update existing projects with the 
new data. See Updating Projects (on page 115) for more information. 

To open the project template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates>Project (Standard) in the left Navigator. 

3) Select a project category (default is All). The Project Templates log opens. 

4) Select a project template from the log and click Open. 

5) The project template home page opens. The navigator expands to display the modules that 
can be configured in the project template. Select a module to edit or set up. 

To edit project template properties 

1) From the project template home page, click the Open button. The Template window opens. 

2) Click the tabs to view or edit project template properties. 

Defining Project (and Project Template) Properties 

This section describes the Properties window for projects and project templates. 

Define general project properties (General tab) 

To define project locations for a project or project template 

1) Open the General tab of the Project or Template window. 

2) Complete the window as described in the following table. 

In this field: Do this: 

Project 
Number 

For Templates, you might enter a phrase such as Enter project number 
here or information for your Project Administrator regarding how to 
assign a project number, as each project created from the template will 
have its own number. When creating a new project, if the Site 
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Administrator enabled automatic project numbering during new 
company setup, this field will be pre-populated each time a new project 
is created. 

Setup Date 
Populates automatically with the current date when the project or 
template is saved. 

Project Name
Enter a project name. For templates, you might enter a generic name or 
instructions such as Enter Project Name here. 

Description 
Explain the purpose or intended uses of the project or template 
(especially if you have multiple templates). 

Administrator 

Click Select to open the User/Group picker and select a Project 
Administrator. For templates, the user will automatically become part of 
the Project Administrator group for any project created from the 
template. (Additional administrators can be selected.) 

Construction 
Type 

Choose New Construction or Retrofit/Remodel. 

Project Status

You can activate the project template immediately, or place it On-Hold 
or make it View-Only and activate later. A template that is On-Hold, 
View-Only, or Inactive cannot be used to create a project. It is good 
practice to leave a project or template On-Hold until you have 
completed the setup. Project Administrators/Users with "modify project 
status" rights are the only ones who can change the status. 

The project administrator will receive email notification when the status 
of a project changes. The change of project status could occur due to a 
manual change, bulk update, through Web Services or a CSV file, or 
through automatic update. 

Status definitions for projects are: 

 Active: Active, in-progress project. All project actions in User and 
Administration Mode are available. 

 On-Hold: The initial shell status. On-hold shells appear on the 
shells log. Shell administration functionality is available to shell 
administrators for setup and maintenance for users with permissions 
to perform that function. Users cannot create records in a shell that 
is On-Hold. If a user attempts to access a shell that is On-Hold, the 
system displays an alert message stating that the shell is On-Hold. 

 View-Only: For end users, View-Only projects can be viewed, 
printed, exported, and included in reports. They cannot be modified. 
When a shell is View-Only, the status overrides (but does not 
modify) access control permissions, granting only View permissions. 
The project reverts to the access control permissions when the 
project is made Active. View-Only projects can be added to and 
removed from programs, and can roll up to programs, UDRs, and 
dashboards. Business process records cannot be auto-created in 
View-Only projects. Data from View-Only projects does not roll up to 
company-level account codes or cost sheets. Data will roll up from 
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View-Only projects to programs, the Planning Manager, and the 
Asset Manager. No updates can occur to View-Only projects 
through Integration, Unifier Mobile, or through reverse 
auto-population. View-Only projects cannot be updated through 
templates. Consolidate line item functionality is disabled for 
View-Only projects. View-Only projects have only view, export, and 
print permissions available. Tasks and Drafts are not available for 
View-Only projects. Messages are available, but users cannot add 
general comments. Mailbox is available for viewing, but users 
cannot send, edit or delete messages for View-Only projects. When 
a project becomes View-only, all scheduled jobs associated with it 
are canceled. When the status of the project changes back to 
Active, you must restart any scheduled jobs. Administrators can 
perform all actions on View-Only projects. 

 Inactive: Used to suspend project usage. Inactive projects are 
visible from the Administration Mode under Sponsored Project log 
only, but not visible under the Projects node (i.e., only Sponsor 
Company can access the project), or in User Mode logs and 
selections. Only System and Project Administrators (users with 
Modify Status rights) can reactivate the project. Late tasks in an 
inactive project may still show up in users’ tasks logs. Though they 
can access the task, no transactions can be performed in the 
inactive project. 

Auto-update 
Status Setup 

The selections on the drop-down list are defined automatic status 
update setups. These setups are defined at the Company level for use 
in specific projects. See Setting Up Automatic Status Update (on 
page 134) for details. If you decide not to use the automatic status 
update, you can deactivate it by deselecting a setup (by literally 
selecting the word "Select"). 

Project Type 
The selections on the drop-down list are defined in the data set of the 
Project Type data definition. The default is None. Contact your 
Company Administrator if you need additional Project Types defined. 

Define project location (Location tab) 

You can define up to four addresses (Project, Billing, Shipping, and Billing & Shipping) for a 
project or project template. For each project or project template, you must enter at least one 
address: the Project Address. The Project Address will be used to generate an online location 
map accessed in the Project Home Page in User Mode. 

The following is applicable when creating a project template or new project: 

To define project locations for a project or project template 

1) Open the Location tab of the Project or Template window. 

2) Complete the Location tab as shown in the following table. 

3) Click Apply to save changes, or OK to save and exit. 
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In this field: Do this: 

Address 
Type 

Select one of the address types listed (you must complete the Project 
Address fields). 

Address 2 

Enter the main street address 

Note: If the Project Template will be used for different project locations, 
you can enter generic notations for the Project Administrator, such as 
Enter project address here. 

Address 3 

Address 4 
Generally for P.O. Box numbers, suite numbers, etc. 

Country Choose the from the drop-down list. 

Site 
Choose a site from the drop-down list. The selections are generated 
from the Project Site data definition. The default is None. 

Add project currencies (Standards tab) 

On the Standards tab, you can specify a currency or currencies that will be used on the project. 
The currency you specify here will be used throughout the project, for example for cost business 
processes, the cost sheet, etc. You must define at least one currency. If the project is 
international, you can define multiple currencies in which to display data, although only one can 
be the default project currency. 

Note: The list of available currencies is maintained in Standards & 
Libraries > Exchange Rate. 

To define project currency for a project or project template 

1) Open the Standards tab of the Project or Template window. 

2) In the Currencies section of the window, click the Add button. The Edit Exchange Rate 
window opens. 

Note: The Base Currency shown at the top of the Edit Exchange Rate 
window is the Base Currency set up for your company. For example, if 
yours is a company in the U.S., then the Base Currency will likely be the 
United States Dollar (USD). If your company does business 
internationally, you may make other currencies available for project use. 

3) Use the information in the table below to add a currency. 

4) Click OK to save and exit the Edit Exchange Rate window. 

5) In the Standards tab, select a Project Currency from the drop-down list. This will be used 
as the default project currency. Once you have selected a project currency and saved the 
template or project, it cannot be changed. The selections are generated from the Currencies 
list you defined. 

6) Click Apply to save changes, or OK to save and exit. 
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In this field: Do this: 

Currency Name 

Select the currency you want to use for the cost functions in this 
project. 

If the currency you selected is other than the company Base 
Currency, then complete the following fields. 

Rate 

Enter an exchange rate to use for conversion calculations. From 
the drop-down list select one of the following: 

 If Float is selected, the rate is updated automatically from the 
Company Currency Table (Standards & Libraries > 
Exchange Rate). 

 A Peg rate locks in the company rate on the day the rate is 
set. (Only a Project Administrator can manually modify the 
Peg rate to a value other than the company peg rate.). 

Hedge? 
If the Hedge selection is Yes, then the Hedge rate is used for 
conversion calculations. Otherwise, the Float rate will be used. 

Rate 
If an amount is entered for the Rate, then the hedge rate is used 
until the amount specified is reached (by spends) and then the 
system will revert back to the normal rate. 

Amount 

If Float is specified, Unifier will retrieve the rate, based on today’s 
date and time. 

If Peg rate is specified, the field will be editable. 

Comments 
(Optional) Add any comments that might be necessary to explain 
the default currency. 

Note: Once a currency is selected and saved, it cannot be modified. The 
remove option is made available to enable you to remove the additional 
currencies and unsaved changes.  

Add a project image (Standards tab) 

You can add a representative image of the project that will display on the project home page for 
users. 

For templates, it is not necessary to select a project image because it will not be copied to a 
project created from the template. However, you can include one to provide an example to users 
creating projects. 

For best results, the recommended image size is 500 pixels wide by 300 pixels high. Image files 
should be in jpeg or gif format. 

To define a project image 

1) Open the Standards tab of the Project or Template window. 

2) In the Project Image field, click the Browse button. 

3) Browse to the location of the image file, select the file and click OK. 
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4) Click Apply to save changes, or OK to save and exit. 

Distribute an External Email Address for the Project (Standards Tab) 

External emails are important communications that need to be included in projects. Such emails 
can come from project members or from external users who do not use Unifier. These email 
communications (and any attachments) can be collected in a central repository, called the 
Project/Shell Mailbox, so that project members can use them in managing and documenting 
the project. Once such emails reside in the project’s mailbox, project users can view them, 
forward them to appropriate members, flag them for review, and reply to them. In addition, these 
external emails can be linked to business process records. 

When Unifier is installed on your system, a dedicated email address for your company is 
specified, and whenever you create a project, Unifier assigns it a unique identifier. Unifier 
combines this email address and project identifier to create the Project Mailbox. This email 
address appears on the Standards tab, and from the Standards tab, you can send the email 
address for the Project Mailbox to all project participants, both within and outside of Unifier. 

Notes:  

 External emails that have been blind carbon-copied (Bcc) are not 
collected by the mailbox. 

 To prevent spam and virus attacks, you will need to create a list of 
approved email addresses that will be accepted by the project. See 
Creating an Approved Email List for Project/Shell Mailboxes. 

To distribute the external email address 

1) Click the Send Email button. An email message window opens. 

2) In the To field, enter the email addresses of all participants in the project. 

You can also send the address of the dedicated mailbox to external users by adding their 
email addresses in the External Cc field. 

3) Click the Send button. 

Distribute the email address from the landing page 

In addition to the Standard tab, you can distribute the email address from the project’s landing 
page. Remember to add the new recipient to the approved email list for this mailbox (Creating 
an Approved Email List for Project/Shell Mailboxes). 
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To notify project users whenever the project mailbox receives an external email 

1) In the Send Notification To field, click the Select button. The User Picker opens. 

2) Select the users you want to notify and click OK. 

Set up project progress tracking (Progress tab) 

The Progress tab of the Project window helps you track the progress of your project. You can 
manage milestones and project phase from this window. This information is displayed on the 
Progress pane of the Project landing page. This means a project administrator can quickly view 
the current status of a project and make modifications as necessary. Project Phase can affect 
other modules such as triggering when certain workflows or documents become available. 

The Progress tab can be linked to the Project Schedule Sheet. By setting up the Project 
properties to integrate with the Schedule Manager, changes in the schedule manager will 
automatically change the progress indicator in the project or program Progress tab. (The 
Schedule Manager is referenced.) 

The Project Phase can be set manually, or can be maintained manually (see Setting Up Gates
(on page 135).) 

To set up project progress tracking 

1) Open the Progress tab of the Project or Template window. 

2) Complete the tab as described in the following table. 

3) Click Apply to save changes, or Ok to save and exit. 

In this field: Do this: 

Start Date 
Choose one of the options: 

Manual: Manually enter the project start date by clicking 
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the calendar icon. 

From Schedule Manager: Click the selection list and 
choose a data column from the list (for example, Project 
Start Date). The Project Schedule Sheet must be created 
and setup before selections become available. 

Planned Completion 

Choose one of the options: 

Manual: Manually enter the project start date by clicking 
the calendar icon. 

From Schedule Manager: Click the selection list and 
choose a data column from the list (for example, Project 
Due Date). The Project Schedule Sheet must be created 
and setup before selections become available. 

Revised Completion 

Choose one of the options: 

Manual: Manually enter the project start date by clicking 
the calendar icon. 

From Schedule Manager: Click the selection list and 
choose a data column from the list The Project Schedule 
Sheet must be created and setup before selections 
become available. 

Design Complete 
This indicates the percentage of the design phase that 
has been completed. Enter a value. 

Construction Complete 
This is the percentage of the construction phase that has 
been completed. Enter a value. 

Notes 

Project notes can be anything that the Project 
Administrator feels is relevant to share with other Project 
Administrators. This note is not displayed on the 
Summary or Project Home Page. 

Status Chose from one of the three statuses. 

Project Phase 

If you are manually managing project phases, you can 
choose from this list for template and projects. 

Note: If you are using Gates, this list may not be applicable. 

Project Phase is a system-defined Data Definition that is 
pre-filled when the company is created. You can update 
this list by navigating to Data Structure Setup > Data 
Definitions > General and add new values to the Data 
Set list. 

Note: Project Phase is associated with Files and Folders 
in the Document Manager. Files and Folders can be 
given a Phase Property. Then, the only Folders and Files 
that will show in the DM are those folders without a 
Phase Property or one that matches what is set in 
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Project Setup. 

Add links to other project-related web pages (Links tab) 

Project Links will appear on the Project Home Page. Links entered here in the Project Template 
will be copied over to the Project. 

Project Links will appear on the Project Home Page. They can be used to provide links for users 
to useful websites, your company’s website, an intranet, etc. Links entered here in the Project 
Template will be copied over to the Project. 

To add a project link 

1) Open the Links tab of the Project or Template window. 

2) Enter the name and URL for any number of links you want to appear on the project home 
page. The name will display as an interactive link on the project home page. When users 
click on the link, a new browser window opens to the URL. 

For example, to provide a direct link to the government Occupational Health and Safety 
website, you might enter OSHA as the name, and http://www.osha.gov as the URL. 

3) Click Add Row to add additional URL links on the project home page. 

4) Click Apply to save. 

Select a project custom attribute (Custom tab) 

Projects can have Custom Attributes associated with them. Custom Attributes are created as 
company-defined Data Definitions. In the case of Projects and Project Templates, they can be 
used to provide further data not defined elsewhere. In the example below, Regions were defined 
as a custom attribute. 

If no custom attributes have been defined, the tab will be blank. 

To select a custom attribute 

1) Open the Custom tab of the Project or Template window. 

2) Select the value from the pull-down menu. Click OK. 

Create a Project Calendar (Calendar Tab) 

Each project can have its own calendar. The project calendar that you specify can be used to 
override the company calendar, or you can use the company calendar for the project. 

If there is no project calendar, or a project calendar is not in use, the company-level standard 
calendar marked as the default calendar (Company Calendar (Default)) is the calendar that is 
used by the project. 

The project calendars can be based on: 

a) Standard calendars created at the company level 
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b) Custom Calendars created for the specific project 

The project calendar you create applies only to the project for which you create that 
calendar. The calendar selected affects project durations and due dates. For example, 
companies can have multiple projects in different countries that have different working and 
non-working days. These working and non-working days must be considered when 
determining such time-driven factors as business process workflow due dates and activity 
dates in schedule sheets. 

Note: Unless otherwise specified, the default calendar for a project is the 
company calendar that is marked as default at the company level. 

To create a project calendar (Classic View) 

1) Open the Calendar tab of your shell. Alternatively, you can open the Calendar tab of your 
project or Template. The calendar you create in this tab is known as the Project/Shell 
Calendar. 

1. Click Details to open the Details window. 

2. Click the Calendar tab. 

2) Select one of the following calendar options: 

a. Standard Calendar

This allows you to use a standard calendar for your shell, project, or template. You 
options are Company Calendar (Default) or other calendars listed. 

b. Custom Calendar

This allows you to use a custom calendar for your shell, project, or template. You option 
are Copy or create a custom calendar. 

The calendar that you select displays in the Calendar tab. 

Note: You cannot modify a standard calendar. 

To create a project calendar (Standard View) 

1) Go to shell home click My Dashboard ..., and click Details to open the details page 
(overlay).   

2) Click Calendar tab. 

3) Select one of the following calendar options: 

a. Standard Calendar

This allows you to use a standard calendar for your shell, project, or template. You 
options are Company Calendar (Default) or other calendars listed. 

b. Custom Calendar

This allows you to use a custom calendar for your shell, project, or template. You option 
are Copy or create a custom calendar. 

The calendar that you select displays in the Calendar tab. 
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Modify a Project Calendar 

You can modify the displayed calendar. You can specify the working and non-working days for 
the calendar. Browse to the month and year using the drop-down lists at the top of the calendar. 
Saturdays and Sundays are set as non-working days by default. Do one of the following:  

To change working and non-working days on a calendar at project level (Classic View) 

1) Open the Calendar tab of your shell. Alternatively, you can open the Calendar tab of your 
project or Template. The calendar you create in this tab is known as the Project/Shell 
Calendar. 

1. Click Details to open the Details window. 

2. Click the Calendar tab. 

a. To change a particular date from a working to a non-working day, click the date cell to 
highlight and click Non Working. You can select multiple dates. This change impacts the 
months individually and does not impact the rest of the calendar or subsequent years. 

b. To change Saturdays and Sundays from non- working days to working days, click the day 
cell for example "Sat," to highlight and click Working. This will make all Saturdays, or 
Sundays, of the calendar as working days, including subsequent years. In this scenario, 
you can select individual dates under Saturdays or Sundays and mark them as 
non-working dates. 

A non-working date appears grayed out, and it will not be used in date calculations. 

To change working and non-working days on a calendar at project level (Standard View) 

1) Go to shell home click My Dashboard ..., and click Details to open the details page 
(overlay). 

2) Click Calendar tab. 

a. To change a particular date from a working to a non-working day, click the date cell to 
highlight and click Non Working. You can select multiple dates. This change impacts the 
months individually and does not impact the rest of the calendar or subsequent years. 

b. To change Saturdays and Sundays from non- working days to working days, click the day 
cell for example "Sat," to highlight and click Working. This will make all Saturdays, or 
Sundays, of the calendar as working days, including subsequent years. In this scenario, 
you can select individual dates under Saturdays or Sundays and mark them as 
non-working dates. 

A non-working date appears grayed out, and it will not be used in date calculations. 

Company Sponsored Projects (Standards Tab) E-Signatures 

If you have configured and activated Company Properties > E-Signatures tab with details about 
the entity that provides electronic signature technology (DocuSign or AdobeSign), then when 
you access your project, Projects (Standard), and open the properties window, you can use the 
Standards tab to select the E-Signatures type.  
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By default, the value of the E-Signature Type drop-down list is: Company Default. This means 
that the Project Administrator has selected the Default E-Signature Type in the Company 
Properties > E-Signatures tab as the E-Signature Type for the project. See Edit Company 
(E-Signatures Tab) (on page 66). 

Note: If only one E-Signature provider has been determined in the 
Company Properties > E-Signatures tab, the value of the E-Signature 
Type drop-down list (Standards tab) will be read-only and set as 
Company Default. 

You can select a different value from the E-Signature Type drop-down list. 

The Company Administrator can go to the Company Properties > E-Signatures tab to change 
the default value (Default E-Signature Type). This change does not impact the value of the 
E-Signature Type in the project, and the values will continue to remain as Company Default or 
as chosen by the Project Administrator. 

Updating Projects 

The Update Projects function allows you to quickly add or modify information into a project 
template, and then apply that template to existing projects. This will "push" the new information 
to the projects that you specify. By allowing data to be entered or modified once, this function 
helps to reduce set up time and ensure cross-project uniformity. 

The Update Projects function is available for select modules in Project Templates. The following 
information can be pushed: 

 Users: users, group membership, permissions 

 Groups: group names, permissions 

 Business Processes and BP Setups: Business processes, setups 

 User-defined Reports: Reports, report permissions 

 Access Control: modules, users, groups, permissions 

 Cost Sheet: Cost sheet columns, column access and restrictions 

 SOV: General and Payment Applications structure 

 Commitment Funding: Commitment funding sheet structure 

 Cash Flow: Curve properties and permissions 

 Rules: Project cost or fund rules 

 Gates Setups: Active or inactive setups 

 Schedule Sheet Properties: title, description, Master Schedule, status, auto-control, 
project start date, and error notification. 

Each project module that can be updated from the template has an Update Project button in the 
toolbar. 

This functionality makes it easy to update information across multiple projects. For example, if 
you add new users, or group of users, to the company and need to add them to multiple 
projects, you can add them to a project template, then use the Update Projects functionality to 
add the users to multiple projects. 
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Projects with a status of Active or On-Hold can be updated with this functionality. Inactive or 
View-Only projects cannot. Users with Create permission for the project template modules can 
do this operation. 

Note: You update project information one module at a time. Any Active 
or On-hold projects can be updated in this way. 

General procedure for updating project information 

In general, the Update Project feature works like this: 

Step 1. Open a Project Template. 

Step 2. Navigate to one of the modules listed above. Add or edit data. 

Step 3. Click the Update Project button. Select which information within the module to update, 
and which of your active or on-hold projects to "push" the information to. New information will be 
added to the selected projects. Edited information will overwrite existing data. 

You can also cancel a project update before it reaches the In Process status. 

Detailed instructions for updating specific types of project information is found in the following 
sections. 

Update users 

You can add new users to multiple projects at once by adding them to a project template in the 
User Administration > Users module. When adding new users to a project, you can assign 
individual permissions directly to a new user, or add the user to a group to apply group 
permissions. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Some notes about updating users

 Users are identified by their unique User ID. 

 Any Active, Inactive or On-hold users can be pushed. 

 If the user does not already exist in the project, the user will be added 
to the project with the permission settings and group membership. 

 If the user already exists in the project, the user information is 
updated (replaced) with the user information as entered in the project 
template. This includes permission settings and group membership. 

 If a group that the user was added to doesn’t already exist in the 
project, the group will be added, and the user will be added to the 
group. Group permissions are not updated; this is done by updating 
groups. 

 If the group already exists, the user will be added to it. Group 
properties and permissions will not be affected. 

To add or update users using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, go to the User Administration > Users log. 

4) Add a user to the project template, or select a user to edit. Define user parameters and 
assign permissions. 

5) Select one or more users in the Users log. 

6) Click the Update Projects button and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

7) Click Yes if you want to proceed with the update, or No to cancel. 

Update groups 

You can add new users to projects individually or by adding them to groups, and then adding the 
groups to the projects. You can assign the user individual permissions, or add the user to a 
group and apply group permissions. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Notes:  

About updating groups: 

 Groups are identified by their unique Group Name. 

 All group properties, including permission settings, will be added or 
updated in the projects that you selected. 

 If the group does not already exist, the group will be created with the 
permission settings. Group membership (user list) will not be 
updated in the project. 

 If a group of that name exists, the properties and permissions of that 
group will be replaced with the new group, but not the list of users. 

 Users will not automatically be added to the group; they need to be 
added by updating users (group membership). 

To add or edit user groups using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates>Projects (Standard) > All in the left Navigator. Open the project template 
to update. 

3) In the Project Template, navigate to the User Administration>Groups log. 

4) Add a group to the project template, or select group to edit. Define group parameters and 
assign group permissions. 

5) Select one or more groups from the Groups log. 

6) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

7) Click Yes if you want to proceed with the update, or No to cancel. 

Update Business Processes and BP Setups 

You can add and update new business processes, or add additional business process setups to 
existing business processes. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Notes:  

About updating business processes and setups: 

 BP Setup is identified by the unique combination of BP Name, Setup 
Name and Workflow Name. 

 If the BP Name does not exist, it will be added to project with the BP 
Setup and permissions. 

 If the BP exists, but the BP Setup does not, it will be added to the BP. 

 If the BP and BP Setup exist, the Setup will be replaced with the new 
one. 

 Users and Groups that are part of a BP setup as assignees are 
added/updated, but not permissions. If a group is created, it will be 
empty. Users must be added to the group separately through user 
administration. 

 BP-related permissions are added/updated (for example, discussion 
groups, which are available in Classic View only). 

To add or update business process setups using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates>Projects (Standard) >All in the left Navigator. Open the project template 
to update. 

3) In the Project Template, navigate to the Setup >Business Process log. 

4) Add any new business processes, if applicable. (The BP must already have been imported 
into Unifier and configured at the company level.) 

5) To add or edit business process setups, select the BP to update in the Business Processes 
log. Click Open. The BP Setup log opens. 

6) Create a new setup or modify an existing setup. You may create as many setups as you 
wish to make available in the project(s). 

7) Select one or more setups from the BP Setup log. 

8) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

9) Click Yes if you want to proceed with the update, or No to cancel. 

Workflow Setup for Workflow Business Processes 
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You have the ability to delete (Delete, or Edit > Delete) inactive Workflow setup for Workflow 
Business Processes in Project Templates. 

Updating Record Properties tab in the BP Setups 

When you push the BP setup to selected shells, or all shells, the users and groups who had 
restrictions to the Audit log and Workflow Progress tabs, the Record Properties tab of the BP 
setup (in shell template) will be pushed into the shells.  

The confirmation message (when pushing BP setup into shells or projects from template) will 
have an additional information: "Users and groups permissions, in the Record Properties tab, 
are added to the shell and existing permissions will be updated." 

Update User-Defined Reports 

You can add and update user-defined reports. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Important information about updating reports in Project/Shell:  

 Reports are identified by the combination of Name and Data Type. 

 Report names do not have to be unique. 

 If the report name and data type does not exist, the new one will be added. 

 The original owner of the report is added to the Users or Groups of the report in the receiving 
Project/Shell (Permission tab). 

 The administrator of the receiving Project/Shell becomes the report owner. 

 If a report exists with the same name and data type in the receiving Project/Shell, the 
existing report will be replaced with the new report, and the following information will be 
according to the new report: 

 Report updates 

 Added or changed Users or groups 

 Added or changed permissions 

To add or update user-defined reports using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, navigate to the Reports > User-Defined Reports log. 

4) Add a UDR to the project template, or select UDR to edit. Define properties. 

5) Select one or more reports from the User-Defined Reports log. 

6) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 
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 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

7) Click Yes if you want to proceed with the update, or No to cancel. 

Update access control 

You can edit access control parameters and update across projects. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes:

 Modules are identified by name. 

 If the module exists in the project, the module is updated, 
users/groups are created or updated, and permissions are updated 
for the module. 

 If the module does not exist, the module is added to the project. 
Users/groups are created and permissions are created for that 
module. 

To update access control using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates>Projects (Standard) in the left Navigator. Open the project template to 
update. 

3) In the Project Template, navigate to Access Control and assign user or group permissions 
to the modules as needed. 

4) Click the Update Projects button. The Update Projects window opens, displaying the list of 
modules for which the access control settings can be updated. 

5) Select the module(s) that you wish to update, click Update Projects and choose one of the 
following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

6) Click Yes if you want to proceed with the update, or No to cancel. 



Unifier General Administration Guide

122

Update cost sheet columns in a project 

Cost sheet columns can be updated using this functionality. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes:  

About updating cost sheet columns: 

 A column is identified by a unique data source. 

 If the project cost sheet does not exist in the project, the column is not 
added. 

 If the project cost sheet is present but the column does not exist, the 
column definition is created, and the column is added. Column 
restrictions are added. Users/Groups are created or updated. 

 For formula columns, be sure to first push the columns or data 
sources that make up the formula (if they don’t already exist in the 
cost sheet), then push the formula column. 

 Any new column that is created will use the column to its immediate 
left as the reference point for positioning. When a column is added to 
the cost sheet via an update, this means: If the column to the left of 
the column that is being pushed exists in both the template and cost 
sheet, the column will be positioned in the cost sheet according to its 
position in the template. If the column to the left of the column being 
pushed exists in the template but does not exist in the cost sheet, 
then the column will be added to the end (far right) in the cost sheet. 

Cost Column Project Update Rules 

If a project cost sheet column of the same name exists, it will be replaced according to the 
following matrix. 

If this template 
(source): 

Is used for this project (destination): The template will: 

Single Date 
Source 

Column exists Update the column 

Column does not exist 
Create column with the 
same definition 

Logical Data 
source 
(Formula 
entry) 

Logical Data source Column Exists 
(Formula entry) 

Update and replace the 
formula 

Logical Data source column exists 
(Manual entry) 

Not update the column or 
formula 

Column does not exist 
Create column with same 
definition 
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Logical Data 
source 
(Manual entry)

Logical Data source Column Exists 
(Manual entry) 

Update the column 

Logical Data source Column Exists 
(Formula entry) 

Update the column and 
change it to manual entry 

Column does not exist 
Create column with same 
definition 

To add or update cost sheet columns using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, navigate to Cost Manager > Cost Sheet. Create or open the 
Project Cost Sheet. 

4) From the cost sheet, click Columns to open the Columns log. Add or edit cost sheet 
columns as needed. 

5) From the Columns Log window, select the column to push. Only one column can be 
updated at a time. 

6) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

7) Click Yes if you want to proceed with the update, or No to cancel. 

Update Schedule of Values (SOV) Structure 

You can update the SOV structure for General Spends, Payment Applications, or Summary 
Payment Applications. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes: 

 Update Project can be used to create or update the SOV structure. If 
the structure already exists, it will be updated. If not, it will be created 
(restrictions apply for payment applications; see below). 

 When creating or updating the structure of the Payment Applications 
SOV or Summary Payment Applications, the Payment Application 
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business process must be set up in the target project first. If the 
business process has an active setup, then Update Project will 
create or update the structure. 

To update SOV structure using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, navigate to Cost Manager > Schedule of Values. Select one of the 
options: General Spends/Payment Applications/Summary Payment Applications. 

4) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

5) Click Yes if you want to proceed with the update, or No to cancel. 

Update commitment funding structure 

You can update the structure used to create commitment funding sheets. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes:  

About updating the commitment funding sheet structure: 

 Update Project can be used to create or update the commitment 
funding structure in the project. If the structure already exists, it will 
be updated. If not, it will be created. 

 Updating the structure in a project will not affect commitment funding 
sheets that already exist. New sheets will reflect the updated 
structure. 

To update commitment funding structure using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 
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3) In the Project Template, navigate to Cost Manager > Funding > Commitment Funding 
Sheet. 

4) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

5) Click Yes if you want to proceed with the update, or No to cancel. 

Update Cash Flow Curve Properties and Permissions 

You can push cash flow detail curve properties and permissions from a project template to a 
project. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Notes:  

About updating cash flow curve properties: 

 Both detail curve properties and permissions are pushed from the 
template to the project. 

 Cash flow detail curves are identified by name. 

 If a detail curve with the same name exists in the project, it will be 
replaced. All properties, including detail level and time scale, and 
permission settings will be updated. 

 If a detail curve with the same name does not exist in the project, a 
new one will be created. 

 Users and groups will be added if they do not exist. If a group is 
created, it will be empty. 

 In order to push a curve, the destination project must have a cost 
sheet. 

 Commitment detail level curves will not be pushed. 

 A Summary CBS curve cannot be pushed to a project where the cost 
sheet is flat. 

 After a successful update, the updated destination curves will be 
refreshed. 

To update cash flow properties and permissions using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, navigate to Cost Manager > Cash Flow. 

4) Add a cash flow curve to the project template, or select one to edit. Define properties and 
permissions. 

5) Select a curve from the Cash Flow log. 

6) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

7) Click Yes if you want to proceed with the update, or No to cancel. 



Project Administration

127

Update project cost or fund rules 

Project cost or fund rules can be updated using this functionality. 

The Update Project process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes:  

About updating rules: 

 Both active and inactive rules can be pushed. 

 Rules are identified by the combination of rule name and the source. 

 If the rule does not exist, it will be added. 

 If a rule already exists with the same name and source, that rule will 
be updated. This includes the status: for example, if the rule being 
pushed is active, and the rule in the project is inactive, the system 
will update the existing rule and activate it. 

 It is possible to have more than one rule with the same name and 
source in a project/shell or template. If two or more rules already 
exist with the same name and source as the rule being pushed, the 
update will not occur and will give an error. 

 When the update process begins, the system will first attempt to 
validate each rule (equivalent to clicking the Validate button). This 
will occur whether the rule is active or inactive in the template. If the 
rule is validated successfully, the system will proceed with the 
update. 

 If the rule fails validation, the rule will not be pushed. The attempt will 
be captured in the History. 

To update rules using Update Project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Projects (Standard) > All in the left Navigator. Open the project 
template to update. 

3) In the Project Template, navigate to Cost Manager > Rules. 

4) Select one or more rules from the log. 

5) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 

 All Projects: updates all projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 
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An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

6) Click Yes if you want to proceed with the update, or No to cancel. 

Update gates setups 

You can update projects with Active or Inactive Gates setups. The Update Project process runs 
in the background. Depending on the number of records and projects you are updating, it can 
take a considerable amount of time to complete. The process is complete when the End Date 
column in the Update History window shows the complete date. 

Notes:  

About updating Gates setups: 

 The Gates setup update will completely overwrite any existing Gates 
setup, or will be added if it did not previously exist. 

 Previously scheduled Gates runs are overwritten by the new Gates 
setup. If the pushed setup is Active new scheduled Gates runs are 
scheduled according to the schedule in the new setup. 

 Both Inactive and Active Gates setups can be pushed in the update. 

 After update the Gates setup reflects the status of the template. 

 After the update, the Current Phase in the Gates setup is reset to the 
First Phase. 

 After the update, the Gates projects will not run the scheduled refresh 
if the project is On-Hold. Gates scheduling will resume automatically 
when the project becomes Active. 

 If you have permission to create Gates setups, you can update Gates 
setups using Update Project, even if you do not have permission to 
access the individual projects. 

 Users and groups specified in the Email Notification field are added if 
they do not exist. 

 Newly-created groups are empty. 

To update Gates setups using Update Project 

1) Go to the Company Workspace tab and switch to admin mode. 

2) Click Templates > Projects (Standard) in the left Navigator. Open the project template to 
update. 

3) In the project template, click Setup and select Gates. 

4) Select a Gates setup. 

5) Click Update Projects and choose one of the following: 

 Projects: allows you to choose which project(s) to update. You can use Find to search 
for specific projects to select from the complete list of projects. You can select as many 
projects as you want to update. The Page and Display fields display on the Project 
Update window, but are disabled in this case. 
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 All Projects: updates all active and on-hold projects. 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a project is updated, this action cannot be undone. 

6) Click Yes if you want to proceed with the update, or No to cancel. 

View update history 

You can view details about previously updated project modules. 

To view Update Project History 

1) In the Project Template, navigate to the module to view the update history. 

2) Click the Update Projects button and choose History. The Update Projects: History window 
opens. It lists any previous incidents of using Update Projects. 

3) Select an instance from the list and click Open. The History Details window opens, detailing 
the module information that was updated. History Details displays: 

 Requestor: User who initiated the update process 

 Projects: Either user-selected or all projects 

 Submitted date: When the update request was submitted 

 Start date: When the update process started 

 End date: When the update process ended 

Cancel a project update request 

You can cancel an update request that has not yet started; that is, any request that does not 
have a status of In Process or Finished. 

To cancel a project update request 

1) In the Project Template, navigate to the module in which you want to cancel the update 
request. 

2) Click the Update Projects button and choose History. The Update Projects: History window 
opens. 

3) Select an update that has not yet started. 

4) Click Cancel Request. 

Managing Member Companies 

If your company has set up Partner Companies, those companies can become eligible to be 
added to projects. When added to a project, these companies become Member Companies, and 
their users can participate in projects with any permission level you set for them. 

Note: The list of eligible partner companies is maintained in the Partner 
Companies log. In Administration Mode, navigate to Company > 
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Partner Companies to view the list. 

Add a member company to a project 

Active partner company users (users with a unique Unifier user name, and status of Active or On 
Hold) can be added to projects and assigned permissions, just like sponsor company users. See 
Add a user to a project (on page 131) for more information. 

To add a member company to a project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > Member Company in the left Navigator. 
The Member Companies log opens. 

3) Click the Add button. The Add Member Companies window opens. This window lists the 
available partner companies that can be added to the project as a member company. 

You can click the Find button to search for a particular company by Company Name or 
Contact Name. 

4) Select one or more companies from the list and click the Add Member button. 

5) At the confirmation window, click Yes. The company is added to the Member Companies 
log. 

View member company profile 

To view a member company profile 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > Member Company in the left Navigator. 
The Member Companies log opens. 

3) Select a company from the list and click Open. The Company Profile window for the 
company opens. This is a view-only window. This information is maintained by the partner 
company’s administrator. 

4) Click the General tab to view general information, and the Address tab to view contact 
information. 

Remove a member company from a project 

You can remove a member company from the project’s Member Companies list. When a 
member company is removed from a project, users belonging to the member company will be 
automatically inactivated for that project. 

To remove a member company 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > Member Company in the left Navigator. 
The Member Companies log opens. 

3) Select the company and click the Remove button. 



Project Administration

131

4) At the confirmation window, click OK. This will remove the selected company from the list 
and inactivate any users who have been added to the project. 

Managing Project Users and Groups 

This section discusses adding groups and users to projects, managing project groups, and 
managing project permission levels. 

You can use bulk processing to update users in projects. See Managing users in bulk for details. 

Add a user to a project 

After you have created a project, you will need to add users to the list of approved project users. 
Project users can be from your own sponsor company, or from approved member companies. 

When adding users from your company to the project: 

 To add users from your own (sponsor) company, the user must be either Active or 
On-Hold at the company level. When added, the user will automatically be Active for the 
project. 

 Users who are Inactive at the company level cannot be added to a project. 

When adding users from a partner company to the project: 

 In order to add a user from a partner company, the company must first be added to the 
Member Companies list for the project. The user must be either Active or On-Hold at the 
company level for their own company. When added, the user will automatically be Active 
for the project. 

 The user does not necessarily need to be listed in the Partner Users log at the company 
level in order to be added to a company. If the user is listed in the Partner Users log, the 
user must be Active or On-Hold. If the user is not already in the Partner Users log, they 
will be automatically added to the list of Partner Users with a status of Active.

To add users to a project 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company SponsoredProjects > [project] > User Administration > Users in the left 
Navigator. The Users log opens. The log lists all users that are already part of the project. 

3) Click New. The User/Group Picker opens. 

Note: If a User Attribute form has been imported, the project user log will 
reflect the design of any designed Partner Log included in that form. See 
Importing User Attribute Form for details. 

4) Click the List Names from drop-down list at the top of the picker window and choose the 
company from which to add the new project user. 

This drop-down lists your sponsor company plus any member companies that have been 
added to the project. You can click the Member Companies node under the project to view 
the list of available member companies. 
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5) Select one or more users to add to the project. You can press the Shift or Ctrl keys to select 
multiple users at once. 

6) Click the Add button. You can continue to select and add names to the Selected Users 
portion of the picker window. 

7) Click OK to add the users to the project. The new users are listed in the Users log. 

Note: By default, new users will have a status of Active. You can 
change the status or other user detail information selecting the user from 
the list and clicking Open. 

To add a user to a project template 

Open the project template and navigate to User Administration > Users. Follow the steps 
above to add a sponsor company or member company user to the template. 

View or edit a project user’s profile 

You can edit a project user’s details. These procedures apply to sponsor company users and 
member company users. 

To view or edit a project user profile 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > User Administration > Users in the left 
Navigator. The Users log opens. 

3) Select a user from the list and click Open. The Edit Project User window opens. The window 
has the following tabs: General, Groups, Permissions and Custom. 

4) In the General tab, review the contact information for the user as it will appear in the Project 
Directory. By default, the project address (as defined in the project details) displays as the 
contact address. You can edit this information as necessary. 

You can also modify the user's project status: 

 Active: User is listed in Project Directory, in User/Group Picker, User can log in and 
participate in the project. New users are Active by default. 

 Inactive: If you deactivate a project user, the user’s name will not appear anywhere for 
selection on any project-related functions. The user will not be able to access the project. 
Inactivating a user at the project level does not affect their status on other projects. 

 On-Hold: User can be added to a project, or assigned as a participant in a business 
process workflow but cannot sign in. 

5) Select the Show user on the Project Directory option if you want the user's information to 
be viewable in the Project Directory. 

6) In the Groups tab, you can add or remove the project users to a project-level group the 
same way that you add company users to company groups. Click the Add button to add a 
group to the user’s list, or select a group and click Remove to remove the user from the 
group. 
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7) In the Permissions tab, you can assign project-related permissions to the user, by module 
and mode. For more information about assigning permissions, see Company User 
Administration. Permissions are described in the Unifier Reference Guide.

8) In the Custom tab, you can view available custom attributes that may have been added to 
the user form. 

Create and Manage Project Groups 

Groups are a way to collect Users together so that adding new team members to the project and 
assigning permissions can be done quickly and efficiently. For example, groups can be 
members of the same project team, and/or they can be users who share the same access 
privileges. At the company level, groups can span projects. At the project level, all members of a 
group are members of a given project. Different members of a project may have different access 
to Unifier functionality, depending on their role on the project. 

For example, a Finance person might require access to cost modules and reports dealing with 
finances, but not RFIs or Transmittals and their associated reports. An Executive might require 
access to Summary financial information, and not the cost BPs. 

As users are added to a Group, they will inherit the Group’s permissions. If they are in more than 
one group, then the highest level of permissions granted in any group for a module will prevail. 
Permissions are described in the Unifier Reference Guide. 

When adding users to the group, you can choose eligible users from the sponsor company and 
any partner company users. The company short name will be listed in the User Picker window 
next to each user. 

Company level groups cannot be copied into a project. 

To create a new group 

1) Go to the Company workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > User Administration>Groups in the left 
Navigator. The Groups log opens. 

3) Click New. The Groups window opens. 

4) Complete the General tab: 

 Group Name: Enter a name for the group 

 Manager: Click Select and select a user from the User Picker window. This is the person 
who will be responsible for administering the group. 

 Description: Enter an optional description for the group. 

5) Click the Members tab. This is where you add and manage group membership. 

a. Click Add. 

b. From the User/Group Picker, select the users to add to the group and click Add.

c. Click OK. 

6) Click the Permissions tab. In this tab, you manage group permission settings. If a user is a 
member of the group, the user will inherit all group permissions. 
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Granting permissions to the group is similar to granting permissions to individual users. 
Choose the project-related permissions for the group that will apply to all members assigned 
to this group. Choose permissions by module and mode. 

7) In the Custom tab, you can view available custom attributes that may have been added to 
the group form. 

To edit group information 

1) Go to the Company workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > User Administration>Groups in the left 
Navigator. The Groups log opens. 

3) Select a group and click Open, or double-click the selected group. The Groups window 
opens. 

4) Make changes as necessary and click OK. 

Grant project user permissions through Project Access Control 

Once you have created a project, assign permissions to the people who need to access the 
project. You can use Access Control to grant multiple Users or Groups permission 
simultaneously, rather than editing the properties for each User or Group individually. 

To view or change a project's access control 

Click Access Control in the Navigator. Unifier displays a copy of the Navigator menu in the right 
pane of the window. In this right pane, you may click on different modules of the Navigator menu 
to set permissions for those functions. 

Generate and print access information report 

You can generate and print an Access Information summary of user and group access 
(permission settings). The report will display all user and group permissions. 

To generate the Access Information report 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Projects > [project] > Access Control in the Navigator. 

3) Click the Access Information button. The Access Information window opens. It may take 
several moments to generate the report. 

To print the Access Information report 

1) Generate the Access Information report. 

2) Click the Print button. (When the report is complete, the Print button becomes available.) 

Setting Up Automatic Status Update 

At the Company level, you can define the setup of the automatic update of project statuses of 
active projects based on triggering conditions which are defined using various data sources as 
parameters. For example: 
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 A selected activity on the schedule sheet is in the Completed status 

 A single-record business process record is set to a specified status 

 A business process workflow reaches a specified status 

Depending on the setup and the conditions that are set, the status of the project can change 
from Active to a non-active status (On-Hold, View-Only, or Inactive). You can define multiple 
setups for each project. After you define these setups, they can be used on project or shell 
instances, or on templates to enable the automatic update of project status. 

The data sources that you use in the triggering conditions can be either from project or shell 
level, or from the Company level. This data sources can be business processes, sheets or 
attribute forms. You can define the frequency at which Unifier evaluates the conditions to see if a 
particular active project should change its status, and can define a list of users or groups to be 
notified when the project status is changed. The highest frequency is daily. 

This automatic update of project status can be useful for users that have a large number of 
projects and want many of these projects to change their status based on certain triggering 
conditions, and thus the users do not have to search for and modify these projects manually. For 
example, you can define a setup at the Company level that contains a triggering condition that 
changes of the status of an active project On-Hold if the project funds consumption exceeds the 
funds appropriated for that project. This allows the project manager to review the project and 
take appropriate action. If, in this case, the project manager is able to get additional funding for 
the project, the Administrator can change the project status back to Active to restart the project 
activities. 

Note: Automatic project status update can change the status of a project 
from Active to an inactive status. If you want the inactive project to status 
to revert to Active, you must activate the project manually. 

Step 1: Create setups - general information. 

Step 2: Verify the order of project statuses. 

Step 3: Define project status triggering conditions. 

Step 4: Define the schedule for automatic update of project status. 

Step 5: Activate the automatic update of project status. 

Step 6: Define permissions. 

Setting Up Gates 

Before you begin: Verify the list of project phases resides in the Project Phase data definition 
pull-down data set. This is the same list that is used when selecting a project phase manually in 
the project properties window. You can add or modify the default list as needed. This list makes 
the phases available for any project or project template; for each project or template, you select 
which of the phases to use. Create any business processes that you plan to use to drive gates 
conditions and phase completion. 

Step 1: Define Project Phases. For each project or template, you define the list of project 
phases to include in the setup, choosing from the entire list in the Project Phase data set. 
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Step 2: Define Gate Conditions. For each phase, define one or more gates conditions. A gate 
condition is a combination data element and trigger condition that enable transition to the next 
phase. 

Step 3: Schedule Gates runs. The gates runs run the validation of gate conditions. You can 
schedule runs automatically. This is optional. 

Step 4: Activate the gates setup. 

Step 5: Define permissions. 

Note: If you create a new project by copying a project template or an 
existing project, any existing gates setup in the source project is copied 
into the new project, including the gates status. The gates phases are 
restarted at the first phase in the new project, and the scheduled gates 
run is activated. 

Example of a gates setup and conditions 

You will be setting up phases in gates to represent the actual phases of a project. For the project 
to advance from one phase to another, certain conditions must be met. This example will 
discuss phases, conditions, and using business processes in the context of the conditions to 
advance a project from one phase to another. 

For example, phases for Project Zero could be: 

 Preliminary 

 Investigation 

 Definition 

 Measurement 

 Analysis 

 Start 

 Control 

Previously, you have set up two business processes to use in the conditions for your gates 
setup. These are: 

 Schedule: A single record business process that is updated manually by a project manager 
by checking checkboxes for the various phases such as Definition Phase Complete? or 
Measurement Phase Complete? 

 Funding: a workflow business process that is automatically updated thorough the steps of 
the workflow. 

As the project manager checks the checkboxes in the phases as represented in the Schedule 
business process, the gates runs keep checking the statuses of the checkboxes. As they are 
checked off, the project advances to the next phase. 

The exception to this procedure is the transition from the Analysis phase to the Start phase. 
Additional approval is needed for funding in order for the project to advance from Analysis to 
Start. The Funding business process is included in the conditions for the Analysis phase. This 
business process must have the status Construction Approved and have a value of greater than 
zero for the Analysis phase to be exited and the Start phase entered for the project. 
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Define the project phase list 

To view the project phase list 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Data Structure Setup > Data Definitions in the left Navigator. 

3) Select Basic. 

4) Select the Project Phase data definition and click Open. The Modify Data Definitions window 
opens. 

5) Click the Data Set tab. The active phases on this list will be available for project phase 
setup. 

6) Modify the list as needed. Any changes you make here will be reflected in new gates setups. 
Current setups will not be affected. 

Create a gates setup 

You can create a gates setup in project templates, and in individual projects. There can be one 
setup per project. 

To create a new gates setup 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Do one of the following: 

 To create the setup in a project template, click Templates > Projects (Standard) in the 
left Navigator. Open the project template. 

 To create the setup in a project, click Company Sponsored Projects in the left 
Navigator. Open the project. 

3) Click Setup > Gates. The Gates Setup log opens. 

4) Click New. The gate setup is created automatically. Double-click the setup, or select from 
the list and click Open. The Gates Setup window opens. There are three tabs: General, 
Settings, Schedule. 

5) In the General tab, enter a Setup Name, which displays in the log, and an optional 
Description. At this point, Status is Inactive by default. 

6) In the Settings tab, define project phases and gates conditions. For details, see Add 
project phases to the gates setup (Settings tab) (on page 137) and Configure gate 
elements (on page 139). 

7) In the Schedule tab, you can schedule regular gates. See Define gates runs schedule 
(Schedule tab) (on page 140). 

Add project phases to the gates setup (Settings tab) 

Select which of the phases to use in the project or template from the available project phase list. 
You can reorder them as necessary for the project or template. 
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To add project phases to the new gates setup 

1) Open the Gates Setup window and click the Settings tab. 

2) In the Phases pane, click the Add button. The Select Phases window opens, displaying the 
list of available project phases. 

3) Select one or more project phases to add to the list. To select multiple phases, hold down 
the CTRL or SHIFT keys while selecting. 

4) Click OK. The phases appear in the Phases list. 

The order in which the phases appear on the list is the order in which they will be followed in 
the project. The first phase on the list will be the first phase of the project. 

Configure Gates conditions 

To access the gate configuration view: 

Select a project phase. The gate configure view opens in the right pane. See the following table 
for more information about the gate configuration view. 

The Phase Gate Configuration section in the navigator lists the Project Phases for the current 
Project. The visual order of the Phases depends on the Order specified in the General tab. 

The Gates Conditions Elements section allows you to define condition criteria per element. 
Gate Elements will be selected from all Unifier data sources and modules available in a 
particular project (for the Sponsoring company). 

In this field: Do this: 

Start Date 

The Start date for a particular Phase can be manually set or auto 
populated from a Schedule Sheet by linking it to a particular 
activity or milestone (activity with zero duration and marked as 
milestone) where it will update dynamically based on the start 
date associated with this activity. If there are multiple Start dates, 
choose the Start date used to set Gantt Charts in Schedule 
Manager. 

The start date must fall within Project date ranges. 

Note: You cannot choose dates from schedule sheets in the 
Schedule Manager for generic shells, because the Schedule 
Manager is not available in generic shells. 

Planned 
Completion 

Can be manually set or auto populated from a Schedule Sheet by 
linking it to a particular activity or milestone (activity with zero 
duration and marked as milestone) where it will update 
dynamically based on the start date associated with this activity. If 
there are multiple End dates, choose the End date used to set 
Gantt Charts in Schedule Manager. 

Note: You cannot choose dates from schedule sheets in the 
Schedule Manager for generic shells, because the Schedule 
Manager is not available in generic shells. 

Note: Dates are for reporting only. Phases cannot be date driven.
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Advance to Next 
Project Phase... 

This checkbox enables automatic phase advancement. Select the 
checkbox if you want the project to move automatically to the next 
phase once all Gate Elements for a particular Phase have been 
checked. 

Notify users on 
Phase Completion 

Allows you to define users who receive phase completion 
notification. You can configure the body text in the notification 
(similar to the BP Setup on the End Step, where you can specify 
the message text content. 

Reevaluate 
conditions on every 
Gates run 

When selected, this checkbox specifies that processing always 
starts at the First phase during a scheduled Gates Run/Refresh. 
You might have to scroll down to see this checkbox. 

If the checkbox is unchecked for a phase: 

 If the phase is currently incomplete, incomplete conditions are 
evaluated and completed conditions are skipped 

 If the phase is currently complete, phase processing is 
skipped 

 If the checkbox is checked in a phase: 

 Every condition in that phase is reevaluated. Including 
conditions that were met 

 All conditions (except conditions that were marked as "ignore" 
manually) are marked as incomplete at the beginning of every 
Gates run and refresh. 

Saved Gates run (PDF) from prior runs persist. Processing will 
stop at a Phase where first un-met condition is encountered. By 
default this checkbox is deselected. 

Configure gate elements 

To add a Gate Condition Element 

1) In the Gates Setup window, gate configuration view, select a project phase and click Add. 
The Data Type window opens. 

2) Select a Data Type from the drop-down. 

3) Click OK. The Edit Gate Condition window opens. 

4) Complete the General tab: Enter a Name for the Gate Element. This can be the name of the 
data element or any descriptive name. This appears on the Gate Conditions Elements list. 
You can add an optional Description. 

5) Click Apply to save changes, or OK to save changes and exit the window. 

To define query and trigger conditions 

1) In the Edit Gate Condition window, click the Query tab. 

2) Under Query Conditions, click Add. The Query Condition window opens. 

3) Complete the Query tab: 
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Data Element: Click the Select button. The Data Element Picker opens. The list is generated 
from the data type you chose in the General tab. If the data element is a picker, pull-down or 
radio button, the Value field will display the values entered in the data set tab of for the data 
definition associated with the data element. For a full list of data elements and data types, 
refer to the Unifier Reference Guide. 

 Label: The label defaults to the data element name. You can enter a different label. 

 Condition: Define Gate Condition Element Condition. The condition options vary 
dynamically depending on the selected Data Element. The screen shots below list out the 
various options for different Data Element types. Examples include equals, does not 
equal. 

 Values: Specify value. The Values field varies dynamically depending on the selected 
Data Element and Condition. (For example, if the element is a text box, the condition 
might be Contains, and value might be one or more letters to search for. If the element is 
a pull-down or other data definition with a data set, you will select a value from the data 
set.) 

Change the order of project phases 

To change the order of the phases in a gates setup 

Select a phase and click the Move Up or Move Down button. 

Define gates runs schedule (Schedule tab) 

You can define a gates run schedule in the Gates Setup window, Schedule tab. This run 
evaluates gates conditions, and marks completed conditions as Complete. The update process 
can also be invoked manually in user mode. The scheduler engine is a background process. 

In this field: Do this: 

Enable 
Scheduled 
Gates Runs 

Select this checkbox to enable scheduled updating of Gate Elements. 
Deselecting this checkbox will disable the scheduler, and any 
scheduled future runs will be canceled immediately. 

The scheduled gates runs are disabled in the last phase provided all 
conditions are met, and the Enable Scheduled Gates Runs checkbox 
is automatically deselected. 

Frequency 
Choose Frequency of the Scheduled Gates Runs (Daily, weekly, 
monthly, quarterly, yearly) 

Range of 
Recurrence 

You can specify a date on which the Gate Runs will end, or no end 
date. 

Auto-email as 
PDF 
Attachment to 
Gates creator 

Select this checkbox to enable automatic emailing of the scheduled 
run results as a PDF attachment. The report displays the current 
status of each project phase and gate condition. 
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Activate or deactivate a gates setup 

Activating a gates setup will enable the scheduled gates runs. After activation, if you need to edit 
the gates set up, you will need to deactivate it first. 

You can make edits while the setup is inactive, including: adding or removing phases; reordering 
phases; add, modify or remove conditions within a phase. 

Some notes about activating/deactivating gates setup: 

 Reactivating an active project: If you temporarily deactivate a project that is in process, and 
then reactivate it, the gates check will start over at the first phase. This is because the setup 
needs to check all phases for new phase additions or new gate conditions that may have 
been added. You can manually update the project phases by clicking the Refresh button for 
gates in User Mode. This will evaluate all phases starting from the first phase, even if the 
phase has been marked Complete, and mark the first phase as the current phase. Note: be 
aware this may trigger email notifications regarding gates advancement, as set up in the 
Settings tab (where the users who are notified are defined), and those users’ email 
subscription settings (User Preferences). 

 While a gates set up is inactive: No scheduled gates run will be done. To manually advance 
phases in User Mode Gates for the project, the gates setup must be active. 

 View-Only and Inactive projects: If a project has View-Only or Inactive status, the gates 
setup is inactivated, and you must manually reactivate the setup. 

Set user permissions for gates 

To grant User Mode Gates permissions: 

In Access Control or Permissions window, navigate to User Mode > Shells/Projects 
(Standard) > Gates. The permissions are: 

 Change Phase: Allows the user to change gates phases. 

 Modify and Refresh: Allows the use to modify gates and refresh gates. 

 Refresh: Allows the user to refresh gates. 

 View: Allows the user to view gates. 

Create an automatic project status update setup 

Multiple setups can be defined at the company level and then used to configure individual 
projects. 

To create a new project status update setup 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Workspace > Auto-update Status Setup in the left Navigator. The 
Auto-Update Status Setup log opens. 

3) Click New. The Auto-update Status Setup window opens. There are three tabs: General, 
Settings, Schedule. 

4) In the General tab, enter a Setup Name, which displays in the log, and an optional 
Description. 
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5) In the Settings tab, define the order of the non-active statuses and the status change query 
and trigger conditions. For details, see Choose the order of non-active statuses (Settings 
tab) (on page 142) and Define status change query and trigger conditions (Settings 
tab) (on page 142). 

6) In the Schedule tab, you can schedule the shell status update. See Define project status 
update schedule (Schedule tab) (on page 143). 

7) Once you have defined the setup, you must activate it to be able to apply it to a project. See 
Activate or deactivate an auto-update status setup (on page 144). 

Note: You must deactivate a setup to be able to modify it. 

Choose the order of non-active statuses (Settings tab) 

By default the order of the listed statuses is On-Hold, View-Only, and Inactive. These are listed 
on the left side of the Settings tab in the Status pane. You can change the order using the 
Move Up or Move Down buttons. You can change the order of the non-active statuses. The 
order of the statues is significant because the triggering conditions for the statuses are 
evaluated in the order in which they are listed on this tab, with the verification of the triggering 
conditions occurring for each condition listed in turn. 

For example, if the conditions for the first listed status are not met, then the conditions for the 
next listed status are evaluated. If the conditions for that status are not met, then the triggering 
conditions for the third status conditions are evaluated. As soon as the first match occurs, Unifier 
will automatically change the project status and does not perform further evaluation. 

To reorder non-active project statuses 

1) Open the Auto-update Status Setup window and click the Settings tab. 

2) In the Status pane, select the status you want to move. 

3) Click the Move Up or Move Down button to reposition the selected status. 

4) Click Apply to save changes, or OK to save changes and exit the window. 

Define status change query and trigger conditions (Settings tab) 

The Conditions Elements section allows you to define condition criteria per element. Elements 
can be selected from all Unifier data sources and modules available at the Company level. 

In this field: Do this: 

Notify users and 
groups on Status 
change 

Allows you to define the users and groups who will receive 
status change notification. 

Email content 
Enter the content of the email you want to send to notified users 
and groups. This content appears in the Additional Information 
section of the email. 
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To define query and trigger conditions 

1) Under Conditions Elements, click Add. 

2) Select a Data Type, and click OK. The Query Condition window opens. 

3) Complete the General tab by entering a name for the query and a brief description. The 
Data type and Element is auto-populated from the selection you make on the Query tab. 

4) Click the Query tab. 

5) Click Add. 

6) Complete the Query tab: 

 Data Element: Click the Select button. The Data Element Picker opens. The list is 
generated from the data type you chose in the General tab. If the data element is a 
picker, pull-down or radio button, the Value field will display the values entered in the 
data set tab of for the data definition associated with the data element. For a full list of 
data elements and data types, Refer to the Unifier Reference Guide. 

 Label: The label defaults to the data element name. You can enter a different label. 

 Condition: Define Gate Condition Element Condition. The condition options vary 
dynamically depending on the selected Data Element. The screen shots below list out the 
various options for different Data Element types. Examples include equals, does not 
equal. 

 Values: Specify value. The Values field varies dynamically depending on the selected 
Data Element and Condition. (For example, if the element is a text box, the condition 
might be Contains, and value might be one or more letters to search for. If the element is 
a pull-down or other data definition with a data set, you will select a value from the data 
set.) 

7) Select the trigger conditions. 

8) Click OK. 

Note: The DE of type Rich Text is not available when you define queries 
in the Auto-Update Status Setup window.  

Define project status update schedule (Schedule tab) 

You can define a schedule to check the conditions for the automatic update in the Auto-update 
Status Setup window, Schedule tab. 

The maximum frequency that Unifier will verify whether triggering conditions are met is daily. If 
you have a need for greater frequency of verification, you must monitor the project with the 
project manager and then change the project status manually as needed. For example, if the 
triggering condition verification is performed in the morning, and the project funds are being 
spend during the course of the day, the project could exceed its budget before the condition 
verification occurs the next morning, and the project status is automatically changed. 

In this field: Do this: 

Enable 
Scheduled 
Runs 

Select this checkbox to enable scheduled evaluating of the automatic 
update status. Deselecting this checkbox will disable the scheduler, and 
any scheduled future runs will be canceled immediately. 
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The scheduled evaluation is disabled for the last status in the list, 
provided all conditions are met, and the Enable Scheduled Runs 
checkbox is automatically deselected. 

Frequency 
Choose Frequency of the Scheduled Runs (Daily, weekly, monthly, 
quarterly, yearly) 

Range of 
Recurrence 

You can specify a date on which the Scheduled Runs will end, or no end 
date. 

Activate or deactivate an auto-update status setup 

You must activate a setup in order to be able to apply it to a project. 

Note: You must deactivate a setup to be able to modify it. 

To activate or deactivate a project status update setup 

1) To activate or deactivate a new setup to use in projects, go to the Company Workspace tab 
and switch to Admin mode. 

2) Click Company Workspace > Auto-update Status Setup. The Auto-Update Status Setup 
log opens. 

3) Select a setup in the log. 

4) Click the Status button. You can choose Active or Inactive. 

Set permissions for automatic update of project status 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Access Control in the left Navigator. 

3) On the right pane, select Administration Mode Access > Company Workspace > 
Auto-update Status Setup. The permissions are: 

 Create: Allows the creation of new auto-update status setups, edit existing auto-update 
status setups and activate or deactivate auto-update status setups. 

 Modify: Allows the edit existing auto-update status setups and activate or deactivate 
auto-update status setups. This permission excludes the ability to create a new 
auto-update status setup. 

 View: Allows viewing of existing auto-update status setups. 
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Shells Administration 

You can use a Shell to organize the information about projects, or facilities, in one place. A Shell 
includes functions and features that are necessary for managing the information about projects, 
or facilities, within that Shell. A Shell does not require to function like a Project. 

In This Section 

Dedicated Mailbox for the Shell ............................................................................. 145 
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Setting Up the Automatic Update of Shell Status ................................................... 255 
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Internationalization (Date and Time Zone Formats) ............................................... 283 
Internationalization (Audit Log) .............................................................................. 283 

Dedicated Mailbox for the Shell 

External emails are important communications that need to be included in shells. Such emails 
can come from project team members or from external users who do not use Unifier. These 
email communications (and any attachments) can be collected in a central repository for the 
shell, called a Mailbox. Once such emails reside in the shell’s Mailbox, users can view them, 
forward them to appropriate members, flag them for review, and reply to them. In addition, these 
external emails can be linked to business process records. 

Note: External emails that have been blind carbon-copied (Bcc) are not 
collected by the Mailbox. 

When Unifier is installed on your system, a dedicated email address for your company is 
specified, and whenever a shell is created, Unifier assigns it a unique identifier. Unifier combines 
this email address and shell identifier to create the shell’s Mailbox. 

Note: To prevent spam and virus attacks, you will need to create a list of 
approved email addresses that will be accepted by the shell. See 
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Creating an Approved Email List for Project and Shell Mailboxes for 
more information. 

When you create a shell, you can notify all shell participants, both within and outside of Unifier, 
of the shell's email address. See Create a New Shell Manually (on page 164). 

User Permissions and Navigation 

Navigation from the Landing Page to a specific place in the sub-shell hierarchy requires 
permissions. Permissions can be: 

 Granted on an instance-by-instance basis 

 Pushed through shell templates 

 Users can be managed through groups or added individually to instances 

Setting up Shells 

Before you begin: Shells types must be designed in uDesigner. 

Step 1: Import shell types. Import into Unifier the shells that were designed in uDesigner. 

Step: Set permissions to configure the shells in the Shell Manager. 

Step 3: Configure imported shells in the Shell Manager. 

Step 4: Set permissions to administer shell templates, which you can use to create shells for 
projects. 

Step 5: Create shell templates. 

Step 6: Set permissions to add or modify shells. 

Step 7: Create new shells for user projects. 

Note: You will set permissions at several points during shell setup, in 
order to be able to access, or to grant access to, various aspects of 
working with the shell. 

Importing Shells 

All designs, including shell designs, are designed in uDesigner and deployed to Unifier. See 
Importing Configuration Packages. 
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Note: Importing Forms that Contain Data Pickers: Data pickers point to a 
data source for the records they display. If that data source—the BP, 
shell, space, planning item, or manager class—to which the picker is 
pointing is not already in Unifier, you will receive a warning. The 
business process will not operate correctly until the data source is 
imported. 

CSV Import or Restful Services (Create Shell) 

When you create a shell instance by using CSV import or Restful Services (Create Shell), the 
system copies into the created Shell:  

 The View Forms tab information from the selected shell template. 

 The forms added in the shell template, along with users and groups who are part of the 
viewers list. 

Setting Permissions to Configure Shell Types in the Shell Manager 

To set permissions to configure shell types in the Shell Manager: 

1) In Administration mode, go to the Company Workspace tab and click Access Control in 
the left Navigator. 

2) On the right pane, select Administration Mode Access > Configuration > All > Shell 
Manager. 

3) See Edit user or group permissions using Access Control. 

4) Click OK. 

Configuring Shells 

Configuring a shell consists of activating it and organizing it into a hierarchy. 

Note: Before you configure shells it is worthwhile to plan the shell 
hierarchy with your users and uDesigner user. The instance, and cost 
settings affect how you will use the shell and its relationship to other 
shells. Planning will help you achieve the result that will meet your 
business needs. 

To configure the shell types in the Shell Manager 

1) Go to the Company Workspace tab and switch to Administration Mode. 

2) Click Configuration > Shell Manager in the left Navigator. 

3) Select a shell type and click the Open button. The Configuration <shell name> window 
opens. 

4) Complete the General tab as described in the first table below. 

5) Click the Organize tab. On this tab you can specify the sub-shell types that are allowed 
under a shell type. 
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This tab is where you establish the shell hierarchy, by selecting allowed sub-shells. For 
example, assume you have configured a shell called Region, which has the sub-shell types 
Properties and Buildings. Also, Properties has Buildings as a sub-shell. Unifier performs 
validation during shell configuration, and manages the relationships among the shells that 
you configure. The second table below shows the relationships among the shells described 
above. 

Click the Add button to add sub-shell types from the list of imported shells. You can add 
sub-shell types to the sub-shell type you are currently configuring. Click Add and select the 
sub-shell types to add. Select the types to add, and click OK. You can only add shells that 
have the Active status. 

6) Select the Active checkbox for the sub-shell types you want to activate. You can deactivate 
sub-shell types that you do not want users to use for sub-shell instance creation. You can 
deactivate sub-shell type even if sub-shell instances have been created with that type. 

Note: You can remove a sub-shell type from the list by clicking Remove, 
as long as an instance of the sub-shell type is not created under the 
shell. 

7) Click Apply to save changes as you enter information, and OK when you are ready to save 
information and exit the Configuration window. 

8) Complete the configuration steps for each shell type. 

In this field Do this 

Enable 
automatic 
numbering 

Select to allow automatic numbering of projects based on the 
specified Format and Start values. You can deselect this checkbox to 
disable automatic numbering. This checkbox is selected by default. 

Format/Start 

Specify the format and starting number for projects if automatic 
numbering is enabled. Format determines the format of the 
numbering schema. Start determines the starting number of the 
numeric schema. By default, Format is blank and Start is 0001. The 
numbering schema format cannot be changed after a user creates 
shell instances using the originally specified format. 

Cost Codes: 
CBS/Generic 

Displays the type of cost code specified in uDesigner for the shell 
type. 

 CBS: Standard Cost Manager 

 Generic: Generic Cost Manager 

The default selection is determined by which cost code was specified 
in uDesigner. 

Status 
Status can be Active or Inactive. Users cannot access shells types 
with the status Inactive. The default is Inactive. If a shell type is 
Inactive, users cannot create shell instances of that type. 
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Shells-> Parent Child Grandchild 

Subshells that are allowed 

Parent No No No 

Child Yes No No 

Grandchild Yes Yes No 

Update generic cost sheet columns and rows 

You may have a large number of codes that are used within the Generic Cost Manager. In 
addition you may have a large number of shells in your implementation. To update codes and 
columns in your generic cost manager sheets with a minimal effort, you can push columns in a 
project or shell template generic cost sheet from the Columns Log to cost sheets. 
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Notes:  

About updating shell instance dashboards: 

 A cost sheet must already exist in the destination shell. Pushing a 
column from a template will not create a cost sheet that can receive 
the column. 

 You can push one column at a time. 

 If a source column is a single data source, then the destination 
column will be created with that single data source if it does not 
already exist. (Column A or B in example below) 

 If a source column is a formula with only single data sources, then 
pushing the source column will create that column in the destination 
cost sheet, if it does not already exist. (Column C in example below) 

 If a source column is a formula with columns included in the formula, 
as long as all constituent columns contain single data sources, the 
source column can be pushed; for any columns that do not exist in 
the destination cost sheet, the formula will be changed to a single 
data source in the formula. (Column D in example below) 

 If a source column is a formula with constituent columns that include 
logical data sources, the logical data source must exist in the 
destination cost sheet. The formula for the logical data source may 
be different in the destination cost sheet. Any column that contains a 
single data source will follow the rule above. (Column F in example 
below) 

To add or update generic cost sheet columns from a template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell-type template to update. 

4) In the shell template, navigate to Configurable Modules > Generic Cost Manager. 

5) Select the Generic Cost Manager Sheet template and click the Structure button. 

6) In the Generic Cost Manager Sheet log, select the cost sheet template and then click the 
Columns button. The Columns Log window opens. 

7) Select a cost sheet column. 

8) Click Update Shells and choose one of the following: 
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 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 

9) Click Yes if you want to proceed with the update, or No to cancel. 

To update generic cost sheet rows from a template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell template you want to update. 

4) In the template, navigate to Configurable Modules > Generic Cost Manager. 

5) Select the template and click the Structure button. 

6) Select a row or rows to push to the project/shell level generic cost sheet. You can select 
multiple rows by holding down the Shift or Ctrl keys as you click on the rows. 

Unifier will update leaf-level rows, but not summary rows. 

7) Click Update Shells and choose one of the following: 

 Shells: allows you to choose which shell(s) to update. You can use Find to search for 
specific shells to select from the complete list of shells. You can select as many shells as 
you want to update. The Page and Display fields display on the Shell Update window, but 
are disabled in this case. 

 All Shells: updates all active and on-hold shells 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a shell is updated, this action cannot be undone. 

8) Click Yes if you want to proceed with the update, or No to cancel. 

Configuring Shell Manager Configuration Package 

The following configurations can be included in the Shell Manager Configuration Package:  

 General setup 

All the fields included in the General Configuration (General tab). 

 Organize setup 

All the fields included in the Organize tab. 

Notes:  

 The sub-shells defined in the Shell hierarchy are also included in the 
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Configuration Package. 

 The sub-shells defined in the Organize tab are included in the 
Configuration Package. 

 You can export the sub-shells. 

For more information, see the Configuration Package Management section in this guide. 

Setting Permissions to Administer Shell Templates 

Setting Shell Template administration access: 

1) Go to the Company Workspace tab and switch to Administration Mode. 

2) Click Access Control in the left Navigator. 

3) On the right pane, select Administration Mode Access > Templates > Shells [shell 
node]. 

4) See Edit user or group permissions using Access Control. 

5) Click OK. 

Accessing a Created Shell Template 

From the Shells node under Templates, you can access the shell type templates that are 
created. 

One node is created under Shells for each shell type that is imported and that has an active 
configuration status. 

Note: Single-instance shells are not listed under Templates > Shells as 
there can only be one instance created for those shell types, and there is 
no need of a template. 

To access shell templates 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Expand the Shells node. Any shell templates are grouped by shell types.  

One node is created for each shell type imported. For example, Buildings, Linear Assets, 
Projects. 

4) Click one of the shell type nodes, for example Projects. The Projects Templates log 
window opens. The log lists any project templates that have been created for that shell type. 

Create a Shell Template 

The following procedure describes how to create a shell template. 

To create a new shell template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 
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Expand the Shells to display the shell types. 

3) Click one of the shell type nodes. The <shell> Templates log opens. The log lists any shell 
templates that have been created under that particular shell type. 

4) Click the New button. The <shell> templates Details window opens. 

5) The General tab you see will depend on the Shell Attributes form that was imported. In the 
General tab, complete the fields as described in the table below: 

6) In the Currency tab, click the Add button. The Edit Exchange Rate window opens. 

Note: The Base Currency shown at the top of the Edit Exchange Rate 
is the Base Currency set up for your company. For example, if yours is a 
company in the U.S., then the Base Currency will likely be United States 
Dollar (USD). If your company does business internationally, you may 
make other currencies available for shell use. 

a. Complete the Edit Exchange Rate window: 

 Click the Select button. 

 Select a currency from the list and click OK. The available currencies are defined 
at the time your company was set up. (The currency list is maintained in 
Standards & Libraries> Exchange Rate.) Contact your Company Administrator if 
you need additional currencies. 

b. If the currency you selected is other than the company Base Currency, then complete the 
following: 

 Rate: enter an exchange rate to use for conversion calculations. From the 
drop-down list select one of the following: 

 If Float is selected, the rate comes from the company active exchange rate set 
(Standards & Libraries > Exchange Rate). 

 A Peg rate is locked at the rate set. (Only an administrator can change the 
Peg rate, or Peg to Float or Hedge). 

 If the Hedge selection is Yes, then the Hedge rate is used. Otherwise, the 
Float rate will be used. If an amount is entered for the Rate, then the hedge 
rate is used until the amount specified is reached (by spends) and then the 
system will revert back to the active exchange rate.  

 Click OK to save and exit the Edit Exchange Rate window. 

c. Select a Default Currency from the drop-down list. This will be used as the default shell 
currency. Once you have selected a shell currency and saved the template or shell, it 
cannot be changed. The selections are generated from the Currencies list you defined. 

Note: You cannot modify this default currency after you save the 
changes to the template Detail window. 

7) In the Options tab, you can upload an image file. This image is displayed on landing page of 
the shell in both Administrator and User Modes. Click Browse to browse for the image file 
and then click the Add button. Also, you can select the phase of the shell on this tab. The 
phases available are based on the Phase data definition. 

Within the Shell Details, the user can select which attributes forms to use for the Document 
Manager, for both folders and documents.  
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From the Options tab, the user can define which attribute form (Document Manager 
Attribute Form) to use for the document/folder. By default , the "DMS Attributes" folder 
properties attribute form, which is system-defined in Document Manager, can be selected, 
and the corresponding Document Manager Attribute Form is used to determine the DMS 
structure. The user will have an option to choose other attributes forms as well. Only the 
active DM configuration forms will be available for selection. 

In case a previous active Document Manager configuration (in a shell) is marked as 
inactive, the DMS structure keeps that attribute form structure. When you open the shell 
details, the Document Manager Attribute is defaulted to system-defined attribute form 
because the previous configuration has been marked as inactive. The Document Manager 
Attribute Form User will show the previous DM attribute form that is kept by the shell. If you 
click OK, Unifier displays a message, informing you of this change. 

In case if a previous active Document Manager configuration (in a shell) is deleted because 
the associate folder attribute form was deleted, the DMS structure is defaulted to the 
system-defined attribute form of a supported DMS structure for the shells. When you open 
the shell details, the Document Manager Attribute is defaulted to system-defined attribute 
form because the previous configuration has been deleted. The Document Manager 
Attribute Form Used will show the system defined DM attribute form that is kept by the 
shell. If you click OK, Unifier displays a message, informing you of this change. 

Project/Shell Creation BP behavior

While creating Project/Shell creation BP records, the shell template that has been selected 
via the shell picker keeps the folder properties attribute form that is mentioned in the 
respective templates and have the DMS structure accordingly. 

Company and Standard Projects

The Company Workspace Document Manager is defaulted to DMS attribute which is 
system-defined. 

The Options tab also enables you to select the entity that provides electronic signature 
technology (DocuSign or AdobeSign). For Projects (Standard), the value for the E-Signature 
Type drop-down list is: Company Default. This means that the Company Administrator has 
selected Company Default in the Company Properties > E-Signatures tab. See Edit 
Company (E-Signatures Tab) (on page 66). 

Note: If a value (E-Signature Type) has been determined in the 
Company Properties > E-Signatures tab, the value of the E-Signature 
Type drop-down list (Standards tab) will be read-only. 

You can select a different value from the E-Signature Type drop-down list. 

The Company Administrator can the Company Properties > E-Signatures tab to change the 
default value (Default E-Signature Type). This change does not impact the value of the 
E-Signature Type in the project, and the values will remain as: 

 Company Default 

 DocuSign 

 AdobeSign 
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8) The Options tab also enables you to select the entity that provides electronic signature 
technology (DocuSign or AdobeSign). For Shells, or Shell Templates, the default value for 
the E-Signature Type drop-down list is: Company Default. This means that the Project 
Administrator has selected the Default E-Signature Type in the Company Properties > 
E-Signatures tab as the E-Signature Type for the project. See Edit Company (E-Signatures 
Tab) (on page 66).  

Note: If only one E-Signature provider has been determined in the 
Company Properties > E-Signatures tab, the value of the E-Signature 
Type drop-down list (Standards tab) will be read-only and set as 
Company Default. 

You can select a different value from the E-Signature Type drop-down list. 

The Company Administrator can go to the Company Properties > E-Signatures tab to change 
the default value (Default E-Signature Type). This change does not impact the value of the 
E-Signature Type in the project, and the values will continue to remain as Company Default, 
or as chosen by the Project Administrator. 

9) Complete the Links tab to add links to the shell. These links are displayed on the shell 
landing page in User Mode. Use links to provide users with access to useful websites, your 
company’s website, an intranet, or other destinations. Click Add Row and enter the name 
and URL for the links you want to add to the landing page. 

10) In the Calendar tab, create a shell calendar. Each shell can have its own calendar. The shell 
calendar that you specify can be used to override the Company calendar, or you can use the 
Company calendar for the shell If there is no shell calendar, or a shell calendar is not in use, 
the company-level Standard Calendar marked as the default calendar is the calendar that is 
used by the shell. Shell calendars can be based on Standard Calendars created at the 
Company level, or Custom Calendars created for the specific shell. The shell calendar you 
create applies only to the shell for which you create that calendar. The calendar selected 
affects shell durations and due dates. For example, companies can have multiple projects in 
different countries that have different working and non-working days. These working and 
non-working days must be considered when determining such time-driven factors as 
business process workflow due dates and activity dates in schedule sheets. 

Note: Unless otherwise specified, the default calendar for a shell is the 
Company calendar that is marked as default at the Company level. 

a. Open the Calendar tab of the shell or Template window. The calendar you create in this 
tab is known as the Project/Shell Calendar. 

b. You can select a company-level Standard Calendar, or use a Custom Calendar for your 
shell. The calendar that you select displays in the Calendar tab. 

 To use a Standard Calendar as the shell calendar, click the Standard Calendar 
radio button and select a calendar from the drop-down list. 

 To use a Custom Calendar as the shell calendar, click the Custom Calendar radio 
button and click Copy. You can copy a previously-created Standard Calendar and 
use it as the project calendar. 
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c. You can modify the displayed calendar. You can specify the working and non-working 
days for the calendar. Browse to the month and year using the pull-down menus at the 
top of the calendar. Saturdays and Sundays are set as non-working days by default. Do 
one of the following: 

 To set a particular date as a non-working day (for example, a holiday), click the 
date on the calendar and select Non Working. The date will appear grayed out, 
and will not be used in date calculations. 

 To set a non-working day as a working day, click a grayed cell and select 
Working. 

 To set a particular day of the week (for example, every Saturday) as a 
non-working day, click the day at the top of the calendar (for example "Sat"), then 
click Non Working. All Saturdays in the calendar will be changed to non-working 
days (gray). 

 To set a particular day of the week as a working day, click the day at the top of the 
calendar, then click Working. 

 If you only want to set the day of the week in a particular month as working or 
non-working days, select each day individually and click Working or Non 
Working. 

Note: If you have marked the day of the week as a non-working day 
throughout the calendar by selecting the day at the top of the calendar 
(for example "Sat"), then you will not be able to mark individual days 
(that is, individual Saturdays in this example) as working days. To be 
able to include both working and non-working instances of a day of the 
week on the calendar, you must select them individually. 

d. Click OK. When you click OK, the calendar displayed in the Calendar tab is the shell 
calendar. 

11) Click Apply to save changes as you enter information, and OK when you are ready to save 
information and exit the window. 

In this field Do this 

Description Enter a description of the shell type template. 

Administrator Select an administrator for the template. 

Location Disabled for template creation. 

Status 

You can activate the shell immediately, or place it On-hold and 
activate later. A template that is On-hold or Inactive cannot be 
used to create a shell. It is good practice to leave a shell or 
template On-hold until you have completed the setup. Shell 
Administrators/Users with "modify shell status" rights are the 
only ones who can change the status. 

The Shell Administrator will receive email notification when the 
status of a shell changes. The change of shell status could 
occur due to a manual change, bulk update, through Web 
Services or a CSV file, or through automatic update. 
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Status definitions for shells are: 

 Active: Active, in-progress shell. All shell actions in User 
and Administration Mode are available. 

 On-hold: The initial shell status. On-hold shells appear on 
the shells log. Shell administration functionality is available 
to shell administrators for setup and maintenance for users 
with permissions to perform that function. Users cannot 
create records in a shell that is On-Hold. If a user attempts 
to access a shell that is On-Hold, the system displays an 
alert message stating that the shell is On-Hold. 

 View-Only: For end users, View-Only shells can be 
viewed, printed, exported, and included in reports. They 
cannot be modified. When a shell is View-Only, the status 
overrides (but does not modify) access control permissions, 
granting only View permissions. The shell reverts to the 
access control permissions when the shell is made Active. 
View-Only shells can be added to and removed from 
programs, and can roll up to programs, UDRs, and 
dashboards. Business process records cannot be 
auto-created in View-Only shells. Data from View-Only 
shells rolls up to Generic Cost Manager cost sheets if all of 
the shells in the hierarchy are generic. Data also rolls up to 
the program level cost sheet, if all of the shells in the 
hierarchy are CBS type and are included in the program 
setup, and Schedule Manager information rolls up to the 
program-level Schedule Sheet. Data rolls up to dashboards 
on a View-Only shell from child shells in the hierarchy, and 
rolls up to a parent shell from a View-Only shell. No 
updates can occur to View-Only projects through 
Integration, Mobile, or through reverse auto-population. 
View-Only shells cannot be updated through templates. 
Consolidate line item functionality is disabled for View-Only 
shells. Users can navigate through the shell hierarchy using 
View-Only shell instances. View-Only shells have only view, 
export, and print permissions available. Tasks and Drafts 
are not available for View-Only shells. Messages are 
available, but users cannot add general comments. Mailbox 
is available for viewing, but users cannot send, edit or 
delete messages for View-Only shells. When a shell 
becomes View-only, all scheduled jobs associated with it 
are canceled. When the status of the shell changes back to 
Active, you must restart any scheduled jobs. Administrators 
can perform all actions on View-Only shells. 

 Inactive: Used to suspend shell usage. Inactive shells are 
visible from the Administration Mode under Sponsored 
Shell log only, but not visible under the Shells node (i.e., 
only Sponsor Company can access the shell), or in User 
Mode logs and selections. Only System and Shell 
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Administrators (users with Modify Status rights) can 
reactivate the shell. 

Note: "Late" tasks in an inactive shell may still show up in 
users’ tasks logs. Though they can access the task, no 
transactions can be performed in the inactive shell. 

Auto-update Status 
Setup 

The selections on the drop-down list are defined automatic 
status update setups. These setups are defined at the 
Company level for use in specific shells. See Setting Up the 
Automatic Update of Shell Status (on page 255) for details. If 
you decide not to use the automatic status update, you can 
deactivate it by deselecting a setup (by literally selecting the 
word "Select"). 

Shell Number Unique number that identifies the shell. 

GeoCoding 
Details for mapping. This field appears if geocoding was set up 
in uDesigner for the shell. 

Note: Once a currency is selected and saved, it cannot be modified. The 
remove option is made available to enable you to remove the additional 
currencies and unsaved changes.  

Create a shell template by copying a template or shell 

You can create a Shell Template by copying from an existing shell template or an existing shell. 

To create a shell template by copying an existing shell or shell template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator, then select a shell type. 

3) Select the shell type template you want to copy. 

4) Click Copy button. The Template <shell type name> Cloning window opens. 

5) From the Copy From drop-down list, select one of the following: 

 Template: The log displays the list of shell templates created under the current shell 
type. 

 <shell type name>: The log displays the list of available shell instances. You can select 
one to use for template creation. 

6) Select a listed template or shell name. 

7) In the Select Modules pane, select the modules to include in the new template. The modules 
available depend on the cost code type of the shell or shell template (CBS or Generic). See 
Shell Cloning window selections (on page 159) for the lists of available modules by cost 
code type. 

8) Click OK. The template Detail window opens, displaying the shell template properties. 

Most properties are copied from the original shell or template into the template Detail 
window, with the following exceptions: 
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 Number: On the General tab, enter a Number for the shell template. If automatic 
numbering is specified, this field is read-only. 

 Currency: On the Currency tab, specify the Shell Currency 

 Image: On the Options tab, specify the Shell Image (optional) 

The status is set to On-Hold. 

9) Click OK. Click Yes to confirm. 

Shell Cloning window selections 

In a shell log, when you click the Copy button, the cloning window lists optional calendar, 
module, manager, sheet, and structure selections. You must select an item to include it in the 
new shell. See Create a shell by copying a template or shell (on page 168). 

Cloning window selections for all shell templates and shells (both CBS and generic 
codes) 

 User/Groups: This is not an optional selection; users and groups in a template or shell are 
always included by default. See User and Group Administration 

 BP Setup: You have the option to copy all, or none, of the business processes and their 
setups that are in the template or shell. See General Procedures for Setting up Business 
Processes. 

Templates do not allow record creation of multiple-record business processes, but they do 
allow record creation of single-record business processes under the Information>General 
node. If you added a single-record business process into the template or shell, and created a 
record, that record with all of its data is cloned when you select this option. See 
Single-record business processes. 

 Configurable Modules > Configurable Managers (CM1 through CM25)>: Configurable 
Managers are designed in uDesigner, and have flexible coding structures to data collection 
and analysis. Each manager appears in the module selection pane by its unique name. 

 Custom Calendars: Custom calendars provide a means to address variations in work 
schedules, holidays, and other non‐working days. You can add custom calendars to a shell 
detail form on the Calendar tab. See Creating Multiple Calendars. 

 Dashboard Setup: Shells and templates may have multiple dashboards, each governed by 
unique permission settings. See Creating a shell dashboard in a template (on page 268). 

 Document Folder Structure: Folder templates help standardize document organization in 
the Document Manager. 

 Gates Setup: Gates provide a means of automating when a project moves to the next 
phase. See How to Set Up Gates (on page 259). 

 Resource Manager: Manage personnel resources using the Resource Manager.  

 User Defined Reports: You can create multiple user-defined report templates and include 
them in the new shell during cloning.  

Cloning window selections for only Generic code shell templates and shells 

 Commitment Summaries: In the same way the schedule of values summarizes all cost 
information related to a particular commitment business process, the commitment summary 
tracks commitment record information. See Setting up the Commitment Summary Template. 

 Generic Cost Manager (CM0): The Generic Cost Manager captures cost-related 
transactions for a generic shell. Each generic shell can have one Generic Cost Manager. 
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Cloning window selections only for CBS code shell templates and shells 

 Cash Flow: Cash flow is the distribution of cost over time— in project management terms, it 
is the movement of cash into or out of a project measured during a specific time period. 

 Commitment Funding Sheet: A funding sheet tracks project funding —where it comes from 
and how it is being spent. You can create one funding sheet per template or shell. See 
Setting up the Funding Manager. 

 Cost Sheet: The cost sheet provides detailed tracking of the project's budget and costs. You 
can create one cost sheet per template or shell. See Setting up Cost Sheets. 

 Schedule of Values: The schedule of values summarizes all cost information related to a 
particular commitment business process. See Setting Up Schedule of Values (SOV). 

 Rules: Project cost or funding rules impose conditions on project transactions per rule 
queries. See Creating Rules and Rules Templates. 

 Schedule Sheet: Schedule sheets track project activities and milestones. You can have 
multiple schedule sheets in a project. Once created, they cannot be deleted. 

Shell Template Modules and Managers 

In shell templates you can prepare modules and managers to make standardized templates, 
which ensure project uniformity and greatly reduce the potential for errors. You can have 
different templates for different project models. For example, you can have one template for 
"cookie-cutter" projects that do not change, and you can have another template for projects that 
might incur substantial changes. Unifier will copy any prep-work when you use the template to 
create a new shell, a process called cloning. Manager and module availability can differ 
depending upon CBS or generic code specification in uDesigner. See Create a shell by 
copying a template or shell (on page 168). 

Managers and Modules Available in all Shell Templates (Both CBS and Generic Codes) 

 Member Companies: In order to make partner companies that you added at the company 
level available in your projects, you add them in Member Companies. Member companies 
added to a shell template automatically copy to a shell during cloning. See Managing 
Member Companies (on page 169). 

 Access Control: For modules and managers included in a shell template, you can assign 
user-mode permissions. Permissions set in a template will automatically copy to a shell 
during cloning. Keep in mind, records created in user mode may require permission 
assignment in user mode. See Managing permissions and access control. 

 User Administration: Users and groups added to a template are copied by default from the 
template to a new shell during cloning. See User and Group Administration. 

 Users—Users added to a template automatically copy to the shell during cloning. Users 
added to shell templates cannot be deleted, only inactivated. 

 Groups—Groups added to a template, and any users added to these groups, 
automatically copy to the shell during cloning. 

 Setup: 

 Business Process—You have the option to copy all, or none, of the business processes 
and their setups that were added to a template. See General Procedures for Setting up 
Business Processes. If you added a single-record business process to a template, and 
created a record, that record with all of its data will be copied during cloning. See 
Single-record business processes. 
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 Dashboards—You can define dashboards in a template and opt to include them when 
you clone a new shell from the template. See Creating a shell dashboard in a template
(on page 268). 

 Gates—Gates provide a means of automating when a project moves to the next phase. 
You can define gates in a template and opt to include them when you clone a new shell 
from the template. See How to Set Up Gates (on page 259). 

 Planning Manager—This is where you can plan for new projects, and create proposals 
and forecasts for projects already running in Unifier. 

 Resource Manager—This is where you can set up and manage personnel resources in a 
company, project, or shell. 

 Information: This is where single-record business processes exist. When you clone a 
template, any single-record business processes are copied as well. See Single-record 
business processes. 

 Configurable Modules > Configurable Managers (CM1 through CM25)>: Configurable 
Managers are designed in uDesigner, and have flexible coding structures to allow data 
collection and analysis.  

 Document Manager: You can create a folder structure for the Document Manager that can 
be used across shells. These can be created from Folder Structure Templates, or folders 
can be added manually. Unlike Folder Structure Templates, you can also assign users 
folder-level permissions (if they are in the shell template), and can import folders and folder 
properties.  

 Reports: You can create one or more user-defined report templates, which will be used for 
shell-level user-defined reports. You can import user-defined reports into shell templates 
from shell templates in other companies and Unifier environments, for example from the 
Development/Test environment to the Production environment. See Importing 
User-Defined Reports into Project or Shell Templates.  

Selections available in only Generic code shell templates 

 Configurable Modules > Generic Cost Manager (CM0): The Generic Cost Manager captures 
cost-related transactions in a Generic Shell. These can include costs like rent, lease 
payments, or landscape care that are based on time scales such as monthly, quarterly or 
yearly. Each generic shell can have one Generic Cost Manager. 

 Cost Manager > Commitment Summaries: In the same way the schedule of values 
summarizes all cost information related to a particular commitment business process, the 
commitment summary tracks commitment record information. See Setting up the 
Commitment Summary Template. 

Selections available only in CBS code shell templates 

Cost Manager

 Cash Flow 

Cash flow is the distribution of cost over time - in project management terms, it is the 
movement of cash into or out of a project measured during a specific time period. 

 Cost Sheet 

The cost sheet provides detailed accounting of the project's budget and costs. You can 
create one cost sheet per template or shell. See Setting up Cost Sheets. Tip! Set up the 
standard cost sheet template and copy it into the shell template. 
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 Earned Value 

The earned value module provides quantitative tracking information about project or shell 
status using earned value analysis. You can only set User Mode permissions in a template. 

 Funding 

The Funding Manager helps you to keep track of where project funding comes from and how 
it is being spent. You can create one funding sheet per template or shell. See Setting up the 
Funding Manager. 

 Schedule of values (SOV) 

The SOV sheet summarizes all cost information related to a particular commitment business 
process. This is where you define structures for General Spends, Payment Applications, or 
Summary Payment Applications. 

You can define a General Spends SOV structure by copying from an SOV template in the 
Templates log. 

For Payment Application SOV and Summary Payment Application SOV, the structure is 
copied from the line item grid structure of the Payment Application Business Process. This 
means that you must first complete the Business Process (BP) setup for the Payment 
Application BP before you can create the structure. See Setting Up Schedule of Values 
(SOV). 

Rules

You can define shell-level cost or funding rules. See Creating Rules and Rules Templates 

Schedule Manager

 Schedule Sheet 

A schedule template will be used to create the schedule sheet. Like the cost sheet, once this 
is created, it cannot be deleted. 

 Custom Calendars 

Primavera Unifier allows you to create Custom Calendars to be used by the Schedule 
Manager. 

Shell Templates

If the Data Element (DE) "uuu_int_schedule_type" is not included in the attribute form, then: 

 The template that has the option "Enable P6 sources" selected is not included when you 
want to create a new Cost Sheet using: New > Cost Sheet > Copy from Template.  

 The cost sheet that has the option "Enable P6 sources" selected is not included when you 
want to create a new Cost Sheet by copying a cost sheet from a Shell instance. 

If the DE "uuu_int_schedule_type" is included in the attribute form, then: 

When you add a Cost Sheet to the template (using a standalone template or by Copy from 
other Shell instances), you can select a "Tree" structure cost sheet, only. 

Notes:  

 You can select any Cost Sheet irrespective of whether the option 
"Enable P6 Sources" is selected or not.  

 Once you create a Cost Sheet , the option "Enable P6 Sources" is 
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available for edit. 

 Once you add columns to the Cost Sheet using "P6 Data Sources" 
you cannot deselect the property. 

 If you remove the columns using P6 Data Sources, you can deselect 
the "Enable P6 Sources" option. 

The value for the DE "uuu_int_schedule_type" remains blank because the DE is read-only. 

Document Manager Template 

Use the document manager template log page to create folders, perform actions, update shells, 
and find folders.  

 : Create folders in the template. 

 : Perform the following actions (Export, Import, Index Report, Move, Copy, and 
Delete) on a folder. 

  Find on Page: Find folders by filtering on the various columns. 

 Update Shells: Use this drop-down menu to update the permissions, or the Structure & 
Permissions for a particular shell or all shells. You can also view the update history. 

Note: The Comment, Lock, Ref and BP columns are not displayed in the 
document template log. 

Manage Shell Templates 

To open the shell template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Select a shell type. The shell templates log opens. 

4) Select a shell template from the log and click Open. 

To edit shell template properties 

1) From the shell template home page, click the Open button. The template Detail window 
opens. 

2) Click the tabs to view or edit shell template properties. 

Adding View Forms in Shell Template 

You (the project administrator) can setup the View forms in shell templates. For details, see 
Setting Up View Forms in Shell Attributes.  

When you create shells using shell templates, the View Forms tab information will be copied 
into the created shell. In addition: 
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 All of the View forms that are added in the template will be copied into the created shell. 

 All of the users or groups, who are a part of the viewers list in the View forms, will become 
the members of the newly created shell. 

Setting Permissions to Create or Modify Shell Instances 

To set shell instance access: 

1) In Administration mode, go to the Company Workspace tab and click Access Control in 
the left Navigator. 

2) On the right pane, select Administration Mode Access > Company Sponsored /Shells> 
[shell node]. 

3) See Edit user or group permissions using Access Control, select these permissions 
depending on what access need to be granted: 

 Create: Allows the creation of new shell instances 

 Modify Status: Allows the modification of the status of shell instances 

 Modify Properties: Allows the modification of shell instance properties 

 Configure User Dashboard: Allows the configuration of the shell dashboard in User 
Mode. This is the dashboard listed as My Dashboard in the View Dashboard drop-down 
list that displays for the end user in a shell instance. 

4) Click OK. 

Creating a Shell 

There are multiple ways to create a shell. 

 Manually, from scratch 

 Copying from a shell template 

 Copying from an existing shell 

 Importing via a CSV file 

 Using a shell creation business process 

When you create a shell from a shell template or by copying another shell, any shell dashboard 
that exists in the source template, Unifier copies the dashboard into the destination shell. 

Create a New Shell Manually 

To manually create a new shell 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells in the left Navigator. 

3) Select a shell type. 
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Note: Ensure that you configure and test shells in the Development 
environment before you import the shells into the Test environment or 
Production environment.  

The DE of type Rich Text DE is not available to be added to the 
Company Sponsored Shells.  

4) Click the New button. The <shell> template Details window opens. 

5) On the General tab, complete the fields as described in the first table below. 

The fields in the table here are only the required fields. The shell that was designed for your 
company may include other fields. 

6) On the Currency tab, click the Add button to add a default currency for the shell type 
template. 

Note: You cannot modify this default currency after you save the 
changes to the template Detail window. 

7) Use the information in the second table below to add a currency. 

8) Click the Options tab. 

9) Use the information in the third table below to complete the Options tab. 

10) Complete the Links tab to add links to the shell. These links are displayed on the shell 
landing page in User Mode. Use links to provide users with access to useful websites, your 
company’s website, an intranet, or other destinations. 

a. Click Add Row and enter the name and URL for the links you want to add to the landing 
page. 

11) Click Apply to save changes as you enter information, and OK when you are ready to save 
information and exit the window. 

In this field Do this 

Description Enter a description of the shell type template. 

Administrator Select an administrator for the template. 

Location

The Location picker allows you to change the location of a shell, and 
is accessible when you set up a shell or modify the shell details. See 
Location picker behavior (on page 168) for details. 

Use the Location Picker to select where the shell instance will reside. 
In the Location picker: 

 Find searches the current level 

 Open shows the next level of shells 

 Select completes the action 

 Location Picker will allow breadcrumbs to display through the 
hierarchy 

 Work systematically from the top of the hierarchy to the bottom 

 There must be an instance of a single shell to connect to 

You can use the Location picker to reorganize the shell hierarchy. 
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The shell can move across tabs, or laterally along the hierarchy. 
When you move a shell instance, all of the shell data moves with the 
shell. If an auto-populated business process moves with the shell 
instance, then the auto-populated data moves with the business 
process. Data for the business process will be collected from the new 
shell location. In addition, if a child shell has been designed with 
linked elements, field values on the shell’s attribute form or 
single-record BPs will be automatically updated to reflect changes 
when the shell is moved. 

Status

You can activate the shell immediately, or place it On-hold and 
activate later. A template that is On-hold or Inactive cannot be used 
to create a shell. It is good practice to leave a shell or template 
On-hold until you have completed the setup. Shell 
Administrators/Users with "modify shell status" rights are the only 
ones who can change the status. 

Status definitions for shells are: 

 On-hold: The initial shell status. On-hold shells appear on the 
shells log. Shell administration functionality is available to shell 
administrators for setup and maintenance for users with 
permissions to perform that function. Users cannot create records 
in a shell that is On-Hold. If a user attempts to access a shell that 
is On-Hold, the system displays an alert message stating that the 
shell is On-Hold. 

 Active: Active, in-progress shell. All shell actions in User and 
Administration Mode are available. 

 Inactive: Used to suspend shell usage. Inactive shells are visible 
from the Administration Mode under Sponsored Shell log only, 
but not visible under the Shells node (i.e., only Sponsor 
Company can access the shell), or in User Mode logs and 
selections. Only System and Shell Administrators (users with 
Modify Status rights) can reactivate the shell. 

Note: "Late" tasks in an inactive shell may still show up in users’ 
tasks logs. Though they can access the task, no transactions can be 
performed in the inactive shell. 

Shell Number Unique number that identifies the shell. 

GeoCoding
Details for mapping. This field appears if geocoding was set up in 
uDesigner for the shell. 

Currency 
Name

Select the currency you want to use for the cost functions in this 
project. 

If the currency you selected is other than the company Base 
Currency, then complete the following fields. 

Rate

Enter an exchange rate to use for conversion calculations. From the 
drop-down list select one of the following: 

If Float is selected, the rate is updated automatically from the 
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company currency table (Standards & Libraries > Exchange Rate). 

A Peg rate is locked at the company rate on the day the rate is set. 
(Only a Project Administrator can manually modify the Peg rate to a 
value other than the company peg rate.). 

Hedge?
If the Hedge selection is Yes, then the Hedge rate is used for 
conversion calculations. Otherwise, the Float rate will be used. 

Rate
If an amount is entered for the Rate, then the hedge rate is used until 
the amount specified is reached (by spends) and then the system will 
revert back to the normal rate. 

Amount

If Float is specified, Primavera Unifier will retrieve the rate, based on 
today’s date and time. 

If Peg Rate is specified, the field will be editable. 

Comments
(Optional) Add any comments that might be necessary to explain the 
default currency. 

Image
(Optional) Upload an image file. This image is displayed on landing 
page of the shell in both Administrator and User Modes. Click 
Browse to browse for the image file and then click the Add button 

Phase
(Optional) Select the phase of the shell on this tab. The phases 
available are based on the Phase data definition 

Shell Email

Email Address

The Email Address field shows the dedicated email "mailbox" that is 
automatically created for the shell. (For information on this mailbox, 
see Dedicated Mailbox for the Shell (on page 145).) 

You can distribute this shell email address to all users, both within 
and outside of Primavera Unifier, who will participate in the shell. To 
do so: 

Click the Send Email button. An email message window opens. 

In the To field, enter the email addresses of all participants in the 
shell. 

You can also send the address of the dedicated mailbox to external 
users by adding their email addresses in the External Cc field. 

Click the Send button. 

Note: You can also create a link on the shell dashboard that users 
can use to distribute this email address to shell users. ( 

Shell Email

Send 
Notification To

Use this field to send notification to users in the shell whenever the 
shell mailbox receives an external email. To do so: 

Click the Select button. The User Picker opens. 

Select the users you want to notify and click OK. 
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Location picker behavior 

The Location Picker opens when you click the Location Select button. This is an example of a 
Location picker: 

In this example there are two single instance shells, Facility Management and Project 
Management. You can use this Location picker to select a shell instance. The multiple instance 
shells are listed under the single shell instances that are represented as tabs. You can select a 
tab on which the shell is listed on the organization configuration. 

When this picker is opened first it displays the instance of single shell. In this example it is 
showing All Facilities. If Project Management tab is clicked then you should see the single 
instance shell created under that tab. You can now select this instance by highlighting it and 
clicking the Select button. If you want to drill down to another shell instance which is created 
under this single shell instance, you can navigate to it by selecting the single instance shell and 
double clicking or selecting a shell and clicking the Open button. 

Create a shell by copying a template or shell 

You can create shells using the shell templates you created. You can also create shells by 
copying from existing shells. You can verify the shell properties, make changes as necessary, 
update status, or activate as necessary. 

Note: As Shell Administrator, you can receive email notification of the 
successful creation of a shell. This notification can be set up in email 
notifications in uDesigner. Also, you can set your User Preferences to 
control whether you receive these notifications. 

Creating a shell from a shell template or another shell, copies shell dashboards in the source 
template or shell to the destination shell. You can choose to copy any existing Custom 
Calendars from the template or from an existing shell. 

To create a shell from a shell template or existing shell 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells in the left Navigator. 

3) Select a shell name. 

4) Click the Copy button. The Shell Cloning window opens. 

5) Click the Copy From drop-down list and choose Shell to copy an existing shell, or Template
to copy a shell template. 
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6) Select a shell or template from the list and click OK. 

To search for a specific shell or template in the list, click the Filter By field and select Name
or Number. In the Filter For field, enter all or part of the name or number to search for and 
click Search. 

7) In the Select Modules pane, select the modules to include in the new shell. Users and 
Groups are selected by default and copied along with the shell properties. See Shell 
Cloning window selections (on page 159) for a discussion of the modules available for 
selection in the type of shell you are cloning. 

Note: When you copy a shell or template, you also copy existing setups 
in the modules you selected. If you select BP Setup when you copy a 
template, you will copy any existing business process setups, including 
those for any single-record business processes (SRBPs). SRBP setups 
and record data are copied along with everything else. 

8) Click OK. The Shell Details window opens, displaying the shell properties. 

Most properties are copied from the original template with the following exceptions: 

 Number: On the General tab, enter a Shell Number 

 Currency: On the Currency tab, specify the Shell Currency 

 Image: On the Options tab, specify the Shell Image (optional) 

9) When you finish completing the shell details, click OK. Click Yes to confirm and create the 
new shell. 

Managing Member Companies 

If your company has set up Partner Companies, those companies can become eligible to be 
added to shells. When added to a shell, these companies become Member Companies, and 
their users can participate in shells with any permission level you set for them. 

Note: The list of eligible partner companies is maintained in the Partner 
Companies log. In Administration Mode, navigate to Company>Partner 
Companies to view the list. 

Add a member company to a shell 

Active partner company users (users with a unique Unifier user name, and status of Active or On 
Hold) can be added to shells and assigned permissions, just like sponsor company users. 

To add a member company to a shell 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > <shell name > <project name > Member 
Companies in the left Navigator. The Member Companies log opens. 

3) Click the Add button. The Add Member Companies window opens. This window lists the 
available partner companies that can be added to the shell as a member company. 

You can click the Find button to search for a particular company by Company Name or 
Contact Name. 

4) Select one or more companies from the list and click the Add button. 
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5) At the confirmation window, click Yes. The company is added to the Member Companies 
log. 

View member company profile 

To view a member company profile 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [shell] > [shell instance] > Member Companies in 
the left Navigator. The Member Companies log opens. 

3) Select a company from the list and click Open. The Company Profile window for the 
company opens. This is a view-only window. This information is maintained by the partner 
company’s administrator. 

4) Click the General tab to view general information, and the Address tab to view contact 
information. 

Remove a member company from a shell 

You can remove a member company from the shell’s Member Companies list. When a member 
company is removed from a shell, users belonging to the member company will be automatically 
inactivated for that shell. 

To remove a member company 

1) Select the company and click the Remove button. 

2) At the confirmation window, click OK. This will remove the selected company from the list 
and inactivate any users who have been added to the shell. 

Managing Shell Users and Groups 

This section discusses adding groups and users to shells, managing shell groups, and 
managing shell permission levels. 

Add a user to a shell 

After you have created a shell, you will need to add users to the list of approved shell users. 
Shell users can be from your own sponsor company, or from approved member companies. 

When adding users from your company to the shell: 

 To add users from your own (sponsor) company, the user must be either Active or 
On-Hold at the company level. When added, the user will automatically be Active for the 
shell. 

 Users who are inactive at the company level cannot be added to a shell. 

When adding users from a partner company to the shell: 

 In order to add a user from a partner company, the company must first be added to the 
Member Companies list for the shell. The user must be either Active or On-Hold at the 
company level. When added, the user will automatically be Active for the shell. 
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 The user does not necessarily need to be listed in the Partner Users log at the company 
level in order to be added to a company. If the user is listed in the Partner Users log, the 
user must be Active or On-Hold. If the user is not already in the Partner Users log, they 
will be automatically added to the list of Partner Users with a status of Active. 

To add users to a shell 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [shell name] > [project name] > User 
Administration > Users in the left Navigator. The Users log opens. The log lists all users 
that are already part of the shell. 

3) Click New. The User/Group Picker opens. 

Note: If a User Attribute form has been imported, the shell user log will 
reflect the design of any designed Partner Log included in that form. See 
Importing a User Attribute Form for details. 

4) Click the List Names from drop-down list at the top of the picker window and choose the 
company from which to add the new shell user. 

This drop-down lists your sponsor company plus any member companies that have been 
added to the shell. You can click the Member Companies node under the shell to view the list 
of available member companies. 

Note: By default, new users will have a status of Active. You can 
change the status or other user detail information selecting the user from 
the list and clicking Open. 

5) Select one or more users to add to the shell. You can press the Shift or Ctrl keys to select 
multiple users at once. 

6) Click the Add button. You can continue to select and add names to the Selected Users 
portion of the picker window. 

7) Click OK to add the users to the shell. The new users are listed in the Users log. 

To add a user to a shell template 

Open the shell template and navigate to User Administration > Users. Follow the steps above 
to add a sponsor company or member company user to the template. 

View or edit a shell user’s profile 

You can edit a shell user’s details. These procedures apply to sponsor company users and 
member company users. 

To view or edit a shell user profile 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [shell instance] > User Administration > Users in 
the left Navigator. The Users log opens. 

3) Select a user from the list and click Open. The Edit Shell User window opens. The window 
has the following tabs: General, Groups, Permissions and Custom. 
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Note: If a User Administration design has been imported from uDesigner 
by your Administrator, the content of this profile can vary. 

4) In the General tab, review the contact information for the user as it will appear in the Shell 
Directory. By default, the shell address (as defined in the shell details) displays as the 
contact address. You can edit this information as necessary. 

You can also modify the user's shell status: 

 Active: User is listed in Shell Directory, in User/Group Picker, User can log in and 
participate in the shell. New users are Active by default. 

 Inactive: If you deactivate a shell user, the user’s name will not appear anywhere for 
selection on any shell-related functions. The user will not be able to access the shell. 
Inactivating a user at the shell level does not affect their status on other shells. 

 On-Hold: User can be added to a shell, or assigned as a participant in a business 
process workflow but cannot log in. 

5) Select the Show user on the Shell Directory option, if you want the user's information to be 
viewable in the Shell Directory. 

6) In the Groups tab, you can add or remove the shell users to a shell-level group the same 
way that you add company users to company groups. Click the Add button to add a group to 
the user’s list, or select a group and click Remove to remove the user from the group. 

7) In the Permissions tab, you can assign shell-related permissions to the user, by module and 
mode. 

8) In the Custom tab, you can view available custom attributes that may have been added to 
the user form. 

Create and Manage Shell Groups 

Groups are a way to aggregate Users together so that adding new team members to the shell 
and assigning permissions can be done quickly and efficiently. For example, groups can be 
members of the same shell team, and/or they can be users who share the same access 
privileges. At the company level, groups can span shells. At the shell level, all members of a 
group are members of a given shell. Different members of a shell may have different access to 
Unifier functionality, depending on their role on the shell. 

For example, a Finance person might require access to cost modules and reports dealing with 
finances, but not RFIs or Transmittals and their associated reports. An Executive might require 
access to Summary financial information, and not the cost BPs. 

As users are added to a Group, they will inherit the Group’s permissions. If they are in more than 
one group, then the highest level of permissions granted in any group for a module will prevail. 

When adding users to the group, you can choose eligible users from the sponsor company and 
any partner company users. The company short name will be listed in the User Picker window 
next to each user. 

Company level groups cannot be copied into a shell. 

To create a new group 

1) Open the shell and switch to Admin mode. 
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2) Click Company Sponsored Shells > [shell] > [shell instance] > User Administration > 
Groups in the left Navigator. The Groups log opens. 

3) Click New. The Groups window opens. 

4) Complete the General tab: 

 Group Name: Enter a name for the group 

 Manager: Click Select and select a user from the User Picker window. This is the person 
who will be responsible for administering the group. 

 Description: Enter an optional description for the group. 

5) Click the Members tab. This is where you add and manage group membership. 

a. Click Add. 

b. From the User/Group Picker, select the users to add to the group and click Add.

c. Click Ok. 

6) Click the Permissions tab. In this tab, you manage group permission settings. If a user is a 
member of the group, the user will inherit all group permissions. 

Granting permissions to the group is similar to granting permissions to individual users. 
Choose the shell-related permissions for the group that will apply to all members assigned to 
this group. Choose permissions by module and mode. 

7) In the Custom tab, you can view available custom attributes that may have been added to 
the group form. 

To edit group information 

1) Open the shell and switch to Admin mode. 

2) Click Company Sponsored Shells > [shell] > [shell instance] > User Administration > 
Groups in the left Navigator. The Groups log opens. 

3) Select a group and click Open, or double-click the selected group. The Groups window 
opens. 

4) Make changes as necessary and click Ok. 

Grant shell user permissions through Shell Access Control 

Once you have created a shell, assign permissions to the people who need to access the shell. 
You can use Access Control to grant multiple Users or Groups permission simultaneously, rather 
than editing the properties for each User or Group individually. 

To view or change a shell’s access control 

Do either of the following: 

 Open the shell and switch to Admin mode. Click Access Control in the Navigator. 

 Go to the Company Workspace tab and switch to Admin mode. Click 
Company-Sponsored Shells > [shell type] > [shell] in the left Navigator. Then click 
Access Control in the Navigator. 

Unifier displays a copy of the Navigator menu in the right pane of the window. In this right pane, 
you may click on different modules of the Navigator menu to set permissions for those functions. 
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Generate and print access information report 

You can generate and print an Access Information summary of user and group access 
(permission settings). The report will display all user and group permissions. 

To generate the Access Information report 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [shell] > [shellinstance] > Access Control in the 
Navigator. 

3) Click the Access Information button. The Access Information window opens. It may take 
several moments to generate the report. 

To print the Access Information report 

1) Generate the Access Information report. 

2) Click the Print button. (When the report is complete, the Print button becomes available.) 

Create new shells using an imported CSV file 

An Integration interface must be created for shell creation to work via CSV file. 

To create new shells using an imported CSV file 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells in the left Navigator. 

3) Select a shell type. 

4) In the shell log, click Export Template. 

5) Complete the shell creation template CSV file. Some hints: 

 The shell location must have a leading /. Be sure to use the true shell name as entered in 
the Shell Manager configuration. 

 Shell statuses are Active or Inactive. Use initial capitalization. 

 Administrators must be valid users. You might enter the user’s full name (for example, 
Henry James) or the system user name (for example, hjames) depending on the 
configuration. 

 If using currency override, be sure the currency is active in Exchange rates and the CSV 
file contains a valid currency code. 

6) In the shell log, click Import. 

7) Select the modules to include in the shell. 

8) Select the template from the listed templates and click OK. 

9) Browse for the CSV file. 

10) Click OK. 

Reasons for a Shell Creation business process CSV failing to import 

1) Any incorrect rows will cause the CSV upload to fail and an error message will display the 
incorrect row number. 

2) Incorrect shell location used (this has to be set up before importing a CSV.) 
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3) Invalid shell name or number. 

4) The location on the imported CSV file is not a valid parent location. 

5) The sub-shell of the type that you are importing was not configured under the parent location 
specified. 

6) Currency override used an invalid currency code or the currency was not active in Exchange 
rates. 

Notes: 

 If shell creation fails, the user who attempted to import the CSV will 
get an email notification of the import failure.  

 When creating a shell through CSV, the Document Manager attribute 
form that is associated with the template, or shell instance, will be 
copied over to the new created shell.  

Create shells with the shell creation business process 

Before you begin, review these conditions for successful Shell creation from the Shell creation 
business process: 

 Shell creation business process must be designed and deployed in uDesigner and 
configured and set up in Unifier. 

 Shell template must be created 

 Shell hierarchies must be correctly configured in Shell Manager 

 Shell number must be unique 

 Shell override currency, if it is to be used, must be active in Exchange Rates 

The shell creation business process can synchronously auto-create a multiple-instance CBS or 
generic shell anywhere in or across a shell hierarchy. The business process uses a shell 
location picker to assign where the shell will reside in the hierarchy, and a shell picker to select a 
template. This means shell organization must be correctly configured in the Shell Manager and 
the shell template must be created. 

The shell creation business processes designer can define the business process as company 
level or shell level. The designer may use workflow to support review and approval processes, or 
elect to design the business process without workflow. At run time, Unifier passes select 
information captured in the business process form to the newly created shell, thus avoiding 
redundant data entry. Reaching terminal status, as defined in uDesigner, triggers the 
synchronous shell creation process. If there is a planning item picker on the shell creation 
business process record or line item Unifier will link the planning item to the new shell. 

Notification 

Unifier will send an email notification upon successful shell auto-creation, provided notification is 
set up in business process setup, Unifier has a valid email address for anyone selected to 
receive notification, and those selected subscribe to email notification in user preferences. If 
auto-creation fails, Unifier will immediately send an alert to those selected to receive notification. 

There are two types of shell creation business processes: simple and line item. 

 Simple-type 



Unifier General Administration Guide

176

The simple-type shell creation business process creates one shell per record. Reaching a 
terminal record status, as defined in uDesigner, triggers the synchronous shell 
auto-creation process. The business process designer has the option to either define 
workflow or not. In uDesigner the designer can define integration; in Unifier you can 
obtain the business process import template from the business process log. 

It is important to note that the CSV import template must be correctly completed or Unifier 
will reject the CSV file in its entirety and not create any shells. When Unifier rejects a 
CSV file it creates an error file that tells you which line item is in error and why it is in 
error. To ensure a successful upload of the shell creation business process CSV file, 
retain the column headings in the same order as exported, and complete all required 
fields. 

 Line Item-type 

The line item-type shell creation business process creates a shell for each line item. Use 
the upper form to create the parent shell and each line item to create a child shell. 
Auto-creation happens when: 

 Record terminal status is reached, as defined in uDesigner 

 Line item status is met, as defined in uDesigner 

 A line item passes validation 

At run time, when Unifier processes a line item-type shell creation business process 
record, it will create a new shell from each line item that passes validation. For 
example, if there are 10 line items in the shell creation record, but only five pass 
validation, Unifier will create five shells. Shell creation line items can be consolidated, 
provided consolidation is configured in uDesigner. 

CSV Import or Restful Services (Create Shell) 

When you create a shell instance by using CSV import or Restful Services (Create Shell), the 
system copies into the created Shell:  

 The View Forms tab information from the selected shell template. 

 The forms added in the shell template, along with users and groups who are part of the 
viewers list. 

Integration Tab 

The Integration tab in shell template attribute window is used to map multiple P6 projects with 
the respective Unifier shell. 

Note: The mapping is used for Activity Sheet, only. Mapping does not 
have any impact on the existing summary sheet. For details about 
summary sheet see Setting Up and Managing Asset Sheets. 

The Integration tab in shell template attribute window has the following options: 

 Add

 Remove

 Apply

 OK
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 Cancel

The Integration tab in shell template attribute window has the following columns: 

 Project ID

An alphanumeric field that can be populated using Add. The Project ID cannot be modified 
or removed from this tab. 

 Project Name

 Schedule Type

While you create the mapping, you are required to enter only the Project ID (marked as 
mandatory field). Unifier populates the other columns (Project Name and Schedule Type) when 
you run project synchronization. 

When you add projects, using this tab, to create an Activity Sheet: 

 You cannot modify, or remove, a Project ID. 

 If the Link Multiple Projects option is not disabled, then the system uses synchronization in 
multiple P6 projects. 

If the user decides to change the existing mapping setup (Activity Sheet), Unifier replaces the 
existing Activity Sheet with P6 projects after the next synchronization. 

If a user tries to remove (Remove) a project that is mapped to an Activity Sheet, unifier cannot 
process the change because the schedule for the project is present in the Activity Sheet. 

You can integrate multiple P6 projects into one Unifier project.  

 When you integrate (Project ID mapping) a P6 project into a Unifier project through the 
General tab of the Shell Attribute form, Unifier updates the Schedule Type field in General 
tab. The General tab is mostly used for one-to-one integration (one P6 project mapped to 
one Unifier project). 

 When you integrate (Project ID mapping) multiple P6 projects into one Unifier project through 
the Integration tab of the Shell Attribute form, Unifier does not update the Schedule Type
field in the General tab. In the Integration tab, the Schedule Type column is updated. The 
Integration tab is mostly used for many-to-one integration (many P6 projects mapped to one 
Unifier project). 

CBS Type Shell for a Non-EVM User 

Updating a CBS type shell 

In a CBS type shell, when a non-EVM user opens the shell details (My Dashboard ... > 
Details), the non-EVM user can click the Integration tab to add only one P6-related project 
(click the plus sign symbol: Add Project ID). If there is an Activity Sheet available, and the 
user decides to add a schedule for the project, then Unifier will display a message informing 
the user that the existing schedule in the Activity Sheet will be replaced with the added 
schedule for project. If the user selects Yes, then the new schedule will be included in the 
Integration tab and the Add External Project ID option becomes disabled. 

Use the gear menu to delete the added, or existing, schedule for project. 

Once non-EVM user add a new schedule for project and clicks Save, the shell dashboard 
page opens and displays the new schedule project information in the Details block. This 
enables the non-EVM user to proceed with the data synchronization. 
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To synchronize data: 

 Click the EVM node to expand (from the left Navigator). 

 Click Activity Sheet sub-node. The Activity Sheets log window opens. 

 Click the Get Data icon. The Get Data window opens.  

 Click inside the Project field and add the schedule for project. 

 From the Activity Sheets log window (on the right-hand panel), click the History tab, 
and click the Refresh icon. 

 From the Activity Sheets log window (on the left-hand panel), click the activity sheet to 
open it. 

The Activity Sheet log window lists all of the activities for the added schedule for project. 

Similar to an EVM user, a non-EVM user can use the following tabs of the Activity Sheet log 
window (on the right-hand panel) to see more information: 

 General

 Assignments

 Audit Log

The non-EVM user can click on the Assignments tab, click on the gear menu of resource, 
and perform the following: 

 View Assignment Spread

 Assign CBS

 Assign Rate Source

The non-EVM user can click on an activity (in the Activity Sheet log window) and select the 
following options: 

 View Activity Spread

 Assign CBS

The non-EVM user cannot add a column to the WBS Sheet (WBS Sheet sub-node, from the 
left Navigator). The same limitation (inability to add column) applies to the Cost Sheet
(Financial Reporting node > Cost Sheet sub-node, from the left Navigator). 

Creating a CBS type shell

When creating a new CBS type shell (Company Workspace (Admin mode) > Company 
Sponsored Shells > Projects), a non-EVM user can use the Integration tab to add a single 
source project ID (click Add). 

CBS Type Shell for an EVM User 

The shell Integration tab enables you to link to a single or multiple Primavera Cloud projects.  

 Users with EVM license can add multiple Oracle Primavera Cloud projects to be linked to a 
Unifier project.  

 Users without EVM license will be able to link to a single Oracle Primavera Cloud project 
using the Integration tab. 
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You can add the Primavera Cloud Project ID using the Add option in the Integration tab. All 
validations (regarding valid project ID, duplicate Project ID, etc.) will take place when you add a 
Project ID in the Integration tab. The Project Name and Schedule Type columns will be 
read-only, and the values will be populated once the Oracle Primavera Cloud project is 
synchronized with the Unifier project. 

The Project Name value will populate with the name of the Oracle Primavera Cloud project, and 
the Schedule Type will be populated with the default value: Duration. The following other fields 
(in shell details) are populated if the shell is synchronized with the Oracle Primavera Cloud 
project, using the Project Number from the shell attribute form: 

Shell 
Status

Populated with a valid status value. It can be: Active. 

Note: The Shell Status will be populated or updated only when the shell instance is created by using a new 

OOTB synchronization from Gateway (Send Activity data from Primavera Cloud to Unifier). When a user 

gets activity data using the Get Data option in the Activity Sheets log, the value of the Shell Status will not 

be updated. 

Project 
Start Date

The start date of the project, received from the Oracle Primavera Cloud 
project. This data element in the shell attribute form will get updated only 
when a project is created from the Gateway. 

Integrated 
with

This data element in the shell attribute form will be populated as: 
Primavera Cloud. 

Note: For projects that are integrated with Oracle Primavera Cloud using 
the shell Integration tab, the Shell Status and the Project Start Date will 
not be updated. 

Project Mappings in Gateway

Oracle Primavera Cloud Gateway Unifier 

projectName Name ProjectName 

dataDate DataDate Data_date 

projectCode Id ProjectNumber 

Start Date DataDate uuu_project_start_date 

status Status uuu_shell_status 

The plus (+) option will be disabled once you add the Oracle Primavera Cloud Project ID, and 
the data from Oracle Primavera Cloud project will be synchronized with the Unifier project in 
case the user does not have an EVM license. 

A user with an EVM license will be able to add multiple Oracle Primavera Cloud Project IDs, and 
the data from multiple Oracle Primavera Cloud projects can be synchronized with the Unifier 
project. Furthermore, the Schedule Type field will be shown as 'Duration' for all of the Oracle 
Primavera Cloud projects in the Integration tab of shell details. In the shell details General tab, 
the field Integrated with is populated as: Oracle Primavera Cloud. 
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Managing Shells 

You can verify the shell properties, make changes as necessary, update status, or activate as 
necessary. It is recommended that you keep the company progress information up to date to 
reflect the ongoing status and progress of the shell. 

You can also modify shell information in a shell type template and then update one or more 
existing shells by "pushing" the information from the template to the shells (see Updating Shells
(on page 183)). 

To open a shell 

Click the tab for the shell. The shell landing page opens. 

To edit an existing shell 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells in the left Navigator; select the shell instance, click to 
open the shell (from the log). The shell window opens. Click My Dashboards, and then click 
Details to open the Details page. 

3) Modify the shell information as necessary. 

You can modify any of the shell properties any time during the shell duration, except for the 
shell currency. Once a shell is set up, the shell currency is locked. 

The Location picker allows you to change the location of a shell, and is accessible when you 
set up a shell or modify the shell details. See Location picker behavior (on page 168) for 
details. 

Use the Location Picker to select where the shell instance will reside. In the Location picker: 

 Find searches the current level 

 Open shows the next level of shells 

 Select completes the action 

 Location Picker will display breadcrumbs through the hierarchy 

 Work systematically from the top of the hierarchy to the bottom 

 There must be an instance of a single shell to connect to 

Note: You can use the Location picker to reorganize the shell hierarchy. 
The shell can move across tabs, or laterally along the hierarchy. When 
you move a shell instance, all of the shell data moves with the shell. If an 
auto-populated business process moves with the shell instance, then the 
auto-populated data moves with the business process. Data for the 
business process will be collected from the new shell location. In 
addition, if a child shell attribute form or a single-record BP in a child 
shell has been designed with linked elements, the child shell attribute 
data and BP data will be automatically changed to reflect the new parent 
shell’s current attribute values. 

4) Click Save to save your changes and exit the Details window. 
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To deactivate an existing shell 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells in the left Navigator; select the shell instance, click to 
open the shell (from the log). The shell window opens. Click My Dashboards, and then click 
Details to open the Details page. 

3) On the General tab, go to the Status field and select Inactive. 

Note: If you deactivate a single instance shell (a shell that displays in 
Unifier as a tab) you cannot access that shell again to activate it. The tab 
will persist, but not be accessible. 

4) Click Save to save your changes and exit the Details window. 

To copy the customized user attributes from the company-level directory  

You can copy (bulk) any customized user attributes from the company-level directory and paste 
them into the shell. 

1. Go to your company (Company Workspace) and switch to the Admin mode. 

2. In the left-hand Navigator, click Company Sponsored Shells node to expand. 

3. Click Projects sub-node to open the Projects log. 

4. From the toolbar, click Export to expand the menu. 

5. Click Export Users to expand the menu, select one of the following options, and follow 
the prompts: 

a. All Shells

b. Selected Shells

After your selection, Unifier will download (bulk) an Excel sheet (CSV file) with all the existing 
users. Click Yes, to copy the company-level directory values under the Copy Attributes column, 
for the shell. 

If you do not click Yes, no values will be copied from the company-level directory. 

To complete the importing of the values: 

1. From the toolbar, click Import to expand the menu. 

2. Click Import Users to expand the menu, select one of the following options, and follow 
the prompts: 

a. All Shells

b. Selected Shells

Proceed with importing the values by uploading the Excel sheet (CSV file). Unifier will update 
(bulk) the user attributes data elements and their values. 

When creating a new project or shell through the New option, you must either add user manually 
or through a CSV file. After creating the new project or shell, you can import the information. If 
you add user manually, the Copy Attributes from Company Workspace option (in the 
General tab of <shell> > User Administration > Users or Groups) enables you to import the 
values in the Copy Attributes column of the CSV file. 
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If you copy user attributes values from a shell template, the shell template attributes for the 
Users are copied over, also. 

By default, Unifier adds the project administrator to any newly created, or copied, shell. In this 
scenario, the additional attributes will not be copied. 

Packaging Single Instance Shells 

You can package Single Instance Shells that exist in the Development/Test environment in 
order to transfer the Configuration Package to the Production environment.  

The Configuration Package that you create will include: 

 The Shell details data (data from all tabs in the Shell). 

 The currency defined in the Currency tab and if the selected currency does not exist in the 
destination environment, the system will create it. 

Note: The Currency attributes such as Code, Name, Symbol, and so 
forth are not updated when you import the Configuration Package, and 
after you create the shell, the Currency tab content will not be updated 
upon subsequent imports. 

 The calendar from the Calendar tab  and if the selected calendar does not exist in the 
destination environment, the system will create it.  

The following Shell details are included in the Single Instance Shell: 

Note: The following Shell details are exported and imported to the 
destination environment on the first import, only. No subsequent updates 
of Shell details data can be performed in the destination environment. 

 Shell data that exists in the form for the following fields: Shell Name, Shell Number, 
Administrator, and Shell Status. 

The Shell log window is a user-defined log, and the user-defined columns appear next to the 
system-defined columns. 

When you create a Single Instance Shell Configuration Package successfully, the system 
stamps the Shell with the Last Packaged Date. 

Shells cannot be created if they are not activated in the Configuration module, so the 
configuration of the Shell will be included in the Shell Configuration Package at the time of 
transfer between environments. 

Note: The contents of the Organize tab, which defines the Shell 
hierarchy, will be included. 
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Updating Shells 

The Update Shells function allows you to quickly add or modify information into a shell template, 
and then apply that template to existing shells. This will "push" the new information to the shells 
that you specify. By allowing data to be entered or modified once, this function helps to reduce 
set up time and ensure cross-shell uniformity. 

The Update Shells function is available for select modules in shell type templates. Go to: 
Company Workspace > Admin mode > Templates > Shells 

Note: When you copy a Setup (Company Workspace > Admin mode > 
Templates > Shells > Projects > … > Setup > …) from a Shell template, 
the fields in the shell details block all will be copied.  

The modules that you can update are listed below. 

 Users: users, group membership, permissions 

 Groups: group names, permissions 

 Business Processes and BP Setups: Business processes, setups 

 User-defined Reports: Reports, report permissions 

 Access Control: modules, users, groups, permissions 

 Cost Sheet: Cost sheet columns, column access and restrictions 

 SOV: General and Payment Applications structures 

 Commitment Funding: Commitment funding sheet structure 

 Cash Flow: Properties and permissions 

 Rules: Cost or fund rules 

 Schedule Sheet Properties: title, description, Master Schedule, status, auto-control, 
project start date, and error notification. Updating Schedule Sheet Properties from 
Templates 

 Gates: Active or Inactive setups 

 Shell Instance Dashboards: dashboards created at the shell level, and are available for 
users to view (but not edit) with granted permissions 

Each of these modules has an Update function where you can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form (designed in 
uDesigner). This makes targeting shells with specific information possible. For example, if you 
add new users, to the company, and need to add them to many shells, but not every shell, you 
can add them to a shell template and use the Update Shells functional to add the users to only 
those shells that require them. 

Shells with a status of Active or On-Hold can be updated with this functionality. Inactive or 
View-Only shells cannot. Users with create permission for the shell type template modules can 
do this operation. 
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Note: You update shell information one module at a time. Any Active or 
On-hold shells can be updated in this way. 

When you create a configuration package for your shell templates, the system includes the 
following configurations from the selected component list:  

 All shell templates that are included in the component list. 

 Content of the shell template. 

 Configuration of selected shells and business processes. 

You can package the shell templates that exist in the Development/Test environment and 
transfer the configuration package to the Production environment, and your configuration 
package will include the shell details data (data from all tabs in the shell setup). 

Currency

The currency, defined in the Currency tab, is included as a part of the configuration package. If 
the selected currency does not exist, then the system creates one in the destination 
environment. The currency attributes such as Code, Name, Symbol, and so forth cannot be 
updated by means of configuration package import. The Currency tab content is update upon 
every import. If the exchange rates, defined for currencies in the source shell template, do not 
exist in the destination environment, then the system creates a new exchange rate record for 
that currency and that exchange rate will be set to Active, and: 

 The Effective is set to the configuration package Import Date. 

 The Peg rate is brought over from the source environment. 

 The Float rate is brought over from the source environment, if the rate does not exist in the 
destination environment. 

Calendar

The calendar, from the Calendar tab, is included as a part of the configuration package. If the 
selected calendar does not exist, then the system creates one in the destination environment. 

Shell Details

The following shell details, in the form, will be exported and imported in the destination 
environment upon every import: 

 Text fields, Pull downs (Integer and String), Radio buttons, check boxes, Integer, Decimal 
and Currency Amounts and Dates. The dataset values, or the default values, will not transfer 
unless you include those in your configuration package. 

Note: Any picker that refers to some other design object like BP pickers, 
data pickers, and so forth will not be included. 

 The contents of the Organize tab (shell configuration), which defines the shell hierarchy, will 
be included. This includes the defined sub-shells. 

Shells cannot be created if you do not activate them in the Configuration module. 

The configuration package creation will fail if: 

 The design of the included shell is not a part of the component list. 
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 The shell design version that is included in the component list does not match the deployed 
Shell design version. 

Business Processes

 A Shell Template can have several Business Processes in the Development/Test
environment. 

 Only those Business Processes that have been included in the configuration package, 
marked as publish for production, can be transferred to the Production environment. 

 The configuration package can contain Workflows that have been setup (activated in 
Configuration module). If there are multiple Workflow setups in a Business Process, then all 
the setups are included in the configuration package, regardless of the status. 

 Business Processes, and other design objects, in a template depend on their setups in the 
Configuration module. Only the configuration setups of the Business Processes, and the 
Shell that the Business Process resides in, are included in the template can be a part of the 
configuration package. 

 In Workflow setups, where additional filtering on assignees exist for steps, the published 
design for user attribute form in the configuration package must include the deployed design. 

 In Workflow setups, in case the Advance workflow when next step is determined option 
is selected:  

 When the user updates shells (Update Shells option), all of the shells (or the selected 
shells) will receive the next step setup. 

 When the user updates a BP setup, from an environment different than the current 
environment, then the next step setup will be imported.  

User-Defined Reports (UDRs)

You can transfer User-Defined Reports (UDRs) that have been included in a Shell Template 
(Company Workspace > Admin mode > Templates > Shells) from Development/Test
environment to Production environment. The data source for the reports can be a uDesigner 
design, a Data View, or a system-provided source. 

Single Record Business Process (BP)

The data from the Single Record BP gets exported from the source environment and then gets 
imported into the destination environment. This includes: Text fields, Pull downs (Integer and 
String), Radio buttons, check boxes, Integer, Decimal and Currency Amounts and Dates. The 
dataset values, or the default values, will not transfer unless you include those in your 
configuration package. 

The following data/items are not included in the configuration package: 

 Any picker that refers to some other design object like BP pickers or data pickers. 

 Attachments, linked records, and general comments. 

Groups and Users

 Only the Shell Administrator user will be extracted for User Mapping, when importing the 
configuration package. 

 Only groups will be extracted for the selected components in the shell templates. 

Access Control
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 For both Admin and User modes, the user can select the permissions for the Design objects 
in shell templates. 

Updating Shell Formation - General Procedure 

In general, the Update Shells feature works like this: 

Step 1. In Administration Mode, open a shell type template. 

Step 2. Navigate to one of the modules listed above. Add or edit data. 

Step 3. Click the Update Shells button. Select which information within the module to update, 
and which of your active or on-hold shells to "push" the information to. New information will be 
added to the selected shells. Edited information will overwrite existing data. 

You can also cancel a shell update before it reaches the In Process status. 

Detailed instructions for updating specific types of shell information is found in the following 
sections. 

Updating Shells, Users 

You can add new users to multiple shells at once by adding them to a shell template in the User 
Administration > Users module. When adding new users to a shell, you can assign individual 
permissions directly to a new user, or add the user to a group to apply group permissions. 

The Update Shells process runs in the background. Depending on the number of records and 
shells you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Some notes about updating users

 Users are identified by their unique User ID. 

 Any Active, Inactive or On-hold users can be pushed. 

 If the user does not already exist in the shell, the user will be added to 
the shell with the permission settings and group membership. 

 If the user already exists in the shell, the user information is updated 
(replaced) with the user information as entered in the shell template. 
This includes permission settings and group membership. 

 If a group that the user was added to doesn’t already exist in the 
shell, the group will be added, and the user will be added to the 
group. Group permissions are not updated; this is done by updating 
groups. 

 If the group already exists, the user will be added to it. Group 
properties and permissions will not be affected. 

To add or update users using Update Shells 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell type template to update. 
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4) In the shell type template, navigate to the User Administration > Users log. 

5) Add a user to the shell type template, or select a user to edit. Define user parameters and 
assign permissions. 

6) Select one or more users in the Users log. 

7) Click the Update Shells button and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the 
selected shells; there is no undo for the update. 

8) Click Yes if you want to proceed with the update, or No to cancel. 

To delete users  

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell type template to update. 

4) In the shell type template, navigate to the User Administration > Users log. 

5) If you are not an administrator or owner of an item in the template: 

1. Select the shell user for deletion. 

2. You can click on the Usage option, which downloads the usage report. 

3. The usage report lists all the references of the selected user in the template. You can 
check if the deletion would impact any area of the usage report. 

4. Select the Delete option. 

5. A confirmation message is displayed along with Yes and No options. 

6. If you choose Yes, then the item is deleted and all the user references are removed from 
the template. 

 The system deletes the user even if the selected user is the only user under the 
Assignee section of any workflow BP. You must manually open the BP and save the 
user in order to move them to an Inactive status. You can also assign a new user in the 
workflow. 

6) If the selected user is an owner of a document, cost sheet, work sheet, schedule sheet, or 
User-defined report: 

1. Select a user ID and click on the Delete option. 

2. A confirmation message is displayed along with Yes and No options. 

3. If you choose Yes, then the system closes the message and automatically downloads the 
usage report without performing a deletion. You can refer to the usage report to 
understand the impact areas and take the necessary action. 
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7) If you select multiple users and all of them are owners of a document, cost sheet, work 
sheet, schedule sheet, or User-defined report: 

1. Select the user IDs and click on the Delete option. 

2. A confirmation message is displayed along with Yes and No options. 

3. If you choose Yes, then the system closes the message and automatically downloads the 
usage report for all the selected users without performing a deletion. You can refer to the 
usage report to understand the impact areas and take the necessary action. 

8) If you select multiple users and none of them are owners of any content in the template: 

1. Select the users and click on the Delete option. 

2. You can select all the users and click on the Usage option, which downloads the 
combined usage report for all the selected users. 

3. A confirmation message is displayed along with Yes and No options. 

4. If you choose Yes, then the system deletes all the selected users. 

9) If you select multiple users and a few of them are owners of some elements in the template: 

1. Select the users and click on the Usage option. 

2. The system downloads the combined usage report for all the selected users. 

3. Select the Delete option. 

4. A confirmation message is displayed along with Yes and No options. 

5. If you choose Yes, then the system automatically downloads the usage report for the 
remaining users who are restricted from deletion. 

6. Another confirmation message is displayed along with Yes and No options. 

7. If you choose Yes, then the system deletes the selected users that are not owners. 

 You can refer to the usage report to further understand why some users cannot be 
deleted. 

10) The push functionality and the copy shells work the same as they did previously. If a user is 
deleted and the record can no longer be selected, then a push cannot be performed. 
However, if a user is deleted and the shell template is copied to create a new template, then 
the deleted user would no longer be included. When a user is deleted and the shell is 
selected for download as part of a Component List in a Configuration Package, the 
deleted user is no longer part of the package. Any existing shells are not affected by the 
changes made and the deletions performed. 

Updating Shells, Groups 

You can add new users to shells individually or by adding them to groups, and then adding the 
groups to the shells. You can assign the user individual permissions, or add the user to a group 
and apply group permissions. 

The Update process runs in the background. Depending on the number of records and shells 
you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Notes:  

About updating groups: 

 Groups are identified by their unique Group Name. 

 All group properties, including permission settings, will be added or 
updated in the shells that you selected. 

 If the group does not already exist, the group will be created with the 
permission settings. Group membership (user list) will not be 
updated in the shell. 

 If a group of that name exists, the properties and permissions of that 
group will be replaced with the new group, but not the list of users. 

 Users are not automatically added to the group; they need to be 
added by updating users (group membership). 

To add or edit user groups using Update Shells 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell template to update. 

4) In the shell type template, navigate to the User Administration > Groups log. 

5) Select one or more groups from the Groups log. 

6) Click Update Shells and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 

7) Click Yes if you want to proceed with the update, or No to cancel. 

To delete user groups 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell template to update. 

4) In the shell type template, navigate to the User Administration > Groups log. 

5) If you select a single group in the template: 

1. Select the shell group. 

2. You can click on the Usage option, which downloads the usage report for the selected 
group. This behavior is dependent on the browser you are working in. 
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3. The usage report lists all the references of the selected group in the template. You can 
check if the deletion would impact any area of the usage report. 

4. Select the Delete option. 

5. A confirmation message is displayed along with Yes and No options. 

6. If you choose Yes, then the item is deleted and all references of the selected group are 
removed from the template. 

 The system deletes the group even if the selected group is the only assignee in any 
workflow BP. You must manually open the BP and save the group for it to move to an
Inactive status. You can also assign a new user in the workflow. 

 The system should not allow the deletion of the Project Administrators group. If you 
select the Project Administrators group and click on the Delete option, then a 
confirmation message is displayed along with an OK option. Click on the OK option to 
proceed further. You can select the Project Administrators group and click on the
Usage option to download the usage report for the group. 

6) If you select other groups apart from Project Administrators: 

1. Select the shell groups. 

2. You can click on the Usage option, which downloads the combined usage report for the 
selected groups. This behavior is dependent on the browser you are working in. 

3. The usage report lists all the references of the selected groups in the template. You can 
check if the deletion would impact any area of the usage report. 

4. Select the Delete option. 

5. A confirmation message is displayed along with Yes and No options. 

6. If you choose Yes, then the item is deleted and all references of the selected groups are 
removed from the template. 

 The system deletes the groups even if the selected group is the only group under the 
Assignee section of any workflow BP. You must manually open the BP and save the 
group for it to move to an Inactive status. You can also assign a new user in the 
workflow. 

7) If you select multiple groups for deletion that include Project Administrators: 

1. Select multiple shell groups. 

2. You can click on the Usage option, which downloads the combined usage report for the 
selected groups. This behavior is dependent on the browser you are working in. 

3. The usage report lists all the references of the selected groups in the template. You can 
check if the deletion would impact any area of the usage report. 

4. Select the Delete option. 

5. A confirmation message is displayed along with Yes and No options. 

6. If you choose Yes, then the system displays another confirmation message along with 
Yes and No options. If you select No, then the operation is aborted. 

7. If you choose Yes, then the selected groups, apart from the Project Administrators
group, are deleted. If you select No, then the deletion is not performed. 



Shells Administration

191

8) The push functionality and the copy shells work the same as they did previously. If a group is 
deleted and the record can no longer be selected, then a push cannot be performed. 
However, if a group is deleted and the shell template is copied to create a new template, 
then the deleted group would no longer be included. 

Updating Shells - Setup Node, Business Process 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Setup 
> Business Process. 

You can add and update new business processes, or add additional business process setups to 
existing business processes. 

The Update Shell process runs in the background. Depending on the number of records and 
shells you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

The business process setup is identified by the unique combination of business process name, 
setup name, and workflow name. 

If the business process name does not exist, it will be added to project with the BP Setup and 
permissions. 

If the BP exists, but the BP Setup does not, it will be added to the BP. 

If the BP and BP Setup exist, the Setup will be replaced with the new one. 

Users and Groups that are part of a BP setup as assignees are added/updated, but not 
permissions. If a group is created, it will be empty. Users must be added to the group separately 
through user administration. 

BP-related permissions are added/updated (for example, discussion groups, which are available 
in Classic View only). 

To add or update business process setups using Update Shells 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell type template to update. 

4) In the shell type template, navigate to Setup > Business Processes. 

5) Add any new business processes, if applicable. (The BP must already have been imported 
into Unifier and configured at the company level.) 

6) To add or edit business process setups, select the BP to update in the Business Processes 
log. Click Open. The BP Setup log opens. 

7) Create a new setup or modify an existing setup. You may create as many setups as you 
wish to make available in the shell(s). 

8) Select one or more setups from the BP Setup log. 

9) Click Update Shells and choose one of the following: 
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 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 

10) Click Yes if you want to proceed with the update, or No to cancel. 

Conditions for Creating a Business Process setup Configuration Package 

When you include a Workflow Business Process setup for Configuration Package: 

 If it is a first time export, you must include the BP design in the configuration package.  

 For subsequent exports, you must include the latest BP design the configuration package. 

When you include a non-Workflow Business Process setup for Configuration Package: 

 If it is a first time export, you must include the BP design in the configuration package. 

 For subsequent exports, if you have included the Data Element used in the setup (for 
example, Auto Creation setup) in the configuration package, then: 

 If published, then it will automatically be included in configuration package, by including 
the BP setup 

 If not published, then you must include the BP design as well. 

At the time of import, the system transfers the setup information of the design object, irrespective 
of the Configuration status (Active/Inactive). 

Oracle recommends that you include your design object for Configuration Package after you 
change the configuration of your design. 

Workflow Setup for Workflow Business Processes 

You have the ability to delete (Delete, or Edit > Delete) inactive Workflow setup for Workflow 
Business Processes in Shell Template so that they are not included when a particular BP setup 
is included in the component list for configuration package. 

Updating Record Properties tab in the BP Setups 

When you push the BP setup to selected shells, or all shells, the users and groups who had 
restrictions to the Audit log and Workflow Progress tabs, the Record Properties tab of the BP 
setup (in shell template) will be pushed into the shells.  

The confirmation message (when pushing BP setup into shells or projects from template) will 
have an additional information: "Users and groups permissions, in the Record Properties tab, 
are added to the shell and existing permissions will be updated." 
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Updating Shells - Setup Node, Dashboards 

You can add new dashboards to shell instances, for users to view. You can assign the user 
View permission to the shell instance dashboards. 

The Update process runs in the background. Depending on the number of shells you are 
updating, it can take a considerable amount of time to complete. The process is complete when 
the End Date column in the Update History window shows the complete date. 

Some notes about updating shell instance dashboards

 If granted View permission, users can view shell instance 
dashboards, but cannot modify them. 

 If a user added to shell instance dashboard permissions, and that 
user does not exist in the shell, that user is added to the shell upon 
update. 

 If a user has created My Dashboard in User Mode for a shell, that 
dashboard is not overwritten by Update Shells. 

To add or update shell instance dashboards using Update 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) From the left Navigator, click Templates > Shells > "Shell template" > Setup > 
Dashboards. The Dashboards log window opens. 

3) Select one or more shell instance dashboards from the Dashboards log. 

4) Click UpdateShells and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the 
selected shells; there is no undo for the update. 

5) Click Yes if you want to proceed with the update, or No to cancel. 

Conditions for Creating a Dashboard Setup Configuration Package 

Note: You must include the Data Cubes used in the Dashboard. 

When you export a Dashboard for the first time, you must include all uDesigner design objects 
that form the Dashboard data source in the Configuration Package.  



Unifier General Administration Guide

194

For subsequent exports ensure that the design object that uses the Data Element that is 
specifically used in the setup is present in the Production Published Package. As long as this 
condition is met, the configuration package creation will be successful. If this condition is not 
met, then the latest design will have to be included in the configuration package. When the data 
source is a business process, the setup must also be included in the configuration package; 
otherwise, the creation process will not complete. 

Dashboards Components in the Configuration Package 

The system includes the following components of a dashboard in the Configuration Package 
(.zip file): 

Dashbo
ards 

Component Field / Option 

Dashbo
ard 

Name 

Dashbo
ard 

Description 

Dashbo
ard 

Permissions 

Dashbo
ard 

Tab Block Tab Name 

Dashbo
ard 

Tab Block Tab Layout 

Dashbo
ard 

Tab Block Show option 

Dashbo
ard 

Tab Block Filters 

Dashbo
ard 

Source Details 
/ Analytics 
Block 

Block Order 

Dashbo
ard 

Source Details 
/ Analytics 
Block 

Block Title 

Dashbo
ard 

Source Details 
/ Analytics 
Block 

Source Name 

Dashbo
ard 

Source Details 
/ Analytics 
Block 

Block Type 
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Dashbo
ard 

Analytics 
Block 

URL  

The URL value will be blank in the Export package. Import 
process will plug in the default value based on the Unifier 
Configurator property. 

Dashbo
ard 

Custom Block Data Cube 

Dashbo
ard 

Custom Block Show Data From  

Dashbo
ard 

Custom Block Block Title 

Dashbo
ard 

Custom Block Display Type 

Dashbo
ard 

Custom Block Source Grouped By (If Group By option is a design object 
then that design should also be included in the Configuration 
Package) 

Dashbo
ard 

Custom Block Output Type 

Dashbo
ard 

Custom Block Report On 

Dashbo
ard 

Custom Block Summary Type 

Dashbo
ard 

Custom Block Show Result 

Dashbo
ard 

Custom Block Show Total 

Dashbo
ard 

Custom Block Decimal Places 

Dashbo
ard 

Custom Block Currency Format 

Dashbo
ard 

Drilldown 
Block 

Data Cube 

Dashbo
ard 

Drilldown 
Block 

Block Title 

Dashbo
ard 

Drilldown 
Block 

Block Filter Elements (If filter elements are design objects, 
then they must be included in the Configuration Package as 
well.) 

Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Title 
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Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Show Data From 

Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Display Type 

Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Source Grouped By (If Group By option is a design object 
then that design must also be included in the Configuration 
Package.) 

Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Output Type 

Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Report On 

Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Summary Type 

Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Show Result 

Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Show Total 

Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Decimal Places 

Dashbo
ard 

Drilldown 
Block / Edit 
Drilldown 
Details 

Currency Format 

Dashbo
ard 

Portlet Block Name 
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Dashbo
ard 

Portlet Block URL 

Use Reset to reset the URL.  

Use Get Parameters to get parameters from the URL as populated by the user in URL text box. When received, 

use the URL Parameter Mapping menu (accordion) to pass the values to the parameters in URLs, by 

mapping those to fields from shell attribute form, and then format the values so that the URL can render in 

the dashboard during runtime, correctly. 

Dashbo
ard 

Standard 
Block 

Source Name 

Dashbo
ard 

Standard 
Block 

Data Type (If Data Type option is a design object then that 
design must also be included in the Configuration Package) 

Dashbo
ard 

Standard 
Block 

Report On 

Dashbo
ard 

Standard 
Block 

Block Title 

Dashbo
ard 

Standard 
Block 

Display Type 

Dashbo
ard 

Standard 
Block 

Show Result 

Dashbo
ard 

Standard 
Block 

Show Total 

Dashbo
ard 

Standard 
Block 

Decimal Places 

Dashbo
ard 

Standard 
Block 

Currency Format 

Updating Shells - Setup Node, Gates 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Setup > 
Gates. 

You can update shells with Active or Inactive Gates setups. The Update Shells process runs in 
the background. Depending on the number of records and shells you are updating, it can take a 
considerable amount of time to complete. The process is complete when the End Date column in 
the Update History window shows the complete date. 

Important Information About Updating Gates (Project Phase Gates) Setups:  

 The Gates setup update will completely overwrite any existing Gates setup, or will be added 
if it did not previously exist. 

 Previously scheduled Gates runs are overwritten by the new Gates setup. If the pushed 
setup is Active new scheduled Gates runs are scheduled according to the schedule in the 
new setup. 

 Both Inactive and Active Gates setups can be pushed in the update. 

 After update the Gates setup reflects the status of the template. 
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 After the update, the Current Phase in the Gates setup is reset to the First Phase. 

 After the update, the Gates shells will not run the scheduled refresh if the shell is On-Hold. 
Gates scheduling will resume automatically when the shell becomes Active. 

 If you have permission to create Gates setups, you can update Gates setups using Update 
Shell, even if you do not have permission to access the individual shells. 

 The phase conditions that have been completed already will reset to incomplete, by the 
system.  

 Users and groups specified in the Email Notification field are added if they do not exist. 

 Newly-created groups are empty. 

 Any conditions that had been previously checked to be ignored will not be checked again, 
and the information about the user who had checked the ignore option will be lost. 

 The project will not set to where it was in the Phase Gates progress prior to template update, 
if the ignore checkbox has been used for any of the phase completion conditions. 

Note: Post update, the next time that the system picks up the scheduled 
runs, the status of the gate phases may vary depending on the setup. 

To update Gates setups using Update Shell 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > [shell type] > [shell instance] in the left Navigator. 

3) In the shell template, click Setup and select Gates. 

4) Select a Gates setup. 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 

5) Click Yes if you want to proceed with the update, or No to cancel. 

Conditions for Creating Gates setup Configuration Package 

When you export the Gates setup for the first time, you must include the data sources for the 
query condition used in the Gates setup. 

For subsequent exports, ensure that the design which uses the Data Element that is specifically 
used in the setup is present in the Production Published package. As long as this condition is 
met, the package creation will be successful. If this condition is not met, then the latest design 
will have to be included in the package. 

Gates Components in the Configuration Package 

The system includes the following components of Gates in the Configuration Package (.zip file): 
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Gates Component F
i
e
l
d

/

O
p
t
i
o
n

Log N
a
m
e

Log S
t
a
t
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s

Gates / General tab N
a
m
e

Gates / General tab D
e
s
c
r
i
p
t
i
o
n

Gates / General tab S
t
a
t
u
s
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Gates Component F
i
e
l
d

/

O
p
t
i
o
n

Gates / Settings tab P
h
a
s
e

n
a
m
e

Gates / Settings tab / Phase Gate Configuration 

Note: If the option of Start Date and Planned Completion dates are from Schedule 
sheet, then only the dates will get copied over. The Master schedule sheet will not get 
copied over.) 

A
l
l

o
p
t
i
o
n
s
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Gates Component F
i
e
l
d

/

O
p
t
i
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n

Gates / Settings tab / Gate Condition Elements A
l
l

G
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e

C
o
n
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i
t
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E
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.
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Gates Component F
i
e
l
d

/

O
p
t
i
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n

Gates / Settings tab / Gate Conditions A
l
l

q
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c
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d
i
t
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t
u
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Gates Component F
i
e
l
d

/

O
p
t
i
o
n

Gates / Settings tab A
d
v
a
n
c
e
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o

n
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P
r
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…
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o
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Gates Component F
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/
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Gates / Settings tab / Additional Information block A
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n
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Gates Component F
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e
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d

/
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p
t
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n

Gates / Settings tab  R
e
e
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Gates Component F
i
e
l
d

/
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Gates / Schedule tab A
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Updating Shells - Setup Node, Planning Manager 

A Shell template might have many planning items in the Development/Test environment; 
however, not all of the planning items might be ready for transfer to another environment.  

To access the Shell template for Planning Manager, go to the Company Workspace > Admin
mode > Templates > "Shell template" > Setup > Planning Manager

You can select multiple items to include in your configuration package. 

Conditions for Creating a Planning Manager setup Configuration Package 

When you include the Planning Manager setup information in a Configuration Package for the 
first time, you must include the corresponding design in the Configuration Package. 

For subsequent exports, you do not need to include the latest design, if the design exists in the 
Published Configuration Package, already. 

At the time of import, the system transfers the setup information of the design object, irrespective 
of the Configuration status (Active/Inactive). 

Oracle recommends include your design in the Configuration Package after you change the 
configuration of your design. 

Planning Manager Components in the Configuration Package 

The system includes the following components of Planning Manager in the Configuration 
Package (.zip file): 

Component Field / Option 

Planning Manager Setup / <Item Name> / General tab  Setup Name 

Planning Manager Setup / <Item Name> / General tab  Description 

Planning Manager Setup / <Item Name> / General tab Help File 

Access Control for Planning Manager Setup 

The configuration package includes permissions settings of Users and Groups from Shell 
templates, Planning Manager. 

To see the permission settings for Dashboards: 

1) Go to the Access Control module (Project/Shell > Admin mode > Access Control). 

2) Click to expand Administration Mode Access. 

3) Click to expand Setup. 

4) Click Planning Manager to open the Module Permission Settings window. 

5) Proceed with adding, modifying, or removing permissions. 
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Updating Shells - Setup Node, Resource Manager 

Go to: Company Workspace > Admin mode > Templates > "Shell template" > Setup > 
Resource Manager

You can select and include the Resource Manager in the Configuration Package. 

Conditions for Creating a Resource Manager setup Configuration Package 

The setup of Resource Manager does not depend on any uDesigner designs and the 
configuration.  

At the time of import, ensure that the Role Based Allocation value is the same between the 
Configuration Package and the Production environment, or destination server. 

Note: The above check is applicable only when the setup has already 
been done. 

At the time of import, the system transfers the setup information of the design object, irrespective 
of the Configuration status (Active/Inactive). 

Oracle recommends that you include your design in the Configuration Package after you change 
the configuration of your design. 

Resource Manager Components in the Configuration Package 

The system includes the following components of Resource Manager in the Configuration 
Package (.zip file): 

Component Field / Option 

Resource Manager Configuration / Role Based Allocation block Selected option 

Resource Manager Configuration / Resource Sheet Defaults  Timescale Unit 

Resource Manager Configuration / Resource Sheet Defaults Date From 

Resource Manager Configuration / Resource Sheet Defaults Date To 

Access Control for Planning Manager Setup 

The Configuration Package includes permissions settings of Users and Groups from Shell 
templates, Resource Manager. 

To see the permission settings for Dashboards: 

1) Go to the Access Control module (Project/Shell > Admin mode > Access Control). 

2) Click to expand Administration Mode Access. 

3) Click to expand Setup. 

4) Click Resource Manager to open the Module Permission Settings window. 

5) Proceed with adding, modifying, or removing permissions. 
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Updating Shells - Setup Node, Configurable Modules (Classes) 

Go to: Company Workspace > Admin mode > Templates > "Shell template" > Setup > 
"Configurable Manager" > "CM0 Classes"/"Class Name" 

Any Configurable Manager of Code and Record type which have classes and which are setup in 
a Shell template can be packaged as part of Configuration Package. 

You can package any Configurable Manager of Code-type and Record-type as part of 
Configuration Package, if the: 

 Configurable Manager has classes 

 Configurable Manager was set up in a Shell template 

A shell template might have many CM Classes in the Development/Test environment; however 
not all of CM Classes might be ready for transfer to another environment.  

Conditions for Creating a CM Class setup Configuration Package 

When you include the setup information in the Configuration Package for the first time, you must 
include the corresponding design in the Configuration Package.  

For subsequent exports, you do not need to include the corresponding design in the 
Configuration Package. 

At the time of import, the system transfers the setup information of the design object, irrespective 
of the Configuration status (Active/Inactive). 

Oracle recommends that you include your design object for Configuration Package after you 
change the configuration of your design. 

CM Class Components in the Configuration Package 

The system includes the following components of CM Class in the Configuration Package (.zip 
file): 

Component Field / Option 

CM Class Setup / General  Setup Name 

CM Class Setup / General  Description 

CM Class Setup / General  Help File 

CM Class Setup / General  Auto Creator 

CM Class Setup / General Send Error Notification to 

Access Control for CM Class Setup 

The Configuration Package includes permissions settings of Users and Groups from Shell 
templates, CM Class. 

To see the permission settings for Dashboards: 

1) Go to the Access Control module (Project/Shell > Admin mode > Access Control). 

2) Click to expand Administration Mode Access. 
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3) Click to expand Setup. 

4) Click Parts to open the Module Permission Settings window. 

5) Proceed with adding, modifying, or removing permissions. 

Updating Shells - Configurable Modules Node (Sheets) 

Go to: Company Workspace > Admin mode > Templates > "Shell template" > Setup > 
"Configurable Manager" > "CM0 Sheet"/"Sheets Name" 

The Generic Cost Sheet templates enables you to have generic cost-codes-based cost sheet, 
and setup, in Shell templates of Generic Cost Code type (Generic Shells). 

You can include the CM0 setup that exists in a Shell template in the Shell Template 
Configuration Package. 

Conditions for Creating a CM Class setup Configuration Package 

When you include the setup information in the Configuration Package for the first time, you must 
include the corresponding design in the Configuration Package.  

For subsequent exports, you do not need to include the corresponding design in the 
Configuration Package. 

At the time of import, the system transfers the setup information of the design object, irrespective 
of the Configuration status (Active/Inactive). 

Oracle recommends that you include your design object for Configuration Package after you 
change the configuration of your design. 

CM Class Components in the Configuration Package 

The system includes the following components of CM Class in the Configuration Package (.zip 
file): 

Component Field / Option 

CM Class Setup / General  Setup Name 

CM Class Setup / General  Description 

CM Class Setup / General  Help File 

CM Class Setup / General  Auto Creator 

CM Class Setup / General Send Error Notification to 

Updating Shells - Rules Node 

Rules can be updated in CBS code-based shells. 

The Update Shells process runs in the background. Depending on the number of records and 
shells you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Notes:  

About updating rules: 

 Both active and inactive rules can be pushed. 

 Rules are identified by the combination of rule name and the source. 

 If the rule does not exist, it will be added. 

 If a rule already exists with the same name and source, that rule will 
be updated. This includes the status: for example, if the rule being 
pushed is active, and the rule in the shell is inactive, the system will 
update the existing rule and activate it. 

 It is possible to have more than one rule with the same name and 
source in a project/shell or template. If two or more rules already 
exist with the same name and source as the rule being pushed, the 
update will not occur and will give an error. 

 When the update process begins, the system will first attempt to 
validate each rule (equivalent to clicking the Validate button). This 
will occur whether the rule is active or inactive in the template. If the 
rule is validated successfully, the system will proceed with the 
update. 

 If the rule fails validation, the rule will not be pushed. The attempt will 
be captured in the History. 

To update rules using Update Shells 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shell in the left Navigator. 

3) Open the shell template to update. 

4) In the Shell Template, navigate to  Rules. 

5) Select one or more rules from the log. 

6) Click Update Shells and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 

7) Click Yes if you want to proceed with the update, or No to cancel. 
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Conditions for Creating a Rules setup Configuration Package 

When you package the Rules Setup information for the first time, you must include the following 
in the package:  

 Design of the Business Processes used in the Rule definition. 

 Corresponding designs. 

The design the design for Configuration Package. 

For subsequent exports, ensure that the design which uses the Data Element that is specifically 
used in the setup is present in the Production Published package. As long as this condition is 
met, the package creation will be successful. If this condition is not met, then the latest design 
will have to be included in the package. 

Importing of Rules based on Rule Status 

Note: For both Active and Inactive, the system does not check for the 
existence of the specific CBS codes in the Cost Sheet (Applicable where 
the Rule definition uses CBS codes). 

Rules with Active Status

At the time of Import, ensure that: 

 The Cost Sheet or Funding Sheet, used in Rules definition, exists either in the Package or in 
the destination server. 

 The data source is present, as a column, in the Funding sheet. 

 The cost sheet columns or the Funding Sheet columns used in Rule definition required for 
Rule Activation are present either in the package or in the destination server. 

When CBS codes are used, ensure that the Cost Sheet used for Rules definition exists either in 
the Package or in the destination server. 

Rules with Inactive Status

The system does not perform any checks at the time of import. 

Rules Components in the Configuration Package 

The system includes the following components of Rules in the Configuration Package (.zip file): 

Component Field / Option 

Rule Properties / 
General 

Name 

Rule Properties / 
General 

Description 

Rule Properties / 
General 

Control Source 

Rule Properties / 
General 

Rule Level 
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Component Field / Option 

Rule Properties / 
General 

Status 

Rule Properties / 
General  

Users / Groups who can override field. Users and groups will be 
part of the Configuration Package. 

(Applicable only for Rule level = Per selected CBS Codes and 
Per selected summary CBS codes) 

Rule Properties / 
General 

Notify Users / Groups when overridden field. Users and groups 
will be part of the Configuration Package. 

(Applicable only for Rule level = Per selected CBS Codes and 
Per selected summary CBS codes) 

Rule Properties / 
Rule 

Limit expression formula: Formula string. 

The formula string contains BPs.   

Rule Properties / 
Rule 

Data Expression:  Might be a formula using BP data sources. 

Rule Properties / 
Rule 

Message when condition not met.  

Rule Properties / 
CBS Codes 

CBS Codes 

(Applicable only for Rule level = Per selected CBS Codes and 
Per selected summary CBS codes) 

Updating Shells - Cost Manager Node, Cash Flow 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Cost 
Manager > Cash Flow.  

The Cash Flow module enables you to generate and compare Baseline, Actuals (or “spends”), 
Portfolio, Forecast, and Custom curves in a project or CBS code-based Shell. 

You can use a Cash Flow Curve template to create cash flow curves in CBS-code based Shells. 

All Cash Flows defined in a shell template will be included in the Configuration Package. 

You can select and include multiple items in the Configuration Package. 
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Conditions for Creating a Cash Flow setup Configuration Package 

Deta
il 

Cur
ve 
typ
e 

Component Check 

Proj
ect/
Lev
el 

Sum
mar
y 
CBS

CBS

Com
mit
men
t 

An
y 

Cost = Distribute amount from 
cost sheet column ensure that 
the checks relevant to Cost 
Sheet are performed. If above 
conditions are not met, you 
will see an error. 

Cost Sheet in the shell template. 

Proj
ect/
Lev
el 

Sum
mar
y 
CBS

CBS

Com
mit
men
t 

An
y 

Schedule = Use dates from 
Schedule Sheet 

Schedule Sheet in the shell template. 

Proj
ect/
Lev
el 

Sum
mar
y 
CBS

CBS

Com
mit
men
t 

An
y 

Filter set to specific CBS 
Codes 

When the Filter is set to specific CBS codes, 
ensure that the Cost Sheet in the Shell 
template has also been included. 
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Deta
il 

Cur
ve 
typ
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Component Check 

Com
mit
men
t 

An
y 

Commitment Business 
Processes both Commitment 
and Change Orders 

Commit Business Process selected must be 
included in the Configuration Package. If 
this condition is not met, throw an error. 

Cash Flow Components in the Configuration Package 

The system includes the following components of Cash Flow in the Configuration Package (.zip 
file): 

 Cash Flow content – Detail Level: Project/Shell 

 Cash Flow content – Detail Level: Summary CBS 

 Cash Flow content – Detail Level: CBS 

 Cash Flow content – Detail Level: Commitment 

Note: For "Additional checks required" see to Conditions for Creating a 
Cash Flow setup Configuration Package, in this topic. 

Cash Flow content – Detail Level: Project/Shell

Component Field / Option 

Cash Flow 
Properties / General 

All fields 

Cash Flow 
Properties / Curves  

All Curves 

Cash Flow 
Properties / Curves / 
Curve type - 
Baseline 

All fields including the selected options for Distribution, Cost and 
Schedule 

1 - If Distribution = Auto by default profile, the Distribution Profile 
will be included in the Configuration Package. 

2 - If Cost = Distribute amount from cost sheet column, all the 
cost sheet columns available for selection will be included in the 
Configuration Package. In addition to this, the value selected for 
this field will also be included in the Configuration Package. 
Additional checks required. Note that Cost Sheet must always be 
included in the Package. 

3 - If Schedule = Use dates from Schedule Sheet, the schedule 
sheet selected in the field should be included in the Package. 
Additional checks required. DEs selected in the From Date and 
To Date fields will also be included in the Configuration Package 
in addition to the possible values of the Schedule sheet DEs. 
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Component Field / Option 

Cash Flow 
Properties / Curves / 
Curve type -  
Forecast / General 

All fields including the selected options for Distribution, Cost and 
Schedule. 

Behavior to be the same as the one outlined in Cash Flow / 
Curves / Baseline 

Cash Flow 
Properties / Curves / 
Curve type -  
Forecast / Options 

All options selected for the Forecast Curve will be included in the 
Configuration Package 

Cash Flow 
Properties / Curves / 
Curve type – 
Portfolio Budget 

All fields selected for the Forecast Curve will be included in the 
Configuration Package 

1 - Additional checks might be needed for Portfolio Manager 
related Configuration. 

2 - Currency is a required field for Portfolio Budget curve. The 
default value is set to the Project Currency. However this 
currency might differ from the Project Currency. It could be any 
of the Active and Future currencies listed in the Exchange Rate 
table. Therefore, if the currency differs from the Project Currency 
then in addition to the Currency value specified in this field, the 
currency and its exchange rate information will also be included 
in the Configuration Package. 

Rules for creating Currencies and Exchange Rates  

- Currency will get created if it does not already exist 

- Currency attributes such as Code, Name, Symbol etc will not 
be updated by means of Package import.  

- Currency tab content will get updated upon every import. 

If exchange rates defined for currencies in the source shell 
template do not exist in the destination environment, then a new 
exchange rate record will get created for that currency and that 
exchange rate will be set to Active.  

- The Effective date will be set to the Package Import Date. 

- The Peg rate will be brought over from the source environment.

- The float rate will be brought over if the rate does not exist in 
the destination environment. 

Cash Flow 
Properties / Curves / 
Curve type - Actuals 

All fields selected for the Forecast Curve will be included in the 
Configuration Package. Additional checks required. 

Cash Flow 
Properties / Filter 

Selected Filter options 

If Filter = Select Summary CBS OR Select CBS codes, then the 
selected CBS codes will be included as part of Filter options. 

Cash Flow 
Properties / Options 

Decimal Place Option will be included in the Configuration 
Package. 
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Component Field / Option 

Cash Flow 
Properties / 
Schedule 

All options set in the Schedule tab will be included in the 
Configuration Package. 

Cash Flow 
Properties / 
Summary 

Not applicable in templates 

Cash Flow / 
Permissions 

Users and Groups 

Cash Flow / Filters Filters defined for the curves will also be included in the Package

Cash Flow content – Detail Level: Summary CBS

Component Field / Option 

Cash Flow 
Properties / 
General 

All fields 

Cash Flow 
Properties / 
Curves  

All Curves 

Cash Flow 
Properties / 
Curves / Curve 
type - Baseline 

All fields including the selected options for Distribution, Cost and 
Schedule. 

1- If Distribution = Auto by default profile per summary CBS, the 
Distribution Profile for the corresponding Summary CBS code will 
be included in the Configuration Package. Additional checks 
required. 

2- If Cost = Distribute amount from cost sheet column, all the cost 
sheet columns available for selection will be included in the 
Configuration Package. In addition to this, the value selected for 
this field will also be included in the Configuration Package. 
Additional checks required. Note that Cost Sheet must always be 
included in the Package. 

3- If Schedule = Use dates from Schedule Sheet, the schedule 
sheet selected in the field should be included in the Package. 
Additional checks required. DEs selected in the From Date and To 
Date fields will also be included in the Configuration Package in 
addition to the possible values of the Schedule sheet DEs. 

Cash Flow 
Properties / 
Curves / Curve 
type -  Forecast / 
General 

All fields including the selected options for Distribution, Cost and 
Schedule.  Behavior to be the same as the one outlined in Cash 
Flow / Curves / Baseline 



Unifier General Administration Guide

218

Component Field / Option 

Cash Flow 
Properties / 
Curves / Curve 
type -  Forecast / 
Options 

All options selected for the Forecast Curve will be included in the 
Configuration Package 

Cash Flow 
Properties / 
Curves / Curve 
type – Portfolio 
Budget 

All fields selected for the Portfolio Budget Curve will be included in 
the Configuration Package. 

1- Additional checks might be needed for Portfolio Manager related 
Configuration. 

2- Currency is a required field for Portfolio Budget curve. The 
default value is set to the Project Currency. However this currency 
might differ from the Project Currency. It could be any of the Active 
and Future currencies listed in the Exchange Rate table. Therefore, 
if the currency differs from the Project Currency then in addition to 
the Currency value specified in this field, the currency and its 
exchange rate information will also be included in the Configuration 
Package. 

Rules for creating Currencies and Exchange Rates 

- Currency will get created if it does not already exist 

- Currency attributes such as Code, Name, Symbol etc will not be 
updated by means of Package import.  

- Currency tab content will get updated upon every import. 

If exchange rates defined for currencies in the source shell 
template do not exist in the destination environment, then a new 
exchange rate record will get created for that currency and that 
exchange rate will be set to Active. 

- The Effective date will be set to the Package Import Date. 

- The Peg rate will be brought over from the source environment. 

- The float rate will be brought over if the rate does not exist in the 
destination environment. 

Cash Flow 
Properties / 
Curves / Curve 
type - Actuals 

All fields selected for the Forecast Curve will be included in the 
Configuration Package. Additional checks required. 

Cash Flow 
Properties / Filter 

Selected Filter options 

If Filter = Select Summary CBS, then the selected Summary CBS 
codes will be included as part of Filter options. Additional checks 
required.  

Cash Flow 
Properties / 
Options 

Decimal Place Option will be included in the Configuration 
Package. 
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Component Field / Option 

Cash Flow 
Properties / 
Schedule 

All options set in the Schedule tab will be included in the 
Configuration Package. 

Cash Flow 
Properties / 
Summary 

Not applicable in templates 

Cash Flow / 
Permissions 

Users and Groups 

Cash Flow / 
Filters 

Filters defined for the curves will also be included in the Package 

Cash Flow content – Detail Level: CBS

Component Field / Option 

Cash Flow Properties 
/ General 

All fields 

Cash Flow Properties 
/ Curves  

All Curves 
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Component Field / Option 

Cash Flow Properties 
/ Curves / Curve type 
- Baseline 

All fields including the selected options for Distribution, Cost and 
Schedule. 

Distribution 

Case 1: Auto by default profile per CBS, the Distribution Profile 
for the corresponding CBS code will be included in the 
Configuration Package. Additional checks required. 

Note: Cost Sheet must always be included in the Package. 

Case 2: Use data from Schedule Sheet, the schedule sheet will 
be included in the Configuration Package. Additional checks 
required. 

Case 3: Use data from P6 Source, the P6 source selected in the 
curve will also be included in the Configuration Package. 

If Cost = Distribute amount from cost sheet column, all the cost 
sheet columns available for selection will be included in the 
Configuration Package. In addition to this, the value selected for 
this field will also be included in the Configuration Package. 
Additional checks required. 

Schedule 

Case 1: Use dates from Schedule Sheet, the schedule sheet 
selected in the field should be included in the Package. 
Additional checks required. DEs selected in the From Date and 
To Date fields will also be included in the Configuration 
Package in addition to the possible values of the Schedule 
sheet DEs. 

Case 2: Use dates from P6 Source, the P6 source selected in 
the curve will also be included in the Configuration Package. 

Cash Flow Properties 
/ Curves / Curve type 
-  Forecast / General

All fields including the selected options for Distribution, Cost and 
Schedule. 

Behavior to be the same as the one outlined in Cash Flow / 
Curves / Baseline 

Cash Flow Properties 
/ Curves / Curve type 
– Portfolio Budget 

All fields selected for the Portfolio Budget Curve will be included 
in the Configuration Package 

Cash Flow Properties 
/ Curves / Curve type 
-  Forecast / Options 

All options selected for the Forecast Curve will be included in 
the Configuration Package 
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Component Field / Option 

Cash Flow Properties 
/ Curves / Curve type 
– Portfolio Budget 

All fields selected for the Portfolio Budget Curve will be included 
in the Configuration Package 

1- Additional checks might be needed for Portfolio Manager 
related Configuration. 

2- Currency is a required field for Portfolio Budget curve. The 
default value is set to the Project Currency. However this 
currency might differ from the Project Currency. It could be any 
of the Active and Future currencies listed in the Exchange Rate 
table. Therefore, if the currency differs from the Project 
Currency then in addition to the Currency value specified in this 
field, the currency and its exchange rate information will also be 
included in the Configuration Package. 

Rules for creating Currencies and Exchange Rates 

- Currency will get created if it does not already exist 

- Currency attributes such as Code, Name, Symbol etc will not 
be updated by means of Package import.  

- Currency tab content will get updated upon every import. 

If exchange rates defined for currencies in the source shell 
template do not exist in the destination environment, then a new 
exchange rate record will get created for that currency and that 
exchange rate will be set to Active. 

- The Effective date will be set to the Package Import Date. 

- The Peg rate will be brought over from the source 
environment. 

- The float rate will be brought over if the rate does not exist in 
the destination environment. 

Cash Flow Properties 
/ Curves / Curve type 
- Actuals 

All fields selected for the Actuals Curve will be included in the 
Configuration Package. Additional checks required. 

Cash Flow Properties 
/ Filter 

Selected Filter options 

If Filter = Select CBS, then the selected CBS codes will be 
included as part of Filter options. Additional checks required. 

Cash Flow Properties 
/ Options 

Decimal Place Option will be included in the Configuration 
Package. 

Cash Flow Properties 
/ Schedule 

All options set in the Schedule tab will be included in the 
Configuration Package. 

Cash Flow Properties 
/ Summary 

Not applicable in templates? 

Cash Flow / 
Permissions 

Users and Groups 
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Component Field / Option 

Cash Flow / Filters Filters defined for the curves will also be included in the 
Package 

Cash Flow content – Detail Level: Commitment

Component Field / Option 

Cash Flow Properties / 
General 

All fields. Additional checks required for Business Processes.

Cash Flow Properties / 
Curves  

All Curves 

Cash Flow Properties / 
Curves / Curve type - 
Baseline 

All fields including the selected options for Cash flow 
granularity, Distribution and Commit BPs. Additional checks 
required for Business Processes. 

Cash Flow Properties / 
Curves / Curve type -  
Forecast / General 

All fields including the selected options for Cash flow 
granularity, Distribution and Commit BPs. 

If Distribution Method has a Profile, then the Profile will also 
be included in the Configuration Package.  

Behavior to be the same as the one outlined in Cash Flow / 
Curves / Baseline 

Cash Flow Properties / 
Curves / Curve type -  
Forecast / Options 

All options selected for the Forecast Curve will be included in 
the Configuration Package 



Shells Administration

223

Component Field / Option 

Cash Flow Properties / 
Curves / Curve type – 
Portfolio Budget 

All fields selected for the Portfolio Budget Curve will be 
included in the Configuration Package 

1- Additional checks might be needed for Portfolio Manager 
related Configuration. 

2- Currency is a required field for Portfolio Budget curve. The 
default value is set to the Project Currency. However this 
currency might differ from the Project Currency. It could be 
any of the Active and Future currencies listed in the 
Exchange Rate table. Therefore, if the currency differs from 
the Project Currency then in addition to the Currency value 
specified in this field, the currency and its exchange rate 
information will also be included in the Configuration 
Package. 

Rules for creating Currencies and Exchange Rates 

- Currency will get created if it does not already exist 

- Currency attributes such as Code, Name, Symbol etc will 
not be updated by means of Package import.  

- Currency tab content will get updated upon every import. 

If exchange rates defined for currencies in the source shell 
template do not exist in the destination environment, then a 
new exchange rate record will get created for that currency 
and that exchange rate will be set to Active. 

- The Effective date will be set to the Package Import Date. 

- The Peg rate will be brought over from the source 
environment. 

- The float rate will be brought over if the rate does not exist 
in the destination environment. 

Cash Flow Properties / 
Curves / Curve type - 
Actuals 

All fields selected for the Actuals Curve will be included in the 
Configuration Package. Additional checks required. 

Cash Flow Properties / 
Filter 

Selected Filter options 

If Filter = Select CBS, then the selected CBS codes will be 
included as part of Filter options.  Additional checks 
required. 

Cash Flow Properties / 
Options 

Decimal Place Option will be included in the Configuration 
Package. 

Cash Flow Properties / 
Schedule 

All options set in the Schedule tab will be included in the 
Configuration Package. 

Cash Flow Properties / 
Summary 

Not applicable in templates. 

Cash Flow / Permissions Users and Groups 
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Component Field / Option 

Cash Flow / Filters Filters defined for the curves will also be included in the 
Package 

Updating Shells - Cost Manager Node, Cost Sheet 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Cost 
Manager > Cost Sheet  

Conditions for Creating a Cost Sheet setup Configuration Package 

When the Sheet Setup information is packaged for the first time, the Cost Attribute design must 
also be included in the configuration package. If this check fails, then the package creation will 
result in an error. For subsequent exports, the deployed version of the design must match the 
Published version of the design. This is mainly being done since the package includes the Cost 
Sheet (CBS) rows and these depend on the deployed design. 

This check will not be performed for customers who do not use Cost attribute forms. If the 
destination server has the cost attribute form, but the Configuration Package does not include 
the Cost Attribute design, then the import will fail and an error will be displayed. 

When the Sheet Setup information is packaged for the first time, the design of any data source 
used in the column definition of the sheet must be part of the package. If this check fails then the 
package creation will result in an error. For subsequent exports, check will be made to ensure 
that the design which uses the Data Element (ex: Status) that is specifically used in the setup is 
present in the Published package. As long as this condition is met, the package creation will be 
successful. If not, the latest design will have to be included in the package. 

Cost Sheet Components in the Configuration Package 

The system includes the following components of Cost Sheet in the Configuration Package (.zip 
file): 

Component Field / Option 

Cost Sheet / 
Properties / 
General 

Title 

Cost Sheet / 
Properties / 
General 

Description 
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Cost Sheet / 
Properties / 
General 

Default View 

Cost Sheet / 
Properties / 
Structure 

Structure option 

Cost Sheet / 
Properties / 
Structure 

All segments 

Cost Sheet / 
Properties / 
Options 

Labels 

Cost Sheet / 
Properties / 
Options 

Forecast Details option 

Cost Sheet / 
Properties / 
Options 

Forecast Inclusion 

Cost Sheet / 
Properties / 
Options 

Forecast Type 

Cost Sheet / 
Properties / 
Options 

P6 Integration: Enable P6 Sources. 

When this option is selected, and if the Cost sheet has used any of 
the P6 Data Sources, then Configuration Package will also include 
the P6 Data sources defined in Standards & Libraries. If the P6 
data sources do not exist in the destination then they will get 
created and will be in Published state. 

The system currently allows up to 12 P6 data sources to be defined 
in the server. So at the time of Import, checks will have to be made 
to ensure that the total number of P6 data sources does not 
exceed 12. 
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Cost Sheet / 
Columns / Column 
Properties 

All options 

Since the data source of a cost sheet column maybe a Cost BP, 
additional checked are to be performed at the time of Configuration 
Package creation to ensure that the BP is included in the 
Configuration Package as well. 

If the entry method uses Work Sheet then the Worksheet must be 
included in the Configuration Package. 

The package will also include the hidden columns.  

Cost Sheet / 
Columns / 
Restrictions 

Users and Groups setup for Restrictions. 

Cost Sheet  / 
Budget 
Distribution 

The Budget Distribution option will be disabled at the Shell 
template level. Hence user cannot setup any distribution. 

Cost Sheet / Fund 
Assignment order 

The Fund assignment option will be disabled a the Shell template 
level. 

Cost Sheet /CBS 
Codes 

All rows which include CBS as well as Summary CBS codes along 
with the Breadown. 

Note: If the Cost Codes do not exist in the destination environment 
i.e if user has not packaged the Cost Codes by selecting the 
options of Data Structure > Cost Codes at the time of Package 
creation, then the cost codes used in the Cost sheet will be brought 
over. However the value/label pair defined in the Cost Code 
definitions will not be brought over. 

Updating Shells - Cost Manager Node, Funding - Funding Sheet 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Cost 
Manager > Funding > Funding Sheet  

A CBS Shell template can have a Funding Manager which helps keep track of Funds. Shell 
Funding sheet can be used to specify the appropriation and assignment of funds from each 
funding source. 

The Funding Sheet setup in shell template is included in the Configuration Package. 

Conditions for Creating a Funding Sheet setup Configuration Package 

When the Sheet Setup information is packaged for the first time, the Fund Attribute design must 
also be included in the package, which means that the design must be included in the 
Configuration Package. If this check fails, then the package creation will result in an error. The 
deployed version and the Published version of the design must match.  
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Note: Although you are not packaging the Funding Rows, the Company 
Fund sheet depends on the deployed version of the design. Fund codes 
in the Company Fund sheet is used in order to create the fund codes in 
the shell templates. 

This check will not be performed for customers who do not use Fund attribute forms. If the 
destination server has the Fund attribute form, but the Configuration Package does not include 
the Fund Attribute design, then the import will fail and an error will be displayed. 

When the Sheet Setup information is packaged for the first time, the design of any data source 
used in the column definition of the sheet must be part of the package. This means that these 
designs must be included in the Configuration Package. If this check fails then the package 
creation will result in an error. For subsequent exports, check will be made to ensure that the 
design which uses the Data Element (ex: Status) that is specifically used in the setup is present 
in the Published package. As long as this condition is met, the package creation will be 
successful. If not, the latest design will have to be included in the package. 

Funding Sheet Components in the Configuration Package 

The system includes the following components of Funding Sheet in the Configuration Package 
(.zip file): 
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Component F
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Component F
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Updating Shells - Cost Manager Node, Funding - Commitment Funding Sheet 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Cost 
Manager > Funding > Commitment Funding Sheet  

A commitment funding sheet is created for each base commit that has been designed for 
Commitment Funding Sheet. 

Funds can be allocated from the Shell template Funding sheet to the Commitment Funding 
Sheet. This sheet works in conjunction with the Schedule of Values (SOV) sheet to track base 
commit and change commit line items and balances. Commitment Funding Sheet templates are 
created and set up in the Templates node, and are used to create the commitment funding sheet 
structure in a project or shell (or in a project or shell template). 

This structure is then used when sheets are created for individual base commit records. A 
Commitment Funding Sheet in a shell template will be included in the Configuration Package. 

The Structure option changes from Create Structure to Update Structure after a selection of the 
Commitment Funding sheet is made. 

If the Structure has not yet been created then an error message will be seen. 

This same behavior will be seen in the following logs:  

 General Spends SOV 

 Payment Applications SOV 

 Summary Payment Applications SOV 

 Document Manager (Structure creation is not applicable here) 

Conditions for Creating a Commitment Funding setup Configuration Package 

When the Sheet Setup information is packaged for the first time, the design of any data source 
used in the column definition of the sheet must be part of the package. 

This means that these designs must be included in the Configuration Package. If this check fails 
then the package creation will result in an error. 

For subsequent exports, check will be made to ensure that the design which uses the Data 
Element (ex: Status) that is specifically used in the setup is present in the Published package. 

As long as this condition is met, the package creation will be successful. If not, the latest design 
will have to be included in the package. 

Other dependency checks performed at the time of Import: 

When the Sheet Setup information is imported for the first time, the Funding Sheet defined in the 
shell template must also be included in the package. If this check fails, then the package import 
will result in an error. 

Commitment Funding Components in the Configuration Package 

The system includes the following components of Commitment Funding in the Configuration 
Package (.zip file): 
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Component Field / Option 

Commitment Funding Sheet  Properties / General All fields 

Commitment Funding Sheet  Properties / Assignment All selections 

Updating Shells - Cost Manager Node, Schedule of Values - General Spends 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Cost 
Manager > Schedule of Values > General Spends  

The General Spends SOV structure setup,  existing in a shell template, will be included in the 
Configuration Package. The structure in the shell template can be created from the SOV 
templates that exist at the company level. 

The Structure option changes from Create Structure to Update Structure after a selection of the 
SOV Structure is made. 

Conditions for Creating a General Spends setup Configuration Package 

When the SOV Setup is packaged for the first time, the design of any data source used in the 
column definition of the sheet must be part of the package. This means that these designs must 
be included in the Configuration Package. If this check fails then the package creation will result 
in an error. For subsequent exports, check will be made to ensure that the design which uses 
the Data Element (ex: Status) that is specifically used in the setup is present in the Published 
package. As long as this condition is met, the package creation will be successful. If not, the 
latest design will have to be included in the package. 

General Spends Components in the Configuration Package 

The system includes the following components of General Spends in the Configuration Package 
(.zip file): 

Component Field / Option 

SOV Structure 
Properties/ General 

All fields 

SOV Structure 
Properties/ Options 

All fields 

SOV Structure / 
Columns 

All columns including the data source and formula definitions 
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Updating Shells - Cost Manager Node, Schedule of Values - Payment Applications 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Cost 
Manager > Schedule of Values > Payment Applications 

Any Payment Application SOV structure setup existing in a shell template will be included in the 
Configuration Package.  

The Structure option changes from Create Structure to Update Structure after a selection of the 
SOV Structure is made. 

Conditions for Creating a Payment Applications setup Configuration Package 

When the SOV Setup is packaged for the first time, the design of any data source used in the 
column definition of the sheet must be part of the package.  

This means that these designs must be included in the Configuration Package. If this check fails 
then the package creation will result in an error. 

For subsequent exports, check will be made to ensure that the design which uses the Data 
Element (ex: Status) that is specifically used in the setup is present in the Published package. 
As long as this condition is met, the package creation will be successful. If not, the latest design 
will have to be included in the package. 

Other dependency checks performed at the time of Import: 

When the Pay App SOV Setup done in a shell Template is imported for the first time, Cost sheet 
defined and setup in the shell template must also be included in the package. If this check fails 
then the package import will result in an error. For subsequent imports, the Cost sheet setup 
need not be part of the Import Package. 

When the Pay App SOV Setup is packaged for the first time, the BP setup of the Payment 
Application BP must also be included in the package. If this check fails then the package import 
will result in an error. For subsequent imports, the Payment Application BP setup need not be 
part of the Import Package. 

Payment Applications Components in the Configuration Package 

The system includes the following components of Payment Applications in the Configuration 
Package (.zip file): 

Component Field / Option 

Payment Application Properties / General All fields 

Payment Application Properties / Options All fields 

Payment Application Structure / Columns All columns 
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Updating Shells - Cost Manager Node, Schedule of Values - Summary Payment 
Applications 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Cost 
Manager > Schedule of Values > Summary Payment Applications 

Any Summary Payment Application SOV structure setup existing in a shell template will be 
included in the Configuration Package.  

The Structure option changes from Create Structure to Update Structure after a selection of the 
SOV Structure is made. 

The content is same as the one mentioned in the "Payment Application" section. 

Conditions for Creating a Summary Payment Applications setup Configuration Package 

When the SOV Setup is packaged for the first time, the design of any data source used in the 
column definition of the sheet must be part of the package.  

This means that these designs must be included in the Configuration Package. If this check fails 
then the package creation will result in an error.  

For subsequent exports, check will be made to ensure that the design which uses the Data 
Element (ex: Status) that is specifically used in the setup is present in the Published package. 
As long as this condition is met, the package creation will be successful. If not, the latest design 
will have to be included in the package. 

Other dependency checks performed at the time of Import: 

When the Pay App SOV Setup done in a shell template is imported for the first time, Cost sheet 
defined and setup in the shell template must also be included in the package. If this check fails 
then the package import will result in an error. For subsequent imports, the Cost sheet setup 
need not be part of the Import Package. 

When the Pay App SOV Setup is packaged for the first time, the BP setup of the Payment 
Application BP must also be included in the package. If this check fails then the package import 
will result in an error. For subsequent imports, the Payment Application BP setup need not be 
part of the Import Package. 

Updating Shells - Cost Manager Node, Templates - Commitment Funding Sheet 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Cost 
Manager > Templates > Commitment Funding Sheet

Commitment summaries contain data for all the Commit Cost BPs, and can be setup in a Shell 
template. Any Commitment Summaries setup included in the Configuration Package will be 
included as part of the Shell template Configuration Package.  
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Conditions for Creating a Commitment Summaries setup Configuration Package 

When the Commitment Summaries setup is packaged for the first time, all the BP designs must 
also be included in the package, which means that the designs must be included in the 
Configuration Package. If this check fails, then the package creation will result in an error. For 
subsequent exports, check will be made to ensure that the design which uses the Data Element 
that is specifically used in the setup is present in the Published package. As long as this 
condition is met, the package creation will be successful. If not, the latest design will have to be 
included in the package. 

Commitment Summaries Components in the Configuration Package 

The system includes the following components of Commitment Summaries in the Configuration 
Package (.zip file): 

Component Field/Option 

Commitment Summary All columns 

Commitment Summary / Columns / 
Column Properties 

All Properties 

Updating Shells - Document Manager Node 

The Document Manager (DM), within a Shell template, contains the entire folder structure that a 
particular shell uses to manage all the relevant documents.  

You can use the Document Manager template to update the structure and permissions, or just 
permissions across all shells or to selected shells of the same type. You can apply changes to a 
single or the entire folder hierarchy in the destination shell. Update rules apply to each 
sub-option – for example, in the Structure & Permissions option, if a folder does not exist, it will 
be added 

To push DM template changes and update shells: 

1) Navigate to Company Workspace > Admin mode > Templates > Shells > "Shell 
template" > Document Manager > Documents.

2) To update the structure and permission: 

a. From the Update Shells drop-down menu, select Structure & Permissions.  

b. To update all shells, select All Shells. To update selected shells, selects Shells. From 
the Shell picker, select the shells and click Update Shell(s).

3) To update the permissions: 

a. From the Update Shells drop-down menu, select Permissions.  

b. To update all shells, select All Shells. To update selected shells, selects Shells. From 
the Shell picker, select the shells and click Update Shell(s).

The tagged Document Manager with folders setup in a tagged Shell template will be included in 
the Configuration Package.  
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Conditions for Creating a Document Manager setup Configuration Package 

When the Setup information is packaged for the first time, if the folder properties are based on a 
DM attribute form, then the DM Attribute design must also be included in the package.  

This means that the design must be included in the Configuration Package. If this check fails, 
then the package creation will result in an error.  

For subsequent exports, check will be made to ensure that the design which uses the Data 
Element that is specifically used in the setup is present in the Published package. As long as 
this condition is met, the package creation will be successful. If not, the latest design will have to 
be included in the package. This check will not be performed for customers who do not use DM 
attribute form. 

Document Manager Components in the Configuration Package 

The system includes the following components of Document Manager in the Configuration 
Package (.zip file): 

Component Field / Option 

Document Manager  All Folders 

Document Manager / 
Folder  

All Permissions which includes users and groups 

Document Manager / 
Folder 

All Folder Properties 

DM attributes DM form attributes will get copied over. 

Updating Shells - Space Manager Node, Levels Sheet 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Space 
Manager > Levels Sheet 

The Levels Sheet, in Space Manager, provides a sheet view of all the floors and associated 
spaces for a given Project/Shell. Tagged level sheet in a tagged Shell template will be included 
in the Configuration Package.  

Conditions for Creating a Level Sheet setup Configuration Package 

When the Setup information is packaged for the first time, the level design must also be included 
in the package.  

This means that the design must be included in the configuration package. If this check fails, 
then the package creation will result in an error.  

For subsequent exports, check will be made to ensure that the Data Element used in the setup 
is present in the Published package. As long as this condition is met, the package creation will 
be successful. If not, the latest design will have to be included in the package. 
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For Levels Sheet, no checks for inclusion of Configuration setup will be done either at the time of 
packaging the setup for Configuration Package or at the time of importing the setup in a 
destination environment. At the time of import, the setup information is brought over regardless 
of the Configuration status (Active/Inactive) of the design object. However as a best Practice, it 
is recommended that any time the configuration of design object has changed it must be 
included in the Configuration Package. 

Level Sheet Components in the Configuration Package 

The system includes the following components of Level Sheet in the Configuration Package (.zip 
file): 

Component Field / Option 

Levels 
Sheet 
Properties 

Name 

Levels 
Sheet 
Properties 

Description 

Levels 
Sheet / 
Columns 

All columns. Columns in Levels sheet are the Data Elements from the 
Levels. Check has to be made to ensure that the latest deployed version 
of Level design has also been included in the Configuration Package. 

Levels 
Sheet / 
Columns  

Group columns names 

Updating Shells - Space Manager Node, Stack Plans 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Space 
Manager > Stack Plans 

The Stack Plan, which is a two-dimensional graphical display of facility or building data derived 
from Space records for levels, can be setup in a Shell template. The Stack Plans in a shell 
template will be included in the Configuration Package.  

You can select multiple items to include in the Configuration Package. 
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Conditions for Creating a Stack Plans setup Configuration Package 

When the Stack plan Setup information is packaged for the first time, the level and Space 
designs used in the setup must also be included in the package. This means that the designs 
must included in the Configuration Package. If this check fails, then the package creation will 
result in an error. For subsequent exports, check will be made to ensure that the design which 
uses the Data Element that is specifically used in the setup is present in the Published package. 
As long as this condition is met, the package creation will be successful. If not, the latest design 
will have to be included in the package. 

Configuration Information: 

For Stack Plans, no checks for inclusion of Configuration setup will be done either at the time of 
packaging the setup for Configuration Package or at the time of importing the setup in a 
destination environment. At the time of import, the setup information is brought over regardless 
of the Configuration status (Active/Inactive) of the design object. However as a best Practice, it 
is recommended that any time the configuration of design object has changed it must be 
included in the Configuration Package. 

Stack Plans Components in the Configuration Package 

The system includes the following components of Stack Plans in the Configuration Package (.zip 
file): 

Component Field / Option 

Stack Plan Properties / 
General 

Name 

Stack Plan Properties / 
General 

Description 

Stack Plan Properties / 
General 

Include levels option 

Stack Plan Properties / 
Options 

Space Type. Space type is a required field in Stack Plans. 
Tthe latest deployed version of the associated Space type 
must also be part of the Configuration Package. 

Updating Shells - Schedule Manager Node, Schedule Sheets 

Go to: Company Workspace > Admin mode > Templates > Shells > "Shell template" > Schedule 
Manager > Schedule Sheets  

The selected Schedule Sheets in Schedule Manager, in the selected Shell template, will be 
included in the Configuration Package.  

The Schedule Sheets can be created by using templates at the company-level. 
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Conditions for Creating a Schedule Sheets setup Configuration Package 

When the Setup information is packaged for the first time, then the Schedule Attribute and the 
Resource Assignment attribute designs must also be included in the package.  

This means that the design must be included in the Configuration Package. If this check fails, 
then the package creation will result in an error. 

For subsequent exports, check will be made to ensure that the design which uses the Data 
Element that is specifically used in the setup is present in the Published package. As long as 
this condition is met, the package creation will be successful. If not, the latest design will have to 
be included in the package. 

Schedule Sheets Components in the Configuration Package 

The system includes the following components of Schedule Sheets in the Configuration 
Package (.zip file): 

Component Field / Option 

Schedule Sheet 
Properties/ General 

All fields. Custom calendars should also be included in the 
Package. 

Schedule Sheet 
Properties / Gantt Chart

All fields  

Schedule Sheet 
Properties / Tracking 
Gantt 

All fields 

Schedule Sheet 
Properties / Options 

All fields 

Schedule Sheet 
Properties / Schedule 

All fields 

Schedule Sheet / 
Activities 

No activity related information will be packaged, meaning no 
rows will be included. 

<Schedule Sheet 
Name> / Scope 
Management Setup 
(Applicable for shell 
templates) 

No Scope setup will be brought over since the scope is tied to 
an activity.  

Schedule Sheet / Data 
Mapping 

All fields. Dependency checks for inclusion of Schedule 
Attribute and Resource Assignment forms will be performed 
to see if the relevant designs are part of the package.  

Schedule Sheet / 
Budget and Progress 
Setup 

All applicable options 
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Component Field / Option 

Schedule Sheet / 
Column 

All columns defined in the sheet. If column definition is based 
on Cost Sheet definition, then the Cost Sheet must also be 
included in the configuration package. If cost sheet column 
does not exist, then an error will be displayed. 

Updating Shells - Access Control Node 

You can edit access control parameters and update across shells. 

The Update Shell process runs in the background. Depending on the number of records and 
shells you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes:

 Modules are identified by name. 

 If the module exists in the shell, the module is updated, users/groups 
are created or updated, and permissions are updated for the module. 

 If the module does not exist, the module is added to the shell. 
Users/groups are created and permissions are created for that 
module. 

To update access control using Update Shells 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell template to update. 

4) In the shell-type template, navigate to Access Control and assign user or group 
permissions to the modules as needed. 

5) Click the Update Shells button. The Update Shells window opens, displaying the list of 
modules for which the access control settings can be updated. 

6) Select the module(s) that you wish to update. 

7) Click Update Shells and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 
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8) Click Yes if you want to proceed with the update, or No to cancel. 

Updating Cost Sheet Columns in a Shell 

Cost sheet columns can be updated in CBS code-based shells. 

The Update Shell process runs in the background. Depending on the number of records and 
shells you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes:  

About cost sheet columns: 

 A column is identified by a unique data source. 

 If the cost sheet does not exist in the shell, the column is not added. 

 If the shell cost sheet is present but the column does not exist, the 
column definition is created, and the column is added. Column 
restrictions are added. Users/Groups are created or updated. 

 For formula columns, be sure to first push the columns or data 
sources that make up the formula (if they don’t already exist in the 
cost sheet), then push the formula column. 

 Any new column that is created will use the column to its immediate 
left as the reference point for positioning. When a column is added to 
the cost sheet via an update, this means: If the column to the left of 
the column that is being pushed exists in both the template and cost 
sheet, the column will be positioned in the cost sheet according to its 
position in the template. If the column to the left of the column being 
pushed exists in the template but does not exist in the cost sheet, 
then the column will be added to the end (far right) in the cost sheet. 

Cost Column Shell Updating Rules 

If a cost sheet column of the same name exists, it will be replaced according to the following 
matrix. 

If this template 
(source): 

Is used for this shell 
(destination): 

The template will: 

Single Date 
Source 

Column exists Update the column 

Column does not exist Create column with the same definition 

Logical Data 
source 
(Formula entry) 

Logical Data source 
Column Exists (Formula 
entry) 

Update and replace the formula 

Logical Data source 
column exists (Manual 
entry) 

Not update the column or formula 

Column does not exist Create column with same definition 
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Logical Data 
source (Manual 
entry) 

Logical Data source 
Column Exists (Manual 
entry) 

Update the column 

Logical Data source 
Column Exists (Formula 
entry) 

Update the column and change it to 
manual entry 

Column does not exist Create column with same definition 

To add or update cost sheet columns using Update Shells 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the template to update. 

4) In the shell type template, navigate to Cost Manager > Cost Sheet. Create or open the 
Shell Cost Sheet. 

5) From the cost sheet, click Columns to open the Columns log. Add or edit cost sheet 
columns as needed. 

6) From the Columns Log window, select the column to push. Only one column can be 
updated at a time. 

7) Click Update Shells and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 

8) Click Yes if you want to proceed with the update, or No to cancel. 

Update schedule of values structure 

You can update the SOV structure for general spends or payment applications in CBS 
code-based shells. 

The Update Shell process runs in the background. Depending on the number of records and 
shells you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes: 

About updating the schedule of values structure: 

 Update Shell can be used to create or update the SOV structure. If 
the structure already exists, it will be updated. If not, it will be created 
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(restrictions apply for payment applications; see below). 

 When creating or updating the structure of Payment Applications SOV 
and Summary Payment Applications SOV, the Payment Application 
Business Process must be set up in the target shell first. If the 
business process has an active setup, then Update Shell will create 
or update the structure. 

To update SOV structure using Update Shells 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shell in the left Navigator. 

3) Open the shell template to update. 

4) In the Shell Template, navigate to Cost Manager > Schedule of Values. Select one of 
these options: General Spends/Payment Applications/Summary Payment Applications. 

5) Click Update Shells and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 

6) Click Yes if you want to proceed with the update, or No to cancel. 

Updating Shells - Reports Node 

You can add and update user-defined reports.  

The Update Shell process runs in the background. Depending on the number of records and 
shells you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Important information about updating reports in Project/Shell:  

 Reports are identified by the combination of Name and Data Type. 

 Report names do not have to be unique. 

 If the report name and data type does not exist, the new one will be added. 

 - The original owner of the report is added to the Users or Groups of the report in the 
receiving Project/Shell (Permission tab). 

 The administrator of the receiving Project/Shell becomes the report owner. 

 If a report exists with the same name and data type in the receiving Project/Shell, the 
existing report will be replaced with the new report, and the following information will be 
according to the new report: 

 Report updates 
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 Added or changed Users or groups 

 Added or changed permissions 

To add or update user-defined reports using Update Shells 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell template to update. 

4) In the shell type template, navigate to the Reports > User-Defined Reports log. 

5) Add a UDR to the shell type template, or select UDR to edit. Define properties. 

6) Select one or more reports from the User-Defined Reports log. 

7) Click Update Shells and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History:You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the 
selected shells; there is no undo for the update. 

8) Click Yes if you want to proceed with the update, or No to cancel. 

Update commitment funding structure 

You can update the structure used to create commitment funding sheets in CBS code-based 
shells. 

The Update Shells process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 

Notes:  

About updating the commitment funding sheet structure: 

 Update Project can be used to create or update the commitment 
funding structure in the project. If the structure already exists, it will 
be updated. If not, it will be created. 

 Updating the structure in a project will not affect commitment funding 
sheets that already exist. New sheets will reflect the updated 
structure. 

To update commitment funding structure using Update Shell 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shell in the left Navigator. 
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3) Open the shell template to update. 

4) In the shell template, navigate to Cost Manager > Funding > Commitment Funding 
Sheet. 

5) Click Update Shells and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 

6) Click Yes if you want to proceed with the update, or No to cancel. 

Update cash flow properties and permissions 

You can push cash flow detail curve properties and permissions from a shell template to a shell. 
This is available for CBS-code based shells and templates. 

The Update Shell process runs in the background. Depending on the number of records and 
projects you are updating, it can take a considerable amount of time to complete. The process is 
complete when the End Date column in the Update History window shows the complete date. 
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Notes:  

About updating cash flow curve properties: 

 Both detail curve properties and permissions are pushed from the 
template to the project. 

 Cash flow detail curves are identified by name. 

 If a detail curve with the same name exists in the project, it will be 
replaced. All properties, including detail level and time scale, and 
permission settings will be updated. 

 If a detail curve with the same name does not exist in the project, a 
new one will be created. 

 Users and groups will be added if they do not exist. If a group is 
created, it will be empty. 

 In order to push a curve, the destination project must have a cost 
sheet. 

 Commitment detail level curves will not be pushed. 

 A Summary CBS curve cannot be pushed to a project where the cost 
sheet is flat. 

 After a successful update, the updated destination curves will be 
refreshed. 

To update cash flow curve properties and permissions using Update Shell 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shell in the left Navigator. 

3) Open the shell template to update. 

4) In the shell template, navigate to Cost Manager > Cash Flow. 

5) Add a cash flow curve to the shell template, or select one to edit. Define properties. 

6) Select a curve from the Cash Flow log. 

7) Click Update Shells and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 

8) An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a shell is updated, this action cannot be undone. Click Yes if you want to 
proceed with the update, or No to cancel. 
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Update generic cost sheet columns and rows 

You may have a large number of codes that are used within the Generic Cost Manager. In 
addition you may have a large number of shells in your implementation. To update codes and 
columns in your generic cost manager sheets with a minimal effort, you can push columns in a 
project or shell template generic cost sheet from the Columns Log to cost sheets. 

Notes:  

About updating shell instance dashboards: 

 A cost sheet must already exist in the destination shell. Pushing a 
column from a template will not create a cost sheet that can receive 
the column. 

 You can push one column at a time. 

 If a source column is a single data source, then the destination 
column will be created with that single data source if it does not 
already exist. (Column A or B in example below) 

 If a source column is a formula with only single data sources, then 
pushing the source column will create that column in the destination 
cost sheet, if it does not already exist. (Column C in example below) 

 If a source column is a formula with columns included in the formula, 
as long as all constituent columns contain single data sources, the 
source column can be pushed; for any columns that do not exist in 
the destination cost sheet, the formula will be changed to a single 
data source in the formula. (Column D in example below) 

 If a source column is a formula with constituent columns that include 
logical data sources, the logical data source must exist in the 
destination cost sheet. The formula for the logical data source may 
be different in the destination cost sheet. Any column that contains a 
single data source will follow the rule above. (Column F in example 
below) 

To add or update generic cost sheet columns from a template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell-type template to update. 

4) In the shell template, navigate to Configurable Modules > Generic Cost Manager. 
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5) Select the Generic Cost Manager Sheet template and click the Structure button. 

6) In the Generic Cost Manager Sheet log, select the cost sheet template and then click the 
Columns button. The Columns Log window opens. 

7) Select a cost sheet column. 

8) Click Update Shells and choose one of the following: 

 Shells: You can use this option to select one or more shells to update. When the update 
window opens, it lists all shells in the project. You can use Find to isolate the shells you 
want to update. The find window contains data elements from the Find form that was 
designed in uDesigner. When you have isolated the shells to update, click the Update 
button and select either Selected Shell(s) or All Filtered Shells. 

 All Shells: You can use this option to update all shells of that shell type. 

 History: You can view the update history from past updates or cancel a request before 
the update begins. 

An Alert window opens letting you know that you are about to push changes to the selected 
shells; there is no undo for the update. 

9) Click Yes if you want to proceed with the update, or No to cancel. 

To update generic cost sheet rows from a template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells in the left Navigator. 

3) Open the shell template you want to update. 

4) In the template, navigate to Configurable Modules > Generic Cost Manager. 

5) Select the template and click the Structure button. 

6) Select a row or rows to push to the project/shell level generic cost sheet. You can select 
multiple rows by holding down the Shift or Ctrl keys as you click on the rows. 

Unifier will update leaf-level rows, but not summary rows. 

7) Click Update Shells and choose one of the following: 

 Shells: allows you to choose which shell(s) to update. You can use Find to search for 
specific shells to select from the complete list of shells. You can select as many shells as 
you want to update. The Page and Display fields display on the Shell Update window, but 
are disabled in this case. 

 All Shells: updates all active and on-hold shells 

 History: allows you to view the update history from past updates or cancel a request 
before the update begins. 

An Alert window opens, detailing the information that will be updated. Read the message 
carefully, as once a shell is updated, this action cannot be undone. 

8) Click Yes if you want to proceed with the update, or No to cancel. 

View update history 

You can view details about previously updated shell modules. 

To view Update Shell History 

1) In the shell type template, navigate to the module to view the update history. 
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2) Click the Update Shells button and choose History. The Update Shells: History window 
opens. It lists any previous incidents of using Update Shells. 

3) Select an instance from the list and click Open. The History Details window opens, detailing 
the module information that was updated. History Details displays: 

 Requestor: User who initiated the update process 

 Shells: Either user-selected or all shells 

 Submitted date: When the update request was submitted 

 Start date: When the update process started 

 End date: When the update process ended 

Cancel a shell update request 

You can cancel an update request that has not yet started; that is, any request that does not 
have a status of In Process or Finished. 

To cancel a shell update request 

1) In the shell type template, navigate to the module in which you want to cancel the update 
request. 

2) Click the Update Shells button and choose History. The Update Shells: History window 
opens. 

3) Select an update that has not yet started. 

4) Click Cancel Request. 

Setting Up View Forms in Shell Attributes 

The shell details page (Details) displays the View Forms tab. To access the shell details page, 
go to Company Workspace > Admin mode > Company Sponsored Shells > shell type > shell 
instance.  

The View Forms tab is available in all shell types (single shell or multiple instance shell) details 
page, when there are View forms defined and deployed for that shell type. The View Forms tab 
is available in all shell types, when there are View forms defined and deployed for that shell 
type. The View Forms tab is available in all shell types, when there are View forms defined and 
deployed for that shell type. 

The View Forms tab is not available: 

 If the design does not have a View form. 

 For shell designs deployed prior to this upgrade. 

In the View Forms tab, click the add option (plus icon) to add the View forms (from a list of 
forms displayed in the Select View Forms window) that are associated with the shell. You, the 
administrator, can select multiple View forms to add. After adding the View forms, you can 
remove or change the forms sequence. You can use the gear menus to remove multiple View 
forms.  

Once you add the View forms and click Add, the system opens the User and Group Picker
window which displays all active users or groups that are associated with the Shell. Multiple 
users and groups can be added to the viewers list. 
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Click Done when finished. The Details page will split in two and the right side displays the 
Permissions Settings block along with the Add Viewers field. 

If you assign users and groups to a View form, then the assigned users and groups can see the 
General tab of the form, only. 

If the users or groups have permission to view multiple View forms, then they will see the View 
forms based on the sequence listed in the Details window, under the Form Name block. 

Click Done when finished. 

If a user or group has access to multiple View forms, then the user or group will see the first 
View form that they have access to, based on the sequence of the View forms listed. 

For example, if user 'U1' has access to View Forms VF01 and VF02 both, and when U1 views 
the General tab of the shell details, then the VF01 is displayed if the VF01 is the first View form 
in the sequence order of forms displayed. 

Setting Up the Automatic Update of Shell Status 

At the Company level, you can define the setup of the automatic update of project statuses of 
active projects based on triggering conditions which are defined using various data sources as 
parameters. For example: 

 A selected activity on the schedule sheet is in the Completed status 

 A single-record business process record is set to a specified status 

 A business process workflow reaches a specified status 

Depending on the setup and the conditions that are set, the status of the shell can change from 
Active to a non-active status (On-Hold, View-Only, or Inactive). You can define multiple setups 
for each shell. After you define these setups, they can be used on shell instances, or on 
templates to enable the automatic update of shell status. 

The data sources that you use in the triggering conditions can be either from shell level or from 
the Company level. This data sources can be business processes, sheets or attribute forms. You 
can define the frequency at which Unifier evaluates the conditions to see if a particular active 
shell should change its status, and can define a list of users or groups to be notified when the 
shell status is changed. The highest frequency is daily. 

This automatic update of shell status can be useful for users that have a large number of shells 
and want many of these shells to change their status based on certain triggering conditions, and 
thus the users do not have to search for and modify these shells manually. For example, you 
can define a setup at the Company level that contains a triggering condition that changes of the 
status of an active shell On-Hold if the shell funds consumption exceeds the funds appropriated 
for that shell. This allows the shell manager to review the shell and take appropriate action. If, in 
this case, the shell manager is able to get additional funding for the shell, the Administrator can 
change the shell status back to Active to restart the shell activities. 

Note: Automatic shell status update can change the status of a shell 
from Active to an inactive status. If you want the inactive shell to status 
to revert to Active, you must activate the shell manually. 

Step 1: Create setups - general information. 
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Step 2: Verify the order of shell statuses. 

Step 3: Define shell status triggering conditions. 

Step 4: Define the schedule for automatic update of shell status. 

Step 5: Activate the automatic update of shell status. 

Step 6: Define permissions. 

Create an automatic shell status update setup 

Multiple setups can be defined at the company level and then used to configure individual shells. 

Note: You must have imported a shell attribute form that contains the 
uuu_au_setup_picker data element to be able to setup the automatic 
update of shell status. 

To create a new shell status update setup 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Workspace > Auto-update Status Setup. The Auto-Update Status Setup 
log opens. 

3) Click New. The Auto-update Status Setup window opens. There are three tabs: General, 
Settings, Schedule. 

4) In the General tab, enter a Setup Name, which displays in the log, and an optional 
Description. 

5) In the Settings tab, define the order of the non-active statuses and the status change query 
and trigger conditions. For details, see Choose the order of non-active statuses (Settings 
tab) (on page 256) and Define status change query and trigger conditions (Settings 
tab) (on page 257). 

6) In the Schedule tab, you can schedule the shell status update. See Define shell status 
update schedule (Schedule tab) (on page 258). 

7) Once you have defined the setup, you must activate it to be able to apply it to a shell. See 
Activate or deactivate an auto-update status setup (on page 258). 

Note: You must deactivate a setup to be able to modify it. 

Choose the order of non-active statuses (Settings tab) 

By default the order of the listed statuses is On-Hold, View-Only, and Inactive. These are listed 
on the left side of the Settings tab in the Status pane. You can change the order using the 
Move Up or Move Down buttons. You can change the order of the non-active statuses. The 
order of the statues is significant because the triggering conditions for the statuses are 
evaluated in the order in which they are listed on this tab, with the verification of the triggering 
conditions occurring for each condition listed in turn. 
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For example, if the conditions for the first listed status are not met, then the conditions for the 
next listed status are evaluated. If the conditions for that status are not met, then the triggering 
conditions for the third status conditions are evaluated. As soon as the first match occurs, Unifier 
will automatically change the shell status and does not perform further evaluation. 

To reorder non-active shell statuses 

1) Open the Auto-update Status Setup window and click the Settings tab. 

2) In the Status pane, select the status you want to move. 

3) Click the Move Up or Move Down button to reposition the selected status. 

4) Click Apply to save changes, or OK to save changes and exit the window. 

Define status change query and trigger conditions (Settings tab) 

The Conditions Elements section allows you to define condition criteria per element. Elements 
can be selected from all Unifier data sources and modules available at the Company level. 

In this field: Do this: 

Notify users 
and groups on 
Status change 

Allows you to define the users and groups who will receive status 
change notification. 

Email content 
Enter the content of the email you want to send to notified users and 
groups. This content appears in the Additional Information section of 
the email. 

To define query and trigger conditions 

1) Under Conditions Elements, click Add. 

2) Select a Data Type, and click OK. The Query Condition window opens. 

3) Complete the General tab by entering a name for the query and a brief description. The 
Data type and Element is auto-populated from the selection you make on the Query tab. 

4) Click the Query tab. 

5) Click Add. 

6) Complete the Query tab: 

 Data Element: Click the Select button. The Data Element Picker opens. The list is 
generated from the data type you chose in the General tab. If the data element is a 
picker, pull-down or radio button, the Value field will display the values entered in the 
data set tab of for the data definition associated with the data element. For a full list of 
data elements and data types, refer to the Unifier Reference Guide. 

 Label: The label defaults to the data element name. You can enter a different label. 

 Condition: Define Gate Condition Element Condition. The condition options vary 
dynamically depending on the selected Data Element. The screen shots below list out the 
various options for different Data Element types. Examples include equals, does not 
equal. 
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 Values: Specify value. The Values field varies dynamically depending on the selected 
Data Element and Condition. (For example, if the element is a text box, the condition 
might be Contains, and value might be one or more letters to search for. If the element is 
a pull-down or other data definition with a data set, you will select a value from the data 
set.) 

7) Select the trigger conditions. 

8) Click OK. 

Define shell status update schedule (Schedule tab) 

You can define a schedule to check the conditions for the automatic update in the Auto-update 
Status Setup window, Schedule tab. 

The maximum frequency that Unifier will verify whether triggering conditions are met is daily. If 
you have a need for greater frequency of verification, you must monitor the shell with the shell 
manager and then change the shell status manually as needed. For example, if the triggering 
condition verification is performed in the morning, and the shell funds are being spend during the 
course of the day, the shell could exceed its budget before the condition verification occurs the 
next morning, and the shell status is automatically changed. 

In this field: Do this: 

Enable 
Scheduled 
Runs 

Select this checkbox to enable scheduled evaluating of the automatic 
update status. Deselecting this checkbox will disable the scheduler, 
and any scheduled future runs will be canceled immediately. 

The scheduled evaluation is disabled for the last status in the list, 
provided all conditions are met, and the Enable Scheduled Runs 
checkbox is automatically deselected. 

Frequency 
Choose Frequency of the Scheduled Runs (Daily, weekly, monthly, 
quarterly, yearly) 

Range of 
Recurrence 

You can specify a date on which the Scheduled Runs will end, or no 
end date. 

Activate or deactivate an auto-update status setup 

You must activate a setup in order to be able to apply it to a shell. 

Note: You must deactivate a setup to be able to modify it. 

To activate or deactivate a shell status update setup 

1) To activate or deactivate a new setup to use in shells, go to the Company Workspace tab 
and switch to Admin mode. 

2) Click Company Workspace > Auto-update Status Setup. The Auto-Update Status Setup 
log opens. 
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3) Select a setup in the log. 

4) Click the Status button. You can choose Active or Inactive. 

Set permissions for automatic update of shell status 

To set permissions for automatic status update: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Access Control in the left Navigator. 

3) On the right pane, select Administration Mode Access > Company Workspace > 
Auto-update Status Setup. The permissions are: 

 Create: Allows the creation of new auto-update status setups, edit existing auto-update 
status setups and activate or deactivate auto-update status setups. 

 Modify: Allows the edit existing auto-update status setups and activate or deactivate 
auto-update status setups. This permission excludes the ability to create a new 
auto-update status setup. 

 View: Allows viewing of existing auto-update status setups. 

How to Set Up Gates 

Before you begin: Verify the list of phases resides in the Phase data definition pull-down data 
set. This is the same list that is used when selecting a phase manually in the shell properties 
window. You can add or modify the default list as needed. This list makes the phases available 
for any shell instance or shell type template; for each shell or template, you select which of the 
phases to use. Create any business processes that you plan to use to drive gates conditions 
and phase completion. 

Step 1: Define Phases. For each shell instance or shell type template, you define the list of 
phases to include in the setup, choosing from the entire list in the Phase data set. 

Step 2: Define Gate Conditions. For each phase, define one or more gates conditions. A gate 
condition is a combination data element and trigger condition that enable transition to the next 
phase. 

Step 3: Schedule Gates runs. The gates run the validation of gate conditions. You can 
schedule runs automatically. This is optional. 

Step 4: Activate the Gates setup. 

Step 5: Define permissions. 

Notes: 

If you create a new shell by copying a shell template or an existing shell, 
any existing gates setup in the source shell is copied into the new shell, 
including the gates status. The gates phases are restarted at the first 
phase in the new shell, and the scheduled gates run is activated. 

The DE of type Rich Text DE is not available to be added as a Gate 
Condition Element (Gates > Settings).  
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Example of a gates setup and conditions 

You will be setting up phases in gates to represent the actual phases of a shell. For the shell to 
advance from one phase to another, certain conditions must be met. This example will discuss 
phases, conditions, and using business processes in the context of the conditions to advance a 
shell from one phase to another. 

For example, phases for shell Zero could be: 

 Preliminary 

 Investigation 

 Definition 

 Measurement 

 Analysis 

 Start 

 Control 

Previously, you have set up two business processes to use in the conditions for your gates 
setup. These are: 

 Schedule: A single record business process that is updated manually by a shell manager by 
checking checkboxes for the various phases such as Definition Phase Complete? or 
Measurement Phase Complete? 

 Funding: a workflow business process that is automatically updated thorough the steps of 
the workflow. 

As the shell manager checks the checkboxes in the phases as represented in the Schedule 
business process, the gates runs keep checking the statuses of the checkboxes. As they are 
checked off, the project advances to the next phase. 

The exception to this procedure is the transition from the Analysis phase to the Start phase. 
Additional approval is needed for funding in order for the project to advance from Analysis to 
Start. The Funding business process is included in the conditions for the Analysis phase. This 
business process must have the status Construction Approved and have a value of greater than 
zero for the Analysis phase to be exited and the Start phase entered for the project. 

Define the phase list 

To view the phase list 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Data Structure > Data Definitions in the left Navigator. 

3) Click Basic. 

4) Select the Phase data definition and click Open. The Modify Data Definitions window opens. 

5) Click the Data Set tab. The active phases on this list will be available for phase setup. 

6) Modify the list as needed. Any changes you make here will be reflected in new gates set 
ups. Current setups will not be affected. 
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Create a gates setup 

You can create a gates setup in shell templates, and in individual shells. There can be one setup 
per shell instance. 

To create a new gates setup 

1) Do one of the following: 

 To create the setup in a shell type template, go to the Company Workspace tab and 
switch to Admin mode. Click Templates > Shells in the left Navigator. Open the shell 
template. 

 To create the setup in a shell instance, go to the Company Workspace tab and switch to 
Admin mode. Click Company Sponsored Shells in the left Navigator. Open the shell 
instance. 

2) Choose Setup > Gates. The Gates Setup log opens. 

3) Click New. The gate setup is created automatically. Double-click the setup, or select from 
the list and click Open. The Gates Setup window opens. There are three tabs: General, 
Settings, Schedule. 

4) In the General tab, enter a Setup Name, which displays in the log, and an optional 
Description. At this point, Status is Inactive by default. 

5) In the Settings tab, define phases and gates conditions. 

6) In the Schedule tab, you can schedule regular gates. 

Delete a Gates Setup 

This section describes how to manually delete a gates setup from a shell.  

Note: You can delete a gates setup from a specific shell template but not 
from other Projects/Shells that have been created using the template. 

In Administration mode: 

1) Open the project or shell and in the left navigation pane, click Setup > Gates. 

2) Select a Gates setup for deletion. 

3) Click Delete. 

Note: System prompts the user asking to confirm deletion of the gates 
setup. 

4) Click Yes to delete the Gates setup. 

Add phases to the gates setup (Settings tab) 

Select which of the phases to use in the shell or shell template from the available phase list. You 
can reorder them as necessary for the shell instance or shell type template. 

To add phases to the new gates setup 

1) Open the Gates Setup window and click the Settings tab. 
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2) In the Phases pane, click the Add button. The Select Phases window opens, displaying the 
list of available phases. 

3) Select one or more phases to add to the list. To select multiple phases, hold down the CTRL
or SHIFT keys while selecting. 

4) Click OK. The phases appear in the Phases list. 

The order in which the phases appear on the list is the order they will be followed in the shell. 
The first phase on the list will be the first phase of the shell. 

Access gate configuration view 

To access the gate configuration view 

Select a phase. The gate configure view opens in the right pane. See the following table for 
more information about the gate configuration view. 

The Phase Gate Configuration section in the navigator lists the Phases for the current shell. 
The visual order of the Phases depends on the Order specified in the General tab. 

The Gates Conditions Elements section allows you to define condition criteria per element. 
Gate Elements will be selected from all Unifier data sources and modules available in a 
particular shell (for the Sponsoring company). 

In this field Do this 

Start Date 

The Start date for a particular Phase can be manually set or auto 
populated from a Schedule Sheet by linking it to a particular activity or 
milestone (activity with zero duration and marked as milestone) where 
it will update dynamically based on the start date associated with this 
activity. If there are multiple Start dates, choose the Start date used to 
set Gantt Charts in Schedule Manager. 

The start date must fall within Shell date ranges. 

Planned 
Completion 

Can be manually set or auto populated from a Schedule Sheet by 
linking it to a particular activity or milestone (activity with zero duration 
and marked as milestone) where it will update dynamically based on 
the start date associated with this activity. If there are multiple End 
dates, choose the End date used to set Gantt Charts in Schedule 
Manager. 

Note: Dates are for reporting only. Phases cannot be date driven. 

Advance to 
Next Phase... 

This checkbox enables automatic phase advancement. Select the 
checkbox if you want the shell to move automatically to the next 
phase once all Gate Elements for a particular Phase have been 
checked. 

Notify users on 
Phase 
Completion 

Allows you to define users who receive phase completion notification. 
You can configure the body text in the notification (similar to the 
business process Setup on the End Step, where you can specify the 
message text content. 

Reevaluate When selected, this checkbox specifies that processing always starts 
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conditions on 
every Gates run

at the First phase during a scheduled Gates Run/Refresh. You might 
have to scroll down to see this checkbox. 

If the checkbox is not selected for a phase: 

 If the phase is currently incomplete, incomplete conditions are 
evaluated and completed conditions are skipped 

 If the phase is currently complete, phase processing is skipped 

If the checkbox is selected in a phase: 

 Every condition in that phase is reevaluated. Including conditions 
that were met 

 All conditions (except conditions that were marked as "ignore" 
manually) are marked as incomplete at the beginning of every 
Gates run and refresh. 

Saved Gates run (PDF) from prior runs persist. Processing will stop at 
a Phase where first un-met condition is encountered. By default this 
checkbox is deselected. 

Configure gate elements 

To add a Gate Condition Element 

1) In the Gates Setup window, gate configuration view, select a phase and click Add. The Data 
Type window opens. 

2) Select a Data Type from the drop down menu. 

3) Click OK. The Edit Gate Condition window opens. 

4) Complete the General tab: Enter a Name for the Gate Element. This can be the name of the 
data element or any descriptive name. This appears on the Gate Conditions Elements list. 
You can add an optional Description. 

5) Click Apply to save changes, or OK to save changes and exit the window. 

To define query and trigger conditions 

1) In the Edit Gate Condition window, click the Query tab. 

2) Under Query Conditions, click Add. The Query Condition window opens. 

3) Complete the Query tab: 

Data Element: Click the Select button. The Data Element Picker opens. The list is generated 
from the data type you chose in the General tab. If the data element is a picker, pull-down or 
radio button, the Value field will display the values entered in the data set tab of for the data 
definition associated with the data element. For a full list of data elements and data types, 
refer to the Unifier Reference Guide.

 Label: The label defaults to the data element name. You can enter a different label. 

 Condition: Define Gate Condition Element Condition. The condition options vary 
dynamically depending on the selected Data Element. The screen shots below list out the 
various options for different Data Element types. Examples include equals, does not 
equal. 
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 Values: Specify value. The Values field varies dynamically depending on the selected 
Data Element and Condition. (For example, if the element is a text box, the condition 
might be Contains, and value might be one or more letters to search for. If the element is 
a pull-down or other data definition with a data set, you will select a value from the data 
set.) 

Change the order of phases 

To change the order of the phases in a gates setup 

Select a phase and click the Move Up or Move Down button. 

Define gates runs schedule (Schedule tab) 

You can define a gates run schedule in the Gates Setup window, Schedule tab. This run 
evaluates gates conditions, and marks completed conditions as Complete. The update process 
can also be invoked manually in user mode. The scheduler engine is a background process. 

In this field: Do this: 

Enable 
Scheduled 
Gates Runs 

Select this checkbox to enable scheduled updating of Gate 
Elements. Deselecting this checkbox will disable the scheduler, and 
any scheduled future runs will be canceled immediately. 

The scheduled gates runs are disabled in the last phase provided all 
conditions are met, and the Enable Scheduled Gates Runs checkbox 
is automatically deselected. 

Frequency 
Choose Frequency of the Scheduled Gates Runs (Daily, weekly, 
monthly, quarterly, yearly) 

Range of 
Recurrence 

You can specify a date on which the Gate Runs will end, or no end 
date. 

Auto-email as 
PDF Attachment 
to Gates creator 

Select this checkbox to enable automatic emailing of the scheduled 
run results as a PDF attachment. The report displays the current 
status of each phase and gate condition. 

Activate or deactivate a gates setup 

Activating a gates setup will enable the scheduled gates runs. After activation, if you need to edit 
the gates set up, you will need to deactivate it first. 

You can make edits while the setup is inactive, including: adding or removing phases; reordering 
phases; add, modify or remove conditions within a phase. 

Some notes about activating/deactivating gates setup: 
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 Reactivating an active shell: If you temporarily deactivate a shell that is in process, and then 
reactivate it, the gates check will start over at the first phase. This is because the setup 
needs to check all phases for new phase additions or new gate conditions that may have 
been added. You can manually update the phases by clicking the Refresh button for gates in 
User Mode. This will evaluate all phases starting from the first phase, even if the phase has 
been marked Complete, and mark the first phase as the current phase. Be aware this may 
trigger email notifications regarding gates advancement, as set up in the Settings tab (where 
the users who are notified are defined), and those users’ email subscription settings (User 
Preferences). 

 While a gates set up is Inactive: No scheduled gates run will be done. To manually advance 
phases in User Mode Gates for the shell, the gates setup must be active. 

 View-Only and Inactive shells: If a shell has the View-Only or Inactive status, the gates setup 
is inactivated, and you must manually reactivate the setup. 

Set user permissions for gates 

To grant User Mode Gates permissions: 

In Access Control or Permissions window, navigate to User Mode > Shells/Projects 
(Standard) > Gates. The permissions are: 

 Change Phase: Allows the user to change gates phases. 

 Modify and Refresh: Allows the use to modify gates and refresh gates. 

 Refresh: Allows the user to refresh gates. 

 View: Allows the user to view gates. 

Editing Multiple Shells at once with Bulk Edit 

If you have a large number of shells that need similar edits, you can use bulk edit to update all of 
them at once. You can update a maximum of 200 records using bulk shell edit. The bulk edit 
must be defined in uDesigner, and you must have the Allow Bulk Edit permission set on the 
shells in order to use the bulk edit. 

The bulk edit function works only on fields from the action form (upper form) for the current step. 
It cannot be used to edit the following : 

 Auto-populated fields 

 Fields in a dynamic data set 

 Read-only fields 

 Fields from line items 

 System-generated fields, such as record number, status, or due date 
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Notes:

 An Integration interface must be created for Bulk Edit to work with 
Shells. 

 You can use bulk processing to update users in shells. See Managing 
users in bulk for details. 

To edit shells using bulk edit 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells in the left Navigator. 

3) Select one or more shells, or perform a Find to search for a group of shells to work with. You 
can select the shells from the shell log or the Find log. 

4) Choose Edit > Update > Bulk Edit. The Bulk Edit window displays. The fields displayed in 
this window depend what was specified in uDesigner for the shell. 

The Bulk Edit form includes all editable fields for the shell. All system-generated elements 
and formula columns are automatically recalculated during the bulk edit for each record. 

5) Modify the Bulk Edit form as needed. 

6) Select the Update checkbox for the fields you want to update. The checkbox is automatically 
selected when you type into or modify a field. You can deselect it if you do not want to 
modify the field at this time. 

7) Click Update. This launches the bulk update of the selected records. 

The Bulk Actions Status window opens after you click Update. This window allows you to 
monitor the progress of the bulk update. 

8) Click OK after all records have processed. Click Cancel if you want to cancel the bulk 
update in progress. 

About Shell Dashboards 

Shell dashboards display project data in an at-a-glance format. You can control the dashboard 
appearance and content and make it specific to the shell with which you are working; however, 
shell dashboards cannot pull data from across shell hierarchies. For example, consider two 
anchor shells, which are seen as tabs, one is labeled "Capital Projects," and one is labeled 
"Facilities." The Capital Projects dashboard can display data from all levels of the Capital 
Projects hierarchy; however, it cannot display Facilities data because Facilities is the root of a 
separate, independent hierarchy. 

Two types of dashboards are available in project shells: 

1) My Dashboard: All shells have a personal dashboard that a user can define if he or she has 
Setup permission. A user can configure My Dashboard in User Mode using the Edit 
Dashboard window. Users can select My Dashboard from the View Dashboard drop-down 
list on each shell. 
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2) Shell dashboards: Shell dashboards allow users to view shell and subordinate shell data. 
This differs from My Dashboard in that a user cannot share his or her personalized 
dashboard. Administrators can create multiple shell dashboards per shell and push them via 
templates. Users can select this type of dashboard to view from the View Dashboard 
drop-down list on each shell. These dashboards are maintained at the shell level and are 
available to any user to view (but not edit) provided the user has permissions. 

Each shell dashboard has at least one tab and can have up to five tabs. The default tab name is 
Summary, which you can change. The default shell dashboard layout contains these four blocks: 

 Image: Displays the image your company administrator uploaded for the shell.  

 In the dashboards, if there are multiple images, then Unifier displays all of the images as 
rolling images. 

 When a shell has multiple images, Unifier uses the first image from the list to print the 
shell image through custom prints and reports.  

 Items Requiring Your Attention: Contains items that are generally listed on the Unifier 
Home page, such as tasks and messages. 

 Details: Lists shell details, including shell number, shell name, administrator, and other 
details. 

 Links: List of links configured for the shell by your company administrator. 

On each tab, you can select a different layout to which you can add blocks of these types: 

 Standard: Use this selection to view project data from, for example, business process, 
manager, users, and active tasks. 

 Portlet: Use this selection to view an external URL, such as a web cam, a frequently visited 
website, or Analytics application. 

To view Analytics in the Portlet block, you need to perform additional and required 
configurations in OBIEE in order to allow the OBI analysis to render properly. Go to: 

 Oracle Help Center: http://docs.oracle.com/en/ 

 Middleware > Middleware Documentation 

 Oracle Fusion Middleware > Oracle Fusion Middleware Documentation 

 Products > Oracle Business Intelligence Enterprise Edition 

 Oracle Business Intelligence Enterprise Edition [latest edition] > Books 

 Administration > System Administrator's Guide for Oracle Business Intelligence 
Enterprise Edition 

 Advanced Configuration Reference > Making Advanced Configuration Changes for 
Presentation Services > Protecting Pages in Oracle BI EE from Attack 

 Drilldown: Use this selection to slice and dice project-shell data. 

 Custom: Use this selection to view data from the current shell, subordinate shells, or both 
(cannot cross hierarchies). 

 Analytics: Use this selection to access the link to the Analytics application. 

Setting shell instance dashboard permissions 

To set shell instance dashboard permissions: 

1) Go to the Company Workspace tab and switch to Admin mode. 



Unifier General Administration Guide

268

2) Click Access Control in the left Navigator. 

3) On the right pane, select Administration Mode Access > Permissions for Shells / 
Projects (Standard) > Setup > Dashboards. 

4) Set the permissions as needed: 

 Setup: Administrators can create a shell instance dashboard. 

Creating a shell dashboard in a template 

You can create new dashboards in shell templates and push them to shells. 

To create a dashboard in a shell template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Templates > Shells > [shell name] > [project shell template] > Setup > 
Dashboards in the left Navigator. The Dashboards log window opens. 

3) Click New. The Dashboard Properties window opens. 

4) Enter the dashboard name and an optional description. The dashboard name must be 
unique within the shell. 

5) Click OK. The dashboard is listed in the log. 

6) Select the dashboard in the log and click Open. The default view of the shell dashboard 
opens. 

7) Choose Edit > Dashboard. The Edit Dashboard window opens. 

Note: You might not see data in parts of the dashboard if you do not 
have specific permissions to access data cubes. 

You can edit a dashboard in an established project shell. For details, refer to the Unifier User 
Guide. 

Copy a shell dashboard 

You can create new shell dashboards by copying and modifying existing dashboards. Copying a 
shell dashboard does not copy the permissions associated with the dashboard, but will copy all 
other dashboard information. 

To copy a shell dashboard 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [shell name] > [project shell name] > Setup > 
Dashboards in the left Navigator. The Dashboards log window opens. 

3) Select a shell dashboard. 

4) Click Copy. 

5) Enter the name of the new dashboard and an optional description. 

6) Click OK. The dashboard is listed in the log. 

7) Select the dashboard in the log and click Open. The shell dashboard opens. 

8) Choose Edit > Dashboard. The Edit Dashboard window opens. 
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9) Modify the new dashboard as needed and OK. 

Modify shell instance dashboard properties 

To modify shell instance dashboard properties: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [shell type] > [shell instance] > Setup > 
Dashboards in the left Navigator. The Dashboards log window opens. 

3) Select a shell instance dashboard. 

4) Click Properties. 

5) Modify the dashboard name or description as needed. 

6) Click OK. 

Delete a shell instance dashboard 

To delete a shell instance dashboard 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [shell type] > [shellinstance] > Setup > 
Dashboards in the left Navigator. The Dashboards log window opens. 

3) Select a shell instance dashboard. 

4) Click Delete. 

Find a shell instance dashboard 

To find a shell instance dashboard 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [shell type] > [shell instance] > Setup > 
Dashboards in the left Navigator. The Dashboards log window opens. 

3) Click Find. 

4) Enter the search criteria and click Search (or press Enter). Unifier displays all the 
dashboards that met the search criteria you entered. 

Set user or group permission for a shell instance dashboard 

To set user or group permission for a shell instance dashboard: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [shell type] > [shell instance] > Setup > 
Dashboards in the left Navigator. The Dashboards log window opens. 

3) Select a shell instance dashboard. 

4) Click Permissions. 

5) Add users or groups as needed. Select the View permission. 

6) Click Apply to save or OK to save and exit. 
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Migrating standard projects to CBS shells 

You can migrate one or multiple standard projects to CBS shell types that you specify. After 
migration, the new CBS shell is created in the shell hierarchy in the location you specify, and the 
standard project is no longer listed in the project log in Unifier. All of the data that existed under 
the standard project can then be accessed from the newly-created CBS shell. 

Note: When you migrate a standard project to a CBS shell, you cannot 
undo the migration and return the shell to the standard project form. The 
migration cannot be reversed, so be sure that you want to perform the 
project-to-shell migration. 

After you migrate standard projects to CBS shells, you can use the features that shells offer, 
such as: 

 Hierarchical distribution, visualization and navigation of capital projects when organized 
under shell hierarchies based on business needs 

 Configurable dashboards 

 Roll up of cost data across the shell hierarchy 

Migration limitations 

The following are some migration limitations for you to consider: 

 The shell type must be a CBS shell. You cannot migrate standard projects to generic shells, 
only to CBS shells. 

 Shell name is limited to 128 characters, and shell description is limited to 250 characters. 
However, standard project name is limited to 250 characters, and the project description is 
limited to 2000 characters. In order for the migration from project to CBS shell to be 
successful, you must modify the project name and description to be within the limits for these 
fields that exist for the shells (128 characters for a shell name, and 250 characters for a shell 
description). 

 The standard project name cannot contain any special characters, such as: 

/\:*?"<>| 

 You cannot migrate a standard project to a single instance (top level) shell. You can only 
migrate to multiple-instance shells. 

 Even if the destination CBS shell type has auto-numbering setup, the migration cannot 
incorporate the new shell into the shell auto-numbering, but instead copies the project 
number while creating shell. The new shell is identified by the project number of the original 
project. 

 You will have to set up a new configurable shell dashboard for the new shell that is created 
by the migration. Any existing project summary set up does not migrate to the new shell. 

 If any business processes, planning items, assets, and configurable managers in the original 
project use project pickers, then you will have to recreate the link between these objects and 
the new shell. 

 Migration from a standard project to a CBS shell cannot be reversed. Once the migration is 
complete, the standard project is converted to a CBS shell, and the information from that 
project resides in the newly-created CBS shell. 
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Migration Considerations 

Before you migrate: 

 Be sure that you have Integration defined for the CBS shells you plan to use for migration 

 Examine the shell hierarchy of your CBS shells and determine the location for the new 
migrated shells. You can migrate several projects at once into a shell type, creating a new 
shell instance under that shell type for each migrated project. 

 Examine the set ups for the original projects and also for the destination shells, and think 
about the mapping from the project to the shell. You might have to add data elements on the 
project side or the shell side to ensure that the data you need is migrated correctly and 
completely. For example, the shell name is limited to 128 characters, and shell description is 
limited to 250 characters. However, standard project name is limited to 250 characters, and 
the project description is limited to 2000 characters. In order for the migration from project to 
CBS shell to be successful, you must modify the project name and description to be within 
the limits for these fields that exist for the shells (128 characters for a shell name, and 250 
characters for a shell description). 

 As a best practice, do not migrate projects that have the Active status. Modify the projects as 
needed to get them as finished as possible and then put them in the Inactive status before 
migration. Make your project as complete as you can before you migrate it to a CBS shell. 

 Test your migration in your Test environment before implementing it in your Production 
environment to ensure that the migration is successful and yields the desired result.  

 You can use user-defined reports to gather data regarding which projects to migrate and the 
location they should occupy in the shell hierarchy. 

 Understand that migration cannot be undone; when you migrate a project to a CBS shell, 
you cannot go back to that project. The project is converted completely to a CBS shell when 
the migration completes successfully. 

Migration mapping of project data elements to shell data elements 

The following table shows the automatic mapping of original project data elements to destination 
CBS shell data elements. These data elements define the fields shown on the project or shell 
setup window tabs. This mapping occurs automatically during the migration. When a standard 
project is migrated to a CBS shell, the project’s data element values are automatically populated 
in the equivalent shell data element as listed in the table: 

Standard project data 
element 

CBS shell data element 
Comments on action during 
migration 

General tab of CBS shell 

Project Number Shell Number One-to-one mapping occurs. 

Project Name Shell Name One-to-one mapping occurs. 

Description Description One-to-one mapping occurs. 

Administrator Administrator One-to-one mapping occurs. 

Project Status Shell Status One-to-one mapping occurs. 
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Auto-update Status 
Setup 

Auto-update Status Setup
Optional on the Shell Attribute 
form; if not present on the Shell 
form, is ignored during migration.

Currency tab of CBS shell

Currency Name Currency Name 
One-to-one mapping occurs for 
all defined currencies. 

Rate Rate 
One-to-one mapping occurs for 
all defined currencies. 

Type Type 
One-to-one mapping occurs for 
all defined currencies. 

Hedge Rate Hedge Rate 
One-to-one mapping occurs for 
all defined currencies. 

Hedge Amount Hedge Amount 
One-to-one mapping occurs for 
all defined currencies. 

Default Currency Default Currency One-to-one mapping occurs. 

Options tab of CBS shell 

Project Image Image One-to-one mapping occurs. 

Project Phase Phase One-to-one mapping occurs. 

Links tab of CBS shell 

Name Name 
One-to-one mapping occurs for 
all defined links. 

URL URL 
One-to-one mapping occurs for 
all defined links. 

Migrate projects to shells 

Before you begin: See the considerations and mapping discussed in Creating a Business 
Process record from a template. 

Step 1: Export the migration template. Export the CSV template. This template will vary 
depending on the data elements included in the configuration of a particular shell type. This 
template contains the fields and format that the system needs to migrate the standard projects to 
CBS shells. See Export the migration template (on page 273). 

Step 2: Modify the exported CSV template. Be sure that you have the correct project 
information ready to enter into the template. After you convert a standard project into a CBS 
shell, you cannot reverse the conversion. See Modify the exported csv template (on page 
273). 
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Step 3: Initiate migration. Import the completed CSV file. See Initiate migration of standard 
projects to CBS shells (on page 274) 

Step 4: View migration history. See View migration history (on page 275). 

Step 5: Test for shell creation. See Test for CBS shell creation (on page 276). 

You export the template, then modify it and import it. You will export the template from a 
selected CBS shell, and then import the modified template back into the same CBS shell to 
complete the migration. 

Export the migration template 

To export the migration template 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > <CBS shell type>. 

Note: The shell type must be for a CBS shell. You cannot migrate 
standard projects to generic shells, only to CBS shells. You cannot 
migrate a standard project to a single instance (top level) shell, only 
multiple-instance shells. 

3) In the shell type log, choose Export Template > Project Migration Template. 

4) Download the template to the desired location. The template you download will be specific to 
the shell type of the log from which you exported the template. 

Modify the exported csv template 

Be sure that you have the correct project information ready to enter into the template. After you 
convert a standard project into a CBS shell, you cannot reverse the conversion. 

Note: You can use user-defined reports to gather data regarding which 
projects to migrate and where they should be in the shell hierarchy. 

To modify the template 

1) Open and edit the CSV template, per the template content, and the description of the 
template content in this section. It is recommended that you migrate projects that are not in 
the Active status. The content of the migration template will vary depending on the shell type 
into which you choose to migrate. 

The exported template is organized in three sections: 

 Instructions: This section at the top of the template explains how to fill in the template to 
initiate the migration. Do not modify this text. 
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 Mapping: This section maps the available standard project attributes with the 
user-defined CBS shell attributes. Use this section to create mapping for data elements 
that you have added in addition to the data elements listed in the table in Migration 
mapping of project data elements to shell data elements (on page 271). The 
Mapping section lists all the project attributes which are not automatically mapped. If you 
use custom project attributes, these attributes be listed and mapped in this section. The 
project data elements are static; you add the shell data elements to complete the 
mapping. The values in this section are overwritten by any literal values that you add in 
the Project section. 

 Project: This section lists the Project Number and Location, and the use- defined CBS 
shell attributes as column headings. Project Number and Location are mandatory; the 
other columns are not, and are based on the attributes listed in the Mapping section. This 
list does not include the automatically-mapped shell attributes such as Shell Name or 
Shell Number. Add a row for each project you want to migrate, and enter the Project 
Number and the Location. The location should be delimited with /. For example: /Capital 
Project/Buildings/Tool Sheds. Add the literal values that are to be changed during the 
migration. 

Note: Projects are identified by the Project Number for migration. Be 
sure that you enter the correct project numbers for standard projects you 
want to migrate to CBS shells. 

2) Save the template CSV file. 

Initiate migration of standard projects to CBS shells 

You can migrate several projects at once into a shell type, creating a new shell instance under 
that shell type for each migrated project. Before you initiate the migration, ensure that you have 
the Create permission on the destination shell type, in order to create the shell instances from 
the migrated projects. You exported the template from a selected CBS shell, and then import the 
modified template back into the same CBS shell to complete the migration. 

Note: You cannot undo the migration of standard projects to CBS shells 
after the migration completes successfully. Verify that you have 
completed the CSV migration template correctly, especially in terms of 
the Project Number. 

To initiate migration 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [CBS shell type] in the left Navigator. 

3) In the shell type log, choose Import > Migrate Projects into Shells. 

4) Browse for the CSV file and click OK. 
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This imports the migration template and performs validations on the data. The migration is a 
background process. Each project listed in the CSV file is migrated into a CBS shell based 
on the mapping and values provided in the CSV. Project migration is either successful or not 
successful. Validation is performed before migration, and if there are any errors, a project is 
not migrated. Errors can include incorrect mapping or invalid format of the project rows 
(including changing column order or adding or removing columns). 

View migration history 

You can view the status of each submitted migration by using the Migration History. 

To view migration history 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click Company Sponsored Shells > [CBS shell type] in the left Navigator. 

3) In the shell type log, choose Import > Migration History. 

Each submitted migration is listed in Migration History with one of these statuses: 

 Not Started: The migration process has not started. 

 In Progress: The migration process is in progress. 

 Completed Successfully: The migration of all standard projects completed, and the 
corresponding CBS shells have been created. 

 Completed with Errors: The migration of standard projects has completed, however, 
there were some errors that prevented the migration of some of the projects to CBS 
shells. 

Potential migration errors: 

 Location entered is invalid. This error can occur if the location does not exist or is inactive 
in the shell hierarchy. 

 Cannot create an instance of the shell type under the location entered; does not exist in 
the shell hierarchy. 

 Project number could happen to be the same as the number of an existing shell in the 
hierarchy. Shell numbers must be unique. 

 String values are entered incorrectly. Enter the labels for sting values. 

 The standard project name is limited to 250 characters, and the project description is 
limited to 2000 characters. In order for the migration from project to CBS shell to be 
successful, you must modify the project name and description to be within the limits for 
these fields that exist for the shells (128 characters for a shell name, and 250 characters 
for a shell description). Any error can result if the project name or project description are 
longer than the character limits for the shell name and shell description. 

4) If any of the projects did not migrate due to errors, you can view the CSV with the rows that 
have errors by clicking the Completed with Errors status hyperlink. 

This link allows you to download the CSV containing any errors. This file is in the same 
format as the submitted CSV, with all mapping information retained. However, in the Project 
section, only the rows which have errors in them are shown with an additional column added 
containing error comments. You can use this CSV file to review the errors and then re-import 
the file after you correct the errors. 

5) Click Close to close the Project Migration History window. 
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Test for CBS shell creation 

Ensure that your new CBS shell is created correctly and contains the attributes that you expect: 

 The shell instance should be accessible in Administrator and User Mode (for Unifier and 
Unifier Mobile) under the parent shell it was migrated to. 

 Users should be able to navigate to the business process and other manager data under the 
new CBS shell. 

 Shell creation will trigger email notification. 

 User/groups membership should remain same as on the original standard project. 

 All the auto-population, reverse auto-population, linked elements, and other settings should 
work as they did on the original standard project. 

Internationalization and CSV Files 

Importing and exporting data in Unifier can be done by using a Comma-Separated Values (CSV) 
data file or a CSV template file. This section explains how the availability of different languages 
(Internationalization) impact the various CSV files created, used, imported, or exported. 

Note: Number formatting is not supported for Symbols that are based on 
a right-to-left language such as official languages of Afghanistan or 
Hebrew. 

Generic CSV files 

Language preferences are detected from the Preferences settings (Region Format), for both 
CSV data files and CSV template in: 

 All column headers 

 All informational text 

If importing a CSV file fails, the import error file displays the system generated error messages in 
the preferred language.  

If importing a CSV file fails because of form validation errors, then the custom error message 
displays the message in the preferred language. 
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Notes: 

 If translation is not available for a custom error message, then the 
source string is displayed. 

 Before importing a CSV file, always check the Preferences settings 
to see the allowed format and number formatting. 

 When importing, or exporting, a CSV file, the date format follows the 
Preferences window (Region Format) Date Format settings. 

Additional information about exporting and importing CSV files 

When importing and exporting of a CSV file is conducted by users with two different language 
settings (for example, French and German), the data entered into an exported file must match 
the original language set. 

Example 

The CSV template Export has been done in French and the template is being used by a 
German User. If the German User enters data without changing the column structure and 
Import the file, the Import action will fail and an error message will appear in German, 
indicating the error. 
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Internationalization and Web Services 

About Web Services

New records can be created and line items added using Integration through Web Services. Also, 
the Unifier Schedule Manager integrates with Primavera scheduling software by way of Web 
Services.  

Note: Integration through Web Services must be coordinated with an 
Oracle Primavera representative. 

As Project Administrator, you can receive email notification of the successful creation of a shell 
instance, for shells that are created manually, through Web Services or a CSV file upload, or 
through auto-creation. This notification can be set up in email notifications in uDesigner. Also, 
you can set your Preferences to control whether you receive these notifications. 

Refer to the Unifier Reference Guide for data elements you can use with Web Services. 

Web Services and Internationalization 

The output data generated by Web Services is always in the source language. 

Note: If a record (Example: Business Process) is created by using Web 
Services and the Data Definition (DD) label includes a non-ASCII string, 
then the record creation will fail. 

Number formatting of data 

When you enter numeric data in XML, you can use the decimal point (period) and negative sign 
(dash), only. 

Examples 

XML Tag: <Committed_Amount>100.99</Committed_Amount> 

XML Tag: <Credited_Amount>-1423.99</Credited_Amount> 

Get Web Services 

You can use the Get Web Services call methods to get various attributes of Shell, CBS, and the 
list of Business Process records, Shells, and User defined data. 

When you run a Get call, the input content in the response XML will be in the language of the 
source strings. 

Number formatting does not apply to the numeric data and the decimal point is a period. The 
negative numbers are displayed with the minus sign before the numeric data, for example, 
-12345.99. 

Note: Number formatting is not supported for Symbols that are based on 
a right-to-left language such as official languages of Afghanistan or 
Hebrew. 
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Internationalization (Email Notifications) 

When Unifier generates an email notification, the language used for that email is based on the 
recipient's in Preferences. 

Email notifications for scheduled User-Defined Reports (UDRs), Gates, and so forth, have two 
components: 

 Text 

 Attachments 

If a Business Process (BP) email notification contains an attachment with the record information, 
then the Custom Strings and number formatting in the attachment is according to the 
Preferences. 

If a scheduled UDR is sent as a part of an email attachment, the language in the PDF 
attachment is according to the Preferences of the UDR owner; however, the email text content 
is according to the recipient's User Preferences. 

When a UDR is generated manually and saved by a User, the language in the PDF attachment 
is according to the Preferences of the User who generated, or ran, the UDR. 

If a scheduled job such as Project Gates, where the "Auto-email as PDF attachment to users 
and groups" option is selected, the language in the PDF attachment is according to the User 
Preferences of the creator of the job (Project Gates creator). 

When a manual refresh of the Gates is requested, the language in the PDF attachment is 
according to the Preferences of the User who requested the refresh. 

Internationalization (Support for Tools) 

When used within Unifier,the following tools support internationalization:  

 Oracle Map, AutoVue Server, Flex replacement (O charts) 

Note: The Unifier Plug-ins do not support internationalization. 

Oracle Map viewer supports internationalization for Tier 1 languages. Refer to the Oracle Map 
Viewer User Guide for more details. 

The language displayed in the map, and the following subsequent areas, is according to the 
language selected in the Preferences of the user: 

 View map for BP records from log 

 Shell Landing Page 

 Map Picker in Log Find 

 Map Picker in Bulk Edit 

 View Map when invoked from the BP record 
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Note: eLocation services, which is used for geocoding, does not support 
internationalization. As a result, the map labels are displayed in English. 
If a User enters a label in a different language, then the Find feature 
does not provide the desired results. 

Internationalization (BI Publisher Custom Reports) 

The Oracle Business Intelligence Publisher (BI Publisher or BIP) Reports support 
internationalization as follows: 

Custom Report (Report File tab) window

If there are no templates available for the report,the Custom Report window (Report File tab) 
displays according to the default settings. 

To upload the translated XLIFF files and report layout, click Add to open the Add Template and 
Files window, enter data in the required fields, and click OK. 

Notes: 

 The non-RTF templates do not support internationalization. 

 You can change the template type when the template is in Creation 
stage, only. Once you create a template, you cannot change the 
template type. Use the report designer to create a new template with 
the desired template type and remove the template that is no longer 
needed. 

In the Custom Report window (Report File tab), the only editable column is the Default column, 
which allows you to set the default template by selecting (check-box) the corresponding 
template. 

Note: The system sets the first template, or XLIFF file, that you upload 
as the default template. 

Use Modify in the Custom Report window (Report File tab) to modify an existing template. Once 
you click Modify, the Modify Template and Files window opens which allows you to modify the 
template and the translated XLIFF file for that template. When finished, click OK. 

Use Download in the Custom Report window (Report File tab) to download a template and the 
corresponding translated XLIFF file, in a zip file. 

External Data Model BI Publisher Reports

If you want to download the data model of a template, select the template and click Download in 
the Custom Report window (Report File tab). When the download is complete for an External 
BIP report, the data model is included. 

Non-RTF type template

BIP supports RTF templates and XLIFF files. If the report designer selects a non-RTF type 
template, the Browse option in the Modify Template and Files window (Translated XLIFF files for 
the Template section) will be disabled. 
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Custom Report (Query tab) window

Queries based on Data Definition (DD) support internationalization and number formatting 
associated with internationalization according to the Preferences settings. 

Queries based on Data Views do not support internationalization and formatting because raw 
data is being used. 

Queries based on Ad-Hoc support internationalization and number formatting associated with 
internationalization according to the Preferences settings. 

Internationalization (Dashboards) 

Shell Dashboards

The Shell Dashboards support Internationalization and number formatting for System Strings as 
well as Custom Strings according to the Preferences settings. 

Custom Dashboards

Custom Dashboards have two components: 

 Data cube 

 SWF file 

The SWF file uses the data cube and the labels are created when the user selects the Download 
XML option from the Custom Dashboard log and downloads the generated XML. The language 
used in the generated XML is based on the Preferences settings for both System Strings and 
Custom Strings. 

Note: If you change the language, you need to recreate the SWF (Small 
Web Format) file in order to generate a translated XML. If there are no 
caching of data in the Dashboard, the translation takes place, but if there 
caching of data in the Dashboard, then there will be no translation. 

Internationalization (Help Files) 

Unifier Help files do not support Internationalization and are not translated. 

Note: You can translate the Help files, using a third party translator, and 
display the files based on the your Preferences settings. This includes 
uploading a single PDF with multiple language help information. 

Internationalization (Spell Check) 

The Spell Check feature does not support Internationalization. 

Note: If the language selected in your Preferences is not English, the 
Spell Check option will not be available. 
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Internationalization (Date and Time Zone Formats) 

Date formats

The following additional date formats support Internationalization: 

 MM/DD/YYYY 

 DD/MM/YYYY 

 MM/DD/YY 

 DD/MM/YY 

 MM-DD-YYYY 

 DD-MM-YYYY 

 MM-DD-YY 

 DD-MM-YY 

 DD.MM.YYYY 

 YYYY-MM-DD 

 MMM/DD/YYYY 

 DD/MMM/YYYY 

 YYYY/MMM/DD 

 M/D/YYYY 

 M/D/YY 

 D/M/YYYY 

 D/M/YY 

 YY/M/D 

 YYYY/M/D 

 YY/MM/DD 

 YYYY/MM/DD 

Time Zone formats

The Time Zone setting is based on the Coordinated Universal Time (UTC) and support 
Internationalization.  

Note: The time format for all dates is: HH:MM AM. 

Internationalization (Audit Log) 

Within the Audit log, the following columns support Internationalization according to the 
Preferences: 

 Event 

 Description 

 Field 

For Event, Description, and Field columns, System Strings are and Custom Strings can be 
translated. 
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Unifier Activity Manager 

Unifier enables you to create, consolidate, and monitor activities that must be completed on a 
schedule by way of the Activity Manager.  

Note: Unifier also enables you to set a series of rate rules that should be 
applied when certain conditions are met in a project by way of the 
Master Rate Sheet.  

Activity Manager Module 

To access the Activity Manager module, go to your project or shell in user mode and from the 
left-hand Navigator click Activity Manager. 

For details about the Activity Manager, Rate Sheet, and Master Rate Sheet, refer to the Unifier 
Managers User Guide. 

In This Section 

Activity Manager Permissions ................................................................................ 285 

Activity Manager Permissions 

You can use the following options to grant permission to Activity Sheet under Activity 
Manager node. 

Access Control 

For Activity Sheet, go to Company Workspace > Admin mode > Access Control > User 
Mode Access > Shells / Projects (Standard) > Activity Sheet. 

Grant any of the following available permissions: 

 Get Data

If enabled, the user will be able to take action ‘Get Data’ for system Activity Sheet which will 
update the system Activity Sheet from P6. 

When enable, the View permission will be enabled, automatically. If you deselect the View
permission, Unifier deselects the Get Data permission. You cannot assign the Get Data
permission without the View permission, but you can assign the View permission without the 
Get Data permission. 

 Send Data

 View

If enabled, the user will be able to view the Activity Sheet node along with the activity 
sheets present in that node (if any). 
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For Rate Sheet, go to Company Workspace > Admin mode > Access Control > User Mode 
Access > Shells / Projects (Standard) > Rate Sheet. 

Grant any of the following available permissions: 

 Full Access

 Create

If enabled, the user can create a Rate Sheet. 

 View

If enabled, the user will be able to view the Rate Sheet node at Company Workspace along 
with the Master Rate Sheet present in that node (if any). 

Permission Templates 

For Activity Sheet, go to Company Workspace > Admin mode > Standards & Libraries > 
Permission Templates. 

Open the template, click the Permissions tab, and assign permissions. 

Under Modules For section, scroll to User Mode Access > Shells / Projects (Standard) > 
Activity Sheet, and assign permissions. See the description of permissions under Access 
Control, above. 

For Rate Sheet, go to Company Workspace > Admin mode > Standards & Libraries > 
Permission Templates. 

Open the template, click the Permissions tab. 

Under Modules For section, scroll to User Mode Access > Shells / Projects (Standard) > 
Rate Sheet, and assign permissions. See the description of permissions under Access Control, 
above. 
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Managing Personal Information in Unifier 

In This Section 

About Consent Notices (Administrator) .................................................................. 287 
Permission Control for Consent Notice .................................................................. 288 
Your Responsibilities ............................................................................................. 289 

About Consent Notices (Administrator) 

Consent notices inform users how personal information (PI) is collected, processed, stored, and 
transmitted along with details related to applicable regulations and policies. Consent notices also 
alert users that the action they are taking may risk exposing PI. Unifier helps you to ensure that 
you have requested the appropriate consent to collect, process, store, and transmit the PI your 
organization holds as part of Unifier data. Consent notices are switched off by default in Unifier. 

Consent notices should: 

 be written in clear language which is easy to understand. 

 provide the right level of detail. 

 identify the purpose and legal basis for your collection, processing, storage, and 
transmission of PI. 

 identify whether data will be transferred to named third parties. 

 identify PI categories and list the data which will be collected, processed, stored, and 
transmitted. 

Note: If an administrator provides consent on behalf of other users, it is 
the administrator’s responsibility to ensure the consent has been 
provided by the users through other means.  

About Personal Information 

Personal information (PI) is any piece of data which can be used on its own or with other 
information to identify, contact, or locate an individual or identify an individual in context. This 
information is not limited to a person's name, address, and contact details. For example, a 
person's IP address, phone IMEI number, gender, and location at a particular time could all be 
personal information. Depending on local data protection laws, organizations may be 
responsible for ensuring the privacy of PI wherever it is stored, including in backups, locally 
stored downloads, and data stored in development environments.  

In Unifier, the custom data, which might include personal information, is also stored when a 
customer:  

 Configures Unifier to store, or collect, data in a business process form (BP form). 

 Configures Unifier to store, or collect, data in other modules.  
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 Adds additional fields to the forms that collects the users' information, during the user 
creation process. 

 Uploads documents that contain user information. 

Personal information may be visible in multiple areas of Unifier, including but not limited to: 

 User administration 

 Records in various business processes 

 Tasks 

 Documents 

 Reports 

 Dashboards 

Personal information may be at risk of exposure in multiple areas of Unifier, including but not 
limited to: 

 Dashboard or custom prints 

 Reports 

 Documents 

 Unifier Web Services 

 Unifier mobile 

Cookies in Unifier 

When using Unifier, the server may generate cookies and send them to the user’s browser. The 
user’s machine stores the cookies, either temporarily by the browser, or permanently until they 
expire or are removed manually.  

Each user that signs in to Unifier web will see a notification banner (Cookies in Unifier) that 
notifies the user that Unifier uses cookies. This banner has a link to the Unifier cookie policy 
which explains what information is being tracked by way of cookies. The user must click Got It in 
order to access the rest of the Unifier application.  

Oracle might use cookies for authentication, session management, remembering application 
behavior preferences and performance characteristics, and to provide documentation support. 
Also, Oracle might use cookies to remember your log-in details, collect statistics to optimize site 
functionality, and deliver marketing based on your interests.  

Permission Control for Consent Notice 

You can assign Consent Notice permissions in the following permissions-related modules:  

 Access Control

1. Go to Company Workspace (Admin mode) and click the Access Control node. 

2. Click to expand Administration Mode Access. 

3. Click to expand Consent Notice. 

 User Administration

1. Go to Company Workspace (Admin mode) and click the Access Control node. 

2. Click to expand the User Administration. 
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3. Assign through Company Users, Partner Users, or Groups sub-nodes. 

 Standards & Libraries

1. Go to Company Workspace (Admin mode) and click the Access Control node. 

2. Click to expand Standards & Libraries. 

3. Assign through Permission Templates sub-node. 

Permissions can be given by anyone who has access to the nodes. 

Users who have the Modify permission will be able to modify the setup and other details related 
to Consent Notice, for either user consent or bidder consent. 

If a user has only the View permission for the Consent Notice node, then the user will have 
only permission to view the setup and will not be able to make any edits to the consent notice 
setup or other details. 

Your Responsibilities 

Information security and privacy laws can carry heavy penalties and fines for organizations 
which do not adequately protect PI they gather and store. If these laws apply to your 
organization, it is your responsibility to configure consent notices before they are required. You 
should work with your data security and legal teams to determine the wording of the consent 
notices you will configure in Unifier. 

If a consent notice is declined, it is your responsibility to take any necessary action. For 
example, you may be required to ensure that data is not stored or shared. 

Personal Information (PI) Data in Unifier 

PI may be visible in multiple areas of Unifier, including but not limited to user administration, 
business process workflows, assignments, work products and documents, reports, user defined 
fields, codes, calendars, project websites, and timesheets. 

PI may be at risk of exposure in multiple areas of Unifier, including but not limited to business 
process workflows, assignments, work products and documents, reports, user defined fields, 
codes, calendars, project websites, and timesheets. 

As part of Unifier Cloud Services, you may be using Oracle Identity Cloud Service (“Oracle 
IDCS”) to manage your user access and entitlements across a number of cloud and on-premises 
applications and services. If you are using or accessing Oracle IDCS, you are responsible for 
deleting your details and data from the Oracle IDCS environment. You are responsible for 
retrieving your content in Oracle IDCS during your applicable services period. 

Configuring Consent Notices for Unifier 

To configure Consent Notices for Unifier: 

1) Go to the Company Workspace. 

2) Switch to Admin mode. 

3) Click Consent Notice to expand the node. 
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The Consent Notice node can be seen by the site administrator (on-premises customers 
only and in the system admin mode) and by the default company contact (in the respective 
company). 

You can manage the Consent Notice in all Unifier environments (Development, Test, and 
Production), independently. 

You can see the status of consent acceptance for users. You can also reset consent 
acceptance for all users if there is a need to regain consent after a consent notice has 
changed. 

The Consent Notice node has the following sub-nodes: 

 User Consent

Use this sub-node to set up consent notice for the web, mobile, self-service, portal, and 
Unifier /m sign-ins. 

 Consent Status

Use this sub-node to audit and track the users who have accepted the terms. 

 Bidder Consent

Use this sub-node to set up consent notice for the bidder portal sign-in. 

 Consent Status

Use this sub-node to audit and track the bidders who have accepted the terms. 

If you enable consent notices, you must enter consent notice text. Work with your data security 
and legal teams to determine the wording of the consent notices. If no content is detected, then 
Unifier displays the message: The default consent notice is required if the consent notice option 
is enabled. 

Configuring Consent Notices for User Signing In through Web 

1) Go to the Company Workspace. 

2) Switch to Admin mode. 

3) Click Consent Notice and then click User Consent. 

  The Setup tab, which is open by default, has the following options: 

Enable Consent Notice

This option is selected by default. You can use this option to enable the consent notice for 
signing in to Unifier through the web, self-service portal, and mobile device. 

Default Consent Notice

This option enables you to enter the default consent notice for the environment when the 
consent notice is enabled. You should work with your data security and legal teams to 
determine the wording of the consent notices you will configure in Unifier. You can enter the 
consent message (text) into the system directly as formatted text or HTML text. 
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Note: Oracle does not recommend direct copy-paste of text from 
external sources in the provided editor for consent notices because 
direct copy-paste from external sources impacts the behavior of text 
seen for users. Copy-paste of text from a Word document or a pdf file is 
supported in the provided editor.  

If you click Save without entering the consent notice, Unifier displays the message: The 
default consent notice is required if the consent notice option is enabled.

Note: When you set the consent notice in this node, the consent notice 
will be applicable to both the web and mobile sign-ins. 

Send notifications when users reject the consent notice

This option enables you to set users or groups to be notified when a user rejects the consent 
notice.  

Cancel

Enables you to undo all the changes that you have made across all tabs. Users who have 
View permission will not see this option.  

Save

Enables you to save all the changes that you have made across all tabs. Users who have 
View permission will not see this option.  

Preview

Enables you to preview the content of the consent agreement. 

Other tabs are language specific consent notices that are supported in Unifier. If you enter 
content for a specific language then the language specific consent notice will be displayed to the 
users based on the user preferences for language. For example, when the language preference 
(Preferences) is set to Dutch, and the Dutch consent notice is not entered, the user will see the 
default consent notice content when signing in to Unifier (web or mobile). The Dutch consent 
notice will be seen by the user only when a Dutch consent is entered. 

Auditing Consent Notices for Unifier Users Signing In through Web 

To audit consent status for users signing in through web: 

1) Go to the Company Workspace. 

2) Switch to Admin mode. 

3) Click Consent Status sub-node to display the log. 

4) Review the status for each user. 

You can use the Consent Status sub-node to track user acceptance. 

Unifier tracks users based on the following responses to the consent notice: 

 Accepted 

 Rejected 

 Not Responded 
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By default, all users are tracked as Not Responded. When users sign in to Unifier through 
web/mobile and accept or reject the consent notice, Unifier tracks their responses and assigns a 
status accordingly. 

If you disable the consent notice option after it was enabled in an environment, Unifier will not 
reset the tracking status for web/mobile consent and tracking statuses will remain as they were. 

The following toolbar options are displayed on the Consent Status log: 

View

Enables you to see the following out-of-the-box (OOTB) views: 

 All 

 Group by Consent Status 

When the view is changed to Group by Consent Status, by default the groups will be 
collapsed and an additional toolbar option of Expand/collapse will be displayed. 

Search

Enables you to find information about any user or group by way of: 

 Name 

 Email Address 

 Title 

 Company 

 Status 

 Record Number 

Find on page

Enables you to filter the contents of the log. 

Print

Enables you to print the contents of the log. Select from the following options: 

 Print 

 Export to CSV 

 Export to Excel 

Reset Accepted Consent

This option is available when the consent notice option is enabled. This option enables you 
to reset the Accepted consent status to Not Responded when there are changes in the 
agreement. Users who have View permission will not see this option. 

The following columns are displayed on the Consent Status log: 

 Name 

 Email Address 

 Title 

 Company 

 Record Number 

 Status 

 Time 
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Configuring Consent Notices for Bidders Signing In through Web 

The site administrator (in the system admin mode) and the default company contact (in the 
respective company) can enable the consent notice for bidders by using the Bidder Consent
node. If you enable consent notices, you must enter consent notice text. If no content is detected 
Unifier displays the message: The default consent notice is required if the consent notice option 
is enabled. 

1) Go to the Company Workspace. 

2) Switch to Admin mode. 

3) Click Consent Notice to expand the node. 

4) Click Bidder Consent sub-node to display the log. 

The Setup tab, which is open by default, has the following options: 

Enable Consent Notice

This option is selected by default. You can use this option to enable the consent notice for 
signing in to Unifier through the Bidder portal. 

Default Consent Notice

This option enables you to enter the default consent notice for the environment when the 
consent notice is enabled. You can enter the consent message (text) into the system directly, 
as formatted text or HTML text. This is a required field and you must enter the consent 
notice. If you click Save without entering the consent notice, Unifier displays the message: 
The default consent notice is required if the consent notice option is enabled. 

Note: When you set the consent notice it will be applicable to both the 
web and mobile sign-ins. 

Send notifications when users reject the consent notice

This option is selected by default. This option enables you to set users or groups to be 
notified when a user rejects the consent notice.  

Cancel

Enables you to undo all the changes that you have made across all tabs. Users who have 
View permission will not see this option.  

Save

Enables you to save all the changes that you have made across all tabs. Users who have 
View permission will not see this option.  

Preview

Enables you to preview the content of the consent agreement. 

Other tabs are language specific consent notices that are supported in Unifier. If you enter 
content for a specific language, then the language specific consent notice will be displayed to 
the users, based on the user preferences for language. For example, when the language 
preference (Preferences) is set to Dutch, and the Dutch consent notice is not entered, the user 
will see the default consent notice content when signing in to Unifier (web or mobile). The Dutch 
consent notice will be seen by the user only when a Dutch consent is entered. 
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Auditing Consent Notices for Unifier Bidders Signing In through Web 

To audit consent status for bidders signing in through web: 

1) Go to the Company Workspace. 

2) Switch to Admin mode. 

3) Click the Consent Status sub-node to display the log. 

4) Review the status for each user. 

You can use the Consent Status sub-node to track the bidders who have accepted the terms 
through signing in by way of bidder sign-in. 

Unifier tracks bidders based on the following responses to the consent notice: 

 Accepted 

 Rejected 

 Not Responded 

By default all the bidders seen are tracked as Not Responded. The bidders listed have been 
invited to bid by way of invitations. For existing and upgrade users, all bidders who received an 
invitation to bid are listed in the log. 

When users sign in to Unifier through bidder portal and accept or reject the consent notice, 
Unifier tracks their responses and assigns a status accordingly. 

The log shows all bidders with Not Responded status before the web consent is enabled for first 
time. 

The following toolbar options are displayed on the Consent Status log: 

View

Enables you to see the following out-of-the-box (OOTB) views: 

 All 

 Group by Consent Status 

When view is changed to Group by Consent Status, by default the groups will be collapsed 
and an additional toolbar option of Expand/collapse will be displayed. 

Search

Enables you to find information about a user or group by way of: 

 Name 

 Email Address 

 Title 

 Company 

 Status 

 Record Number 

Find on page

Enables you to filter the contents of the log. 

Print

Enables you to print the contents of the log by way of the following options: 

 Print 
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 Export to CSV 

 Export to Excel 

Reset Accepted Consent

This option is available when the consent notice option is enabled. This option enables you 
to reset the Accepted consent status to Not Responded, for example if there are changes 
in the agreement. 

The following examples explain how Unifier administers consent notices in the case of an 
email address or user ID changes: 

Example One 

The email address of vendor record V1 was changed from Email1 to Email2, and the user 
id Email1 was assigned to vendor record V2.  

Unifier displays a new entry for the user ID (in the Consent Status log) after the invitation 
is sent to the new email address. Unifier retains the consent agreement provided to 
the previous user ID. 

Example Two 

The email address of vendor record V1 was changed from Email1 to Email2, and the user 
id Email1 has left the organization. 

Unifier displays a new entry for the user ID (in the Consent Status log) after the invitation 
is sent to the new email address. Unifier removes the consent agreement provided to 
the previous user ID, and the entry for that user ID is not displayed in the Consent 
Status log. 

The following columns are displayed on the Consent Status log: 

 Name 

 Email Address 

 Title 

 Company 

 Record Number 

 Status 

 Time 
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Translating Custom Strings (Internationalization) 

The content of the material created by the Users (also known as custom strings) can be 
translated into different languages. 

Examples 

Business Process (BP) name, Data Element (DE) label, drop-down labels, radio button, 
navigation log names, and multi select values 

Note: The user input data in Business Processes (BPs), attribute forms 
of various Managers, and other similar elements, when entered at 
runtime, cannot be translated. 

The Internationalization node (a sub-node of Configuration node) contains the custom strings 
that the users have developed. The custom strings that are listed in the Internationalization Log 
window are set to provide the necessary details for translators. 

In This Section 

Internationalization Node Properties ...................................................................... 297 
Displaying Custom Strings and System Strings ..................................................... 299 
Assigning Permissions .......................................................................................... 301 
Translating Methods .............................................................................................. 302 
Internationalizing Unifier Environments ................................................................. 304 

Internationalization Node Properties 

To access the Internationalization node: 

1) Sign in to Unifier. 

2) Go to Company Workspace. 

3) Switch to Admin mode. 

4) Click Configuration node to expand. 

5) Click Internationalization to open the Configuration - Internationalization log window. 

Within the log, you can: 

 Determine which log item qualify for custom strings translation. 

 Select to see 100 or 200 items per page. 

Use the Display drop-down list on top right-hand side of the log window. 

 Change the order of the items in the Source Type column. 

 Change the sequence of the languages displayed in the log as explained in the following 
section. 

 See the list of all Custom Strings available for translation. 
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To select which languages must be displayed in the log list:  

1) From the Configuration - Internationalization log window toolbar, click Language Log to 
open the Internationalization Log - Default Language window. This window has the 
following tabs: 

1. Languages

Displays the following information: 

 Columns: Displays the column number (in the Configuration - 
Internationalization log) corresponding to a particular language. 

 Language: Displays the name of the language. 

 Status: Active (for languages that are available for use) or Inactive (for languages 
that are not available for use). Click on the cell to change the status. The General 
tab in the Modify Translation String window will list languages with Status = 
Active to enable you to modify the translation strings for each of those languages. 

 Default: Enables you to select one language as the default language for Unifier. 

2. Columns

In this tab, only languages that have been marked as Active, in the Languages tab, will 
be displayed. 

 Column: Displays the column number (in the Configuration - 
Internationalization log) corresponding to a particular language. 

 Language: Displays the name of the language. 

 Show Language: Enables you to select which languages will be displayed in 
Configuration - Internationalization log and elsewhere where the language is 
available for use. 

To change the sequence of the languages displayed in the log: 

1) To rearrange the order of languages displayed on each row in the log list, click to select the 
language, and click Move Up or click Move Down. 

Alternatively, you can double-click the number next to the language, edit the number, and 
click Update Order. 

2) When finished, click Update Order, Apply, and OK. 

3) Use Refresh to update the list in the Internationalization Log window. The following explains 
the refresh options: 

 Strings: Use this option to refresh the Internationalization log with the source strings 
belonging to a particular source type. The system prompts you to select the Source Type 
of the strings that need to be refreshed. 

When you select Strings, the Refresh Strings window opens, which allows you to select, 
or deselect the source types that you want the system to display. Click OK to save your 
changes, Cancel to terminate the change. 

 All Strings: Use this option to refresh the Internationalization log with all custom strings 
from all source types. This operation might take a few minutes.  

When you select All Strings, a Confirmation message window opens explaining the 
system status. Review the message and proceed as desired. 
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 History: Use this option to see the history of refresh requests: Requestor, Source Type, 
Submit Date, End Date, and Status. You can view History details after the refresh is 
complete. 

The following explains the function of each toolbar option in the Internationalization Log window: 

 Open: This option allows you to open the translated custom string. 

 Export: This option allows you to export strings for bulk translation. 

 Import: This option allows you to import a file that is ready (translated) into Unifier, or log. 

 Delete: This option allows you to delete translated custom strings. 

Note: You can delete a custom string only if it has not been used elsewhere. 

 Find: This option allows you to filter out the custom strings that are available in the log. 

Note: When you select this option, you must select a source type and 
provide search operator for the string that you want to find. 

 Columns: This option allows you to set the sequence of log columns. 

 Refresh: This option allows you to refresh the items in the log with new or modified custom 
strings that qualify for custom translation. 

The following explains the function of each menu option in the Internationalization Log window: 

Note: You can perform the functions of menu options using the toolbar. 

 File: This option allows you to perform: Open, Export, Import, and Refresh 

 Edit: This option allows you to perform: Delete 

 View: This option allows you to conduct a search: All, Find 

 Help: This option allows you to access: Unifier Help, Unifier Library (documentation), and 
About Unifier information 

Displaying Custom Strings and System Strings 

The following describes how Custom Strings and System Strings display in Administration mode 
and while defining Sheets and User Define Reports (UDRs). 

The contents that appear in the Unifier application UI (also known as System Strings) cannot be 
modified by the Users. The System Strings are available in different languages, per user 
preferences. 

Example 

Sign In and Terms and Condition pages, Menus, Alerts, and Errors 

In contrast, the content of the material created by the Users (also known as Custom Strings) can 
be translated into different languages. 

Example 

Business Process (BP) name, Data Element (DE) label, pull-down values, radio button, text 
in lines, navigation log names, and multi select values 

System Strings are translated according to the user preferences, set in the User Preferences 
window. 
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Custom Strings are translated according to the specifications added to the source string, set in 
the XLIFF file. 

When a combination of System and Custom strings are used (concatenation), for example, in a 
form, the System String portion is translated according to the user preferences, set in the User 
Preferences window, and the Custom String portion is translated according to the specifications 
added to the source string, set in the XLIFF file. As a result, it is possible to see an object having 
one field displayed in one language and another field displayed in another language. 

In general, the translated Custom Strings cannot be displayed, or seen, while in the user is in 
Admin mode, except for: 

 Translated Custom Strings for Attribute forms. 

Example 

If there is a Data Element (DE) called, "Building Name" in an Attribute form (Shell), and if 
the German translation of the DE exists, then the details page displays the German 
translation in Admin mode. 

 Pages that are shared between the User mode and Admin mode. 

Example 

If translated Custom Strings are available, then the pages display the translated Custom 
Strings in Admin mode and are synchronized when switching to the User mode, as is 
the case with: 

 Code-based Configurable Manager- sheet templates 

 Record-based Configurable Manager - sheet templates 

 Asset Class templates 

 Shell Dashboard templates 

 User Define Reports (UDRs) templates 

Administration Mode 

Administration mode 

When in the Administration mode, the contents that appear in the Unifier application UI (also 
known as System Strings) cannot be modified by the Users. The System Strings are available in 
different languages, per user preferences. 

Example 

Sign In and Terms and Condition pages, Menus, Alerts, and Errors 

In contrast, the content of the material created by the Users (also known as Custom Strings) can 
be translated into different languages. 

Example 

Business Process (BP) name, Data Element (DE) label, pull-down values, radio button, text 
in lines, navigation log names, and multi select values 

System Strings are translated according to the user preferences, set in the User Preferences 
window. 
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Custom Strings are translated according to the specifications added to the source string, set in 
the XLIFF file. 

When a combination of System and Custom strings are used (concatenation), for example, in a 
form, the System String portion is translated according to the user preferences, set in the User 
Preferences window, and the Custom String portion is translated according to the specifications 
added to the source string, set in the XLIFF file. As a result, it is possible to see an object having 
one field displayed in one language and another field displayed in another language. 

In general, the translated Custom Strings cannot be displayed, or seen, while in the user is in 
Admin mode, except for: 

 Translated Custom Strings for Attribute forms. 

Example 

If there is a Data Element (DE) called, "Building Name" in an Attribute form (Shell), and if 
the German translation of the DE exists, then the details page displays the German 
translation in Admin mode. 

 Pages that are shared between the User mode and Admin mode. 

Example 

If translated Custom Strings are available, then the pages display the translated Custom 
Strings in Admin mode and are synchronized when switching to the User mode, as is 
the case with: 

 Code-based Configurable Manager- sheet templates 

 Record-based Configurable Manager - sheet templates 

 Asset Class templates 

 Shell Dashboard templates 

 User Define Reports (UDRs) templates 

Assigning Permissions 

The Company Administrator assigns access permissions to the Internationalization node, and 
the permissions can be set for both Users and Groups.  

To proceed with assigning permissions, go to Configuration node > Access Control (Admin 
mode), and select the Internationalization module to change the access settings. Alternatively, 
you can use the Permission tab of the User properties, also. 

There are two types of permissions available for the Internationalization node: 

 Configure 

 View 

Users who have Configure permission can translate the custom strings, and Users who have 
View permission can view the translated custom strings, only.  

To assign View permission to a User, disable the following options in the Modify Translation 
String window: 

1) Import, in the toolbar and menu. 

2) Delete, in the toolbar and menu. 
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3) Columns, in the toolbar and menu. 

4) When finished, click Apply and then OK. 

Translating Methods 

There are two methods available in Unifier for translating custom strings: 

 User Interface 

Use this translation method when you add or modify a limited number of custom strings, only. 

 Export/Import 

Use this translation method when you need to translate a large number of custom strings. 
This method is particularly useful to professional product-translator because the system 
provides a file format (.XLIFF) that streamlines the translation efforts (Export). After the 
translations are completed, the Company Administrator, or a User with appropriate 
permissions, can access the Internationalization node and import the translated file back into 
Unifier (Import). The translation is done for one language at a time. 

To use the User Interface translation method 

1) Go to the Internationalization node. 

2) Select the custom string that you want to translate. 

3) Click Open from the toolbar to open the Modify Translation String window. The Source Type
and Source String fields are read only. 

4) In the Note field enter a description explaining the context and usage of the custom string 
that you are about to translate. 

5) Modify, or add to, the existing translations. You can enter multiple languages for the custom 
string. 

6) When finished, click Apply and then OK. 

About Source Type and Source String 

Each custom string is unique according to the custom string Source Type and Source String. 
The Source Type displays the Source String category. Data Structure, uDesigner, and Reports 
are some of the options under Source Type. 

Example 

A designers designs a Data Element (DE) with the label: Vendors. The Business Process is 
also name: Vendors. Since both the DE and BP constitute a design element, the Source 
Type is: uDesigner. 

Language codes 

Use the following information to match the language settings: 

 Chinese (Simplified): zh_CH 

 Chinese (Traditional): zh_TW 

 English: en 

 French: fr 

 German: de 
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 Italian: it 

 Japanese: ja 

 Korean: ko 

 Portuguese (Brazil): pt_BR 

 Russian: ru 

 Spanish: es 

To use the Export/Import translation method 

1) Go to the Internationalization node. 

2) Select the custom string that you want to translate. 

3) Click Export from the toolbar to open the Export Options window. 

4) Select values for the following fields: 

 Source Language 

The current language of the custom string. (Example: English) 

 Target Language 

The language that the source custom string has to be translated into. You can select one 
language, only. (Example: German) 

 Source Type 

To allow you to filter the custom string for export base on a particular Source Type. The 
drop-down list contains values such as: Data Structure, Reports, etc. (Example: Business 
Process Setup) 

 Include Translated Strings 

This is an optional parameter. By default, this option is selected.  

- If selected, the custom strings (source strings) that are currently translated into the 
selected language will be exported, also. 

- If deselected, only the custom strings (source strings) that are not translated into the 
selected language will be exported. 

5) Click Export to open the File Download window. The file download operation follows the 
Unifier standard file download process.  

The exported file is in ".XLIFF" format and the file name contains "Unifier" 
(Unifier+-+<Language Name>.XLIFF). 

The number of characters allowed in the file name is based on Unifier standard. For 
supported version of the "XLIFF" file refer to the Primavera Unifier Tested Configurations in 
the Primavera Unifier Documentation Library.  

The exported file contains the following information: ID, Source String, Target Language, and 
Note.  

The Source String is the base for all translations, the Target Language is the language 
selected, and the Note is a placeholder, which stores notes for the translators. The source 
language attribute for the exported file originates from the Source language selection at the 
time of export. 

6) Save the file in your local folder and open the file using a program such as Notepad or 
WordPad. 
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7) Open the saved XLIFF file, review the declaration information, and search for <source>. 
Example: 

<source>Assets</source> 

8) Enter a new line, include the target language information, and save the file. Example: 

<target>Aktiva</target> 

9) Change the value of "approved" to "yes." Example: 

<trans-unit id="o8oRKk8ZYDv+BJodINqTIBpmz+fhygs3" approved="yes"> 

10) Proceed to import the file back to Unifier. 

When the file is ready, use the Import option to bring the translated file back into Unifier. 

1) Go to the Internationalization node. 

2) Click Import from the toolbar to open the Unifier standard File Upload window. 

3) Click Browse, and import the translated file (Unifier-,Language Name.XLIFF). Basic file 
replacement and override apply. 

At this point, the translated custom strings map to the appropriate language settings and ready 
to be used. 

Note: The Oracle Database column size must not exceed the storage 
size of 4000 bytes. 

Internationalizing Unifier Environments 

A translated custom string can be used in Unifier Development environment, Test environment, 
and Production environment.  

You can use the "XLIFF" file across the two environments using the export and import functions. 

Workflow 

First, export the custom string (translated) using the Export option out of one environment. 
Then, using the Import option, import the exported custom string (translated) into the other 
environment. 

Notes: 

 The transfer of translated custom strings can be done one language 
at a time. 

 If a custom string does not exist in the destination environment, then 
that custom string cannot be used; however, the custom string will be 
available in the Internationalization Log window. 

 If you add a source string to your source type in the 
Development/Test environment, but this source string does not exist 
in the Production environment, upon exporting the XLIFF file to the 
Production environment, the source string will carry over. 
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Unifier Mobile Application 

The Oracle Primavera Unifier Mobile Application is built specifically for installation and use on 
mobile devices that use iOS or Android operating system. To get the Unifier Mobile App, you 
have the following options:  

 Download it from App Store or Play Store, or 

 Launch Unifier, click User login name ( ), click Get Unifier Mobile App, and follow 
the prompts. 

After download, you can scan the QR code to set up Unifier Server URL and user name on your 
Oracle Primavera Unifier Mobile Application. 

Note: If you are in a region without access to the Google Play Store, 
Apple App Store, or your organization is using a Content Security 
Service or Mobile Device Management solution and requires that users 
do not download from the Apple Store or Play Store, submit a Service 
Request in My Oracle Support to request versions of the Oracle 
Primavera Unifier Mobile Application for those scenarios. 

Important sign in information for on-premises users on non-SSO servers  

For on-premises customers on non-SSO server (prior to 19.12.2): 

The Unifier mobile app used the Basic Authentication for login while connecting to the Unifier 
web application deployed on a non-SSO server. 

For on-premises customers on non-SSO server (on or after 19.12.2): 

Unifier mobile app now uses the Form-based Authentication while connecting to the Unifier web 
application deployed on a non-SSO server. As a result, you must use the latest version of Unifier 
mobile app to access app data on your device.   

Note: The user preferences, in the Unifier web application, will be 
effective when you sign in to the Unifier mobile app. 
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Unifier and Other Oracle Applications 

Unifier objects can be integrated with other Oracle applications by way of: 

 Web Services 

Client and server applications that communicate over the World Wide Web’s (WWW) 
HyperText Transfer Protocol (HTTP) and provide a standard means for operation between 
software applications running on a variety of platforms and frameworks, using XML. For more 
information about Web Services integration, refer to the Unifier Integration Interface Guide. 

 Oracle Database Gateways 

Addressing the needs of disparate data access and making it possible to integrate with any 
number of non-Oracle systems from an Oracle application. Oracle Database Gateways 
enable integration with data stores such as IBM DB2, Microsoft SQL Server, Excel and 
transaction managers like IBM CICS. 

Unifier is integrated with the following enterprise applications via Primavera Gateway: 

 Oracle Primavera Analytics 

 Oracle Primavera P6 

 Oracle E-Business Suite (also known as Applications/Apps or EB-Suite/EBS) 
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As shown below, once all the objects are created and linked to each other, data flows to Unifier 
(business flows/synchronizations) in this formation: Oracle application/external application > 
Oracle application/external Provider > Gateway > Unifier Provider > Unifier 

The following sections describe the process in details. 

In This Section 

Unifier and Primavera Analytics ............................................................................. 309 
Unifier and Primavera P6 ...................................................................................... 347 
Unifier and Primavera Gateway ............................................................................. 354 
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Unifier and Primavera Analytics 

Analytics provides an in-depth and comprehensive method for analyzing and evaluating: 

 Shells 

 Project performance 

 Project history 

 Business Processes (including Vendor analysis) 

 Cost Sheet 

 Cash Flow 

 P6 Summary Sheets 

 Generic Cost Sheet 

 Space Utilization (from Space Manager) 

Configure this section in Unifier for users to ensure they are able to see data within Analytics. 

If the Analytics module is enabled, the Company administrator can access the Analytics 
module by signing into Unifier and navigating to the System Modules node (Data Structure > 
Administration mode > System Modules). 

Note: The System Administrator has to load the Analytics module. 

Users can use the Analytics for data input and must have permission in order to be able to 
access the Analytics node. Permissions set in Unifier (Access Control) enable users to view 
the data in Oracle Business Intelligence (OBI) server. Users ability to access OBI server is also 
set in Unifier. 
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In This Section 

Analytics Node ...................................................................................................... 310 
Analytics Log Properties ........................................................................................ 311 
Analytics Log (Business Process) Setup ............................................................... 311 
Analytics Log (Cash Flow) Setup ........................................................................... 317 
Analytics Log (Cost Sheet) Setup .......................................................................... 319 
Analytics Log (Generic Cost Sheet) Setup............................................................. 323 
Analytics Log (P6 Summary Sheets) ..................................................................... 324 
Analytics Log (Shells) ............................................................................................ 325 
Analytics Log (Space Manager) ............................................................................. 328 
Analytics Log (Vendors) ........................................................................................ 335 
Scheduling Setup .................................................................................................. 336 
Access Control Changes for Analytics Node in User Mode Access ....................... 338 
Analytics Subject Areas and Unifier Data .............................................................. 338 
Granting Permissions to Setup Analytics ............................................................... 339 
Analytics and Dashboards ..................................................................................... 340 
Accessing the Unifier Analytics Dashboard in OBI ................................................. 341 
Accessing Unifier from OBI server ......................................................................... 341 
Action Links (from OBI to Unifier) .......................................................................... 341 
Accessing Analytics from Unifier ........................................................................... 342 
Publishing Unifier Data to Analytics ....................................................................... 343 
Unifier Configurator and OBI Server for On-Premises ........................................... 344 
Analytics Block ...................................................................................................... 344 
Analytics Block and Shell Templates ..................................................................... 345 

Analytics Node 

The Analytics node is located under the Administration node, above the Custom Dashboard 
node. In Analytics node, you can select publication of Unifier data to Unifier staging tables, map 
data, and set schedule for periodic publication of Unifier data into Analytics.  

Note: A separate ETL process pushes the staging data into STAR which 
then becomes available in Analytics. 

When you click the Analytics node, the log displays predefined set of Unifier modules such as:  

 Business Processes 

 Cash Flow 

 Cost Sheet 

 Generic Cost Sheet 

 P6 Summary Sheets 

 Shells 

 Space Manager 

 Vendors 
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Analytics Log Properties 

The Analytics log has two columns which display the Name and the Last Modified Date of the 
records. 

The Analytics log toolbar has the following options: 

 Open 

 Schedule 

 Run History 

The Open and Run History options can be accessed from the File menu. The Schedule option 
can accessed from the Edit menu. 

Analytics Log (Business Process) Setup 

You can set up Dashboards and Analyses, for Unifier Business Process, in Oracle Business 
Intelligence Enterprise (OBIE) analyses and select the Business Process data that you want to 
use for analyses. 

When you open a Business Process in the Analytics node, you will see the Analytics - 
Business Process Setup window with the following tabs: 

 Business Processes tab 

 Custom Fields tab  

 Data Mapping tab 

Business Processes tab 

Select Business Processes for Analytics

The Business Processes tab allows you to select the Business Process that you want to 
use in Analytics. 

Use the Add or Remove buttons to add or remove the Business Processes for Analytics. To 
add a new Business Process for use in Analytics: 

1. Click Add to open the Select Business Processes for Analytics window that lists all the 
company-level, Shell-level, and Project-level Business Processes, in alphabetical order. 

Note: This list includes Active and Inactive Business Processes. 

2. Select one Business Process, or select as many as you need, and click OK to add the 
Business Process to the log. 
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Note: After you added the Business Process, that Business Process will 
no longer be available in the Select Business Processes for Analytics 
list. 

You can remove a Business Process that is published for Analytics. To remove a Business 
Process for use in Analytics, select the Business Process from the Select Business 
Processes for Analytics list and click Remove. You can delete multiple Business Processes 
from the list. You can add a removed Business Process for Analytics reporting.  Click Add if 
you want to add a removed Business Process to the list. 

If Company Administrator inactivates a Business Process that has been used for Analytics, 
then this Business Process continues to remain in the Business Processes tab. If you 
remove a Business Process from the Business Processes tab, data that exists in Analytics, 
for the removed Business process, remains as is; however, the new data will not be 
published. 

To save space, you can decide not to track the history of facts and dimensions, on a 
Business Process.  

In the Analytics - Business Processes Setup window (Business Processes tab) you can 
select a business process and mark to not track the history of the business process data 
elements (Track History of Data Elements? column). By default, all BPs in this tab are 
selected to have their history tracked. After your initial selection in the Track History of Data 
Elements? column for a BP, if you open the Analytics - Business Processes Setup
window and go to the Business Processes tab and deselect the track history option for a 
BP, then Unifier will notify you that the BP will no longer maintain the historical data in 
Analytics. 

For a BP with track history option selected, all data mapping changes for the elements of the 
BP will be recorded as errors in the historical data in Analytics. 

Note: The Track History of Data Elements? column values will be 
included in the Configuration Package during export or import. 

Custom Fields tab 

The Custom Fields tab is available after you add your Business Processes in the Business 
Processes tab. The Custom Fields tab has two sections:  

 Main Form Elements 

 Line Item Elements 

You can specify values in each field to set the number of user-defined fields for Data 
Mapping. The default values displayed are based on the existing user-defined fields limit that 
is currently set in Unifier. 

The total number of Main Form custom fields cannot exceed 900. Similarly the total number 
of Line Item custom fields cannot exceed 900.  

When entering values in the fields:  

 Use numeric values. 

 Do not use decimal points. 

 Use numbers greater than the default values. 
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Note: The number of fields specified are bundled as a part of 
configuration package, if the component has been tagged. 

Data Mapping tab 

The Data Mapping tab allows you to map the predefined Analytic Business Process fields to a 
corresponding Unifier Data Element (DE) in the Business Process. 

Notes: 

 The Data Mapping tab is available after you have added a Business 
Process, in the Business Processes tab, and clicked Apply or OK. 

 The Data Mapping is done per DE and not per Business Process. All 
Business Processes added in the Business Processes list tab are 
included and you do not need to select a specific Business Process 
for mapping. 

 The fields from both Upper and Detail forms can be mapped in the 
Data Mapping tab, and you can change mapping of the fields. 

 The workflow data (Steps and tasks), related to any Workflow BP, is 
also sent to Analytics. 

 The DE of type Rich Text is not available to be mapped to the UDFs 
from Analytics.  

The Data Mapping tab displays the following information: 

 Name 

 Source 

 Data Source 

 User Defined Attributes 

 Name 

 Data Type 

 Source 

 Data Source 

 Label 

Note: In addition to the system defined fields for Analytics, you can 
define additional custom fields for Analytics in the User Defined Attribute 
section. 

Name

The Name column is pre-populated and displays the following names:  

 Contract Type 

 Reason 

 Specification Section 

 Vendor ID 

 Quantity 
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 Spend Category 

 Unit Cost 

 Unit of Measure 

The names above represent the fields used in OBI. These are read-only fields and you cannot 
modify them. 

All the "Main Form" fields are listed first and are sorted alphabetically within the source. 

All the "Line Item" fields are listed after the Main form fields and are sorted alphabetically within 
the source. 

Source

The Source column displays the location of the Data Element (DE) seen in the Data Source. For 
Business Processes, the DEs can either be from the "Main Form" or the "Line Item." 

Data Source

The Data Source column contains a consolidated list of all DEs for all of the selected Business 
Processes in the Business Processes tab. In addition: 

 The list of values displayed upon clicking the Data Source drop-down will be those that have 
a matching data definition as the Name field. When you click the Data Source drop-down list 
contains a list of values that have a matching Data Definition (DD) as the Name field. 

 The drop-down list, which requires the Upper form mapping, contains a consolidated list of 
all Upper form DEs. For example, if there are ten Upper forms from all the Business 
Processes, and each Upper form has 10 DEs, then the list of DEs displayed in the 
drop-down list will be a consolidated and unique list of DEs from all the Business Processes. 

 The drop-down list, which requires the Detail form mapping, contains a consolidated list of all 
Detail form DEs. For example, if there are twenty Detail forms, and each Detail form has 10 
DEs, then the list of DEs displayed in the drop-down list will be a consolidated and unique list 
of DEs from the Detail forms of all the Business Processes. 

 The fields displayed in the Data Source drop-down list is a concatenation of DE Label and 
DE Name, and the DE Name is displayed within parenthesis. For example, 
Department(contract_department)

User Defined Attributes

The User Defined Attributes section of the Data Mapping tab lists the following columns: 

 Name 

 Data Type 

 Source 

 Data Source 

 Label 

The Label will be based on the selected DE label, but you can change it. 

Use the Add, Modify, and Remove to add, modify, or remove user defined attributes. 

To modify a user-defined attribute, click to select the attribute, click Modify, and modify the 
fields. 
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To remove a user-defined attribute, click to select the attribute, click Remove, and modify the 
fields. 

To add a user-defined attribute, read the following information: 

When you click Add, the Add User Defined Attribute window opens. This window allows you to 
select the following mandatory fields: 

 Data Type

 Source

 Name

 Data Source

 Label

Notes: 

 A value for the mandatory Label field will be selected by the system. 

 The Label field is populated based on the Data Element that you have 
selected from the Data Source drop-down list. 

 The Label field is editable and required. You will receive an error 
message if you leave the Label field blank. 

 If you notice that the value in the Label field has changed, it means 
that other fields have been updated at one point. 

 Analytics displays the value, if the label is absent. 

 Analytics displays the label, which has the Value/Label pair, in the 
case of Data Elements (DEs). 

The Data Type that you select impacts the Name and the Data Source of the user-defined 
attribute. The Data Type field allows you to select the following attributes, only: 

 String (default) 

 Date 

 Numeric 

For example, if you select String as your Data Type, you can: 

 Select from a predefined set of sources from Source drop-down list (Main Form or Line 
Item). 

 Add up to 30 names (User Defined String Fields 1 - 30) as the Name. 

 Select from a predefined set of data sources from Data Source drop-down list. 

 The content of the Label filed will be selected by the system and according to your other 
selections. 

Analytics Dimension and Fact 

The Data Type that you select corresponds to the Analytics fields as follows: 

 If the Data Type that you select is String/Date, then your selection corresponds to a 
Dimension object in Analytics. 

 If the Data Type that you select is Numeric, then your selection corresponds to a Fact object 
in Analytics and are available in the Primavera - Project User Defined, only.  
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Additional information 

 If the same DE exists in both Upper form and Detail form, then the DE is displayed for the 
Upper form fields, as well as the Line Item fields. 

 If you map a DE for one field, you can map the same DE to another field. You can choose 
the DEs, per your Company business needs, when setting up the mapping. 

 If you change the mapping of the fields, for the new records, then the next time the data is 
published to OBI, the values will be as per the updated fields. If you need to refresh, for all 
the records, then you need to click the checkbox option in the Schedule tab. 

 If you delete a DE mapped to an Analytic field, then the Data Source field displays the DE 
name, only. 

 If there are any un-mapped fields in the Data Mapping tab, the un-mapped fields appear in 
the DE list, based on the updated design. 

 If you delete a Business Process, and click Apply, then the Data Source field displays the DE 
name, only. 

 The allowed user-defined attributes is driven by the number that is set in the Custom Fields 
tab.  

 Pickers are available for String field mappings for both canned and user defined attributes 
are as follows:  

 BP Data Picker 

 Shell Data Picker 

 Space Data Picker 

 User Data Picker 

 BP Picker 

 User Picker 

 Shell Picker 

 Space Picker 

 BP Creator  

 P6 Activity Picker  

Summary Payment Application (SPA) SOV type BPs 

You can perform data reporting in Analytics for Base Commit, Change Commit, and Payment 
Application Business Processes of SPA SOV type. The system sends the following Cost 
allocation Line Item details to Analytics: 

 Cost Code 

 Cost Name 

 Short Description 

 Quantity 

 Unit Price 

 Amount 

If you need to transfer data from any field (at the Summary level) to Analytics, then you must 
map the field to a User Defined Field in Line Items of the Business Process. The system sends 
the mapped field to Analytics as a part of Cost allocation Line Item.  
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Note: Users can map any field that exist in the Detail form.  

The values of the fields in the existing Cost allocation Line Items are retained for the fields that 
are common to both the Summary and Cost allocation Line Items. The following explains the 
details: 

 Cost Code

The value of the field in the Cost allocation Line Item is retained. The CBS Picker field does 
not exist in the Detail Form design. 

 Cost Name

The value of the field in the Cost allocation Line Item is retained. The bi_item field does not 
exist in the Detail Form design. 

 Short Description

The value of the field in the Cost allocation Line Item is retained.  

 Quantity

The value of the field in the Cost allocation Line Item is retained.  

 Unit Price

The value of the field in the Cost allocation Line Item is retained. The Unit price is 
auto-populated from the value of the field in the Detail Form and is a read-only field in the 
Cost allocation Line Item. The value of the field in the Cost allocation Line Item will match the 
value of the field in the Detail Form. 

 Amount

The value of the field in the Cost allocation Line Item is retained. 

Analytics Log (Cash Flow) Setup 

You can set up Dashboards and Analyses, for Unifier Cash Flow data, in Oracle Business 
Intelligence Enterprise (OBIE) analyses and: 

 Select the Cash Flow names that you want to use for analyses. 

 Set up the data for the fields related to Cash Flow in the Cash Flow record. 

When you open a Cash Flow record in the Analytics node, you will see the Cash Flow Setup 
window that contains the Cash Flow names defined in Shells. In this window, you can add a 
Cash Flow record and click Apply to see the Data Mapping tab. 

In addition to the system-generated Cash Flow Curves, you can add additional user-defined 
Cash Flow Curves (total of 10). The User Defined Curves section, in Data Mapping tab of the 
Cash Flow Setup, displays the additional 5 Cash Flow Curves (User Defined Curves from 6 to 
10). 

Cash Flow tab 

Use the Cash Flow tab to select the Cash Flow names that you want to use in Analytics. Once 
selected, you can use Add to add the name or Remove to remove a Cash Flow. 

To add a new Cash Flow: 
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1) In the Analytics - Cash Flow Setup window, Cash Flow tab, click Add to open the Cash Flow 
window, Select Cash Flow for Analytics. 

Note: This list includes the available Cash Flow items, from all CBS 
Shells with Detail Levels of CBS, Summary CBS, and Commitment  in 
alphabetical order.  

2) Select one Cash Flow, or select as many as you need, and click OK to add the Cash Flow to 
the log. 

Note: After you add a Cash Flow, that Cash Flow will no longer be 
available in the Select Cash Flow for Analytics list. 

You can remove a Cash Flow item that is published for Analytics. To remove a Cash Flow item 
for use in Analytics, select the Cash Flow item from the Select Cash Flow item for Analytics list 
and click Remove. You can delete multiple Cash Flow items from the list. You can add a 
removed Cash Flow item for Analytics reporting. Click Add if you want to add a removed Cash 
Flow item to the list. 

Data Mapping tab (Cash Flow) 

The Data Mapping tab allows you to map the predefined Analytic Cash Flow fields to a 
corresponding Unifier Cash Flow Curve type. 

Note: The Data Mapping tab is available after you have added a Cash 
Flow item, in the Cash Flow tab, and clicked Apply or OK. 

The Data Mapping tab displays the following information: 

 Name: Predefined and represents the fields used in OBI. 

 The names are grouped logically and sorted based on Initial Baseline, Current Baseline, 
Actuals, Forecast, and User Defined Curves (1 through 10). 

 The drop-down list for the Initial Baseline and Current Baseline includes the items that 
are based on the Baseline Cash Flow curve type, defined under the Cash Flow data 
sources (Cashflow Datasources window) in the Standard & Libraries. 

 The drop-down list for the Actuals includes the items that are based on the Spends curve 
type. 

 The drop-down list for the Forecast includes the items that are based on the Forecast 
curve type. 

 The drop-down list for the User Defined Curves (1 through 10) includes all the Cash Flow 
data sources. The items listed are based on the Cash Flow curve type and sorted in 
alphabetical order. 

 Data Source: The Cash Flow data sources defined under the Cash Flow > Data Sources 
node of the Standards & Libraries. 

 The fields displayed in the Data Source drop-down list is a concatenation of the Cash 
Flow data source name and Cash Flow curve type. 

The Analytic field name can be the same as the Data Source name. For example, you can map 
a User Defined Curve to data source named, "Initial Baseline." 
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The following is a list of fields that need mapping for Cash Flow: 

 Initial Baseline 

 Current Baseline 

 Actuals (Spends) 

 Forecast 

 User Defined Curve 1 

 ... 

 User Defined Curve 10 

Note: Cash Flow Derive curve is not supported. 

Analytics Log (Cost Sheet) Setup 

You can set up Dashboards and Analyses, for Unifier Cost Sheet data, in Oracle Business 
Intelligence Enterprise (OBIE) analyses and select the Cost Sheet column data that you want to 
use for analyses.  

This section explains the following topics: 

 Data Mapping - Columns

 Data Mapping - Cost Attributes

When you open a Cost Sheet record in the Analytics node, the Analytics - Cost Sheet Setup 
window opens with the following tabs: 

 Data Mapping - Columns

 Data Mapping - Cost Attributes

The following explains each tab and their respective fields. 

Data Mapping - Columns 

The Data Mapping - Columns tab is divided in two sections: 

 System-defined columns: Listed on top of the window. 

 User-defined Columns: Listed under User Define Columns section of the window. 

The system-defined columns of the Data Mapping - Columns tab allows you to map the Cost 
Sheet Analytic fields to a corresponding Cost Sheet Data Source defined in Unifier. 

In addition to the system-defined Cost Sheet columns, you can add additional user-defined 
columns (total of 20). The User Defined Columns section, in Data Mapping - Columns tab of 
the Cost Sheet Setup, displays the additional 10 columns (User Defined Columns from 11 to 20). 

The top section of Data Mapping - Columns tab (system-defined columns) has the following 
columns: 

 Name

 Data Source

The following explains each column. 

Name
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Lists a series of predefined fields which correspond to the fields used in OBI. 

Note: Since the fields under Name are grouped logically, the order 
displayed are according to the list of fields that need mapping for Cost 
Sheet. 

This is a list of predefined fields: 

 Estimate 

 Original Budget 

 Pending Budget Revisions 

 Approved Budget Revisions 

 Revised Budget 

 Contracts 

 Purchase Orders 

 Original Commitments 

 Forecast 

 Pending Change Orders 

 Pending PO Amendments 

 Pending Commitment Changes 

 Approved Change Orders 

 Approved PO Amendments 

 Approved Commitment Changes 

 Revised Commitments 

 Pending Payment Applications 

 Pending Invoices 

 Pending Spends 

 Approved Payment Applications 

 Approved Invoices 

 Approved Spends 

 Actuals Received 

 Journal Entries 

 Risks & Issues 

 Forecast Adjustments 

 Budget Variance 

 Remaining Budget 

 Budget Percent 

 Commitment Percent 

Data Source

Lists the corresponding data source to each field that is listed in the Name column. The values 
in the Data Source fields: 

 Are divided into two sources (Single Sources and the Logical Sources). 

 Are sorted in alphabetic order.  
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 Exist in the Cost Sheet for all CBS type Shells. 

The lower section of Data Mapping - Columns tab (under the User Defined Columns section) 
has the following columns: 

 Name

 Data Source

 Label

The following explains each column. 

Name

This is a list of predefined columns: 

 User Defined Column 1 

 ... 

 User Defined Column 20 

The Analytic field name can be the same as the Data Source name. For example, you can map 
a User Defined Curve to data source named, "Initial Baseline." 

Data Source

 The P6 data sources are included under the Single Sources, and the element is included 
within the parenthesis of the P6 Data Source. For example, Current Baseline (Planned 
Cost).

 In addition to the predefined list displayed, you can add up to 10 additional mappings for the 
Cost Sheet data sources. 

 You can pick the same data source for multiple fields. 

Label

 Labels are required for the User Defined Columns. A red-color asterisk (*/star symbol) 
appears for the columns that have been mapped to a data source.  

Note: Asterisk (*/star symbol) does not appear for a column that has not 
been mapped to a data source. 

 For existing mappings of user-defined Cost Sheet columns, the labels are populated based 
on the data source name. 

 Labels support non-ISO characters (UTF-8 characters). 

 If there are no labels, then the data source names will be sent to OBIEE. 

Note: Custom String translation is not applied. 

 When you select a data source for the first time, the label is populated based on the data 
source name. You can modify the label according to your business need. 

 The maximum characters allowed in the label field is 50, same as the Cost Sheet Data 
Source Name. 
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Note: The system does not perform Label Uniqueness test. 

Data Mapping - Cost Attributes 

The Data Mapping - Cost Attributes tab contains user-defined Attributes, listed under the User 
Defined Attributes section. 

To add a new field, click Add to open the Add User Defined Attribute window. Enter name, 
source, and label in the following fields: 

 Name

 Data Source

 Label

The Data Type field is read-only and set as "String" by default. The value in the Data Type field 
determines if the selected field is a Dimension object or a Fact object in Analytics. If the Data 
Type field is "String," then the field is a Dimension object in Analytics. 

Note: Only the "String" type field is supported for Cost Code Attributes 
data mapping in Analytics. 

You can add up to 20 String type Data Elements (DEs) from the Cost Code Attributes Detail 
Form as User Defined Attributes. 

The Name field is a required field and lists User Defined String Field 1 through 20. 

 If a name has been selected, for example, User Defined String Field 1, then the list does not 
include User Defined String Field 1 and starts with User Defined String Field 2. 

 If an existing name has been deleted, the name will appear in the list. 

The Data Source field lists Data Elements (DEs) in the Cost Code Attributes Detail Form. 

Only DEs with the "String" type Data Definitions (DDs) are displayed in the Data Source field. 
The "String" type DDs in the list are: 

 Text Box 

 Multiple Text Lines 

 Pull-Down Menu 

 Radio Buttons 

 Multi-select Input 

The DDs in the Data Source field include the DEs. For example, Description 
(uuu_cost_description). If a DE that has already been added is deleted from the deployed 
design, then the DE name will be seen, only. 

Unifier populates the Label field based on the DE that has been selected in the Data Source
drop-down list. The Label field is a required and editable field, and it will accept non-ISO 
characters (UTF-8), to support internationalization. 

The maximum allowed length is the same as the DE label, and Unifier does not check for label 
name uniqueness. 
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Analytics Log (Generic Cost Sheet) Setup 

Analytics supports reporting and analyses of data from the various cost attributes in the Generic 
Cost Sheet of Shells with Generic Cost Codes. 

Note: You work with a Generic Cost Sheet in the same way that you 
work with Cost Sheet (CBS Shells); however, the difference is that the 
data in the Generic Cost Sheet comes from Generic Shells and 
sub-shells, but the data for Cost Sheet comes from the CBS Shells. 

You can access your Generic Cost Sheet from the Analytics node in Unifier (Shell > Admin 
mode > Analytics > Generic Cost Sheet) and map your Analytics fields to the corresponding 
Generic Cost Sheet columns. 

Double click Generic Cost Sheet to open the Analytics – Generic Cost Sheet Setup window. 

The Data Mapping tab (in the Analytics – Generic Cost Sheet Setup window) enables you to 
map the Generic Cost sheet Analytic fields to the corresponding Generic Cost Sheet columns, 
defined in Unifier. The  Data Mapping tab has the following fields: 

 Name 

 Data Source 

 Label 

The Data Source values are the Single Sources and Logical Sources existing in the Generic 
Cost Sheets of all the Generic type Shells. You can pick the same data source for multiple fields. 

The Label field is required field for the user-defined columns. The system supports a total of 40 
user-defined columns, for the Generic Cost Sheet. 

Note: An asterisk (*) appears for columns where mapping has been 
completed. The asterisk (*) does not appear if the column is not mapped 
to any data source. 

The system populates the Label column with the Name column for the data source, as set in the 
Generic Cost sheet column definition. You can modify the values in the Label column, based on 
your business needs. The Label column supports non-ISO and UTF-8 characters. 

The maximum number of characters allowed for this field is 50, same as the maximum number 
of characters in the Generic Cost Sheet Data Source Name. 

Notes: 

 The system does not support Custom String translation. 

 The system does not perform label uniqueness verification. 
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Analytics Log (P6 Summary Sheets) 

You can set up Dashboards and Analyses, for P6 Summary Sheets, in Oracle Business 
Intelligence Enterprise (OBIE) analyses and select the P6 Summary Sheets data that you want 
to use for analyses. 

When you open P6 Summary Sheets in the Analytics node, you will see the Analytics – P6 
Summary Sheets Setup window with the following tab: P6 Data Sources. 

P6 Data Sources tab 

The P6 Data Sources tab allows you to select the P6 Data Sources that you want to use in 
Analytics (P6 Data Sources for Analytics). 

Use the Add or Remove buttons to add or remove the P6 Data Sources that you want to use in 
Analytics. 

To add a P6 Data Sources for Analytics: 

Click Add to open the Select P6 Data Sources for Analytics window and select a P6 data source 
for Analytics. The following data sources are available to select: 

Note: The P6 Data Sources that need to send data to OBIEE are set up 
here. 

 Current Schedule 

 Customer Sign-Off Baseline 

 Initial Planning Baseline 

 Management Sign-Off Baseline 

 New P6 Data Source for Analytics Testing 

 P6 Testing datasource 

These are all the published P6 data sources defined under Standards & Libraries.  

When finished, click Apply and then OK. 

You can select more than one data source. To select more than one data source, click one 
source, click OK, and click to add additional data sources. 

Note: Once you add a data source, that data source will not be shown in 
the Select P6 Data Sources for Analytics window. 

Additional information

 You can use the P6 Summary Sheets that are included in the following types of Unifier CBS 
Shells for Analytics: 

 Duration 

 Resource loaded 

 Cost loaded 
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Note: The P6 Summary Sheets for the above data sources will send 
data to Analytics. 

 If fields overlap between the CBS Shells and the existing P6 Summary Sheets, then the 
system-defined fields in the P6 Summary Sheets will be used. 

Example: 

Planned Start and Planned Finish are mapped fields in Unifier CBS Shells; however, 
these fields will be replaced by the system-defined fields in the P6 Summary Sheets. 

 Data analysis can be performed on P6-Unifier integrated data. Since there is no user 
interface (UI) component for the P6 Summary Sheets in Unifier, when Unifier sends data to 
OBIEE, the details of the P6 Summary Sheets of the selected P6 data source is sent to 
Analytics. In Analytics, views are created based on the details of the P6 Summary Sheets 
and the user can see the daily-level data. 

Analytics Log (Shells) 

You can set up Dashboards and Analyses, for Unifier Shells, in Oracle Business Intelligence 
Enterprise (OBIE) analyses and select the Shell data that you want to use for analyses. 

When you open a Shell in the Analytics node, you will see the Analytics - Shells Setup window 
with one tab: 

Data Mapping. 

The Data Mapping tab is divided in two sections: 

 System defined and User defined attributes 

 User Defined Columns 

The system defined columns of the Data Mapping tab allows you to map the Shells (called 
"Projects" in Analytics) Analytic fields to a corresponding Shell attribute Data Element (DE) 
defined in Unifier. 

The top section of the Data Mapping tab displays all the system defined fields in the following 
columns: 

 Name 

 Data Source 

Name

Lists a series of predefined, read-only fields, which represent the fields used in OBI. 

Note: When the user adds a new user-defined field on a Shell mapping 
page, the "Name" field displays fields up to 100 (minus the ones used 
already).  

 Shell Phase 

 Anticipated Start 

 Anticipated Finish 

 Start 
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 Finish 

 Forecast Start Date 

 Forecast Finish Date 

 Planned Start 

 Planned Finish 

 Scheduled Finish 

 Current Budget 

 Original Budget 

 Proposed Budget 

 Address 1 

 Address 2 

 City 

 State 

 State Code 

 Country 

 Country Code 

 Postal code 

Data Source

 Lists all of the Data Elements (DEs), in the Shell attributes, with matching Data Definitions 
(DDs). 

 The DEs are listed in alphabetical order. 

 The values listed in the drop-down list have a matching DD as in the Name field and includes 
a consolidated list of all the DEs across all Shell attribute forms. For example, when you 
select the "Project Start Date," the drop-down list will include all the date fields in all of the 
Shell attribute forms. 

The bottom section of the Analytics - Shells Setup window includes the User Defined 
attributes/fields presented in the following columns: 

 Name 

 Data Type 

 Data Source 

 Label 

Use the Add, Modify, and Remove to add, modify, or remove user defined attributes. 

To modify a user-defined attribute, click to select the attribute, click Modify, and modify the 
fields. 

To remove a user-defined attribute, click to select the attribute, click Remove, and modify the 
fields. 

Note: If you remove a user-defined attribute, the DE name will remain in 
the list for future use. 

To add a user-defined attribute, read the following information: 
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When you click Add, the Add User Defined Attribute window opens. This window allows you to 
select the following mandatory fields: 

 Data Type 

 Name 

 Data Source 

 Label 

Notes: 

 The Label field is populated based on the Data Element that you have 
selected from the Data Source drop-down list. 

 The Label field is editable and required. You will receive an error 
message if you leave the Label field blank. 

 If you notice that the value in the Label field has changed, it means 
that other fields have been updated at one point. 

The Data Type that you select impacts the Name and the Data Source of the user-defined 
attribute. The Data Type field allows you to select the following attributes, only: 

 String (default) 

 Date 

 Numeric 

For example, if you select String as your Data Type, you can: 

 Add up to 20 names (User Defined String Fields 1 - 20) as the Name. 

 Select from a predefined set of data sources from Data Source drop-down list. 

 The content of the Label filed will be selected by the system and according to your other 
selections. 

Dimension and Fact

The Data Type that you select corresponds to the Analytics fields as follows: 

 If the Data Type that you select is String/Date, then your selection corresponds to a 
Dimension object in Analytics. 

 If the  Data Type that you select is Numeric, then your selection corresponds to a Fact 
object in Analytics. 

Additional Information 

Pickers are available for String field mappings for both canned and user defined attributes are as 
follows:  

 BP Data Picker 

 User Data Picker 

 Planning Data Picker 

 User Picker 

 Location Picker 

 P6 Activity Picker 
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 Auto-update Status Setup Picker  

Analytics Log (Space Manager) 

You can set up Dashboards and Analyses, for Space Manager, in Oracle Business Intelligence 
Enterprise (OBIE) analyses and select the Space Manager data that you want to use for 
analyses. 

When you open the Space Manager in the Analytics node, you will see the Analytics - Space 
Manager Setup window with one tab: Space Types. 

The Space Types tab contains a list of space type names under the Space Types for Analysis
section. You can add and remove a Space type using the Add and Remove buttons on this tab 
and below the Space Types for Analysis section. When finished, click Apply and Ok to 
complete the operation. 

Adding Space Types 

To add new Space Types click Add to open the Select Space Types for Analytics window. If 
available, a list of available Space Types that have been deployed in the Company appear in the 
window, in alphabetical order. The list contains all Active and Inactive Space Types. 

Click to select one, or more, Space Types. 

Click OK to add the selected Space Types to the Space Types log. 

Once added: 

 The selected Space Types do not appear in the Select Space Types for Analytics window.  

 The Data Mapping - Space Types tab appear. 

Click Apply to complete the adding operation. 

Removing Space Types 

You can remove the Space Types that have been published for Analytics. To remove the Space 
Types, click to select one, or more, Space Types and click Remove. Once removed: 

The selected Space Types do not appear in the Select Space Types for Analytics window.  

If you want to add removed Space Types, read the instructions in the Adding Space Types topic. 

Working with Space Types 

If you (Company Administrator) inactivate a space type, and the inactivated space type was 
used for Analytics, then the inactivated space type remains in the Space Types tab. 

If a published space type is removed from the Space Types tab, the data that exists in Analytics 
(for the removed space type) remains as is. 

Note: Added new data will not be published.  

If an unpublished space type is removed from the Space Types tab, then no information related 
to the space type, and Level, is sent to Analytics. 
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The following sections explain the following tabs that appear after you add Space Types: 

 Data Mapping - Space Types tab 

 Data Mapping - Level tab 

Data Mapping - Space Types Tab 

The Data Mapping - Space Types tab appears after you add Space Types, and it enables you 
to add custom fields, from various Space Types, to use in Analytics. You can use this tab to map 
the Analytics field to the corresponding Space Types field. The Data Mapping - Space Types
tab contains a list of user-defined attributes under the User Defined Attributes section. The 
User Defined Attributes section is a log that lists the following fields for each user-defined 
attributes: 

 Name

 Data Type

 Data Source

 Label

All the fields mentioned above are read-only fields. You can add, modify, and remove 
user-defined attributes using the Add, Modify and Remove buttons on this tab. 

Adding new user-defined fields 

To add new user-defined fields, click Add to open the Add User Defined Attribute window and 
enter values in the following required fields: 

 Data Type

 Name

 Data Source

 Label

About Data Type 

The values for Data Type field are: 

 String

 Date

 Numeric

When you select a Data Type, you set the value of the of the field as either a Dimension or a 
Fact. If you select the Data Type as String, or Timestamp, then the field will be a Dimension 
object in Analytics. If you select the Data Type as Numeric, then the field will be a Fact object in 
Analytics. 

Data Type Analytics 

String Dimension 

Date Dimension 

Numeric Fact 
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Adding new user-defined fields (custom fields) for Data Type: String 

If you select the Data Type as String, then up to 20 String type Data Elements can be added 
from the Space Detail Form, as user-defined attributes. 

To add new user-defined fields (custom fields) for String Data Type, click Add to open the User 
Defined Attribute window and enter values in the following required fields: 

Name

The Name drop-down list contains values from “User Defined String Field 1" to "User Defined 
String Field 20.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. 

Example 

If the "Department" field has been added as a “User Defined String Field 1," then the “Name” 
drop-down list does not display the “User Defined String Field 1." 

If a previously added field has been deleted, then that Name is displayed in the Name 
drop-down list. 

Data Source

The Data Source drop-down list contains a list of Data Elements from the Space Detail Form. 

If you select the Data Type as String, the Data Elements in the Data Source drop-down list are: 

 Strings and Integer Pull Downs 

 Integer and String Radio Buttons 

 Check Boxes 

 Test Data Elements 

There are no Pickers listed/available. The Data Source field displays a series of interconnected 
Data Element names and Data Element labels in the following format: DE Label(DE name). For 
example, Project Type(prjt_type). If a previously added Data Element is deleted from the 
Deployed design, then the Data Element name is displayed, only. 

Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The maximum allowed length is similar to Data Element label. The 
system does not perform a label uniqueness verification. 

Adding new user-defined fields (custom fields) for Data Type: Date 

If you select the Data Type as Date, then up to 10 "Date" Data Elements can be added from the 
Space Detail Form, as user-defined attributes.  

To add new user-defined fields (custom fields) for Date Data Type, click Add to open the User 
Defined Attribute window and enter values in the following required fields: 

Name

The Name drop-down list contains values from “User Defined Date Field 1" to "User Defined 
Date Field 20.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. 
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Example 

If the "Project Commission Date" field has been added as a “User Defined Date Field 1," 
then the "Name" drop-down list does not display the “User Defined Date Field 1." 

If a previously added field has been deleted, then that Name is displayed in the Name 
drop-down list. 

Data Source

If you select the Data Type as Date, the Data Elements in the Data Source drop-down list are: 

 Date 

 Date only Picker 

The Data Source field displays a series of interconnected Data Element names and Data 
Element labels in the following format: DE Label(DE name). For example, Project Archive 
Date(prjt_arc_date). If a previously added Data Element is deleted from the Deployed 
design, then the Data Element name is displayed, only. 

Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The system does not perform a label uniqueness verification. 

Adding new user-defined fields (custom fields) for Data Type: Numeric 

If you select the Data Type as Numeric, then up to 40 numeric data elements can be added 
from the Level Detail Form, as user-defined attributes. 

To add new user-defined fields (custom fields) for Numeric Data Type, click Add to open the 
User Defined Attribute window and enter values in the following required fields: 

Name

The Name drop-down list contains values from “User Defined Date Field 1" to "User Defined 
Date Field 40.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. For example, if the "Total Count" field has been added as a “User Defined Date 
Field 1," then the Name drop-down list does not display “User Defined Date Field 1." If a 
previously added field has been deleted, then that Name is displayed in the Name drop-down 
list. 

Data Source

If you select the Data Type as Numeric, the Data Elements in the Data Source drop-down list 
are the Data Elements found on the Space Detail Forms and are: 

 Integer 

 Currency 

 Decimal Amount 

There a no Integer Pull Downs, Integer Radio Buttons, and Integer Check Boxes. The Data 
Source field displays a series of interconnected Data Element names and Data Element labels 
in the following format: DE Label(DE name). For example, Contract Amount(con_amt). If a 
previously added Data Element is deleted from the Deployed design, then the Data Element 
name is displayed, only. 
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Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The maximum allowed length is similar to Data Element label. The 
system does not perform a label uniqueness verification. 

Data Mapping - Level Tab 

The Data Mapping - Level tab appears after you add Space Types, and it enables you to add 
custom level/floor fields, from various Levels, to use in Analytics. You can use this tab to map 
the Analytics field to the corresponding Levels field. 

The Data Mapping - Level tab contains a list of user-defined attributes under the User Defined 
Attributes section. The User Defined Attributes section is a log that lists the following fields for 
each user-defined attributes: 

 Name

 Data Type

 Data Source

 Label

All the fields mentioned above are read-only fields. You can add, modify, and remove 
user-defined attributes using the Add, Modify and Remove buttons on this tab. 

Adding new user-defined fields 

To add new user-defined fields, click Add to open the Add User Defined Attribute window and 
enter values in the following required fields: 

 Data Type

 Name

 Data Source

 Label

About Data Type 

The values for Data Type field are: 

 String

 Date

 Numeric

When you select a Data Type, you set the value of the of the field as either a Dimension or a 
Fact. If you select the Data Type as String, or Timestamp, then the field will be a Dimension 
object in Analytics. If you select the Data Type as Numeric, then the field will be a Fact object in 
Analytics. 

Data Type Analytics 

String Dimension 
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Data Type Analytics 

Date Dimension 

Numeric Fact 

Adding new user-defined fields (custom fields) for Data Type: String 

If you select the Data Type as String, then up to 20 String type Data Elements can be added 
from the Level Detail Form, as user-defined attributes. 

To add new user-defined fields (custom fields) for String Data Type, click Add to open the User 
Defined Attribute window and enter values in the following required fields: 

Name

The Name drop-down list contains values from “User Defined String Field 1" to "User Defined 
String Field 15.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. For example, if the "Department" field has been added as a “User Defined String 
Field 1," then the Name drop-down list does not display “User Defined String Field 1." If a 
previously added field has been deleted, then that Name is displayed in the Name drop-down 
list. 

Data Source

The Data Source drop-down list contains a list of Data Elements from the Level Detail Form. 

If you select the Data Type as String, the Data Elements in the Data Source drop-down list are: 

 Strings and Integer Pull Downs 

 Integer and String Radio Buttons 

 Check Boxes 

 Test Data Elements 

There are no Pickers listed/available. The Data Source field displays a series of interconnected 
Data Element names and Data Element labels in the following format: DE Label(DE name). For 
example, Project Type(prjt_type). If a previously added Data Element is deleted from the 
Deployed design, then the Data Element name is displayed, only. 

Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The maximum allowed length is similar to Data Element label. The 
system does not perform a label uniqueness verification. 

Adding new user-defined fields (custom fields) for Data Type: Date 

If you select the Data Type as Date, then up to 10 "Date" Data Elements can be added from the 
Level Detail Form, as user-defined attributes.  

To add new user-defined fields (custom fields) for Date Data Type, click Add to open the User 
Defined Attribute window and enter values in the following required fields: 

Name
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The Name drop-down list contains values from “User Defined Date Field 1" to "User Defined 
Date Field 10.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. For example, if the "Project Commission Date" field has been added as a “User 
Defined Date Field 1," then the Name drop-down list does not display “User Defined Date Field 
1." If a previously added field has been deleted, then that Name is displayed in the Name 
drop-down list. 

Data Source

The Data Source drop-down list contains a list of Data Elements from the Level Detail Form. 

If you select the Data Type as Date, the Data Elements in the Data Source drop-down list are: 

 Date 

 Date only Picker 

The Data Source field displays a series of interconnected Data Element names and Data 
Element labels in the following format: DE Label(DE name). For example, Project Archive 
Date(prjt_arc_date). If a previously added Data Element is deleted from the Deployed 
design, then the Data Element name is displayed, only. 

Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The system does not perform a label uniqueness verification. 

Adding new user-defined fields (custom fields) for Data Type: Numeric 

If you select the Data Type as Numeric, then up to 30 numeric data elements can be added 
from the Space Detail Form, as user-defined attributes. 

To add new user-defined fields (custom fields) for Numeric Data Type, click Add to open the 
User Defined Attribute window and enter values in the following required fields: 

Name

The Name drop-down list contains values from “User Defined Date Field 1" to "User Defined 
Date Field 30.” If a name has already been selected, then the name is not listed in the Name 
drop-down list. For example, if the "# of Spaces" field has been added as a “User Defined Date 
Field 1," then the Name drop-down list does not display “User Defined Date Field 1." If a 
previously added field has been deleted, then that Name is displayed in the Name drop-down 
list. 

Data Source

If you select the Data Type as Numeric, the Data Elements in the Data Source drop-down list 
are the Data Elements found on the Level Detail Forms and are: 

 Integer 

 Currency 

 Decimal Amount 
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There a no Integer Pull Downs, Integer Radio Buttons, and Integer Check Boxes. The Data 
Source field displays a series of interconnected Data Element names and Data Element labels 
in the following format: DE Label(DE name). For example, Contract Amount(con_amt). If a 
previously added Data Element is deleted from the Deployed design, then the Data Element 
name is displayed, only. 

Label

The Label field is populated based on the Data Element that you select in the Data Source. You 
can modify the value of this field with non-ISO characters (UTF-8), in order to support 
internationalization, only. The maximum allowed length is similar to Data Element label. The 
system does not perform a label uniqueness verification. 

Analytics Log (Vendors) 

You can set up Dashboards and Analyses, for Unifier Vendors data, in Oracle Business 
Intelligence Enterprise (OBIE) analyses.  

When you open a Vendors record in the Analytics node, you will see the Analytics - Vendors 
Setup window that contains the following tabs, after you add a Vendor record and click Apply: 

 Vendors tab 

 Data Mapping tab 

Vendors tab 

Note: You need to first select the Business Processes that you want to 
set as Vendor Business Processes for use in Analytics. 

In the Vendors tab, click Add to open the Select a Business Process as Vendor for Analytics 
window. The list of Business Processes in this window is in alphabetic order. 

Note: Only one Business Process can be marked as Vendor, so the Add 
option is disabled after your selection. 

Select a Business Process (Company and Shell level - Active and Inactive), then click OK. You 
can select one Business Process, only. 

You can remove a Vendor Business Process by selecting the item and clicking Remove.  

Use the Vendors tab to select the Vendors names that you want to use in Analytics. Once 
selected, you can use Add to add the name or Remove to remove a Vendors. 

You can remove a Vendor Business Process that is published for Analytics. To remove an item 
for use in Analytics, select the item from the list in the Select a Business Process as Vendor for 
Analytics window and click Remove. You can add a removed item for Analytics reporting. Click 
Add if you want to add a removed item to the list. 

If the Company Administrator inactivates a Business Process marked as Vendor, and if the item 
is used for Analytics, then this Vendor Business Process remains in the Vendors tab. 

If a Vendor is removed from the Vendors tab, data that exists in Analytics (for the removed 
Vendor Business Process) remains as is; however, the new data will not be published. 
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Data Mapping tab 

The Data Mapping tab allows you to map the predefined Analytic Vendor related fields to a 
corresponding Unifier Data Element (DE) in the Business Process. As mentioned earlier, this tab 
is available after you have added a Business Process in the Vendors tab and clicked Apply or 
OK. 

In the Data Mapping tab, the following columns, or fields, are present: 

 Name 

 Source 

 Data Source 

Name

Pre-populated and represents the fields used in OBI. These are read-only fields and you cannot 
modify them. 

Source

Displays the location of the Data Element (DE) seen in the Data Source. The DEs for Vendor 
mapping are the Upper form DEs. 

Data Source

Allows you to select from a list of  all Upper form DEs, for the selected Vendor Business 
Process in the Vendors tab. The list is filtered based on the Data Definition (DD) match. You can 
change the mapping of the fields. 

The following is a list of fields that need mapping for Vendors: 

 Vendor ID 

 Name 

 Type 

The fields displayed in the Data Source drop-down list is a concatenation of DE Label and DE 
Name, and the DE Name is displayed within parenthesis. For example, 
Department(contract_department)

Rules for Data Mapping 

 If the Analytic field is of a String type, then all pull-downs (Integer and String), Radio Boxes 
(Integer and String), check boxes, and text DEs are displayed. No pickers will be seen. 

 If the Analytic field is of a Pull-down type, then the list of DEs displayed in the Data Source 
drop-down list are filtered and only the DEs of Pull-down type are displayed. This list 
includes both Integer and String Pull-downs. 

 If the Analytic field is of a Numeric type, then the list of values displayed is a consolidated list 
of all numeric data elements, which include DEs of type Integer Amount, Currency Amount, 
and Decimal Amount. No integer pull-downs or Radio boxes will be seen. 

Scheduling Setup 

Unifier sends data from all Shells, regardless of the Shell status. If you need to filter the data, 
based on the Shell status, you (the Administrator responsible for setting up the Analytics 
Schedule) must set up filter condition on the data and set up a schedule to send the data to OBI. 
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You can set up Scheduling by clicking the Schedule (on the log toolbar). The Schedule Setup 
window allows you to set the following: 

 Frequency

 Filters

Note: If you change the filter setup, the change only applies to the 
subsequent runs. Since the scheduled runs sends incremental data 
(Data that has changed between runs) only, the filter change is 
applicable to the sent incremental data. 

The default option is: Include data from all Shells. 

If you select to set up a filter to include data from Shells with a particular status (Include data 
from Shells with Statuses), the system provides the following Shell statuses: 

 Active 

 On-Hold 

 View Only 

 Inactive 

You can exclude data, also. Include the Shell that you want its data to be excluded (Exclude 
data from selected Shells) to prevent the data in that Shell to be sent to OBI. 

 Data Refresh

Select the Refresh all data button if you made changes to data mappings and data 
definitions, and want the system to apply your filtering to the existing data in OBI. 

 Additional Information

In the Send error notification to field, specifywho must receive the error notifications. 
Notifications are emails that contain failure of data exchange between Unifier and Analytics 
server.The Administrator can set up Users and Groups to receive these notifications. 

Unifier sends data to Analytics periodically. To accommodate your business needs, the following 
additional granularity, for sending the data, is available.  

A user can send Unifier data to OBIE every 4, 6, 8, or 12 hours so that the dashboards and 
reports in Analytics get the latest data. You can set up Scheduling by clicking the Schedule (on 
the log toolbar). The Schedule Setup window allows you to set the Frequency. Furthermore, 
you can update the Publish at values according to the frequency. 

In addition, since the Company-level data that is seen in Analytics is determined by permissions 
(see Granting Permissions for Analytics), user permissions impact the data that is being 
available to the users. An administrator can set permissions in terms of who can view the 
Company-level information from the respective level Business Processes that are enabled for 
Analytics. 

The Run Now option (toolbar), in the Analytics setup page, enables the admin to run the data 
publish at-will, for Analytics.  

Upon selecting the Run Now option, Unifier displays the following message: "This action will 
only publish the Unifier data for Analytics and will not update the data seen in Dashboards and 
Analyses. You must run Analytics ETL to update them. Do you want to proceed?" 

This option is available for the users only if the Modify permission has been granted. 
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When Unifier is already running a job of data publish based on the schedule setup, an alert is 
displayed to inform the user that the job for data publish is already in progress: "Unifier data is 
already being published based on the schedule. You must wait for this to be complete before 
performing this action." 

Access Control Changes for Analytics Node in User Mode Access 

Use this access control to: 

 Give permission to view or visit analytics or OBIEE at the company or shell levels  

 Provide data level access for analytics or OBIEE dashboards  

User Mode Access > Company Workspace 

The root node "Non-navigational Nodes" (under Company Workspace section of the Access 
Control), contains the Analytics node, and the administrator can assign permissions to the root 
node "Non-navigational Nodes." The View option is the only permission option available for 
Analytics node. 

When users have view permissions at Company Workspace level, the users can see the 
executive dashboard tab and the “Analytics” link, after opening the tab. 

User Mode Access > Shells/Projects (Standard) 

The Analytics node is available under the "Non-navigational Nodes." The administrator can 
assign permissions to both users and groups.  

Analytics Subject Areas and Unifier Data 

Analytics subject areas use the following Unifier data: 

 Generic cost sheet 

 P6 Summary Sheets 

 Shells 

 Space Manager 

 Vendors 

 Business Process 

Analytics uses this subject area to analyze cost and non-cost line items in business 
processes. 

 Business Process History 

Analytics uses this subject area to analyze weekly historical business process facts to better 
understand changes over time. Note that dimensional business process history is not 
supported. 

 Cash Flow 

Analytics uses this subject area to analyze CBS-level cash flows. You can map columns to 
predefined company-level cash flow curves. Five generic columns are included to support 
custom labels from Primavera Unifier. Any Cash Flow families will be designated in 
Primavera Unifier (based on Cash Flow 'Name' value). 
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 Cash Flow History 

Analytics uses this subject area to analyze weekly historical cash flow facts to better 
understand changes over time. Note that dimensional cash flow history is not supported. 

 Cost Sheet 

Analytics uses this subject area to analyze cost sheets. You can map your data source to a 
predefined list of cost sheet columns. Ten generic columns are included to support custom 
labels from Primavera Unifier. 

 Cost Sheet History 

Analytics uses this subject area to analyze weekly historical cost sheet facts to better 
understand changes over time. 

Note: Dimensional cost sheet history is not supported. 

Granting Permissions to Setup Analytics 

To initially setup the Analytics node within Unifier, permissions must be enabled in the 
Administration mode and User mode  

To grant permission for Analytics (Administration Mode Access) 

1) Go to the Company Workspace tab and switch to Admin mode.  

2) Click Access Control in the left Navigator. 

3) On the right pane, select Administration Mode Access > Analytics. The Permission 
Settings for: Analytics window opens. Here you can add, modify, or remove permission 
settings. 

4) Click Add to open a new Permission Settings for: Analytics window. 

5) Click Add Users/Groups. The Users/Group Picker window opens. 

6) Select the intended users and/or groups and click Add. 

7) Click OK to return to the Permission Settings window. 

8) Select the users or groups in Select Users/Groups, located in the upper portion of the 
window, and select the appropriate level of access for the user or group in Permissions 
Settings, located in the lower portion of the window. 

View: This option allows users and groups to open and view the contents in Analytics node. 
Users with View permission cannot make any changes. 

Modify: This option allows users and groups to configure and modify the data required for 
Analytics. This setting includes View permission. Users are also able to set schedule for 
publishing data, for various areas in Unifier, to the Oracle Business Intelligence (OBI) server. 

9) Click OK. 

10) Click Apply to save changes and keep the window open, or click OK to save changes and 
close the window. 

To grant permission for Unifier data in Analytics (User Mode Access) 

1) Go to the Company Workspace tab and switch to Admin mode.  

2) Click User Mode Access to expand. 
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3) Click Company Workspace to expand. 

4) Click Non-navigational Nodes to expand. 

5) Click Analytics to open the Permission Settings for: Analytics window. 

6) Click Add to open a new Permission Settings for: Analytics window. 

7) Click Add Users/Groups. The Users/Group Picker window opens. 

8) Select the intended users and/or groups and click Add. 

9) Click OK to return to the Permission Settings window. 

10) Select the users or groups in Select Users/Groups, located in the upper portion of the 
window, and select the appropriate level of access for the user or group in Permissions 
Settings, located in the lower portion of the window. 

View All Records: This option allows users and groups to open and view Company level 
Business process data and all the available project level data in Analytics . Users with View 
All Records permission cannot make any changes. 

View All Company Records: This option allows users and groups to open and view only the 
Company-level information from the respective level Business Processes that are enabled 
for Analytics. Users with View All Company Records permission cannot make any 
changes. 

View All Shell Records: This option allows users and groups to open and view all the 
available/mapped shell level data in Analytics, like Cost, Cashflow etc. Users with View All 
Shell Records permission cannot make any changes. 

Note: For existing users, the first checkbox option (View All Records) is 
automatically selected, after upgrade. 

Analytics and Dashboards 

Each of the following dashboards has filter selections, or prompts, to help you narrow the results 
in the sections by the date, project, location, and so on. You can access the Analytics node in 
Company Workspace > Administration mode > Analytics. 

 Business Process 

The Business Processes dashboard enables you to view business process data, including 
business process overview analyses, business process data by geographic location, and 
business process history analyses. 

 Cash Flow 

The Cash Flow dashboard enables you to view cash flow data, including comparisons of 
actuals vs. forecast and forecast vs. baseline, cash flow data by geographic location, and 
cash flow history analyses. 

 Cost Sheet 

The Cost Sheet dashboard enables you to view cost data, including a comparison of original 
and revised budget details, and cost history analyses. 
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Accessing the Unifier Analytics Dashboard in OBI 

Users can access the Unifier Analytics dashboard designed in Oracle Business Intelligence 
(OBI) platform by using the link provided in Unifier. 

With Single Sign On (SSO) 

When accessing the Unifier Analytics dashboard with Single Sign On (SSO) enabled, you 
navigate from Unifier to the OBI, directly. 

If a user goes to the OBI landing page, the accessibility of the landing page, dashboards, 
analyses, and so forth are controlled by the settings for the user that is logged in OBI. 

If a Shell analytics user cannot go to the corresponding dashboard, the system will take the user 
to the default landing page set in OBI. 

Without Single Sign On (SSO) 

To access the Unifier Analytics dashboard without Single Sign On (SSO) enabled, you need to 
login to the OBI server. 

Accessing Unifier from OBI server 

You can access Unifier from OBI server by way of Action Links. Action Links are a way of 
providing easy and seamless navigation from an Analysis to other local content (such as other 
Analyses or Dashboards) or external content (such as websites). The Action Links in Analytics 
allows you to view the data in Unifier. 

Action Links (from OBI to Unifier) 

The following is a list of available Action Links: 

 Link to BP Log 

 Link to BP Record 

 Link to Cash Flow log 

 Link to Cost Sheet log 

 Link to Shell landing page 

 Link to P6 Summary Sheet log 

 Link to Spaces log (Space Manager) 

 Link to Level log (Space Manager) 

With Single Sign On (SSO) 

When accessing from OBI server with Single Sign On (SSO) enabled, you must have 
appropriate permission to access a particular page, and pertinent navigation, in Unifier. For 
example, if you want to access a Cost Sheet using the Cost Sheet Action Link, you must have 
permission to access that particular Cost Sheet, for the selected project (Project Cost Sheet). 

If you do not have permission to a Unifier page that is linked to an Action Link, then the system 
will take you to the default landing page. 
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Without Single Sign On (SSO) 

To access the Unifier Analytics dashboard without Single Sign On (SSO) enabled, when using 
an Action Link, you need to login to the OBI server and enter your credentials. 

If a Unifier session is already in progress and you click an Action Link, the system will take you 
to the Unifier page, directly. 

Users must have appropriate permission to access a particular page, and pertinent navigation, 
in Unifier. For example, if you want to access a Cost Sheet using the Cost Sheet Action Link, 
you must have permission to access that particular Cost Sheet, for the selected project (Project 
Cost Sheet). 

If you do not have permission to a Unifier page that is linked to an Action Link, then the system 
will take you to the default landing page. 

About Link to BP Record 

With Single Sign On (SSO) enabled, if you click the Link to BP Record (Action Link), you can 
launch Unifier application and open the Business Process Record, provided that you have the 
appropriate permissions to the Business Process record. If you do not have the required 
permissions to the Business Process record, then the system will take you to the Business 
Process Log. 

Without Single Sign On (SSO) enabled, if you click the Link to BP Record (Action Link), the 
system displays the Sign In page or Unifier landing page (depending on whether the session is 
expired or not). If you click the Link to BP Record (Action Link), you can launch Unifier 
application and open the Business Process Record, provided that you have the appropriate 
permissions to the Business Process record. If you do not have the required permissions to the 
Business Process record, then the system will take you to the Business Process Log. 

Accessing Analytics from Unifier 

You can access Analytics from the following places in Unifier: 

Company level Dashboards 

The company level access is typically provided to executive level users who want to view the 
Analytics dashboards at a Company level. These users will be able to access data from all 
Shells. 

Dashboards 

You can access the executive Analytics Dashboards by clicking the Analytic Dashboards icon. 
This icon will be in place of the existing Custom Dashboard tab. Clicking the Analytic 
Dashboards icon, on the top left-hand corner of the screen, allows you to open the Analytic 
Dashboards in OBIE. 

The Analytic Dashboards icon can be seen by users who have access to Company level 
Analytics (Company Workspace > Non Navigational Nodes: View access).  

When a user has access to both Custom dashboards (Small Web Format (SWF) Dashboard) 
and Analytics, the existing Custom Dashboards tab remains as is; however, an additional button 
called “Analytics Dashboards…” will be seen in the Dashboards page. 
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When a user has access to Custom SWF Dashboards, only, there are no changes to the 
existing User Interface (UI). 

When a user has no access to the Custom SWF Dashboards or Analytics, the Analytic 
Dashboards icon will be hidden. 

Shell-level Dashboards 

The Shell members can configure Custom Shell dashboards. 

In the Source Details section of the Edit Dashboard window, the Analytics option for the Block 
Type supports Analytics for Shell details. 

Any user with the Edit Dashboard permissions can add the Analytics option for the Block Type. 

Publishing Unifier Data to Analytics 

You must send Unifier data to Analytics periodically on an incremental basis. To send data to 
analytics ,you will need to:  

1) Publish Unifier data to staging tables 

2) Run ETL Using the Primavera Analytics Administration Web Application to send data to the 
STAR schema of Primavera Data Warehouse 

For more details on how to use the Primavera Analytics Administration Web Application, see 
Primavera Analytics Cloud Service Administration Guide. 

You can set the frequency of sending data to Analytics to Oracle Business Intelligence (OBI), by 
using the Schedule option in the toolbar. 

Note: If you need location-specific details for Spatial Data in Analytics, 
ensure that the values for Country and State Data Elements (DEs) are 
according to the ISO standards. These values can be pulldowns or plain 
text fields. 

Schedule Setup 

The frequency for the data publication can be Daily, Weekly or None. The default value is Daily. 

You can set the frequency to Daily, Weekly, or None. 

The default frequency is Daily. 

If you select Weekly, the system sets the day to Sunday. You can change the day. 

If you select None, there will be no periodic publication of Unifier data to Analytics. 

You can set the time for the publication of data. 

You must set the time format to 24-hour notation in the form hh:mm, for the publication of data. 
The Hour drop-down lists hours from 0 to 23 for hour and 0 to 59 for minute. The default option 
for time is set to 00:00. The system displays the server time zone after the minute. 

You must select the checkbox for the Data Refresh option if you made changes to the DD value 
or labels. By default, the checkbox is unchecked. 
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You must select the checkbox for the Data Refresh option if you made changes to the data 
mapping fields. After the run is complete, the system resets the checkbox for the Data Refresh
option and the checkbox will be unchecked. 

Mapping Linked Elements 

The linked elements can be mapped to Analytics fields. The values of linked elements from the 
source are rendered at run-time in the destination record. However, if there are any changes to 
the value of the linked elements in the source record, then you need to conduct a full refresh of 
data in order for Analytics to display these values. As a result, you must select Refresh All data
for this purpose. 

Run History 

The Run History option allows you to see the status of the scheduled runs of the Unifier data 
publication to the Analytics server. When you select the Run History option, by clicking Run 
History on the toolbar, the Run History window opens and displays the following information: 

 Requestor: Is always "System" 

 Submit Date: The date entered by user 

 Start Data: The date entered by user 

 End Date: The date entered by user 

 Status: The run status 

You can view the Run History details  by opening a record in the Run History log.  

The history details window includes the Start Date, End Date, and a message. 

 Success message: Data was sent to Analytics, successfully. 

 Failure message: For example, An error occurred and data was not published to Analytics 
successfully. Contact System Administrator. The system then displays the actual error after 
the generic failure message. 

Unifier Configurator and OBI Server for On-Premises 

The Unifier Configurator has an additional option for users to enter the URL to the OBI server. 
Refer to the Unifier Installation Guide (WebLogic) for details. 

Analytics Block 

The following provides detailed information about the Analytics Block window: 

 Block Title: This field contains the title of the Analytics Block. 

 Name: This field contains the name (as a hyperlink) of the Analytics Block.  

 URL: This field contains the URL, entered by the user, and it must match the URL specified 
in the Configurator. 

Note: The URL protocol, server path, and port must all match; otherwise, 
the validation fails. 

Example 
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If the URL is: http://slc44.us.oracle.com:7001/analytics, then the Analytics 
URL must be: http://slc44.us.oracle.com:7001/analytics. 

Note: The system does not validate the other URL parameters, for 
example, the Dashboard name. 

When you post the Analytics Block, it appears in the Source Details log and provides the 
following information: 

 Block Title: Title entered by the user. 

 Source Name: Same as the name entered in the Name field. 

 Block Type: Analytics 

 Result Type: Blank 

 Display Type: Blank 

The Analytics Block is also displayed in the Shell landing page. In the Unifier Analytics pane, 
you can click Analytics Dashboards to go to the shell dashboard in the Analytics server. 

If a user does not have permissions to access the Shell dashboards defined in OBIEE server, 
then the link is disabled and displays as plain text. 

You can add Analytics block to “My Dashboards”. However, the link connecting Unifier to the 
Analytics server, from this "My Dashboards" is completely driven by the Access Control > Mode 
Access > Shells/Projects (Standard) > Non-Navigation Nodes > Analytics. 

Analytics Block and Shell Templates 

The Analytics Block that is defined in the Shell dashboard of the Shell templates can be pushed 
to Shell instances. 
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Unifier and Primavera P6 

Unifier receives the integrated data, from P6, and uses the data for the following Cost modules: 

 Cost Sheet 

 Cash Flow 

 Earned Value (EV) 

As a part of integration, you can capture the "summarized" P6 data within the Cost modules and 
view the information in a columnar and comparative format, for example, Cost Sheet columns, 
Cash Flow Curves, and Earned Value Curves). In addition, the Reporting functionality within 
Unifier enables you to create "User-Defined" or "Custom" reports using the "summarized" P6 
data. 

Prerequisites for a Successful Integration 

 Use CBS type Shells to use Unifier cost modules with data integrated from P6. 

 Use the system Data Element uuu_int_schedule_type within the Integration -> Detail 
section of Shell attribute form definition. 

 Create and Publish P6 Data Sources to pull P6 data into Cost Sheet. 

 Create Shell instances corresponding to each P6 Schedule that needs to be integrated with 
Unifier by following these instructions: 

 Each Shell instance must have the same ‘Shell Number’ as the corresponding P6 Project 
ID. 

 To bring the P6 internal Project id to Unifier, you need to add the P6 Internal Project ID 
field (uuu_int_internal_proj_id) to the Attribute form and the Integration Detail 
form (Company Workspace > Admin mode > uDesigner > Shell Manager > Integration > 
Detail) 

 Create or use separate Shell Templates for Duration Based and Resource or Cost 
Loaded integrated Shells in Unifier because the Cost Sheet for Duration Based 
schedules will not contain columns rolling up from P6 Summary Sheets (when the other 
two types of schedules will have columns rolling up from P6 Summary Sheets) 

 Include the following in the Role attribute form, if the integration will be Resource or Cost 
Loaded: 

 uuu_role_imported_from_p6

 uuu_role_type, uuu_role_id 

 uuu_role_uom 

 For correct cost calculations in Resource Loaded schedules, update all imported roles with 
Rate values. 

 If you create Unifier Roles via integration, include the Roles above the Data Elements (DEs) 
in the integration detail section in uDesigner Role attribute design. 

 For Resource Loaded or Cost Loaded schedules: 

 (Recommended) Do not change or update the ID of Roles created via integration 
manually because when you create Roles via integration the Role ID is used as the 
identifier by means of which the integration interface maps the P6 Resource to Unifier 
Role. 
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 If you want to integrate the CBS codes with P6, do the following: 

 Include uuu_cost_imported_from_p6 and uuu_int_hidden_from_p6 in the CBS 
attribute form 

 Define the default CBS segment values within Data Structure Setup -> Data Definitions 
-> Cost Codes 

 If you want to create Cost Codes for a Shell using the P6 CBS structure, ensure that the 
Cost Sheet structure in P6 is Tree. 

 Do not include Unifier Cost Code separators (“-”, “.”,) in P6 CBS Codes if you are creating 
Cost Codes in Unifier using P6 data. 

 When working with P6 data sources or Cost Sheet columns: 

 You can create or publish P6 data sources via integration and when the "Send Summary 
data" integration is used. 

 You can add published P6 data sources, as columns, in Cost Sheet Templates, only. 

 If you create P6 data sources via integration, and not manually, then you can add 
columns to Cost Sheet after the "Send Summary data to Unifier" is used, only. 

 If you create P6 data sources manually, and not via integration, then create or publish P6 
data sources by: 

 Creating or publishing one P6 Data Source called "Current Schedule." This 
datasource is used by the system to define the "Type" of all Master Summary 
sheets (Summary sheets which contain summary data from the main P6 project 
which is integrated with Unifier). 

 Creating or publishing all "Baseline Type" values defined within P6 Enterprise 
Data as P6 Data Sources in Unifier. 

 Once you created or published the P6 data sources, you can use the P6 data 
sources to create columns in the Cost Sheet Template and push the information to 
the Shell instances. 

In This Section 

P6 Data Sources node ........................................................................................... 348 
P6 Activity Data ..................................................................................................... 351 
P6 Activity Picker Query Configuration .................................................................. 351 
P6 Data and Cash Flow Templates ....................................................................... 353 

P6 Data Sources node 

The P6 Data Sources node is located under the Standards &Libraries node. The P6 Data 
Sources node enables you to access the following information, based on your permissions: 

 Data source 

Captured from P6 Summary Sheets, for use in Cost Sheets or Cost Sheets Templates. 

Examples of P6 Data Sources: Current Schedule Summary, Original Baseline Summary, 
Sanctioned Baseline Summary 

 Dataset for the attribute "Type" for P6 Summary Sheets 
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Note: Unifier allow a maximum of 12 P6 Data Sources to be integrated, 
with "Current Schedule" as one of the 12 P6 Data Sources must be 
named. 

P6 Data Sources Permissions 

The P6 Data Sources node appears under the Standards &Libraries node, when in 
Administration mode. The following permissions are available for the P6 Data Sources: 

 Create 

User with Create permission have full access to the P6 Data Sources node and is allowed to 
create new data sources, modify existing data sources, and delete and view all data sources. 

If a  user has "Create" permission, the remaining two permissions is enabled automatically. 

 Delete/Modify 

User with Delete/Modify permission will not be able to Create new data sources. 

If a user has "Delete/Modify" permission, the "View" permission is enabled automatically. 

 View 

User having View Permission will not be able to Create, Modify or Delete, but will only be 
able to View the different data sources. 

P6 Data Sources Log Window (Main menu) 

File

New: To create a new Data Source 

Copy: To copy a Data Source 

Open: To open a Data Source 

Note: Data Sources must have unique names. 

Edit

Delete: To delete a P6 Data Source 

If the P6 Data Source has been published already, you cannot delete. 

Properties: To edit the Data Source properties 

Note: You cannot edit the name of a Data Source. 

View

To find a Data Source. 

Help

To access online hep and documents. 

P6 Data Sources Log Window (Toolbar menu) 

New
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To define a new P6 Data Source, using the New window. 

Open

To open a defined P6 Data Source. 

Delete

To delete an existing Data Source, one record at a time. 

Publish

To make the P6 Data Source available to be added as Cost Sheet columns. You can select and 
Publish more than one Data Source at a time. 

Note: Once a Data source is published, it appears as a "single" Data 
Sources within a Cost Sheet or Cost Sheet Template that have the 
option of "Enable P6 Sources" selected in the properties. Unpublished 
Data Sources are not be available as Cost Sheet "Single" Data Sources. 

Find

To find a Data Source 

P6 Data Sources Properties Window 

 Name

Text (maximum 120 characters). This content of this field is from P6 and maps to the P6 
Project Name. 

 Description

Editable field allowing you to enter a description (maximum 500 characters). 
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P6 Activity Data 

If you are using both Unifier and P6, you can link the two applications using Primavera Gateway 
and send data from a P6 Schedule to Unifier Projects. You can "pick" activities and 
Auto-populate (AP) or Reverse Auto-populate (RAP) from the corresponding P6 project. 

Corresponding P6 Project 

The term “Corresponding P6 project” refers to that P6 project which has the: 

 Same ID as Unifier Project 

or 

 Same ID as captured in a system element in Unifier project attributes 

Maintaining Projects (Unifier and P6) 

Maintain projects between the two applications by ensuring that the: 

 ID of the projects match in both applications 

or 

 System Data Element (DE) (uuu_int_p6_project_id) is present on the Shell Attribute 
form, and the value is the same as the corresponding P6 project ID. 

If only when one of the conditions above is met that the Gateway - Unifier Provider can 
determine which P6 project corresponds to which Unifier project. 

Note: Integration with P6 application applies to Unifier CBS type Shell 
only. The integration does not apply to the Unifier Project (Standard). 

P6 Activity Picker Query Configuration 

You can query the P6 Activity Picker elements by using the fields associated with the P6 Activity 
Attribute form. 

To define query conditions for P6 Activity Picker elements, from the same place as Data Picker 
query conditions in Unifier, switch to the Admin mode > uDesigner > Business Processes > 
Open > Data picker. 

In the Query Condition window, you can add query conditions under the Add Query Condition
section: 

 Data Element

A drop-down list that contains all the elements (pre-defined or custom) from the P6 Activity 
Attribute form. Yo can use the Data Element to create any query to filter out P6 Schedule 
activities from the P6 Activity Picker. 

 Condition

To set conditions for the query. 
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P6 Data and Cash Flow Templates 

You can use a Cash Flow Shell template (Shell instances and Shell templates) to select the 
Summary Sheets by selecting the associated P6 data sources. As a result, when you use a 
Cash Flow Shell template to push the Cash Flow settings, the system updates the Shell instance 
with the Cash Flow settings of the template. 

Note: The following applies to both Distribution, Cost, and Schedule 
sections. 

At runtime, the system uses the data from Summary Sheets, associated with the P6 data 
source, to render the Cash Flow curves. 

Distribution and Schedule 

Admin mode > Templates > Shells > Building > Template > Cost Manager > Cash Flow

In the Distribution or Schedule sections of the Cash Flow templates (with Detail level CBS), click 
Select from the Use data from P6 Sources option to open the Select Data sources window. This 
window displays all the data sources listed in the Standards & Libraries. 

Note: The Data Type option (under the P6 Source selection option) is a 
required field, if you select Use data from P6 Sources option. Use the 
drop-down list in the Data Type field to see a list of all the data types 
available for the selected P6 data source. 

Since the Schedule type will be blank, the Cash Flow template displays all the options available 
regardless of the Schedule type. 

The P6 sources in Distribution, Cost (only for Actuals), and Schedule sections are always 
enabled in the Cash Flow templates. 

The P6 Sources window (source selection) lists all the Published data sources, in alphabetical 
order. You can click on a source name to select that source. To find a source, go to Find, click 
the drop-down list, and follow the prompts. Depending on the type of the Cash Flow curve, this 
option is available only if you select the Distribution/Schedule/cost option as Use data/dates 
from P6 Sources. 

The Data type options for the Baseline curves are: 

 At Completion 

 Planned 

The Data type options for the Forecast curves are: 

 At Completion 

 Remaining 

You can copy the Cash Flow curve properties that exist in a Shell template to the Cash Flow 
curves that exist in instances if: 

 The Shell template push is done 

 The Shell template is used to create new instances 
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Unifier and Primavera Gateway 

Gateway allows data to be moved between two applications (at least one of them is a Primavera 
application) on schedule or on demand. It is a single integration hub where all the data 
integration happens with Primavera applications. 

For a Unifier object to exchange data with an object in another application via Gateway, the 
object must be pre-defined within: 

 Unifier Provider 

 Gateway 

 Oracle application/external application Provider 

Additionally, objects within each Provider must have a hard-coded (Java code) link to the 
corresponding object (with which it exchanges data) in Gateway. 

Example 

To expose Unifier Project object for integration with another application via Gateway, there 
must be: 

 Project object defined in Unifier Provider 

 Project object defined in Gateway 

 Project object defined in Unifier Provider must be hard-coded (Java code) to link to 
Gateway Project object 

Correspondingly, to exchange data with Unifier Project object, the Oracle application/external 
application Provider must have a Project object within it and that object must be hard coded (via 
java coding) to link to Gateway Project object. 

Unifier Objects and Gateway 

Unifier sends data to the Oracle application through Gateway. The following Unifier objects can 
be integrated with Oracle applications via Gateway: 

 Projects/Shells 

You can create and update Projects in Unifier using project data from an external application 
via Gateway. The exchange of information is bi-directional, from the Oracle application to 
Unifier and from Unifier to the Oracle application. 

Note: Integration with an Oracle application/external application does not 
apply to the Unifier Project (Standard). 

 Business Processes

You can create and update Business Process records using data from external applications sent 
to Unifier via Gateway. The exchange of information is bi-directional, from the Oracle application 
to Unifier and from Unifier to the Oracle application. 

 Roles

You can create and update Unifier Roles using data sent over from Gateway. The exchange 
of information is bi-directional, from Oracle application to Unifier and from Unifier to the 
Oracle application.  
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 CBS Codes

You can create CBS codes, within a Cost Sheet, using data sent over from Gateway. The 
exchange of information is one-directional, from the Oracle application to Unifier. 

Note: Integration with P6 application applies to Unifier CBS Shell-type 
only. 

Document exchange support through Gateway 

Unifier supports exchanging documents attached to BP records, or Line Items, through 
Gateway. In particular, through integration between Unifier and Gateway, Gateway performs as 
an intermediary and supports: 

Attaching documents to the respective BP records, or Line Items, while importing the documents 
into Unifier. 

Exporting documents (attached to BP records, or Line Items,) out of Unifier and to any Oracle 
application which is receiving the BP records, or Line Items. 

Notes: 

 The Oracle application must support receiving and exporting 
documents. 

 Once the documents are sent across to the Oracle application, the 
system deletes the documents from Gateway. 

Gateway Objects and Unifier Provider Objects 

Business Processes 

When you deploy a BP design to Gateway, the system maps to the BP design, in Gateway, in 
two ways: 

 Mapping to the existing, predefined, objects in Gateway. 

 Mapping to a newly created object in Gateway, under Unifier Provider. 

Mapping to a newly created object in Gateway requires that you: 

 Use the dynamic object mapping, in Gateway, to map the newly created objects from Unifier 
Provider to an existing object in Gateway. 

 or  

 Create a new object in Gateway and map the Unifier Provider object to newly created object 
in Gateway. 

The new objects created in Unifier Provider contain the following default information: 

 Object name. 

 Description that is added in the Unifier. 

 Fields (including respective properties) associated with the design 

Before you can use the object, you must configure the remaining information for the newly 
created object: 
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 Data related to Flow Type 

 Cross-reference to the Gateway object 

Once you complete mapping the object in Gateway, you can use the object for creating business 
flows in Gateway and use the data. 

Configuring Unifier Objects on Gateway 

By default, the mapping of data involves the following applications in order: 

1) Unifier 

2) Unifier Provider on Gateway 

3) Gateway Provider on Gateway 

Mapping to a newly created object in Gateway requires that you match the information of that 
object in Gateway to the information of the object that you deployed from Unifier. In Gateway, 
once you find and select an object that you can use (i.e., an object that has matching 
information), you can proceed by cross-referencing the object in Unifier to the selected object in 
Gateway. 

Default Gateway Objects 

The following table lists the object names that are available for mapping in Gateway, by default, 
and provides a description: 

Ite
m 

Object 
Name 

Description 

1 
BlanketP
urchaseO
rder

A company level purchase order, which enables agreements with 
vendors to provide services across multiple projects, released on a 
per-project/per-period basis with work authorizations against a 
previously determined maximum. 

2 

BlanketP
urchaseO
rderDeta
il

Line Items for Blanket Purchase Orders 

3 Contract Base Commit for EPC Activities (SOV = Payment Application) 

4 
Contract
Detail Line Items for Contracts 

5 
Purchase
Order

To track money committed to be spent (General Spends type Base 
Commit) 

6 
Purchase
OrderDet
ail

Line Items for Purchase Orders 

7 
WorkRele
ase

Process that is connected to Blanket Purchase Order Business 
Process that is deployed at company level. This process can be used 
to write against the blanket purchase order  
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Ite
m 

Object 
Name 

Description 

8 
WorkRele
aseDetai
l

Line Items for Work Releases 

9 
ChangeOr
der

A formal commit change to the contract. 

10
ChangeOr
derDetai
l

Line Items for Change Orders 

11
POAmendm
ent

Approval process for purchase order changes.  

12
POAmendm
entDetai
l

Line Items for PO Amendments 

13 Invoice
A general process for requesting and approving payments against 
commitments (invoice at the CBS or breakdown level, do not calculate 
retainage or stored materials) 

14
InvoiceD
etail

Line Items for Invoices 

15
PaymentA
pplicati
on

A process to track your payment information using a standard 
payment application method (for example, tracking retainage, stored 
materials, past payments, etc.) 

16
PaymentA
pplicati
onDetail

Line Items for Payment Applications 

17 Estimate
Used to create multiple project estimates and identify the preferred 
scenario. 

18
Estimate
Detail

Line Items for Estimates 

19
BudgetAp
proval

Used to approve project budget  

20
BudgetAp
provalDe
tail

Line Items for Budget Approval 

21
BudgetCh
ange

For requesting additional (or reduced) budget beyond the existing 
budget.  

22
BudgetCh
angeDeta
il

Line Items for Budget Changes 
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Ite
m 

Object 
Name 

Description 

23
BudgetTr
ansfer

For transferring budget from one CBS code to another. Most typically 
used to release budget contingency to other cost items.  

24
BudgetTr
ansferDe
tail

Line Items for Budget Transfers 

25
Potentia
lChangeO
rder

Contractor initiated potential change order.  

26

Potentia
lChangeO
rderDeta
il

Line Items for Potential Change Orders 

27
JournalE
ntry

A process for adjusting spends line items. Most commonly used to 
reassign costs to alternate cost centers or GL codes; Generic spend 
to transfer across cost codes 

28
JournalE
ntryDeta
il

Line Items for Journal Entries 

29 Payment BP to hold Checks Processed Information from Financial System.  

30
PaymentD
etail Line Items for Payments 

31
RiskAndI
ssue

A log for documenting, tracking, and estimating impacts of open 
issues and risks; Log of items that may impact schedule/scope/cost 

32
RiskAndI
ssueDeta
il

Line Items for Risks & Issues 

33
FundAppr
opriatio
n

Fund accounts as assigned to projects  

34
FundAppr
opriatio
nDetail

Line Items for Fund Appropriations 

35
ProjectI
nformati
on

Project attribute information 

36
VendorEv
aluation

Document vendor performance for consideration for future work 
(Simple) 

37 Vendor Company vendor directory 
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Ite
m 

Object 
Name 

Description 

38
Vendor 
Detail

Line Items for Vendors 

39
Timeshee
t

Used to capture Employee Timesheets (project / non-project hrs) 

40
Timeshee
tDetail

Line Items for Timesheets 

41
Requestf
orSubsti
tution

A change of identical material or equipment  

42

Requestf
orSubsti
tutionDe
tail

Line Items for Request for Substitution 

43
BudgetCh
angeOrde
r

 A change to a budget that is typically created for a contractor that is 
based on changes to a contract between the contractor and owner. 

44
BudgetCh
angeOrde
rDetail

Line Items for Budget Change Orders 

45
BudgetIt
em

 A budget that is typically created for a contractor that is based on a 
contract they have with an owner for a project. 

46
BudgetIt
emDetail

Line Items for Budget Items 

47

PaymentA
pplicati
ontoOwne
r

 A payment application that is raised by a contractor to the owner in 
order for the contractor to receive payment. 

48

PaymentA
pplicati
ontoOwne
rDetail

Line Items for Payment Applications to Owner 

49
PaymentF
romOwner

 A record of the actual payments a contractor will have received from 
the owner based on the payment application they presented to the 
owner. 

50
PaymentF
romOwner
Detail

Line Items for Payments From Owner 



Unifier General Administration Guide

360

User-Defined Report (UDR) 

Unifier displays a project-level/company-level UDR that is enabled for integration in the log page 
of the Business Objects node (Company Workspace > Admin mode > Gateway > Business 
Objects). 

You can export data, generated out of a project-level/company-level UDR that is enabled for 
integration, to an Oracle/external application Provider through Gateway. 

To export, you can select the listed UDR and click Deploy to send the data in the UDR to 
Gateway and use the data for integration with an Oracle/external application Provider. 

Gateway Node in Unifier 

To access the Gateway node go to Unifier CBS type Shell > Company Workspace > Admin 
mode > Gateway > Business Objects

The Gateway node provides the following information on the Gateway Integration landing 
page:   

 API URL

 This element captures the Gateway API URL that Unifier goes to in order to establish 
connection with Gateway. 

 Data Definition: SYS Description Text 250 

 User Name

 This element contains the user's name who logs into Gateway URL. 

 Data Definition: SYS Long Name 

 Unifier Deployment

 Allows you to enter the name of the Unifier Deployment, which needs to be accessed to 
exchange data with external applications 

 Data Definition: SYS Short Description Text 250 

 Integration Parameters block 

 Source Base Currency

 Activity Sheet Synchronization

 Import Synchronization (The import synchronization that is selected for Activity 
and Assignment data for customers with EVM license and import synchronization 
that is selected for Activity data for customers without EVM license.) 

 Export Synchronization

 Rate Sheet Synchronization

To see the Integration Settings, click Open from the toolbar to open the Integration Settings
window. In the Integration Settings window, you can edit fields and run test. The Integration 
Settings window contains the following blocks and fields: 

Gateway block 

 API URL

 User Name

 Password
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 Contains the password required to log into the Gateway URL.  

 Data Definition: Short Description Text  

 Test Connection

 Enables you to run a test to verify that the Gateway URL and other credentials are 
valid. See the "Testing Connection" topic below. 

 Unifier Deployment

 Allows you to enter the name of the Unifier Deployment, which needs to be 
accessed to exchange data with external applications 

 Data Definition: SYS Short Description Text 250 

Integration Parameters block 

Select Source Base Currency for Rate Conversion

 Currency

 Select Synchronizations to exchange Activity data

 Import Synchronization (editable drop-down (size 250 chars)) 

 Contains the name of the Gateway Synchronization, which will be used to Import Activity 
data from Unifier to P6 

 Using the Gateway URL and the Unifier Deployment details captured within the 
Integration tab of "Company Properties," this field lists all the "Import" synchronizations 
from the URL, which are applicable to the mentioned Unifier Deployment. 

 The synchronizations shown in the drop-down will be the ones that match the Unifier 
Deployment. It lists the OOTB synchronizations provided for Oracle Primavera Cloud. 

Note: For Unifier, this is an "Import" synchronization (to import data into 
Unifier). From P6 perspective, this is an "Export." 

For customers with or without EVM licenses, the import synchronization that is selected in 
Select Synchronizations to exchange Activity data will be the import synchronization 
that is selected for EVM data, provided customer selected that prior to upgrade to 20.7; 
otherwise, the synchronization selected will be from Select Synchronizations to 
exchange Activity data. 

For all customers, the activity import synchronization that is selected in Select 
Synchronization to exchange Activity and Assignment data prior to upgrade to 20.7 
is shown as selected under import synchronization Select Synchronization to 
exchange Activity data. If there is no synchronization selected in Select 
Synchronization to exchange Activity and Assignment data, then the synchronization 
selected in Select Synchronization to exchange Activity data must be selected. If 
none of them are selected prior to upgrade to 20.7, then the import synchronization will 
be empty. 

Starting from 20.7, customers with or without EVM licenses can get data from P6, and the 
existing export synchronization and Import Synchronization selected from Role and 
Resources synchronization will not have any impact. 

 Export Synchronization (editable drop-down (size 250 chars)) 

Contains the name of the Gateway Synchronization which will be used to Export Activity 
data from P6 to Unifier 
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Using the Gateway URL and the Unifier Deployment details captured within the 
‘Integration’ tab of Company Properties, this field lists all the "Export" synchronizations 
from the URL which are applicable to the mentioned Unifier Deployment. 

The export synchronization shows additional OOTB synchronizations "Send Activity 
data from Unifier to Primavera Cloud" defined for Oracle Primavera Cloud. You will be 
able to push the updated activity data to Primavera Cloud, using the export 
synchronization. 

The Export Synchronization option "Update Activity data from Unifier to Primavera Cloud" 
enable you to send updated activity data from Unifier to the Oracle Primavera Cloud. 
When you are using Oracle Primavera Cloud data for scheduling project, you can bring 
the activities, schedules, and the associated WBS to the Unifier Activity Sheet. From the 
Activity Sheet, Unifier pulls the activity attributes in to the business processes. In the 
business processes, you can update the schedules and reverse auto-populate (RAP) 
data back to the Activity Sheet. In the Unifier Activity Sheet log of the projects that are 
synchronized with Oracle Primavera Cloud, the Send Data option enables you to send 
the updated schedules back to the Oracle Primavera Cloud. The business flow updates 
the activity data in Oracle Primavera Cloud according to the activity data in Unifier.  

Note: For Unifier, this is an "Export" synchronization (to export data from 
Unifier), from P6 perspective, this is an "Import." 

 Import Synchronization (editable drop-down (size 250 chars))  

Contains the name of the Resource and Role Rates from P6 for EVM Copy. 

When you make changes in the Integration Settings window, you must click OK to save your 
changes. Click Cancel to close the Integration Settings window. 

Testing Connection

To run a test to verify that the Gateway URL and other credentials are valid use the Test 
Connection option, in the Gateway block. If the system is unable to establish connection, you 
will receive an error message. If the system is able to establish connection, you will receive a 
confirmation message. 

Business Objects Node in Unifier 

You can expand the Gateway node to see the Business Objects node (Company Workspace
> Admin mode > Gateway > Business Objects). When you click the Business Objects node 
the Business Objects log window appears on the right-hand side. 

The Business Objects log window in Unifier provides the following information: 

 List of Unifier objects that have been deployed from uDesigner. The Unifier objects are: 

 Projects/Shells (Attribute form) 

 Business Processes 
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Note: The following types of BPs are not supported for integration: 
Project/Shell Creation BP - Resource BP - RFB BP - Text BP. 

 Roles (Attribute form)  

 CBS Codes (Unifier CBS Shell-type only) 

 Detailed information about each Unifier object that has been deployed: 

 Name 

 Category 

 Type 

 Last Updated 

 Last Deployed to Gateway 

 A mean to deploy a Unifier Business object that is ready to Gateway 

 Deploy to Gateway 

In the Business Objects log window, the columns provide detailed information about each Unifier 
object that has been deployed. 

Column name Description 

Name The name of the Unifier object. 

Category 
The category of the Unifier object: 
Business Processes, Shell Manager, and 
so forth 

Type 

The type of the Unifier object: Activity 
Sheet Attributes (from P6 and not defined 
in uDesigner), Resource Attributes, Roles 
Attributes, Cost, Simple, Shell Type, 
Document, Line Item, and so forth. 

Last Updated 
The date when the Unifier object was last 
updated, which is the Unifier object 
"Deploy" date from uDesigner. 

Last Deployed to Gateway 
The date when the Unifier object was last 
deployed to Gateway. 

In the Business Objects log window, the menu enables you to: 

 Deploy a Unifier object to Gateway 

 Edit 

 Find a Unifier object by applying filters 

 View 

 Review the history of a Unifier object 

 View 

 Access Unifier Help, documentation library, and productivity kit 
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 Help 

In the Business Objects log window, the toolbar enables you to: 

 Deploy a Unifier object to Gateway 

 Deploy to Gateway

 Review the history of a Unifier object 

 History

 Find a Unifier object by applying filters 

 Find

Deploy to Gateway 

When deployed to Gateway, the system appends the attributes of the objects in Unifier to the 
corresponding object in Unifier Provider. You can select multiple items and deploy the selected 
items to Gateway. For the selected objects, the user can create the following and synchronize 
the data exchange: 

 Data Mapping templates 

 Business Process flows 

If the "Integration" form of the following is set in uDesigner, you can use this option to deploy: 

 Activity Sheet Attributes (as captured in Unifier > Unifier Provider > Gateway) 

The deploy action only sends the values that you had manually entered in the Activity 
Attribute form to Gateway. 

The "Activity Sheet" object in Gateway contains all the pre-defined Activity Attributes fields by 
default. 

If you have added bitemID field in the Activity Sheet, then the P6 CBS code (P6) can then be 
mapped to the bitemID (Unifier) in the field mappings on Gateway.  

 Projects/Shells (Attribute form) 

 Business Processes 

Data Elements of type SYS Rich Text must not be sent to Gateway, when deployed.  

 Roles (Attribute form)  

 CBS Codes (Unifier CBS Shell-type only) 

 Project-level/Shell-level User-Defined Reports (UDRs) 

 Company-level UDRs 

How to exchange data through UDR with an Oracle application Provider 

You can export the data generated out of a UDR through Gateway and out to an external 
system. UDRs that are enabled for integration (i.e., the "Enable for Integration" option is 
selected) appear in the Business Objects node log, under Gateway in Company Workspace. 
You can deploy these UDRs and integrate them with Oracle integrators. 
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Note: For a UDR to be eligible for deploying to Gateway, you must 
select the "Enable for Integration" option. 

All the UDRs, which have been enable for integration (i.e., the "Enable for Integration" option is 
selected), are listed in in the Business Objects node, and you can choose to deploy those 
UDRs to Gateway to configure them for Data Exchange. 

The Business Objects node log displays UDR types and categories. 

All Project-level/Shell-level UDRs have Project-level/Shell-level as their type and User Defined 
Report as their category. 

All company-level UDRs have company-level as their type and User Defined Report as their 
category. You can search for and find a UDR Business Object by type or category. 

If you deselect the "Enable for Integration" option of a UDR after it has been deployed to, and 
configured in (for a Business Flow), Gateway, the system generates an error when 
synchronizing. 

If you delete a UDR that you have recently deployed to, and configured in (for a Business Flow), 
Gateway, the system generates an error when synchronizing. 

When a Line Item Type BP is deployed to Gateway, from Unifier, the system creates two objects 
for that BP. 

You can create different field mapping templates, according to the template requirements, and 
use the templates in different Business Flows to transfer the data. 

If you share documents between Unifier and any Oracle application, and the Oracle application 
does not support document integration, the system completes the Business Flow but without 
transferring the documents. 

History 

The system logs all the deployed Unifier objects in History. The History option allows you to 
view the status of a deploy action, informing you whether the deployment was successful, or not, 
in addition to the following information: 

 Requestor 

The name of the user who has deployed the record. 

 Source 

If you select Unifier objects of same type and deploy, then the system provides all selected 
objects (including names of all objects which were chosen by you for deploy) in alphabetical 
order. 

If you select Unifier objects of multiple types and deploy, then the system provides separate 
history entries for each of the objects that are getting deployed to Gateway. 

 Start Date 

The date when the deployment action started (Unifier started to prepare the xml file for 
Gateway). 

 End Date 

The date when the deployment action ended. 
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 Status 

The status of deployment action (Finished, In Progress, Finished with Errors). 

In the History window toolbar, you can: 

 Open 

To open an item in the History log. 

- Similar to the Open option in other "History" windows in Unifier, this action opens the 
"History Details" window.  

- Similar to other places in Unifier, you can take this action on one selected row only.  

 Find 

To allow you to search the History records. You can search on all columns (Requestor, 
Attribute Form, Submit Date, Start Date, End Date, Status). 

 Close Window 

To close the History window. 

History Details 

 If you select a row in the History window and click Open, the History Details window opens. 
This window includes information about: 

 Business Processes 

The name of the attribute form that was deployed. 

 Gateway URL 

The Gateway API URL through which link to the 3rd party applications is established, as 
defined by the user within Unifier Company Properties > Integration tab. 

 Unifier Deployment Name 

The name of the Unifier Deployment as defined within the Unifier Company Properties > 
Integration tab. 

 Deploy action status details 

The details of the status of the deploy action, successful or not. 

Find 

The Find option allows you to search for records in all of the Business Objects window columns. 

Configuring Permissions for Business Objects 

To configure the permissions for Business Objects go to: Company Workspace > Admin mode 
> Access Control. The Access Control node includes the Gateway node. 

To set permission for Gateway node: 

 Configure

If you check this permission, the user can update the "Integration Settings" at "Gateway 
Integration" landing page. 

 Get / Set Activity Sheet Data
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If you check this permission, the user can do the following from the Shell log File menu 
(Unifier CBS type Shell): 

 Get Activity Sheet Data (from the Shell toolbar): 

- All Shells 

- Selected Shells 

- Filtered Shells 

- History 

 Send Activity Sheet Data (from the Shell toolbar): 

- All Shells 

- Selected Shells 

- Filtered Shells 

- History 

Permission for "Get / Set Activity Sheet Data" from Shell log are configured in Unifier Admin 
Mode while permissions to take these action from within a Shell (User mode) are given at 
Unifier User mode level. 

To set permission for Business Objects node: 

Deploy

If you check this permission, you will enable the Deploy option, in the right-had pane of the 
Business Objects page. 

You can grant permissions, for Business Objects, by way of the User Mode Access in Access 
Control node: Company Workspace > Admin mode > Access Control > User Mode Access
> Shells / Projects (Standard) > Schedule Manager > Activity Sheet. 

Note: You can move the Activity Sheet module under other nodes. 

The following permissions are available for Activity Sheet: 

 Get Data

If you check this permission, the user can go in the Activity Sheet (Shell > User mode > 
Schedule Manager > Activity Sheet) and perform "Get Activity Sheet Data" or view 
"History." 

If you select the "Get Data" permission, the "View" permission will be selected automatically. 
In addition to the "Get Data" permission, the user needs the "View" permission in order to be 
able to have the "Get Activity Sheet Data" permission. You can grant "View" permission 
without granting the "Get Data" permission. 

 Send Data

If you check this permission, the user can go in the Activity Sheet (Shell > User mode > 
Schedule Manager > Activity Sheet) and perform "Send Data" or view "History." 

If you select the "Send Data" permission, the "View" permission will be selected 
automatically. In addition to the "Send Data" permission, the user needs the "View" 
permission in order to be able to have the "Send Activity Sheet Data" permission. You can 
grant "View" permission without granting the "Send Data" permission. 

 View
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If you check this permission, the user can view Activity Sheet data (Shell > User mode > 
Schedule Manager > Activity Sheet) and perform "Open." 

The permissions above are also available: 

 When granting permissions through User Administration (Company Workspace > Admin
mode > User Administration). 

 Within a Shell Template or Shell Instance Access Controls. 

 When granting permissions within a Shell Template or Shell Instance Access Control 
through User Administration. 

 Where all nodes are listed in Unifier Navigator (User mode), when appropriate. 

Unifier Provider, Unifier, and Gateway 

The following Unifier objects are available in Unifier Provider: 

 Project

Includes attributes that support the creation of projects in Unifier by way of Gateway. The 
Project object in Unifier Provider includes the following information: 

 Status 

 Location 

 Template Number 

 Business Processes (BPs) 

Enables you to create/update different types of BPs such as Cost, Line Item, Document, and 
so forth, in Unifier. To correspond to the Gateway infrastructure, separate objects are 
available to capture the information in the BP Upper Form and Detail tab. To support the 
creation of BPs in Unifier, the Business Processes object in Unifier Provider includes the 
following information: 

 Name 

 Status 

 Detail tab Name 

 Roles

Enables you to create/update Roles in Unifier (Resource Manager > Roles). 

 Resources

Enables you to create/update Roles in Unifier (Resource Manager > Roles). You can use the 
Resources object to identify whether a data from Unifier Provider can create a Role, or not. 

 CBS Codes (Unifier CBS Shell-type only) 

 Enables you to use the CBS object in Unifier Provider to import/export the CBS code data 
from Unifier.  

 Enables you to use the CBS object in Unifier Provider to import the CBS code data into 
Unifier. 

The following provides more details. 
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Project/Shell 

To create/update Project/Shell in Unifier you can use the following attributes: 

 Data Dictionary 

 Business Flow 

 Synchronization 

 End-to-end solution 

The following sections provide more details. 

Project/Shell Data Dictionary 

The following table describes the Data Dictionary for Unifier Provider (Project/Shell): 

Attribute Name Description 

Status To capture the status of Unifier project. 

Since Unifier projects must have one of 
following statuses, the user must define 
the data value mapping XML to map status 
of source project and to a project status 
value in Unifier. 

 Active 

 On-Hold 

 View-Only 

 Inactive 

Location The location of the destination Unifier 
Project. 

Example 

All Regions > Sites > Properties 

Template The "Number" of the template which must 
be used to create the new project in 
Unifier. 

 Unifier Shell Template Numbers are 
enforced to be unique across all shell 
template types.  

 Unifier determines the "Type" of the 
shell that must be created, using the 
template number. 

Project/Shell Business Flow 

When defining a Business Flow in Unifier Provider (Project/Shell), the destination application 
parameters for Unifier Provider, Project object, enable you to define the location (Location) and 
template (Template) as parameters. The attributes are specific to Unifier and eliminate the need 
for the source application to send the values for Unifier fields. 
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If the source application sends value for either of the parameters mentioned below via data 
mapping and you define the parameter value in the business flow, then the value sent by way of 
mapping takes precedence. 

The following parameters are required for successful project creation in Unifier. 

Note: Oracle recommends that you set these parameters as "Required" 
in the Business Flow definition. 

Object Value Description 

Project Location This is a Text field. You 
must enter one location, 
only. 

Example 

All Regions > Sites > 
Properties 

If you enter multiple 
locations, Unifier Provider 
will not be able to resolve 
the location in Unifier and 
project creation will fail. 

Use this parameter to 
identify the location 
(Location): Where the 
Unifier project must be 
created in Unifier. 

You can also add the 
location as "Shell Attribute" 
(uuu_location) when 
defining the "Project" object 
filters. 

If you define the location 
parameter as a shell 
attribute (uuu_location = 
<xyz>), and use the 
available drop-down field 
(Location) for the Project 
object, then project creation 
will fail.  

If you add a filter row by 
selecting the fields as Shell 
Attribute Form and provide 
a value of the Shell 
Location, for Project object, 
then project creation will 
fail. 

Project Template Number This is a Text field. You 
must enter one number, 
only. 

If you enter multiple 
numbers, Unifier Provider 
will not be able to resolve 
the template in Unifier and 
project creation will fail. 

Use this parameter to 
identify the templates which 
must be used to create the 
new Project in Unifier. 
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Project/Shell Synchronization 

Synchronization in Unifier Provider (Project/Shell) occurs when you set the parameters (Project 
Location and Project Template Number) as "Required" or "Optional" in the Business Flow 
definition. 

Project/Shell End-to-End Solution 

The following explains the end-to-end solution for Unifier Provider (Project/Shell). The 
configuration settings are for: 

 Unifier 

 Unifier Provider 

To configure the creation of projects in Unifier via Gateway 

Note: This is an optional step. You can skip deploying the objects from 
Unifier and add relevant fields in Gateway Data Mapping Templates 
directly, manually. 

In Unifier, go to Company Workspace > Admin mode > Gateway > Business Objects. 

Deploy the Shell Attribute Forms of the shells that you want to create in Unifier, via Gateway 
Integration. 

All fields from the deployed Shell Attribute Forms appear as attributes of Project object in Unifier 
Provider Data Dictionary. 

To configure the creation of projects in Unifier Provider via Gateway 

You must: 

 Create Data Mapping Templates 

 Define Business Flow 

 Define Synchronizations 

 Synchronize 

The following provides the details for each step: 

Create Data Mapping Templates

Create Data Mapping Templates to map attributes of the Shell that needs to integrate with the 
Oracle application. All attributes of the Unifier Data Dictionary Project object are available to be 
added to the Data Mapping Template. 

Note: Ensure that you create one Data Mapping Template per Shell 
type. 

If you do not want to deploy from Unifier and want to create the Data Mapping Templates in 
Gateway directly, then add each Shell Attribute Form Data Element that needs to receive data 
from the Oracle application Project object, manually. 

If you want to deploy from Unifier, after adding the Shell Attribute Form Data Element, then: 
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 If the manually added field is same as one of the fields that were deployed from Unifier, then 
there will be no adverse impact on the existing fields. 

 If the manually added field does not exist as a Data Element in Unifier, then there will be no 
adverse impact on the existing fields. 

The fields remain as they are when the Oracle application sends values for the fields that were 
added to Unifier Provider and those values are not sent to Unifier. 

Define Business Flow

Define Business Flow using the appropriate Data Mapping Template. 

Create one Business Flow per Shell type in Unifier. 

Add the appropriate source (Source) application parameters to filter the projects that you want to 
create in Unifier. 

Add the values of relevant destination (Destination) application parameters (Location and 
Template). 

Configure the Business Flow to be used for creating (Create) and updating (Update) the project 
in Unifier. 

Define Synchronizations

Define Synchronizations by using the appropriate Business Flow. 

Define the appropriate parameter values for data exchange. 

Define the schedule frequency so that the synchronization does not have to be run manually for 
the project creation or update. 

Synchronization

When a synchronization is run, Unifier Provider sends data to Unifier to: 

 Create or update a Shell instance (as per Business Flow configuration). 

 Populate the Data Element with the name of the application that is integrating with Unifier, if 
the destination Shell Attribute Form contains the "uuu_integrated_with" Data Element. 

Note: The application name value is sent by Gateway. The name is not 
hard-coded by Unifier. 

Gateway maintains a cross-reference table between objects of the two applications to monitor 
whether to create or update the records of an object. The cross-reference table has IDs of 
projects in Unifier and P6. If the cross-reference table has and entry for a Unifier project against 
a P6 project, then Gateway will update the Unifier project; otherwise, Gateway will create a 
Unifier project. 

Note: If a project exists in Unifier and does not have an entry in the 
Gateway cross-reference table, then when Gateway proceeds to create 
a project in Unifier, to prevent creating aduplicat project in Unifier, Unifier 
converts the create request to update request and proceeds to update 
the existing project, instead of creating a new project. 
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Business Processes 

To create/update Business Process records in Unifier you can use the following attributes: 

 Data Dictionary 

 Business Flow 

 Synchronization 

 End-to-end solution 

The following sections provide more details. 

Business Processes Data Dictionary 

Data Dictionary (Unifier Provider Business Processes) 

Notes: 

 The remaining attributes are deployed from Unifier, as Data 
Elements, and will be added to relevant business processes, per 
business need. 

 If available, the Object IDs in Gateway are noted in the corresponding 
field. 

 The Parent Element ID is the tag in the Line Item which connects the 
Line Item with the parent record in which the Line Item has to exist 
in. 

 Create separate templates for importing data into different BPs. 

Item Object Name Description Object Attributes 

1 Company Costs Unifier business processes that 
hold company level costs. 

When deployed from Unifier, the 
Upper forms of the Business 
Processes of the following 
category provide data for this 
object: 

Type = Cost  

AND 

Sub-type = Commit at Company 
Level           

AND 

Classification = <Null> OR Generic

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Status (status) 

 Amount (amount) 
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Item Object Name Description Object Attributes 

2 Company Costs 
Detail 

Detail tabs of Company Cost 
business processes. 

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Company 
Costs category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Short Description 
(short_desc) 

 Item Quantity 
(uuu_quantity) 

 Item Unit Cost 
(uuu_unit_price) in 
Unifier Provider and 
PricePerUnit in 
Gateway Object field 
(S.No 4) 

 Amount (amount) 



Unifier and Other Oracle Applications

375

Item Object Name Description Object Attributes 

3 Project 
Commits 

Unifier Project level business 
processes related to money 
committed to be spent. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Cost 

AND 

Sub-type = Line Items with CBS 
Code OR Line Items with Multiple 
Codes 

AND  

Classification = Base Commit OR 
Change Commit 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Due date (due_date) 

 Effective Date 
(uuu_effective_date) 

 Transaction Currency 
(currencyid) 

 Rate in Project 
Currency 
(currencyrate) 

 Status (status) 

 Description 
(description) 

 Amount (amount) 

 Publish Path 
(uuu_dm_publish_path
) 

 Reference BPO 
(ref_bpo) 

 Contract/PO (refid) 
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Item Object Name Description Object Attributes 

4 Project 
Commits Detail 

Detail tabs of the Project commits 
type business processes.  

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Project 
Commits category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Cost Code (bitemID) 

 Short_Description 
(short_desc) 

 Description 
(description) 

 Work Package (wpid) 

 Item Quantity 
(uuu_quantity) 

 Item Unit Cost 
(uuu_unit_price) in 
Unifier Provider and 
PricePerUnit in 
Gateway Object field 
(S.No 4) 

 Amount (amount) 

 Reference BPO 
Lineitem 
(ref_bpo_lineitem) 

 Reference 
(uuu_sovlinum) 

 Parent Detail Id 
(ParentDetailId) 
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Item Object Name Description Object Attributes 

5 Project Invoices Unifier invoice related Project level 
business processes. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Cost 

AND 

Sub-type = Line Items with CBS 
Code OR Line Items with Multiple 
Codes 

AND  

Classification = General Spends 
OR Payment Applications 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Due date (due_date) 

 Effective Date 
(uuu_effective_date) 

 Contract/PO (refid) 

 Transaction Currency 
(currencyid)  

 Amount (amount) 

 Status (status) 

 Publish Path 
(uuu_dm_publish_path
) 
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Item Object Name Description Object Attributes 

6 Project Invoices 
Detail 

Detail tabs of the Project invoices 
type business processes.  

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Project 
Invoices category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Cost Code (bitemID) 

 Short_Description 
(short_desc) 

 Description 
(description) 

 Work Package (wpid) 

 Item Quantity 
(uuu_quantity) 

 Item Unit Cost 
(uuu_unit_price) in 
Unifier Provider and 
PricePerUnit in 
Gateway Object field 
(S.No 4) 

 Amount (amount) 

 Effective Date 
(uuu_effective_date) 

 Scheduled Value 
(scheduled_value) 

 Parent Detail Id 
(ParentDetailId) 
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Item Object Name Description Object Attributes 

7 Other Project 
Costs 

Unifier Project level business 
processes that captures costs 
other than commits or invoices. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Cost  

AND 

Sub-type = Line Items with CBS 
Code OR Line Items with Fund 
Code OR 

AND 

Classification = Generic OR 
Transfer OR 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Status (status) 

 Amount (amount) 

 Publish Path 
(uuu_dm_publish_path
) 



Unifier General Administration Guide

380

Item Object Name Description Object Attributes 

8 Other Project 
Costs Detail 

Detail tabs of the Other Project 
costs type business processes. 

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Other Project 
Costs category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Cost Code (bitemID) 

 Fund Code 
(uuu_fund_code) 

 Short_Description 
(short_desc) 

 Description 
(description) 

 Item Quantity 
(uuu_quantity) 

 Item Unit Cost 
(uuu_unit_price) in 
Unifier Provider and 
PricePerUnit in 
Gateway Object field 
(S.No 4) 

 Amount (amount) 

 Effective Date 
(uuu_effective_date) 
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Item Object Name Description Object Attributes 

9 Project Simple Unifier project level Simple 
business processes. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Simple 

AND 

Level = Project/Shell 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Status (status) 

 Publish Path 
(uuu_dm_publish_path
) 

10 Company 
Simple 

Unifier company level Simple 
business processes. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Simple 

AND 

Level = Company 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Status (status) 

 Due Date (due_date) 

 Publish Path 
(uuu_dm_publish_path
) 
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Item Object Name Description Object Attributes 

11 Company Line 
Item 

Unifier company level Line Item 
type business processes. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Line Item 

AND 

Sub-Type = Any 

AND 

Level = Company 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Status (status) 

 Due Date (due_date) 

 Publish Path 
(uuu_dm_publish_path
) 

12 Company Line 
Item Detail 

Detail tabs of the company Line 
Item type business processes.  

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Company 
Line Item category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Short Description 
(short_desc) 
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Item Object Name Description Object Attributes 

13 Project 
Document 

Unifier Project level Document type 
business processes. 

When deployed from Unifier, the 
Upper forms of the business 
processes of the following category 
provide data for this object: 

Type = Document 

AND 

Sub-Type = Any 

AND 

Level = Project/Shell 

 Record Number 
(record_no) 

 Title (title) 

 Creator 
(uuu_creator_id) in 
Unifier Provider and 
CreateUserId in 
Gateway Object field 
(S.No 2) 

 Creation Date 
(uuu_creation_date) in 
Unifier Provider and 
CreateDate in 
Gateway Object field 
(S.No 1) 

 Short Description 
(short_desc) 

 Status (status) 

 Publish Path 
(uuu_dm_publish_path
) 

14 Project 
Document 
Detail 

Detail tabs of Project Document 
type business processes. 

When deployed from Unifier, the 
Detail tabs of all business 
processes that are in Project 
Invoices category provide data for 
this object. 

 Parent Record 
Number 

 Line No./LiNum in 
Unifier Provider and 
LineNo in Gateway 
Object field (S.No 3) 

 Tab Name 
(uuu_tab_id) 

 Name (uuu_Name) 

 Short Description 
(short_desc) 

 Line Item Status 
(uuu_line_item_status)

 Issue Date 
(uuu_issue_date) 

Summary Payment Application (SPA) SOV type BPs 

The creation and update of the Line Items in the Summary Payment Application (SPA) SOV type 
BPs requires three fields in Unifier Provider. These fields are designed to identify and separate 
the SPA SOV type BPs in Unifier Provider from the existing SPA SOV type BPs in Unifier. 
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Note: Line Item update is not supported for Project Invoice (Payment Applications) Type of BP’s 
through Gateway Integration. As a result, every Update from Gateway to Unifier will result in the 
creation of a new Line Item. 

Depending on which Line Item is referenced, the Line Items coming from Gateway follow a 
certain structure as described in the examples below: 

Base Commit Type BP Line Item

Example 

<_bp_lineitems>  <!—Summary Line -- >

<ElementId>Summary1</ElementId>

<ParentDetailId></ParentDetailId>

<short_desc>desc 1</short_desc>

</_bp_lineitems>

<_bp_lineitems>  <!—Costed line -- >

<ElementId>costed line 1</ElementId>

<ParentDetailId>Summary1</ParentDetailId>

<short_desc>desc 1</short_desc>

</_bp_lineitems>

Note: The parentdetailid connects the BP Line Item to its parent 
Summary Line Item in the SOV. 

Change Commit Type BP Line Item

Example 

<_bp_lineitems> <!—Summary Line -- >

<ElementId>Summary1</ElementId>

<ParentDetailId></ParentDetailId>

<short_desc>desc 1</short_desc>

<uuu_sovlinum>1</uuu_sovlinum>

</_bp_lineitems>

<_bp_lineitems> <!—Costed line -- >

<ElementId>costed line 1</ElementId>

<ParentDetailId>Summary1</ParentDetailId>

<short_desc>desc 1</short_desc>

<uuu_sovlinum>1.1</uuu_sovlinum>

<bItemID>Code 1</bItemID>

</_bp_lineitems>
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Notes: 

 The parentdetailid connects the BP Line Item to its parent 
Summary Line Item in the SOV. 

 The Data Element uuu_sovlinum is an optional field. If the value is 
received by Unifier for the same field, then Unifier will try to update 
an existing row; otherwise, the update will create a new Line Item in 
the SOV (based on the settings of the SOV). 

Invoice Type BP Line Item

Example 

<_bp_lineitems> <!—Summary Line -- >

<ElementId>Summary1</ElementId>

<ParentDetailId></ParentDetailId>

<short_desc>desc 1</short_desc>

<bItemID></bItemID>

<_refnum>1</_refnum>

</_bp_lineitems>

<_bp_lineitems> <!—Costed line -- >

<ElementId>costed line 1</ElementId>

<ParentDetailId>Summary1</ParentDetailId>

<short_desc>desc 1</short_desc>

<bItemID>Code 1</bItemID>

<_refnum>1.1</_refnum>

</_bp_lineitems>

Notes: 

 The parentdetailid connects the BP Line Item to its parent 
Summary Line Item in the SOV. 

 The refnum is for Unifier and is used when creating the structure 
within the SOV for the incoming Line Items and the Summary lines.  

Unifier Provider BP Objects and Gateway Objects 

To correspond to the Unifier Provider objects (explained in the preceding Data Dictionary 
section), Gateway will introduce new objects to support the various business processes. 

You can use the mapping information in the following table to see how data is sent from Unifier 
to an Oracle application and flows from object to object (Unifier Provider > Gateway). 
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Item Unifier Provider Object Name Corresponding Gateway Object Name 

1 Company Costs BlanketPurchaseOrder 

2 Company Costs Detail BlanketPurchaseOrderDetail 

3 Project Commits 

BudgetChangeOrder 

BudgetItem 

Contract 

PurchaseOrder 

WorkRelease 

ChangeOrder 

POAmendment 

4 Project Commits Detail 

BudgetChangeOrderDetail 

BudgetItemDetail 

ContractDetail 

PurchaseOrderDetail 

WorkReleaseDetail 

ChangeOrderDetail 

POAmendmentDetail 

5 Project Invoices 

Invoice 

PaymentApplication 

PaymentApplicationtoOwner 

6 Project Invoices Detail 

InvoiceDetail 

PaymentApplicationDetail 

PaymentApplicationtoOwnerDetail 

7 Other Project Costs 

Estimate 

BudgetApproval 

BudgetChange 

BudgetTransfer 

PotentialChangeOrder 

JournalEntry 

Payment 

PaymentFromOwner 

RiskAndIssue 

FundAppropriation 
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Item Unifier Provider Object Name Corresponding Gateway Object Name 

8 Other Project Costs Detail 

EstimateDetail 

BudgetApprovalDetail 

BudgetChangeDetail 

BudgetTransferDetail 

PotentialChangeOrderDetail 

JournalEntryDetail 

PaymentDetail 

PaymentFromOwnerDetail 

RiskAndIssueDetail 

FundAppropriationDetail 

9 Project Simple ProjectInformation 

10 Company Simple VendorEvaluation 

11 Company Line Item 
Vendor 

Timesheet 

12 Company Line Item Detail 
VendorDetail 

TimesheetDetail 

13 Project Document  RequestforSubstitution 

14 Project Document Detail RequestforSubstitutionDetail 

Business Processes Business Flow 

When defining a Business Flow in Unifier Provider (Business Processes), the destination 
application parameters for Unifier Provider, BP object, enable you to define which BP needs to 
receive data by way of the Business Flow configuration. The attributes are specific to Unifier and 
eliminate the need for the source application to send the values for Unifier fields. 

Notes: 

 To avoid duplicating records, create separate Business Flows (for two 
BPs of the same type) when importing data into Unifier. 

 Do not use a single Business Flow in Gateway to import into two 
Company Costs type BPs. Instead, use different Business Flows for 
setting up the data flow. 

If the source application sends value for either of the parameters mentioned below via data 
mapping and you define the parameter value in the business flow, then the value sent by way of 
mapping takes precedence. 

The following parameters are required for successful project creation in Unifier. 
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Object Value Description 

Business Process Name Text field 

If you enter more than one 
value, then the integration 
will fail. 

Use this parameter to 
identify the Name of the 
business process that 
requires the data from the 
Oracle application. The 
value that you enter in this 
parameter is used by Unifier 
Provider to identify which 
BP requires data. 

Example 

Creating Data Mapping 
Template 

 Unifier Provider object: 
Project Commits 

 Gateway object: 
Contracts 

 Oracle Application 
object: xyz 
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Object Value Description 

Business Process Detail 
Tab Name 

Text field 

If you enter more than one 
value, then the integration 
will fail. 

Use this parameter to 
identify the Detail tab of the 
business process that 
requires the data from the 
Oracle application. The 
value that you enter in this 
parameter is used by Unifier 
Provider to identify which 
BP requires data. 

Example 

Creating Data Mapping 
Template 

 Unifier Provider object: 
Project Commits Detail 

 Gateway object: 
Contracts Detail 

 Oracle Application 
object: xyz 

Note: The tab Name is also 
an attribute for all Line Item 
objects in Unifier Provider. If 
the Oracle Application 
sends value for tab name 
by way of mapping, then the 
mapped value will override 
the parameter value defined 
in Business Flow. 
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Object Value Description 

Line Item Identifier Text field 

Note: Oracle recommends 
that you use the Data 
Element name. 

If you enter more than one 
value, then the integration 
will fail. 

This parameter is used by 
Unifier during an update of 
an existing Line Item (in 
Unifier), only. The value that 
you enter in the Data 
Element of this parameter is 
used by Unifier to identify 
which Line Item requires 
update. 

Note: Within this parameter 
text box, enter the name 
(not label) of the Data 
Element on the Detail tab 
that must be used as the 
identifier for Line Item 
update. Unifier Provider 
identifies the value entered 
in this text boxas the DE 
name (not label). 

Business Processes Synchronization 

Synchronization in Unifier Provider (Business Processes) occurs when you set the parameters 
(Business Process Name, Status, and Detail Tab Name) as "Required" or "Optional" in the 
Business Flow definition. 

Business Processes End-to-End Solution 

The following explains the end-to-end solution for Unifier Provider (Business Processes). The 
configuration settings are for: 

 Unifier 

 Unifier Provider 

To configure the creation of Business Processes in Unifier via Gateway 

Note: This is an optional step. You can skip deploying the objects from 
Unifier and add relevant fields in Gateway Data Mapping Templates 
directly, manually. 

Go to Company Workspace > Admin mode > Gateway > Business Objects. 

Deploy the business process record that you want to create in Unifier, via Gateway Integration. 

All Data Elements from the deployed business process record appear as attributes of Business 
Process object (Company Costs, Project Commits, Project Invoices, etc.) in Unifier Provider 
Data Dictionary. 
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To configure the creation of Business Processes in Unifier Provider via Gateway 

You must: 

 Create Data Mapping Templates 

 Define Business Flow 

 Define Synchronizations 

 Synchronize 

The following provides the details for each step: 

Create Data Mapping Templates

Create Data Mapping Templates to map attributes of the BPs Upper Form data that needs to 
integrate with Gateway > Oracle application. 

Notes: 

Ensure that you create one Data Mapping Template per BP. 

If the BP that needs to integrate has Detail tab, then create additional 
Data Mapping Template, one template per Detail tab, to ensure that the 
map the Detail Form elements to Gateway > Oracle application. 

Once you deploy the BP from Unifier to Gateway, all the attributes of the Business Process 
object Unifier Provider (Company Costs, Project Commits, Project Invoices, etc.) will be 
available for you to add to the Data Mapping Template. 

If you do not want to deploy from Unifier and want to create the Data Mapping Templates in 
Gateway directly, then you must add each BP Data Element that needs to receive data from a 
Oracle application object in Gateway, manually (use the Add New Field in the Add Template 
window). After you add each BP Data Element in Gateway, you must deploy the BP from Unifier. 
Note the following conditions: 

 If the manually added field is the same as one of the fields that you deployed from Unifier, 
there will be no impact on the existing field. This is similar as if you deployed the manually 
added field from Unifier. 

 If the manually added field does not exist as a Data Element in Unifier, there will be no 
impact on the existing field. When the Oracle application sends value for this field to Unifier 
Provider, the value remains as is and it is not sent to Unifier. 

Define Business Flow

Define Business Flow using the appropriate Data Mapping Template. 

Create one Business Flow per BP Upper Form and one Business Flow per BP Detail tab in 
Unifier. 

Add the appropriate source (Source) application parameters to filter the BP records that you 
want to extract for the Oracle application and create in Unifier. 

Add the values of the following relevant destination (Destination) application parameters in order 
for the BP Records/Line Items to be created in Unifier: 

 Project ID 

 Business Process Name 
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 Business Process Detail Tab Name 

Configure the Business Flow to be used for creating (Create) and updating (Update) the BP 
Records/Line Items in Unifier. 

Define Synchronizations

Define Synchronizations by using the appropriate Business Flow. 

Define the appropriate parameter values for data exchange. 

Define the schedule frequency so that the synchronization does not have to be run manually for 
the BP Records/Line Items creation or update. 

Synchronize

When a synchronization is run, Unifier Provider sends data to Unifier to create or update BP 
Records/Line Items instance (as per Business Flow configuration). 

Example 

To create BP records of Base Commits type in Unifier: 

1) In Unifier, deploy the Base Commits BP to map to Unifier Provider object (Project Commits). 

2) Log in to Gateway instance and create the following two Data Mapping Templates: 

a. Using the Gateway object "Project Commits" to map the Base Commits BP "Upper Form" 
information to the Oracle application. 

b. Using the Gateway object "Project Commits Detail" to map the Base Commits BP "Detail" 
tab information to the Oracle application. 

3) Using the appropriate Gateway objects, create the following two Business Flows: 

a. Using Gateway object "Purchase Orders" and selecting the corresponding Data Mapping 
Template that you created (sub-step "a" above). 

b. Using Gateway object "Purchase Orders Detail" and selecting the corresponding Data 
Mapping Template that you created (sub-step "b" above). 

4) Add the appropriate source (Source App Parameters) to filter records from the source 
application and set the destination application parameters (Destination App Parameters) to: 

a. Business Process Name = Base Commit 

b. Business Process Detail Tab = <detail tab name> 

5) Create two synchronizations: 

a. For Base Commit BP in Unifier 

b. For Base Commit Line Item in Unifier 

6) Define the schedule frequency so that the synchronization does not have to be run manually 
for the BP Records/Line Items creation or update. 

Roles 

You can create a Role in Unifier by using both Role and Resource data from a Oracle 
application. The Role object in Unifier Provider can be used to create and update Roles in 
Unifier. The following sections provide details about: 

 Roles Data Dictionary 
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 Roles Business Flow 

 Roles Business Flow (Destination App Parameters) 

 Roles Synchronization 

 Roles End-to-End Solution 

Roles Data Dictionary 

The Role object in Unifier Provider has the following default attributes which are the mandatory 
fields needed to create a Role object in Unifier: 

Attribute Name Description 

Role Name The name of the Role object in Unifier. 

Role Status The Role status is either Active or Inactive.

 If the Oracle application Role Status 
values do not match the Unifier Role 
Status values, then use Data Mapping 
values. 

 If the Oracle application does not send 
any values for this attribute, then 
Unifier creates a Role with a default 
status of "Active." 

Role Currency The currency for the Role. 

This attribute is mandatory/required for 
creating a Role object in Unifier. 

If the Oracle application does not send any 
values for this attribute, then Unifier 
creates a Role with a default currency of 
company base currency. 

As a result of the Summary Sheet integration that creates Role in Unifier (by pulling data from 
P6 Schedule Summary data, the Role ID (uuu_role_id) is a mandatory/required field for creating 
a Role object in Unifier. 

Creating a Role object in Unifier by pulling data from Gateway (Role/Resource object) does not 
require the Role ID (uuu_role_id) field for creating a Role object in Unifier. 

Creating a Role object in Unifier via Gateway integration (by pulling data from Gateway 
Role/Resource object) require the values of the following fields, mentioned in the table above: 

 Role Name 

 Role Status 

 Role Currency 

Roles Business Flow 

Role, or Resource, mapping in Unifier (from an Oracle application) is achieved by way of the 
"Dynamic Object Mapping" field in Gateway. 

The "Create Template" window in Gateway enables you to select "Provider 1" as a Oracle 
application and "Provider 2" as Unifier. 
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In the section available for mapping objects, you can select "Resource" as the object in the 
Oracle application and "Role" as the object in Unifier (Provider 2). 

You can choose a criteria to bring the "Resource" data from the Oracle application by selecting 
the "Use Criteria Step" checkbox. You can then proceed to the next step and add the required 
mappings. 

Roles Business Flow (Destination App Parameters) 

You can create the Roles object in Unifier from both Resources and Roles objects in Unifier 
Provider. As a result, when defining a Business Flow, you need to identify the parameters 
(Destination App Parameters) within Unifier Provider. The following explains the Roles Business 
Flow: 

Roles Synchronization 

You can create synchronization using the appropriate Business Flow. 

Roles End-to-End Solution 

Follow these steps to create Roles objects in Unifier, via Gateway integration: 

1) From Unifier, deploy the Roles attribute form to Gateway. 

 This is an optional step. You can use this step to add additional Data Elements (required 
for Role creation or to receive values from the Oracle application) to the Roles attribute 
form. 

 You can create the Role object in Unifier from Role, or Resource, object in Unifier 
Provider by using the destination parameter (see the Roles Business Flow (Destination 
App Parameters) above); however, when a Roles object is deployed from Unifier, it only 
provides attributes for the Role object in Unifier Provider, only. 

2) Create Data Mapping Template. 

Unifier Provider "Role" object > Gateway "Role" object > Oracle Application "xyz" object 

3) Create Business Flow. 

Use the Gateway "Role" object and Data Mapping Template. 

4) Create Synchronization. 

Use the Business Flow. 

5) Create Schedule. 

Enable the scheduled creation/update of roles. 
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Resources 

You can use the Resources object to identify whether a data from Unifier Provider can create a 
Role/Resource, or not. When you map a Unifier "Resource" object to a Gateway "Resource" 
object, you can create/update both the Resources and Roles object in Unifier. The following 
sections provide details about: 

 Resources Data Dictionary 

 Resources Business Flow 

 Resources Synchronization 

 Resources End-to-End Solution 

Resources Data Dictionary 

The Resources object in Unifier Provider has the following default attributes which are the 
mandatory fields needed to create a Resources object in Unifier: 

Attribute Name Description 

Resource Name Unifier Resource Name. 

Resource Status The Resource status is either Active or 
Inactive. 

If the third-party application Role Status 
values do not match the Unifier Resource 
Status values, then use Data Mapping 
values. 

If the third-party application does not send 
any values for this attribute, then Unifier 
creates a Resource with a default status of 
"Active." 

Resource Code Resource Code. 

Resource Capacity Resource Capacity. 

User First Name First name of the Unifier user who is being 
added as a resource. 

User Last Name Last name of the Unifier user who is being 
added as a resource. 

User E-mail ID E-mail ID of the Unifier user who is being 
added as a resource. 

Default Role Name The role that the resource is allocated to. 
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Resources Business Flow 

You can create the Business Flow by using the appropriate Resource-to-Resource Data 
Mapping Template. 

Resources Synchronization 

You can create the Synchronization by using the appropriate Business Flow. 

Resources End-to-end Solution 

Follow these steps to create Resources objects in Unifier, via Gateway integration: 

1) From Unifier, deploy the Resource attribute form to Gateway. 

 This is an optional step. You can use this step to add additional Data Elements to the 
Resources attribute form that are required for: 

Resource, or Role, creation. 

Receiving value from the third-party application. 

When a Resource object is deployed from Unifier, it only provides attributes for the Resource 
object in Unifier Provider, only. 

2) Create Data Mapping Template. 

Unifier Provider "Resource" object > Gateway "Resource" object > Third-party Application 
"xyz" object 

3) Create Business Flow. 

Use the Gateway "Resource" object and Data Mapping Template. 

4) Create Synchronization. 

Use the Business Flow. 

5) Create Schedule. 

Enable the scheduled creation/update of resources. 

CBS Codes 

You can create and update the CBS Codes in Unifier Cost Sheet via Gateway integration with 
any Oracle application. 



397

Oracle Primavera Unifier General Administration Guide 

Copyright © 1998, 2022, Oracle and/or its affiliates. All rights reserved. 
Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be 
trademarks of their respective owners. 

Intel and Intel Inside are trademarks or registered trademarks of Intel Corporation. All SPARC 
trademarks are used under license and are trademarks or registered trademarks of SPARC 
International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or 
registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open 
Group. 

This software and related documentation are provided under a license agreement containing 
restrictions on use and disclosure and are protected by intellectual property laws. Except as 
expressly permitted in your license agreement or allowed by law, you may not use, copy, 
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or 
display any part, in any form, or by any means. Reverse engineering, disassembly, or 
decompilation of this software, unless required by law for interoperability, is prohibited. 

The information contained herein is subject to change without notice and is not warranted to be 
error-free. If you find any errors, please report them to us in writing. 

If this is software or related documentation that is delivered to the U.S. Government or anyone 
licensing it on behalf of the U.S. Government, the following notice is applicable:  

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, 
integrated software, any programs installed on the hardware, and/or documentation, delivered to 
U.S. Government end users are "commercial computer software" pursuant to the applicable 
Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, 
duplication, disclosure, modification, and adaptation of the programs, including any operating 
system, integrated software, any programs installed on the hardware, and/or documentation, 
shall be subject to license terms and license restrictions applicable to the programs. No other 
rights are granted to the U.S. Government. 

This software or hardware is developed for general use in a variety of information management 
applications. It is not developed or intended for use in any inherently dangerous applications, 
including applications that may create a risk of personal injury. If you use this software or 
hardware in dangerous applications, then you shall be responsible to take all appropriate 
failsafe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation 
and its affiliates disclaim any liability for any damages caused by use of this software or 
hardware in dangerous applications. 

This software or hardware and documentation may provide access to or information on content, 
products and services from third-parties. Oracle Corporation and its affiliates are not responsible 
for and expressly disclaim all warranties of any kind with respect to third-party content, products, 
and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or 
damages incurred due to your access to or use of third-party content, products, or services. 

Copyright 


	Contents
	Getting Started with Unifier General Administration Guide
	Security Considerations in Unifier
	Authentication: How Users Sign On
	Authorization: What Users Can Access
	Endpoint Security
	Confidentiality for Primavera Unifier
	Integration with Other Applications
	Security for Developers - API Security
	Establishing Security Contacts

	Companies in Unifier
	Administrators in Unifier
	Permission-Based Security in Unifier
	Company Landing Page (Admin)
	Program Landing Page (Admin)
	Shell Landing Page (Admin)
	Project Landing Page (Admin)
	Queries
	How Queries Work
	Using Formulas or Conditions in Queries
	Field Value Comparison
	Date Plus or Minus
	Date Difference
	Compare Date Fields
	Dynamic Date Value
	Between Dates

	Assignee Filter Query Condition
	Query Based Data Element (QBDE)
	Defining the Format of the Currency for QBDE

	Dashboards in Unifier
	Self-Service Portal
	Access Control and AutoVue Stamps
	Managing Public Searches
	Setting Public Search Permissions
	Managing Public Searches

	Adding & Managing Partner Companies
	Add a partner company
	Remove a partner company
	View partner company profile

	Manage Support and e-Learning contact information (Contact tab)
	Manage Company Password Policy (Security tab)
	Manage Company Addresses (Address tab)
	Access Company Details (Edit Company Window)
	Edit Company (General Tab)
	Edit Company (Address Tab)
	Edit Company (Contact Tab)
	Edit Company (E-Signatures Tab)
	Edit Company (Outgoing E-mails Tab)

	Background Jobs
	Event Notifications
	uDesigner Overview
	Custom Dashboards
	Creating Company or Shell Custom Dashboards
	Granting Custom Dashboard Permissions
	Configuring a Company Custom Dashboard
	Modify the General Properties of a Company Dashboard
	Define queries for Company Dashboard data cubes
	Specify cache details
	Grant Company Dashboard View permission


	Configuring a Shell Dashboard
	Modify the General Properties of a Shell Custom Dashboard
	Define queries for shell dashboard data cubes

	Modifying a custom dashboard
	Delete a custom dashboard
	Find a custom dashboard
	Download XML data associated with a custom dashboard
	Refresh the Company Dashboard cache


	Program Administration
	Creating and Managing Programs
	Creating a Project
	Grant permission to administer projects or project templates
	Create a project by copying a template or project
	Create a new project manually
	Add Cost Sheet
	Manage Projects
	Activate or deactivate a project

	Creating a Program
	Defining Program Properties
	Define Program General Properties (General tab)
	Add or Remove Projects or Shells From a Program (Projects tab)
	Set Up Program Progress Tracking (Progress tab)
	Add Links to Other Program-Related Web Pages (Links tab)

	Program User Administration
	Add Users or Groups to a Program
	Grant Program Permissions (Access Control)


	Project Administration
	Creating and Managing Projects
	How to create and setup a project
	Creating a Project Template
	Access project templates
	Create a project template
	Create a project template by copying a template or project
	Set up modules in the project template
	Manage Project Templates

	Defining Project (and Project Template) Properties
	Define general project properties (General tab)
	Define project location (Location tab)
	Add project currencies (Standards tab)
	Add a project image (Standards tab)
	Distribute an External Email Address for the Project (Standards Tab)
	Set up project progress tracking (Progress tab)
	Add links to other project-related web pages (Links tab)
	Select a project custom attribute (Custom tab)
	Create a Project Calendar (Calendar Tab)
	Modify a Project Calendar

	Company Sponsored Projects (Standards Tab) E-Signatures


	Updating Projects
	General procedure for updating project information
	Update users
	Update groups
	Update Business Processes and BP Setups
	Update User-Defined Reports
	Update access control
	Update cost sheet columns in a project
	Cost Column Project Update Rules

	Update Schedule of Values (SOV) Structure
	Update commitment funding structure
	Update Cash Flow Curve Properties and Permissions
	Update project cost or fund rules
	Update gates setups
	View update history
	Cancel a project update request

	Managing Member Companies
	Add a member company to a project
	View member company profile
	Remove a member company from a project

	Managing Project Users and Groups
	Add a user to a project
	View or edit a project user’s profile
	Create and Manage Project Groups
	Grant project user permissions through Project Access Control
	Generate and print access information report

	Setting Up Automatic Status Update
	Setting Up Gates
	Example of a gates setup and conditions
	Define the project phase list
	Create a gates setup
	Add project phases to the gates setup (Settings tab)
	Configure Gates conditions
	Configure gate elements
	Change the order of project phases
	Define gates runs schedule (Schedule tab)
	Activate or deactivate a gates setup
	Set user permissions for gates

	Create an automatic project status update setup
	Choose the order of non-active statuses (Settings tab)
	Define status change query and trigger conditions (Settings tab)
	Define project status update schedule (Schedule tab)
	Activate or deactivate an auto-update status setup
	Set permissions for automatic update of project status

	Shells Administration
	Dedicated Mailbox for the Shell
	User Permissions and Navigation
	Setting up Shells
	Importing Shells
	Setting Permissions to Configure Shell Types in the Shell Manager
	Configuring Shells
	Update generic cost sheet columns and rows
	Configuring Shell Manager Configuration Package
	Setting Permissions to Administer Shell Templates
	Accessing a Created Shell Template
	Create a Shell Template
	Create a shell template by copying a template or shell
	Shell Cloning window selections
	Cloning window selections only for CBS code shell templates and shells

	Shell Template Modules and Managers
	Managers and Modules Available in all Shell Templates (Both CBS and Generic Codes)
	Selections available in only Generic code shell templates
	Selections available only in CBS code shell templates
	Document Manager Template

	Manage Shell Templates
	Adding View Forms in Shell Template

	Setting Permissions to Create or Modify Shell Instances
	Creating a Shell
	Create a New Shell Manually
	Location picker behavior

	Create a shell by copying a template or shell
	Managing Member Companies
	Add a member company to a shell
	View member company profile
	Remove a member company from a shell

	Managing Shell Users and Groups
	Add a user to a shell
	View or edit a shell user’s profile
	Create and Manage Shell Groups
	Grant shell user permissions through Shell Access Control
	Generate and print access information report

	Create new shells using an imported CSV file
	Create shells with the shell creation business process

	Integration Tab
	CBS Type Shell for a Non-EVM User
	CBS Type Shell for an EVM User

	Managing Shells
	Packaging Single Instance Shells
	Updating Shells
	Updating Shell Formation - General Procedure
	Updating Shells, Users
	Updating Shells, Groups
	Updating Shells - Setup Node, Business Process
	Updating Shells - Setup Node, Dashboards
	Conditions for Creating a Dashboard Setup Configuration Package

	Updating Shells - Setup Node, Gates
	Updating Shells - Setup Node, Planning Manager
	Updating Shells - Setup Node, Resource Manager
	Updating Shells - Setup Node, Configurable Modules (Classes)
	Updating Shells - Configurable Modules Node (Sheets)
	Updating Shells - Rules Node
	Updating Shells - Cost Manager Node, Cash Flow
	Updating Shells - Cost Manager Node, Cost Sheet
	Updating Shells - Cost Manager Node, Funding - Funding Sheet
	Updating Shells - Cost Manager Node, Funding - Commitment Funding Sheet
	Updating Shells - Cost Manager Node, Schedule of Values - General Spends
	Updating Shells - Cost Manager Node, Schedule of Values - Payment Applications
	Updating Shells - Cost Manager Node, Schedule of Values - Summary Payment Applications
	Updating Shells - Cost Manager Node, Templates - Commitment Funding Sheet
	Updating Shells - Document Manager Node
	Updating Shells - Space Manager Node, Levels Sheet
	Updating Shells - Space Manager Node, Stack Plans
	Updating Shells - Schedule Manager Node, Schedule Sheets
	Updating Shells - Access Control Node
	Updating Cost Sheet Columns in a Shell
	Cost Column Shell Updating Rules

	Update schedule of values structure
	Updating Shells - Reports Node
	Update commitment funding structure
	Update cash flow properties and permissions
	Update generic cost sheet columns and rows
	View update history
	Cancel a shell update request

	Setting Up View Forms in Shell Attributes

	Setting Up the Automatic Update of Shell Status
	Create an automatic shell status update setup
	Choose the order of non-active statuses (Settings tab)
	Define status change query and trigger conditions (Settings tab)
	Define shell status update schedule (Schedule tab)
	Activate or deactivate an auto-update status setup
	Set permissions for automatic update of shell status

	How to Set Up Gates
	Example of a gates setup and conditions
	Define the phase list
	Create a gates setup
	Delete a Gates Setup
	Add phases to the gates setup (Settings tab)
	Access gate configuration view
	Configure gate elements
	Change the order of phases
	Define gates runs schedule (Schedule tab)
	Activate or deactivate a gates setup
	Set user permissions for gates

	Editing Multiple Shells at once with Bulk Edit
	About Shell Dashboards
	Setting shell instance dashboard permissions
	Creating a shell dashboard in a template
	Copy a shell dashboard
	Modify shell instance dashboard properties
	Delete a shell instance dashboard
	Find a shell instance dashboard
	Set user or group permission for a shell instance dashboard

	Migrating standard projects to CBS shells
	Migration limitations
	Migration Considerations
	Migration mapping of project data elements to shell data elements
	Migrate projects to shells
	Export the migration template
	Modify the exported csv template
	Initiate migration of standard projects to CBS shells
	View migration history
	Test for CBS shell creation


	Internationalization and CSV Files
	Internationalization and Web Services
	Web Services and Internationalization
	Number formatting of data
	Get Web Services


	Internationalization (Email Notifications)
	Internationalization (Support for Tools)
	Internationalization (BI Publisher Custom Reports)
	Internationalization (Dashboards)
	Internationalization (Help Files)
	Internationalization (Spell Check)
	Internationalization (Date and Time Zone Formats)
	Internationalization (Audit Log)

	Unifier Activity Manager
	Activity Manager Permissions

	Managing Personal Information in Unifier
	About Consent Notices (Administrator)
	About Personal Information
	Cookies in Unifier

	Permission Control for Consent Notice
	Your Responsibilities
	Personal Information (PI) Data in Unifier
	Configuring Consent Notices for Unifier
	Configuring Consent Notices for User Signing In through Web
	Auditing Consent Notices for Unifier Users Signing In through Web

	Configuring Consent Notices for Bidders Signing In through Web
	Auditing Consent Notices for Unifier Bidders Signing In through Web




	Translating Custom Strings (Internationalization)
	Internationalization Node Properties
	Displaying Custom Strings and System Strings
	Administration Mode

	Assigning Permissions
	Translating Methods
	Internationalizing Unifier Environments

	Unifier Mobile Application
	Unifier and Other Oracle Applications
	Unifier and Primavera Analytics
	Analytics Node
	Analytics Log Properties
	Analytics Log (Business Process) Setup
	Analytics Log (Cash Flow) Setup
	Analytics Log (Cost Sheet) Setup
	Analytics Log (Generic Cost Sheet) Setup
	Analytics Log (P6 Summary Sheets)
	Analytics Log (Shells)
	Analytics Log (Space Manager)
	Data Mapping - Space Types Tab
	Data Mapping - Level Tab

	Analytics Log (Vendors)
	Scheduling Setup
	Access Control Changes for Analytics Node in User Mode Access
	Analytics Subject Areas and Unifier Data
	Granting Permissions to Setup Analytics
	Analytics and Dashboards
	Accessing the Unifier Analytics Dashboard in OBI
	Accessing Unifier from OBI server
	Action Links (from OBI to Unifier)
	Accessing Analytics from Unifier
	Publishing Unifier Data to Analytics
	Unifier Configurator and OBI Server for On-Premises
	Analytics Block
	Analytics Block and Shell Templates

	Unifier and Primavera P6
	P6 Data Sources node
	P6 Activity Data
	P6 Activity Picker Query Configuration
	P6 Data and Cash Flow Templates

	Unifier and Primavera Gateway
	Unifier Objects and Gateway
	Gateway Objects and Unifier Provider Objects
	Gateway Node in Unifier
	Business Objects Node in Unifier
	Deploy to Gateway
	History
	Find

	Configuring Permissions for Business Objects
	Unifier Provider, Unifier, and Gateway
	Project/Shell
	Project/Shell Data Dictionary
	Project/Shell Business Flow
	Project/Shell Synchronization
	Project/Shell End-to-End Solution

	Business Processes
	Business Processes Data Dictionary
	Business Processes Business Flow
	Business Processes Synchronization
	Business Processes End-to-End Solution

	Roles
	Roles Data Dictionary
	Roles Business Flow
	Roles Business Flow (Destination App Parameters)
	Roles Synchronization
	Roles End-to-End Solution

	Resources
	Resources Data Dictionary
	Resources Business Flow
	Resources Synchronization
	Resources End-to-end Solution

	CBS Codes




